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Preface

This instruction manual describes how to use the inverter support software FRENIC-Loader 4. This
instruction manual does not cover the handling of inverters. For information on the handling of inverters,
refer to inverter instruction manuals or user's manuals.

In this manual, the Windows 7 Professional 32 bit version is used as a standard.

@ o |f you use a folder name or file name that contains environment-dependent characters
created in a Windows that differs from the language specifications of your Windows, you
may not be able to read or write the file. Use folder and file names that do not contain
environment-dependent characters.

o |If the settings shown below are set in the Windows of use, the characters may protrude.

+ When the size of text or the like is set to a size larger than specified in the [Display]
setting of the control panel.

+ In the Windows10, when the size of text or the like is set to a size larger than the
specified size in [Settings]—[System]—[Display] settings.

e Some of the views may be in languages or fonts that depend on your Windows
preferences.

¢ If you do not install language packs Microsoft. NET Framework Ver. 4.5 or higher, some of
the displayed languages may become English.

e The resolution of the monitor is recommended to be 1920 x 1080 or more. Below that, the
operability may deteriorate.

e Example screens shown in this manual might differ from actual displaying screen by the
software version or specifications change.

m Safety Precautions

Prior to the use (including connection, wiring, operation, maintenance, inspection, etc.), be sure to read
this instruction manual as well as the "RS-485 Communication User's Manual”, inverter instruction
manuals and user's manuals, as needed, to gain an understanding of how to handle the product and
ensure correct use of related devices. Incorrect handling may hinder normal operation or result in
inverter failure or shortening of product life.

Use your devices after ensuring a thorough understanding of device knowledge, safety information,
and all related precautions.

Safety precautions contained in this instruction manual have been categorized as follows.

&WARN I NG Failure to heed the information indicated by this symbol may result in
death or serious injury.

ACAUTION Failure to heed the information indicated by this symbol may result in
minor or light injury and/or substantial property damage.

Failure to heed the information contained under the CAUTION title may also result in serious
consequences.
All items indicate important content and therefore must be observed.



Wiring

AWARNING

e Before wiring the RS-485 ports and connecting the cables, ensure that the power is off (the switch is
open).
Failure to observe this could result in electric shock.

ACAUTION

e Before connecting wires to the RJ-45 connectors on the inverter (such as the RJ-45 connector for
keypad connection, the RS-485 communication card's RJ-45 connector, and the inverter's RJ-45
connector for RS-485 communication), check the wiring of the devices to be connected. Refer to the
"RS-485 Communication User's Manual" for details.

Failure to observe this could result in a failure.

Operating Precautions

AWARNING

e Carefully note that resetting the alarm with the operation command on causes the inverter to start
unexpectedly as soon as the alarm is cleared.
Failure to observe this could result in an accident.

AWARNING

o If the loader goes down or is forcibly terminated during the operation with the test drive screen open,
it will be impossible to stop the inverter operation with the loader. If this is the case, stop the inverter
by doing one of the following:

Failure to observe this could result in an accident.
<How to stop the inverter when the loader goes down or is forcibly terminated>
1) If an emergency stop switch is available, use the switch to stop the inverter.
2) Turn off the inverter power.
3) Turn off the inverter operation command and switch the inverter from "remote command mode"
to "local command mode".
More specifically, do one of the following:
- Turn off the terminal to which the "LE" command is assigned.
- Zero the data for the link function for support (function code: y99).
- Zero the data for the link function (function code H30).

e Do not remove the RS-485 cable, USB cable, or keypad during the operation with the test drive
screen open. Doing so would be dangerous because it would be impossible to stop the inverter
operation with the loader.

Failure to observe this could result in an accident.
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Chapter 1

Before Use

This chapter provides an overview of the inverter support loader software FRENIC Loader (hereinafter
referred as "the Loader"), descriptions about preparations before using the Loader, and procedures for
installation and uninstallation.






Chapter 1 Before Use

1.1. Overview

1.1.1. Features

- The Loader is a software that supports remote operation of our inverters from a personal
computer (hereinafter referred as "the PC") using the RS-485 communication port and the
USB connection (including the connection via the TP-E1U Keypad), and is designed to
operate on the Windows operating system (hereinafter referred as "the OS").

- The Loader facilitates simple operation to set or manage function codes of the inverter.

[Function code]

Can be used to read or write, edit, compare, initialize, save, or
print the parameters (function code setting data) that set the
inverter operations.

[Operation monitor]

Can be used to check the status of the external 1/O (I/O monitor),
the Loader information or maintenance information (system
SEECEEEEEE | monitor), alarm  occurrence information (alarm monitor), or
information such as the current frequency (operation monitor).

[Customizable logic]
Can be used to extend the inverter functionality and to customize
for the user interface.

abla Logic

[Schedule operation]
Can be used to set the inverter operation pattern according to the
calendar settings.

[Real-time trace]

Can be used to monitor operation conditions in the form of
continuous waveform information with the maximum of four analog
channels and the maximum of eight digital channels (to the
maximum total of eight channels).

[Historical trace]

Can be used to monitor inverter operation conditions in the form of
waveform information in a sampling time that is shorter than the
realtime trace. (The number of samplings is limited.)

[Test run]
Can be used to manipulate the frequency command or operation
command on the Loader screen to test run the inverter.

Test Fun

[Communication setting]

Can be used to make communication settings between the PC and
the inverter or with the remote control keypad provided with a USB
terminal.
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1.1.2. Loader Functions by FRENIC Series Inverter Model

This section lists functions that can be used by each FRENIC series inverter.

Table 1-1 Correspondence between FRENIC Series Inverter Models and Loader Functions

FRENIC series Inverter

Mini | Mini Eco Ace | eFIT |MEGA |HVAC
(Cl | (c2) | (F1) | (E2) | (EF1) | (G1) |(AR1)

. (GX1)

Multi VP «5 AQUA
Function (E1) | (F2S) (AQ1)

eHVAC

(F2E)
Lift
(LM2)
O
[Function code window] 1 © © © © © ©

[Customizable logic

function code window]

[Operation monitor] © © © © © ©
O
[Customizable logic] X X X © © X *0
[Schedule operation] X X X X X X ©
@) O

[Real-time trace] *3 © %3 © © © ©
[Historical trace] X X X © © © X
[Test run] © © © © © © ©

RS-485 © | ©|l 0|0 | ©| 00| 0
[Communication USB % % % % % % o
setting] (directly)

uUsB

(via Keypad)

Remote keypad with USB
(TP-E1U) Copy function 4

©: Supported, O: Supported with restrictions, X: Not supported

*1 Auto tuning cannot be used.
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*2 1/0 checking, logic checking, and trace monitoring cannot be used.
On-line monitoring can be used only for one function block. Function block inputs cannot be
monitored. Input terminals and output terminals cannot be monitored.
Settings for the user setting area and storage area (function codes: U121 to U140 and U171
to U175) cannot be used.

*3 Tracing is not possible with the special communication commands. The "Trace function" is
not available with Eco Plus (F1-PL)

*4 Supported by the remote keypad with USB (ROM version 1600 or later).

*5 The MEGA (G1) is for driving an induction motor and the MEGA (GX1) is for driving a
permanent magnet synchronous motor.

The following table shows the Loader functions that can be used when accessing the keypad
memory from the Loader.

Table 1-2 Correspondence between the Keypad and Loader Functions

Keypad
Function
TP-E1U - - - - .

@)
[Function code window] 1 - - - - -
[Operation monitor] © - - - - -

@)
[Customizable logic] 6 - - - - _
[Schedule operation] X - - - _ _
[Real-time trace] X - - - - -
[Historical trace] X - - - - _
[Test run] X - - - _ _
[Communication USB )

(Datain © - - - -

setting] Keypad)

©: Supported, O: Supported with restrictions, X: Not supported
*1 Auto tuning cannot be used.

*6 Start/stop and monitoring functions of the customizable logic cannot be used.
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1.1.3. Obtaining this Product

This product can be obtained according to the following procedure. (A PC that can be connected
to the Internet is required.)

1) You can visit our website and access "Fe Library" on the technical support page.

https://felib.fujielectric.co.jp/download/index.htm?site=global&lang=en

Membership registration is required. If you do not have an account, a new registration is
necessary. (The registration is free of charge.)

Select the "Region/Language" in the upper right of the window according to your operating
environment.

r
[F= Fuiji Electric Giobal H

»Login  »Newmember registration  » Forgotten password

Fe Library

D 0

Format (Device Type) Search Full-text Search(Login to run.)

's ™
T N
Search for Catalogs Search for Technical Data Search by Products
\ o 9 L)
's ™ N ' N
£ 2 ®
ooo 8
Search on the List of Products FAQ What's New
\ Lt o) \ o)
e ¥
C N | -
1 1
1 1
1 1
1 1
1 1
1 1
1 1
I i
: O New Member | o :
i i
.

2)

s

]

~

s

NS

~N

.

Search for Catalogs Search for Technical Data Search by Products
L) o o)
~ g Manual N 's \
ooog Aleraens__ Mo ___L | @
oog 1| Sofwere !
! H
Search on the List of Products o What's New
0 CAD data&Outline drawing °
4 " 7 | o’



https://felib.fujielectric.co.jp/download/index.htm?site=global&lang=en
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3) On the search menu, make the following settings.

EFuji Electric Global RegionLanguege: |GloballEnglish v
Fe Library [y rLogout  »Change member information / Withdraw from membership  » Inguiries

‘ Format (Device Type) Search | Search 0 | Full-text search | W 0
Search for
Catalogs °

Open all [ [ Manual 0]‘[ Technical document 0] Datasheet I CAD data & Outline o
drawing

LV Distribution & Motor Control

[&] Search for Search by o9 Search on the 1l )
E| Tochnical Data & [ﬁﬁ Products ") [553 List of Pmductsc] [?% FAQ ") [ What's New °]

B Control [pep—— ——————

Programmable control Equipment : Title 1 | Format Document No.

EX Meter & Instruments e e r- --l

Energy Control Equipment & Protective L = e o homh e : ‘I
Control Equipment .

e————————

| loadera ! Enter "loader 4" with a space
b between "r" and "4", to the "Title"
[ | Only display new documents. Manth of Is field.

Document No.
Press the [Search] button.

Document
DL Category  Title ¥ . .
e Click the Loader Software title, and
l the screen appears to inquire about
——————— ey ]
1 - 1 downloading.
] Software : : [Details]
J Loader Software FRENIC Loader 4 verl x.x.x 1

Clickﬂ:eh:rtoTﬂm_m_ded—' Press the [Download Files] button,
n = and the download starts.
H % Download es !

| Sy ey

Select the [Save] button to save the
data to your PC.

* Obtaining the Product from Sources Other than the Website:
Please consult your dealer or the nearest Fuiji Electric sales office.
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1.1.4. Product Warranty

Limitation Fuji Electric Co., Ltd. accepts no responsibility for any losses (this includes,
of liability but is not restricted to lost profits, suspension of business, loss of business
information, or other financial loss) arising from the use, or inability to use this
software or its documentation.

1.1.5. Menu Command and Operation Button Notation

Menu commands and operation buttons for each screen are expressed as follows in this user's

manual.
For example, [File(E)] is abbreviated as [File] ("(E)" omitted).
((F) indicates the shortcut key [Alt] + [F].)

Screen operation buttons are expressed as follows: for example, the [Open (O) ...] button is
expressed as [Open] ("(O)"and "..." omitted). ((O) indicates the shortcut key [Alt] + [O].)
However, square brackets [ ] are omitted, and bold font is used in chapter and section titles, as

well as in captions.
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1.2. Connecting Inverters to the PC

1.2.1. Connection Methods

This section describes basic connection methods. Connection methods are different depending
on the type of inverters to be connected. Check the relevant instruction manuals for the inverters
and use the correct connection method.

Numbe_r of PC side Invg rer Connection Methods Refen_ence
connections side section
Connection via the USB/RS-485
1n USB RS-485 converter (Note 1)
(n=12,.., 1221
32) COM port RS-485 Connection via the RS-232C/
(RS-232C) RS-485 converter (Note 1)
Connection using the USB cable.
TP-E1U If the TP-E1U cannot be attached
usB (Note 2) to the inverter, connect the 1.2.3.1.[1]
11 (Note 3) TP-E1U to the inverter using the
' LAN cable.
USB . .
USB Connection using the USB cable. 1.2.3.1. [2]
(Note 4)

Note 1: When using the RJ-45 connector, use a branch adapter for multi-drop connection from the second
inverter onward.

Note 2: The TP-E1U is a remote keypad with a USB connector
as shown in Figure 1-1.

Note 3: This connection is possible only for inverters that
support the TP-E1U. For information on the TP-E1U
support  details, refer to "1.1.2. Table 1-1
Correspondence between FRENIC Series Inverter

USB port cover

Models and Loader Functions" or catalogs of relevant
inverters.

Note 4: This connection is possible only for inverters with
built-in USB port. For information on whether the
inverters are equipped with the USB port or not, refer to
"1.1.2. Table 1-1 Correspondence between FRENIC
Series Inverter Models and Loader Functions" or catalogs

Figure 1-1 TP-E1U

of relevant inverters.

1) For information on the RS-232C/RS-485 converter and USB/RS-485 converter, refer to
"1.2.2.2. Devices Required for RS-485 Connection".

Qlote

2) When connecting inverters with the LAN cable using the RJ-45 connector, refer to "1.2.2.2.
[2] Cables" and "1.2.2.2. [3] Branch Adapter for Multi-drop Connection".

3) Ifthe RS-485(RJ-45 connector) is commonly used with the keypad connection connector
for the inverter, the keypad must be removed from the inverter.

4) To minimize the effects of noise, avoid wiring in the same bundled cable as for the power
supply and, instead, wire in a separate line. (Refer to "1.2.2.3. Noise Countermeasures for
RS-485 Communication".)
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@ 5) Itis not possible to use the Loader with a PLC or other host devices at the same time.
Before using the Loader, disconnect the connection cables to other host devices.

6) For configuring the multi-drop connection, assign different station addresses to inverters to
be connected.

AWARNING

e Be sure to turn off the power to the inverters and related devices before wiring or making RS-485.

Failure to observe this could result in electric shock.

AWARNING

e Do not connect the LAN terminal of the PC directly with the RJ-45 connector of the inverter using the
LAN cable.
The RJ-45 connector of the inverter is not for LAN communication.
The voltage level and pin arrangement are different from those of the LAN terminal of the PC.
A trouble such as a power short-circuit or signal line collision may occur and may damage the
product.

Failure to observe this could result in a product failure.

ACAUTION

e When connecting cables to the RJ-45 connectors on the inverter (RJ-45 connector for connecting to
the keypad, RJ-45 connector for connecting to the RS-485 communication card, and RJ-45 connector
for the inverter's RS-485 communication), be sure to check the wiring of the devices to be connected.
For details, refer to the "RS-485 Communication User's Manual".

Failure to observe this could result in a product failure.
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1.2.2. RS-485 Communication Port Connection

1.2.2.1. Basic Connection Drawings

[1] Multi-drop Connection Using the RJ-45 Connectors
The following diagram shows an example of multi-drop connection using RJ-45 connectors.

PC Branch adapter for FRENIC series

multi-drop connection Inverter RS-485
Communication

FRENIC .
Loader Converter %}E / device
| ——— RJ-45 connector

Terminating resistor / o
(100 — 120 ohm) ON Termmatmg
Cable 2 resistor SW

OFF

Cable 1 Cable 2 x
%}E — l¢«—F— RJ-45 connector

Terminating
resistor SW
OFF

e RJ-45 connector

Terminating
resistor SW
ON

Figure 1-2 RS-485 Connection Diagram (RJ-45 connector Connection)

The following devices are used for the connection. For information on recommended devices,
refer to "1.2.2.2. Devices Required for RS-485 Connection".

Devices used Description

Converter PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485
converter or USB/RS-485 converter is required.

To connect to the RJ-45 connector of the inverter, a converter equipped with the
RJ-45 connector is required on the RS-485 port side.

Cable 1 Follow the specifications of the converter.

Cable 2 Use the extension cable for remote operation (CB-5S, CB-3S, or CB-1S) or
commercially available LAN cable (straight).

Branch adapter for | The branch adapter is convenient to use when using the cable with RJ-45
multi-drop connector for the multi-drop connection. The branch adapter is not necessary for
connection the inverter equipped with the RJ-45 connector for functional extension.

AWARNING

e The power supply (1, 2, 7, and 8 pins) for the keypad is connected to the RJ-45 connector
for the RS-485 communication (communication port 1). When connecting to other devices,
be careful not to connect to pins assigned to the power supply. Connect only pin 4 and pin
5.

e Do not connect the LAN terminal of the PC directly with the RJ-45 connector of the
inverter using the LAN cable.

Failure to observe this could result in a product failure.
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For information on RS-485 communication settings, refer to the following.
Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side
Loader side: 1.5.5. Communication Setting and Connection Setting for the Loader

For information on the inverter's terminating resistor switch, refer to the inverter instruction
manuals or the RS-485 Communication User's Manual.

@ e For the selection of connection devices to prevent damage or malfunction in the
control PCB caused by an external noise and to eliminate the influence of the
common mode noise, be sure to refer to "1.2.2.2. Devices Required for RS-485
Connection".

e The maximum wiring length must be 500 m in total.
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[2] Multi-drop Connection Using Terminal Blocks
The following diagram shows an example of multi-drop connection using terminal blocks.

PC FRENIC series
. Inverter
FRENIC Converter | PX()
Loader DX(-)
‘ DX(+) Terminating
Terminating resistor DX() ge;:ftor SW
(100 — 120 ohm) ON
Cable 1 Shield DX(4) Terminating
=% resistor SW
©) OFF
Cable2 —»
DX(+) Terminating
DX() resistor SW
ON

Figure 1-3 RS-485 Connection Diagram (Terminal Block Connection)

The following devices are used for the connection. For information on recommended devices,
refer to "1.2.2.2. Devices Required for RS-485 Connection".

Devices used Description

Converter PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485
converter or USB/RS-485 converter is required.

To connect to the terminal block of the inverter, a converter equipped with the
terminal block is required on the RS-485 port side.

Cable 1 Follow the specifications of the converter.

Cable 2 Use a shielded twisted-pair cable for long distance transmission.

For information on RS-485 communication settings, refer to the following.
Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side
Loader side: 1.5.5. Communication Setting and Connection Setting for the Loader

@ e For the selection of connection devices to prevent damage or malfunction in the
control PCB caused by an external noise and to eliminate the influence of the
common mode noise, be sure to refer to "1.2.2.2. Devices Required for RS-485
Connection".

e The maximum wiring length must be 500 m in total.
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1.2.2.2. Devices Required for RS-485 Connection

This section describes about the devices required when connecting to a PC with non RS-485
interface.

[1] Converter

PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485 converter or
USB/RS-485 converter is required. Always use a converter that meets the recommended
specifications shown below in order to ensure correct use. Note that the software may not
function properly if a converter other than those recommended is used.

Recommended converter specifications

Transmission/receipt Automatic switching through monitoring transmission data at the PC

switching method: side (RS-232C)

Isolation: Must be dielectrically isolated from the RS-485 side.
Fail-safe: Must be equipped with a fail-safe function (*).

Other requirement: Must have excellent noise resistance properties.

* The fail-safe function is a function capable of ensuring that the RS-485 receiver output is
logic high even when the RS-485 receiver input is open or shorted or when all the RS-485
drivers are inactive.

Recommended converters

Manufacturer:  System Sacom Industry Corp.
Model: KS-485PTI (RS-232C/RS-485 converter)
USB-4851 RJ-45-T4P (USB/RS-485 converter)

Transmission/receipt switching method

RS-485 communication involves half-duplex operation (two-wire system), and therefore
converters require a function for switching between transmission and receipt. There are the
following two switching methods.

(1) Automatic switching through monitoring transmission data
(2) Switching with RS-232C flow control signals (RTS or DTR) from the PC

The FRENIC Loader 4 does not support the above switching method (2). Therefore, use the
converter with the above switching method (1).
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[2] Cables (for RJ-45 connector connection)
The connection cable specifications are set as follows to ensure reliable connection.

Specifications

Common specifications 10BASE-T/100BASE-TX straight cables (commercially
available LAN cable) that satisfies the US ANSI/TIA/EIA-568A
Category 5 standard.

Extension cable for remote operation | Same as above, 8-conductor, 5-m long, RJ-45 connector (on
(CB-5S) both ends)

Extension cable for remote operation | Same as above, 8-conductor, 3-m long, RJ-45 connector (on
(CB-3S) both ends)

Extension cable for remote operation | Same as above, 8-conductor, 1-m long, RJ-45 connector (on
(CB-1S) both ends)

When connecting to the keypad, use an 8-conductor straight cable. Use the extension cable for
remote operation (CB-5S, CB-3S, or CB-1S) or commercially available LAN cable (20 m or less).

Recommended LAN cable

Manufacturer:  Sanwa Supply Inc.
Model: KB-10T5-01K (1 m)
KB-STP-01K (1 m shield cable: possible to conform to the EMC Directive)

@ e The power supply (1, 2, 7, and 8 pins) for the keypad is connected to the RJ-45
connector for the RS-485 communication (communication port 1). When connecting
to other devices, be careful not to connect to pins assigned to the power supply.
Connect only pin 4 and pin 5.

[3] Cables (using terminal blocks)
Use a shielded twisted-pair cable for long distance transmission with the wire gauge of AWG 16
to AWG 26 to ensure reliable connection.

Recommended cable

Manufacturer:  Furukawa Electric Co., Ltd.
Model: AWM 2789 Long-distance connection cable

[4] Branch Adapter for Multi-drop Connection
The RJ-45 connectors are used as communication connectors. When configuring a multi-drop
connection using the standard LAN cable, a branch adapter for the RJ-45 connector is required.

Manufacturer: SK KOHKI CO., LTD.
Model: MS8-BA-JJJ
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1.2.2.3. Noise Countermeasures for RS-485 Communication

Depending on the operating environment, the system may malfunction due to noise generated
by the inverter. To prevent such malfunction, countermeasures can be taken by separating
wiring lines, using shielded cables, isolating the power supply, or adding an inductance. As an
example, addition of an inductance is shown below.

Addition of an inductance

Form an inductance component in the circuit to generate a high-impedance state against the
high frequency noise by inserting a choke coil in series with the signal circuit or by passing the
wiring through the ferrite core.

Ferrite core
RS-485 communications cable

RS-485 TRD+

'i i Inverter
converter TRD- H :

FG

Pass the wiring through the ferrite core or
wind the ferrite core with the wiring a few times

Figure 1-4 Addition of an Inductance
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1.2.3. USB Communication Port Connection

1.2.3.1. Basic Connection Drawings

[1] Connection with the Inverter Equipped with TP-E1U as Standard
The following section describes a connection of the PC with the inverter that is equipped with the
TP-E1U Remote Keypad with USB port as standard.

FRENIC series
Inverter

USB A connector

/) 282
FRENIC Loader / -

USB mini B connector

Figure 1-5 USB Connection Diagram (Connection with the Inverter Equipped with TP-E1U as Standard)

Devices used Description

Cable Use a commercially available USB cable (mini B connector).

For information on USB communication settings, refer to the following.
Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side
Loader side: 1.5.5. Communication Setting and Connection Setting for the Loader

On the Loader side, select [Data in Inverter (via TP)] for the USB connection under [Port] on the
[Communication setting] window.

@ e A USB driver must be installed on your PC. For information on the installation
methods, refer to "1.4.1.5. Checking the USB Driver".

e When connecting the inverter to the PC Loader via the USB communication port,
use 1:1 connection. (Do not use the USB hub.)
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[2] Connection with the Inverter via the TP-E1U

The following section describes a connection of the PC with the inverter via the TP-E1U Remote
Keypad with USB port. Connect the TP-E1U to the keypad coupling connector on the inverter
with a communication cable. Be careful with the connector. If it is connected to any connector or
port other than the keypad coupling connector, no communication will be possible.

Inverters that Support TP-E1U Other than the FRENIC-Mini (C2)

The keypad mounted on the inverter as standard must be removed.

FRENIC series

Remote keypad with USB Inverter
TP-E1U
USB A connector Cable 2
PC Cable 1

RJ 45 connector

FRENIC Loader on back side
USB mini B connector Keypad coupling connector
(RJ-45)

Figure 1-6 USB Connection Diagram (Connection with the Inverter (Other than the C2 Model) via TP-E1U)

FRENIC-Mini (C2)

Remote keypad with USB FRENIC-Mini (C2)
TP-E1U

Cable 2

HE RJ-45 connector

on back side

USB A connector

PC Cable 1
FRENIC Loader

USB mini B connector Keypad coupling connector (RJ-45)

Figure 1-7 USB Connection Diagram (Connection with the FRENIC-Mini (C2) via TP-E1U)

Devices used Description

Remote keypad For the inverter models that support the TP-E1U as an optional item, the TP-E1U

with USB needs to be purchased separately.
Cable 1 Use a commercially available USB cable (mini B connector).
Cable 2 Use the extension cable for remote operation (CB-5S, CB-3S, or CB-1S) or

commercially available LAN cable (straight).

For information on USB communication settings, refer to the following.
Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side
Loader side: 1.5.5. Communication Setting and Connection Setting for the Loader

On the Loader side, select [Data in Inverter (via TP)] for the USB connection under [Port] on the

[Communication setting] window.
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@ e This connection is possible only for inverters that support the TP-E1U. For
information on the TP-E1U support detalil, refer to "1.1.2. Table 1-1
Correspondence between FRENIC Series Inverter Models and Loader Functions" or
catalogs of relevant inverters.

e Be sure to connect the TP-E1U to the keypad coupling connector on the inverter.
For example, the keypad coupling connector for the FRENIC-Ace is available only
on the RS-485 communication port 1. Therefore, if the TP-E1U is connected to the
RS-485 communication port 2, no communication is possible.

e A USB driver must be installed on your PC. For information on the installation
methods, refer to "1.4.1.5. Checking the USB Driver".

¢ When connecting the inverter to the PC Loader via the USB communication port,
use 1:1 connection. (Do not use the USB hub.)

[3] Connection with the Inverter with Built-in USB Port
The following section describes a connection of the PC to the USB connector on the inverter
with built-in USB port.

FRENIC series
Inverter

USB A connector

PC / Cable z
FRENIC Loader // fhe

USB connector

Figure 1-8 USB Cable Connection Diagram (For the Inverter with Built-in USB Port)

Devices used

Description

Cable

Refer to the instruction manuals or user's manuals of relevant inverters.

For information on USB communication settings, refer to "1.5.5. Communication Setting and
Connection Setting for the Loader".

No settings are required on the inverter side.

On the Loader side, select [Data in Inverter (Direct connection)] for the USB connection under
[Port] on the [Communication setting] window.

@ e This connection is possible only for inverters with built-in USB port. For information
on whether the inverters are equipped with the USB port or not, refer to "1.1.2. Table
1-1 Correspondence between FRENIC Series Inverter Models and Loader
Functions" or catalogs of relevant inverters.

e For information on the inverter's USB connector location, USB connector profile, or
connection methods, refer to the instruction manuals or user’s manuals of relevant
inverters.
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@ e A USB driver must be installed on your PC. For information on the installation
methods, refer to "1.4.1.5. Checking the USB Driver".

¢ When connecting the inverter to the PC Loader via the USB communication port,
use 1:1 connection. (Do not use the USB hub.)

e |f communication is enabled while the inverter is stopped and if it is disabled while
the inverter is in operation, it is highly possible that the communication is affected by
noise. Implement an appropriate noise countermeasure such as by passing the USB
cable through the ferrite core. Connect the USB cable to the USB 3.0 terminal of the
PC. If the problem is not solved, use the RS-485 communication.

1.2.3.2. USB Specifications

[1] USB Specifications for the TP-E1U
Table 1-3 USB Specifications for the TP-E1U

Specifications Conforming to USB1.1
Transfer speed 12 Mbps
Wire length 5 m max.
Connector USB Mini-B connector

When connected to the inverter:  Self power
Power supply

When connected to the PC: Bus power

[2] USB Specifications for the Inverter with Built-in USB Port
Refer to the instruction manuals or user's manuals of relevant inverters.
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1.3. Connection between the PC and the Keypad

1.3.1. Connection between the TP-E1U and the Inverter

1.3.1.1. Memory Function of the TP-E1U

The TP-E1U Remote Keypad with USB port can be used as a temporary memory medium.
Retrieve the inverter operation condition data into the TP-E1U, remove the TP-E1U, and, ata
location such as an office other than the work site, connect the TP-E1U to the PC with the
Loader installed. Using the Loader, the retrieved function code data can be edited, set, or

monitored.

The settings edited using the Loader can be retrieved into the TP-E1U and, at the work site, the
data can be written into the inverter from the TP-E1U.

Even if the inverter does not support the USB communication via the TP-E1U (see 1.2.3.1. Basic
Connection Drawings [2]), the TP-E1U can be used as a temporary memory medium as long as
the inverter support the copy function of the remote keypad.

1.3.1.2. Connection between the PC and the TP-E1U

The following section describes a connection between the PC and the TP-E1U when using the
TP-E1U as a temporary memory medium.

PC

Remote keypad with USB
TP-E1U

USB A connector

Cable

FRENIC Loader

USB mini B connector

Figure 1-9 Connection Diagram between the PC and the TP-E1U

Devices used

Description

Remote keypad
with USB

For the inverter models that support the TP-E1U as an optional item, the TP-E1U
needs to be purchased separately.

Cable

Use a commercially available USB cable (mini B connector).

For information on USB communication settings, refer to "1.5.5. Communication Setting and
Connection Setting for the Loader".

There is no function for communication setting on the keypad side.

On the Loader side, select [Data in Keypad] for the USB connection under [Port] on the
[Communication setting] window.

@ e A USB driver must be installed on your PC. For information on the installation
methods, refer to "1.4.1.5. Checking the USB Driver".

e When connecting the inverter to the PC Loader via the USB communication port,
use 1:1 connection. (Do not use the USB hub.)
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1.3.1.3. Connection between the TP-E1U and the Inverter

The following section describes a connection between the TP-E1U and the inverter when using
the TP-E1U Remote Keypad with USB port as a temporary memory medium.

Use the copy function of the keypad to retrieve the data from the inverter into the TP-E1U and to
write the function code setting data into the inverter from the TP-E1U. For information on the
copy function, refer to the instruction manuals of relevant inverters.

For the inverter equipped with the
FRENIC series Inverter TP-E1U as standard, attach the

Remote keypad (TP-E1U supported as standard) keypad to the specified location.
TP-E1U

Attachment

Figure 1-10 Connection Diagram between the TP-E1U and the Inverter (Attaching to the Inverter)

If there is no space on the inverter to attach the keypad, connect the TP-E1U to the keypad
coupling connector on the inverter with a communication cable. Be careful with the connector. If
it is connected to any connector or port other than the keypad coupling connector, no
communication will be possible.

Inverters that Support TP-E1U Other than the FRENIC-Mini (C2)

The keypad mounted on the inverter as standard must be removed.

FRENIC series Keypa:
Remote keypad Inverter supported as

TP-E1U Cable standard

Removal
HE RJ-45 connector

= on back side

6868

Keypad coupling connector
(RJ-45)

Figure 1-11 Connection Diagram between the TP-E1U and the Inverter (Other than the C2 Model)
(Connection Using a Communication Cable)
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FRENIC-Mini (C2)

Remote keypad FRENIC-Mini (C2)

TP-E1U
Cable

HE \ RJ-45 connector

= on back side

\

Keypad coupling connector (RJ-45)

Connection Diagram between the TP-E1U and the FRENIC-Mini (C2)

Figure 1-12
(Connection Using a Communication Cable)

Description
For the inverter models that support the TP-E1U as an optional item, the TP-E1U

needs to be purchased separately.
Use the extension cable for remote operation (CB-5S, CB-3S, or CB-1S) or
commercially available LAN cable (straight).

Devices used

Remote keypad
with USB

Cable

@ e For information on the connection methods between the TP-E1U and the inverter,
refer to the instruction manuals or user's manuals of relevant inverters.
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1.4. Installation and Uninstallation

1.4.1. Installation Methods

1.4.1.1. Flowchart of Installation Procedures

Perform installation according to the following procedure.

START

¢

Perform pre-installation check. (See section 1.4.1.2.)

v
4 )

Install the FRENIC Loader 4 and a set

of required applications.

N j
\E

/ (*1) The following devices can be used for USB
Use USB communication (*1) with the communication with the FRENIC Loader 4.
FRENIC Loader 4?

(See section 1.4.1.3.)

- TP-E1U Remote Keypad with USB port

\ j - FRENIC series inverter with built-in USB port
[No]
[Yes]
/Perform pre-installation check before\
. . . (See section 1.4.1.4.)
installing the USB driver. (*2)(*3
4 I _
Install the USB driver. (See section 1.4.1.4.)
o v

(*2) For the installation of the USB driver, connect the PC
with the USB device. Therefore, the following devices

END are required.

- USB device
(TP-E1U Remote Keypad with USB port or FRENIC
series inverter with built-in USB port)

- USB cable
(Used for connecting the PC with the USB device)

(*3) The FRENIC Loader 4 and the Message Manager must
be closed.
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1.4.1.2. Perform Pre-installation Check.

Perform the following tasks prior to installation.

Task Description

Checking Windows version Make sure that the version is one of the following.
Windows 7 (32-bit/64-bit)

Windows 8.1 (32-bit/64-bit)

Windows 10 (32-bit/64-bit)

Exiting running applications Exit any applications that are currently running.

It is not necessary to uninstall the FRENIC Loader 3.3 or other FRENIC Loaders.

@ ¢ For installing this Loader software, use an account authorized to install this software.
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1.4.1.3. FRENIC Loader Installation Procedure

This application requires the following applications.

At the time of installation, these applications are installed as required. Follow the instructions on

the screen to install them.

1 Microsoft .NET Framework 4.5.2 Full
2 Microsoft Visual C++ 2015 Redistributable Package

3 Message Manager (MsgMgr USB Setup)

The following section describes the FRENIC Loader 4 installation procedure.

START

¢

Execute the installer
FRENIC Loader4_[CM0 setup.exe.
Ve

\!

Select the language for installation. ]

Install a set of required applications. \

a ) o ) Automatically selected.
Select required applications. o )
Applications that are already installed are
\l/ not selected.
/ \ Automatically executed.

Install the Microsoft .NET Framework
4.5.2 Full Package.

v

Install the Microsoft Visual C++ 2015
Redistributable Package.

!

Install the Message Manager.

Not executed if it is not selected at the

above staae (a).

It is automatically executed.
Not executed if it is not selected at the

above staage (a).

Follow the instructions on the wizard.

Not executed if it is not selected at the

above stage (a). /

Install the FRENIC Loader 4. Follow the instructions on the wizard.

®

END

NN Y o
- J )L
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Install the FRENIC Loader according to the instructions on the wizard.

The following shows installation procedures in English.

P Downloads

|6(_)v| 4§ - Fuji Electric + Downloads

Right-click

Organize = [ Open  Share nith

i7" Favorites
Bl Desktop
4§+ Downloads

£l Recent Places @ Run as admiristrator

Troubleshoot compatiié
i Libraries There with »
%] Documents Restore previous versions
" Music
I Pictures send o ¢
B videos cut
Copy
il
[ [Jcnmpuner Create shortcut
&, Local Disk (C) Delete
Rename
i Network
Properties

FRENIC-Loader4_V1.0.3.1_setup Date modified: 8/17/2019 2:06 AM
Size: 132MB

Application

Date created: 9/18/2019 6:33FM

[FRENIC-Loader4_[COC_setup.exe]
and select [Run as administrator] from
the right-click menu that appears.

The setup will automatically run the
installation wizard.

]

FRENIC Loader4 - InstallShield Wizard

. Select the language for the installation from the choices below.

‘ English

(United States)

Select the language, either [Japanese] or
[English], to be used in the installation.

The selected language affects
registration items of the start menu.

[ Select [English] here.

[1] Installation of Required Software

Click [OK].

If all the required softwares have already been installed, the following screen does not appear.

Proceed to [[3] Installation of the FRENIC Loader].

FRENIC Loader4 - Installshield Wizard
Y
4
<

Install to begin installing these requirements,

FRENIC Loader4 requires the following items to be installed on your computer. Click

| A list of required softwares is displayed.

Status | Reguirement
Pending Microsoft .NET Framework 4.5.2 Full

Pending Microsoft Visual C++ 2015 Redistributable Package (x88)
Pending MsgMgr USE Setup

Click [Install].

Cancel |
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@ User Account Control x|

ﬁ Do you want to allow the following program from an unknown
#  publisher to make changes to this computer?

Program name:  FRENIC Loader4_1000_E setup.exe

Publisher: Unknown
File origin: Hard drive on this computer
j Show details Yes

Change when these notifications appear

E& Microsoft NET Framework 4.5.2 x|
Installation Progress N
Please wait while the .MET Framework is being installed. Nkmwf

File security verification:

I

Verifying netfx_Ful_GDR.mzz

Installation progress:

[

Installing necessary components for JNET Framewaork

Canicel

[2] Installation of the Message Manager

44 FRENIC Loader4 requires the following items to be installed on your computer. Click
L5 Install to begin installing these requirements.

Status | Requirement |
Succeeded Microsoft .NET Framework 4.5.2 Full
Succeeded Microsoft Visual C++ 2015 Redistributable Package (x86)

Instaling CMsgMagr USE Sety

Installing MsgMgr USE Setup
| |

Inistall | Cancel I

When the screen on the left is
displayed, click [Yes].

If "MsgMgr USB Setup” is displayed on
the screen shown to the left after
clicking [FRENIC Loader4 [0
setup.exe], the Message Manager will
be installed.

If "MsgMgr USB Setup" is not
displayed, it means that the Message
Manager has already been installed.

If the Message Manager has already been installed, the following screen does not appear.

Proceed to [[3] Installation of the FRENIC Loader].
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Message Manager - InstaliShield Wizard 2 % ] 7]

First, select the language to be used in
the installation of the Message
Manager.

Select [English] here.

Click [Next].
Message Manager - InstallShield Wizard N x|
Welcome to the InstallShield Wizard for Message Manager
=
The InstalShield Wizard wil install Message Manager on your computer. To continue, dick Next.
L ]
Click [Next].
e Al Carefully read the Software End User

License Agreement.

To view the full text of the contract
agreement:

Press the PAGE DOWIN key to see the rest of the agreement.

Software End User License Agreement i’

The Sofvere il L Agrnent (1 “Agconer ) e Press the [Page Down] key or [Page

entity on behalf of which such individual is acting) (licensee”) and U k

Fuji Electric Co. Ltd. (Fuii). p] ey'

- IT IS IMPORTANT THAT YOU READ CAREFULLY AND UNDERSTAND THIS .
AGREEMENT. B CLICKING THE T ACCEPT" BLITTON LOCATED ON THIS You can also use the scroll bar to view

NOT ACCEPT THIS AGREEMENT, IT WILL NOT BE REGISTERED TO USE
OR ACCESS THE SOFTWARE. IF LICENSEE DOES NOT AGREE WITH ALL
TERMS OF THIS AGREEMENT, LICENSEE MUST DESTROY ALL COPIES OF
THE SOFTWARE.

Do you accept all the terms of the preceding License Agreement? If
you seloctNo, the setup il cose: 7o st Messege varoger you (D

must accept this agreement,
If you agree to the terms of the
y g

i ﬁ! ﬁ !g agreement, click [Yes].
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Message Manager - InstallShield Wizard

2l Select a destination folder.
Setup willinstall Message Manager in the following folder.
To install to this folder, cick Next, Ta instal to a different folder, dick Browse and select another . . . i
e To install in a different folder, click the
[Browse] button and select another
destination folder.
=

e =]

When the above selection is finished,
click [Next].

The default folder for the 32-bit OS is C:¥Program Files¥Common Files¥Fuji Electric Shared¥Message
Manager.

Here,"C:" is a drive letter for the disk or partition where the Windows is installed. If the Windows is installed
in a different drive, substitute a drive letter for that drive.

With the 64-bit OS, "Program Files" in the above address string is replaced with "Program Files (x86)".

Message Manager - InstallShield Wizard

x|

_ - e o
Setup will add program icans to the Program Folder listed below. You may type a new folder The default folder name is Message
name, or select one from the existing folders list. Click Next to continue.

Manager".

Existing Folders:

=
Administrative Tools
Games
Maintenance
Startup

e Tablet PC

When the setup is finished, click [Next].

Message Manager - InstallShield Wizard

x|
A confirmation screen is displayed.
Setup has enough information to start copying the program files. If you want to review or
change any settings, click Back. If you are satisfied with the settings, click Mext to begin
copying files.
Current Settings:
Distination Folder d
C:\Program Files (x86)\Common Files\Fuji Electric Shared\Message Manager
Distination Program Folder
= Message Manager
- If a change is required, click [Back] to
return to the previous screen.
L "'_I If no change is required, click [Next].
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Message Manager - InstaliShield Wizard

When the installation of the Message
Manager is finished, the screen shown
to the left is displayed.

InstaliShield Wizard Complete

The InstaliShield Wizard has successfully installed Message Manager. Click Finish to exit the

wizard,

e

Click [Finish].

RTEAR— <

When installations of all the required softwares are completed, proceed to install the FRENIC
Loader 4.
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[3] Installation of the FRENIC Loader

i'._% FRENIC Loader4 - InstallShield Wizard

Welcome to the InstallShield Wizard for
FRENIC Loader4

S

The InstallShield(R) Wizard will install FRENIC Loader4 on your

computer, To continue, dick Next.

WARNING: This program is protected by copyright law and

international treaties.

Click [Next].

i-.% FRENIC Loader4 - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

Software End User License Agreement

This Software End User License Agreement (this “Azreement™) is
between you (both the individual installing the Software and any
single legal entity on behalf of which such individual is
acting) ("Licensee™) and Fuji Electric Co.,Ltd. ("Fuji”).

IT IS IMPORTANT THAT YOU READ CAREFULLY AND UNDERSTAND THIS
WGREEWENT. BY CLICKING THE "I ACCEPT™ BUTTON LOCATED ON THIS

3
|

Carefully read the Software End User
License Agreement.

To view the full text of the agreement:
Press the [Page Down] key or [Page
Up] key.

. You can also use the scroll bar to view
the whole page.

If you agree to the terms of the
agreement, select [l accept the terms in

the license agreement] and then click

[Next].

Enter the user name and company

name.

PAGE, LICENSEE AGREES TO BE BOUND BY THIS AGREEMENT. LI
% T accept the terms in the license agreement! Print
" Ido not accept the terms in the license agreement
Instalshield
< Back I Mext > I Cancel I
{ FRENIC Loader4 - InstallShield Wizard =l
Customer Information
Please enter your information.
User Name:
IUser @
Qrganization:
IUser Company *————
Instalishield
< Back I Next = I Cancel
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{ FRENIC Loader4 - InstallShield Wizard

Destination Folder
Click Mext to install to this folder, or dick Change to install to a different folder.

D Install FREMIC Loader4 to:
C:'Fujielectric\FREMIC Loader 4,

Instalshield

< Back Cancel I

{i FRENIC Loader4 - InstallShield Wizard
Ready to Install the Program

The wizard is ready to begin installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Current Settings:

Setup Type:

Typical

Destination Folder:
C:\Fujielectric\FRENIC Loader4',

User Information:
Mame: User
Company: User Company

Instalshield

Cancel I

'@ user Account Control x|

a Do you want to allow the following program from an unknown
publisher to make ch to this puter?

i WUsers'sz008 53 AppData'Local \Downloaded
Installations \{ABI3COBE-EES6-4E04-32DC-9CBCF. .. \FRENIC

Program name:

Loader4.msi
Fublisher: Unknown
File origin: Hard drive on this computer
ﬂ Show details Yes | Mo I

Change when these notifications appear
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Select the destination folder.

The default folder is
¥Fujielectric¥FRENIC Loader4 in the C
or D drive.

(Note: The drive that has the largest
hard disk space is selected.)

To install in a different folder, click the
[Change] button and select another
destination folder.

When the above selection is finished,
click [Next].

A confirmation screen for selected
contents is displayed.

If a change is required, click [Back] to
return to the previous screen.

If no change is required, click [Install].

When the screen on the left is
displayed, click [Yes].



{1 FRENIC Loader4 - InstallShield Wizard |

InstaliShield Wizard Completed When the installation of the FRENIC
Loader 4 is finished, the screen shown

The wizard was interrupted before FRENIC Loader<4 could be to the left IS d|5p|ayed.
completely installed,

‘Your system has not been modified. To install this program ata
later time, please run the installation again.

Click Finish to exit the wizard.

To end the installation work and to
return to the Windows, click [Finish].

Canicel
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1.4.1.4. USB Driver Installation Procedure

To establish communication by connecting to the USB device (TP-E1U Remote Keypad with
USB port or FRENIC series inverter with built-in USB port), first you must install the USB driver.
This installation work is required only once at the start of using your system.

@ o If the USB driver is not properly installed, communication is not possible via the
USB connector on the TP-E1U or on the inverter.

The installation procedure for the TP-E1U Remote Keypad with USB port is the same as for the
inverter with built-in USB port.

[1] Before Installing the USB Driver
Preparing Devices

For the installation of the USB driver, connect the PC with the USB device.
Prepare the following devices.

USB devices: TP-E1U Remote Keypad with USB port or FRENIC series inverter
with built-in USB port

USB cable: Used for connecting the PC with the USB device.

Installation of the FRENIC Loader 4

Install the FRENIC Loader 4 in advance.

The files required for the installation of the USB driver are saved in the FRENIC Loader 4
installation folder.

For information on the installation methods, refer to "1.4.1.3. FRENIC Loader Installation
Procedure".

Close the FRENIC Loader 4

If the FRENIC Loader 4 was started after installation, close the Loader.

Close the Message Manager.

Close the Message Manager. The Message Manager is automatically started when the FRENIC
Loader 4 or other loader is started. However, it does not close automatically.

The following section describes how to close the Message Manager.

Procedure for Closing the Message Manager

Show hidden icons

- o .. 1041
(S CAECS 2015/08/18
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Left-click here, and hidden icons are displayed as shown below.

Right-click the Message Manager icon, and a display for exiting the Message Manager
appears.

Move the mouse cursor to this display and then left-click on the display, and the Message
Manager is closed.

MessageManager £

l ,  Exit MessageManager ?

Exit MessageManager z

oo 3 i)

4 A w4 e 15:57

The icon may be displayed here.

@ ¢ If an attempt is made to install the USB driver with the Message Manager
already started, the Message Manager cannot recognize the USB driver and, as
a result, a communication failure may occur in the communication between the
Loader and connected devices. In such a case, close the Loader and the
Message Manager and then start the Loader again.

[2] Installation of the USB Driver.

Windows 10

Connect the PC with the USB device (TP-E1U Remote Keypad with USB port or the inverter
with built-in USB) using the USB cable.

When the OS recognizes the USB device of this Loader, the following display appears.

1:31 PM

* —
) = Bl ENG 5/17/2017

The wizard used to install the USB driver does not start automatically. Therefore, install the USB
driver according to the following procedure.

i
B wordPad

Skype video Search

Select [START] -> [Control Panel] and
then left-click.

[l File Explore
ile Explorer Snipping Tool
@ Settings

d) Power

i= Allapps s DDC Loader Get Started

A Search the web and Windows n ﬂ
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[E5] All Control Panel ltems

4 [Z » Control Panel » All Control Panel ltems

Search Conh

vo When the Control Panel home screen

Adjust jyour computer’s settings

[5g AutoPlay
CCX Diagnostic Utility

155 Admipistrative Tools
%g) BitLofker Drive Encryption

& Date and Time

[E Credgntial Manager
& Device Manager s Devices and Printers

@ Ease of Access Center File Explorer Opticns
Z p p

Flash Player (32-bit) A Fonts

& Indexing Options Intel ® HD Graphics

vienny: smallicons - 1S diSplayed, select [Device Manager]
and then left-click.

i Backup and Restore (Winda
K| Color Management

[ Default Programs

= Display

£ File History

& HomeGroup

Internet Options

% Device Manager — O
File

&= T HE B EXE

Action  View Help

X
When the Device Manager screen is
displayed, select "Unknown device"

v &% DESKTOP-B4IDNCT
i Audic inputs and cutputs
E Batteries
ea Bluetooth
3 Computer
- Disk drives
& Display adapters
- DVD/CD-ROM drives
) Human Interface Devices
=2 IDE ATA/ATAP| controllers
E=2 Keyboards
@ Mice and other pointing devices
[ Menitors
I Network adapters
v KY Other devices

I Processors

B Software devices

i| Sound, video and ga
Sy Storage controllers
i3 System devices

§ Universal Serial Bus ¢

Disable
Uninstall

Properties

and then right-click to display options.

= rint queues Update Driver Software... Select "Update Driver Software" and

then left-click.

Scan for hardware changes

Launck

B Update Driver Software - Unknown Device

How do you want to search for driver software?

—» Search automatically for updated driver software

settings.

‘Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation

When the screen on the left is

—» Browse my computer for driver software
Locate and install driver software manually.

displayed, select "Browse my computer
for driver software".

Cancel
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& 0 Update Driver Software - Unknown Device

Browse for driver software on your computer

When the screen on the left is

Search for driver software in this location:

[Ci\Users\Default\Documents|

HInclude subfolders

“] | Browse..

= Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

Cancel

displayed, click [Browse].

Browse For Folder

Select the folder that containg drivers for vour hardware.

Select ... ¥Driver¥MICREXSX" inside

FRENIC Loader4
C15
C25
CstmlLof

DATA

W

gic

W Driver

MICREX!

Folder: |MICF‘.E>{S>{

the FRENIC Loader destination folder
and then click [OK].

The default folder is
C:¥Fujielectric¥FRENIC
Loader4¥Driver¥MICREXSX when the
installation drive is C.

(Note: The drive that has the largest
hard disk space is selected.)

Cancel

& 0 Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

C:\FujielectrictFRENIC Loaderd\Driver\MICREXSX]

Browse...

[ Include subfolders

—> Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

(S ]

Cancel

Click [Next].
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B Update Driver Software - Unknown Device

Installing driver software...

B Update Driver Software - Driver for FRENIC USE interface
Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

Driver for FRENIC USB interface
= 4

The installation will begin.

When the installation of the FRENIC
Loader 4 is finished, the screen shown
to the left is displayed.

| To end the installation work and to
return to the Windows, click [Close].
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Windows 8.1

Connect the PC with the USB device (TP-E1U or the inverter with built-in USB) using the USB
cable.

When the OS recognizes the USB device of this Loader, the following display appears.

The wizard used to install the USB driver does not start automatically. Therefore, install the USB
driver according to the following procedure.

Select the [Computer] icon and then
right-click to display options.

Unpin from Staet Select "Properties” and then left-click.
Manage

Properties

'i Map network drive
Desktop Disconnect network drive

Resize

t=al System

4 18 » Control Panel » System and Security » System v

When the Control Panel home screen
is displayed, select "Device Manager"

Centrol Pgnel Home

View basic information about your computer

S e indows edition and then left-click.
) Remote settings Windows 8.1 Pra --

) System protection © 2013 Micresoft Corporation. All rights \

@ Advanced system settings reserved. ..-

Get more features with a new edition of
Windows
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= Device Manager - E'

File Action View Help

= = E HmE e BSSs

4 = WIN-EG4SRNSPVEE ~
i Audio inputs and outputs

@- Batteries

g Bluetooth
18| Computer

=

v

7

v

7

— Disk drives

B Display adapters

o) DVD/CD-ROM drives
= Floppy disk drives

7

=

=4 Floppy drive controllers
Eﬁ. Human Interface Devices
g IDEATASATAP| controllers

7

=

=

=

== Keyboards

v

Fii Mermory devices
B Mice and other pointing devices
I__-j_, Menitors

LF Metwork adapters
4 |5 Other devices
Unknown devic

=

v

=

77 o (COM & LPT_UpdeleDrverSofvere,
' gé; Print queues Disable
. [} Processors Uninstall

Launches the Upds Scan for hardware changes

Properties

[l Update Driver Software - Unknown Device

How do you want to search for driver software?

< Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

% Browse my computer for driver software
Locate and install driver software manually.

Cancel

@ [l Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

[C:\Users\Public\Documents| v Browse:,

[¥] Include subfolders

= Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

Cancel
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When the Device Manager screen is
displayed, select "Unknown device"
and then right-click to display options.

Select "Update Driver Software" and
then left-click.

When the screen on the left is
displayed, select and click "Browse my
computer for driver software".

——— When the screen on the left is

displayed, click [Browse].



Browse For Folder

Select the folder that contains drivers for your hardware.

*

"]

[ .

[ .

. Driver

4| | MICREXSX

4 || FREMIC Loader4

C15
C25

; Cstmloegic
. DATA

Folder: MICREXSX

@ Il Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

IC:\Fujielectric\FRENIC Loaderd\Driver\MICREXSK}

v ‘ | Browse...

[¥] Include subfolders

< Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

Next Cancel
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Select "... ¥Driver¥MICREXSX" inside
the FRENIC Loader destination folder
and then click [OK].

The default folder is
C:¥Fujielectric¥FRENIC
Loader4¥Driver¥MICREXSX when the
installation drive is C.

(Note: The drive that has the largest
hard disk space is selected.)

When the screen on the left is
displayed, click [Next].
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I Update Driver Software - Unknown Device

Installing driver software...

I Update Driver Software - FRENIC

Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

FRENIC

1-41

The installation will begin.

When the installation of the FRENIC
Loader 4 is finished, the screen shown
to the left is displayed.

To end the installation work and to
return to the Windows, click [Close].



Windows 7

Connect the PC with the connection target device (TP-E1U or the inverter with built-in USB)
using the USB cable.

When the OS recognizes the USB device of this Loader, the following display appears.

= Device driver software was not successfully installed * *
Click here for details.

1050 AM |
10/12/2010 |
The wizard used to install the USB driver does not start automatically. Therefore, install the USB
driver according to the following procedure.

i 7l ([

“__" Getting Started »
! Connect to 3 Projector

Calculator

: Select [START] -> [Computer] and then
SEERANE right-click to display options.

Documents

Sticky Notes

Pictures
% Snipping Tool

Music ‘ Select "Properties” and then left-click.
,.J Paint s |

i, XPS Viewer
g,j/ Windouws Fax and Scan
% Remote Desktop Connection

y Show on Desktop
Q" Magnifier .

Rename
> AllPrograms

[ Search programs and fites £

[E=N o =5
(j()v\;ﬂp ¥ Control Panel » System and Security » Systern [ 42 ][ Search Control Panet £
e T - When the Control Panel home screen
View basic information about your computer . . .
I H is displayed, select [Device Manager]
) Remote settings Windows 7 Professional

and then left-click.

& System protection Copyright © 2003 Microsoft Corporation. All rights reserved.

Service Packl
Get more features with a new edition of Windows 7
See also

@) Advanced system settings

Action Center

Windows Update
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=y Device Manager
File Action View Help

&= || E HE % E %S
= USERMAME-PC

:s -E Batteries

> M Computer

> —w Disk drives

B Display adapters
- DVD/CD-ROM drives
=4 Floppy disk drives

=3 Floppy drive controllers

J:t‘-a Human Interface Devices
g IDE ATA/ATAPI controllers
<& Keyboards

}3 Mice and other pointing devices

B Monitors

- ¥ Network adapters
|5 Otherd

7 Unknown device

; T3 Ports (COM & LPT) Update Driver Software...

2 Processors Disable
-% Sound, video and ga

A Uninstall
» 44 Storage controllers

{8 System devices Scan for hardware changes
- a Universal Serial Bus

Properties -
Launches the Update Driver SoftWare Wizara Tor tHE SElECted Oevice.

U Update Driver Software - Unknown Device

How do you want to search for driver software?

2 Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation

settings,
.

2 Browse my computer for driver software
Locate and install driver software manually.

Cancel

==

@ [l Update Driver Software - Unknown Device

Browse for driver software on your computer

Search for driver software in this location:

:\Users\USER NAME\Documents] - Browse...

[#]Include subfolders

< Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.
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When the Device Manager screen is
displayed, select "Unknown device"
and then right-click to display options.

Select "Update Driver Software...” and

then left-click.

When the screen on the left is
displayed, select and click "Browse my
computer for driver software".

When the screen on the left is
displayed, click [Browse].



Browse For Folder @

Select the folder that contains drivers for your hardware.

Select "... ¥Driver¥MICREXSX" inside
the FRENIC Loader destination folder

> ARL o and then click [OK].
» g C1S
> 5 The default folder is
» u Cstmlog|c m C:¥Fuijielectric¥FRENIC
. DATA Loader4¥Driver¥MICREXSX when the
4 | Driver installation drive is C.
<[ MICREKISE - (Note: The drive that has the largest

Fold MICREXSX hard disk space is selected.)
Faolder: L

[ OK l [ Cancel

@ [ Update Driver Software - Unknown Device
Browse for driver software on your computer
Search for driver software in this location:
[C:\Fujielectric\FRENIC Loaderd\Driver\MICREXSX - Browse...
[#] Include subfolders
2 Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device. Cl
ick [Next].
Chei)

Il Update Driver Software - FRENIC .
A When the screen on the left is

Windows has successfully updated your driver software diSpIayed, the installation process is
now complete.

Windows has finished installing the driver software for this device:

FRENIC

Click [Close].

[
Close
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1.4.1.5. Checking the USB Driver

Check whether the USB driver is properly installed or not using the Device Manager of
Windows.

Windows 10

Select as follows to open the Device Manager: [Start] -> [Control Panel] -> [Device Manager]

Windows 8.1

Right-click the icon on the [Computer], select [Properties] and then select [Device
Manager].

Windows 7

Select as follows to open the Device Manager: [Start] -> [Control Panel] -> [Hardware and
Sound] -> [Device Manager]

Confirm that [FRENIC] is displayed under [Loader USB device] on the Device Manager.

o: Installation succeeded. x: Installation failed.
£ Device Menager (o] O] 1 Device Manager [o ] O]
File Action View Help File Action View Help
&5 @ EIBE QF&8S &5 @ EIHBF 8 S
a 75 USERNAME-PC 4 = USERMAME-PC
+.4g9 Batteries ..4g9 Batteries
» 1M Computer » 1M Computer
= Disk drives o Disk drives
p B Display adapters > B Dizplay adapters
> 43 DVD/CD-ROM drives > o DVD/CD-ROM drives

23 Floppy disk drives =3 Floppy disk drives
=3 Floppy drive contrallers
L IDE ATAJATAPI contrellers » g IDE ATASATAPI controllers
..y Keyboards

=4 Floppy drive controllers

>

> }E!, Mice and cther pointing devices
b P I (OF

}3 Mice and other pointing devices ’ |5 Other devices

Hifm Unknown device
7 Pors COM& TP

-mF MNetwork adapters

» | Other devices > i

b ‘? Ports (COM & LPT) b D Processors

b D Processors b A Storage controllers

b Az Storage controllers b M System devices

b M| Systemn devices b - § Universal Serial Bus controllers

» - i Universal Serial Bus controllers
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1.4.1.6.

Installation of the Message Manager

Normally, when the FRENIC Loader 4 is installed, the Message Manager is installed at the same
time. Therefore, there is no need to separately install the Message Manager.

However, the Message Manager may accidentally be uninstalled when the FRENIC Loader 3.3
is uninstalled after the FRENIC Loader 4 is installed. The Message Manager may need to be
uninstalled as a step to recover a communication failure. In such a case, the Message Manager

can be separately installed.

00 setup

Msghgr USB Setup Date modified: 2/27/2017 5:44 AM
Size: 512 MB

Application

(o [0
@Uv‘ &4 » Downloads - |&, | | 1loads o
Organize » Open Burn  » iw v [ @
4y te]
~ %3
dotMET FREMIC wi_redist.xd
Setup Loaderd_10 USB Setup [

Tip °

be used to install the Message Manager.
When using the FRENIC Loader 4 installer, after you install the Message Manager
according to the procedure in "1.4.1.3. FRENIC Loader Installation Procedure"
click [Cancel] on the step "[3] Installation of the FRENIC Loader".

To install only the Message
Manager, double-click [MsgMgr
USB Setup.exe].

The installation wizard will be
started automatically.

Install the Message Manager
according to the instructions on the
wizard.

After you uninstall the Message Manager, the FRENIC Loader 4 installer can also

o If the FRENIC Loader 4 installer does not recognize the Message Manager as one
of the installation targets even if the Message Manager has been uninstalled, use
[MsgMgr USB Setup.exe] to install the Message Manager.
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1.4.2. Uninstallation Methods

1.4.2.1. FRENIC Loader Uninstallation Procedure

Windows 10
On the Windows, selecticon T = [BE START] = [Fuijielectric] > [FRENIC-Loader4
Uninstall].

Windows 8.1
Left-click [All apps] icon and then select [Fujielectric] > [FRENIC-Loader4 Uninstall].

Windows 7
On the Windows, select [Start] > [All Programs] - [Fujielectric] > [FRENIC-Loader4] ->
[Uninstall FRENIC-Loader4].

'@ Default Programs
@ Desktop Gadget Gallery
"E Internet Explorer (64-bit)
& Internet Explorer
‘; Windows Anytime Upgrade
& Windows DVD Maker
G2 Windows Fax and Scan
 Windows Media Center
@ Windows Media Player
£ Windows Update
- KPS Viewer
| Accessories
. Fujielectric
. FREMIC-Loader 4
B FRENIC-Loaderd Start
\jﬁ FREMIC-Loaderd Unlnstall
. Games

, Maintenance

. Message Manager
| Startup

,1

Back

| |Search programs and files je |

Windows Installer X

The uninstallation confirmation screen
will be displayed as shown here.

Are you sure you want to uninstall this product?
Upon confirmation, click [Yes].

[ fes ] [ No
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FRENIC Loaderd The uninstallation progress screen is

displayed.
| Please wait while Windows configures FRENIC Loaderd

Click [Cancel] to stop uninstallation.

Gathering required information...

-— | Cancel

%) User Account Control @

—

U Do you want to allow the following program from an
/" unknown publisher to make changes to this computer?

Program name:  C\Windows\Installer\9607fd.msi
Publisher Unknown When the screen on the left is
File arigin: Hard drive on this computer i .

displayed, click [Yes].

(v) Show details

Change when these notifications appear

FREMIC Loaderd Uninstallation will continue.

| Please wait while Windows configures FRENIC Loaderd

Time remaining: 31 seconds

— |

Uninstallation is executed according to the above procedure.
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1.4.2.2. Uninstallation of the Message Manager
Uninstall the Message Manager according to the following procedure.

START

Tasks required prior to uninstallation

Close all the Loaders.

\2

@ Close the Message Manager.

start menu?

3& [No] ]

Is [FRENIC Loader3 EN Message

Manager Start] listed in the start menu?

[ Is [Message Manager] listed in the ]

[Yes]

[No]

[Yes] END

Click [FRENIC Loader3 EN FRENIC
Loader3.3 EN Uninstall] on the start

Click [Uninstall Message Manager].

menu.

4 )

Execute uninstallation according to the
instructions on the wizard.

v

Restart the Windows.

®
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®

Tasks required after uninstallation

Did you close the Message Manager in

the above step (a)?

[Yes]

[No]

Does the installation folder for the

Message Manager exist?

[No]

[Yes]

Delete the installation folder for the
Message Manager.

®

END
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[1] Before uninstalling the Message Manager

Close the Loaders.

Make sure that the loaders are not running before uninstalling (deleting) the Message Manager.
If any one of the loaders is running, close the loader before starting uninstallation.

Close the Message Manager.

Be sure to close the Message Manager before uninstalling (deleting) the Message Manager.
The Message Manager is automatically started when the FRENIC Loader 4 or other loader is
started. However, it does not close automatically.

The following section describes how to close the Message Manager.

Procedure for Closing the Message Manager

Show hidden icons

@ T T
AEE I o 2015/08/18

Left-click here, and hidden icons are displayed as shown below.

Right-click the Message Manager icon and select [Exit MessageManager] on the context
menu, and a dialog box appears. Click [Yes], and the Message Manager is closed.

MessageManager 3

; l\ Exit MessageManager 7

I Exit MessageManager ]@

038pPM | | u Ne

[Be i)
= 10/1/2017 | |

CARS F . _ |
Kabn = & 1 |.j_'{ |_,lJ"L ':J;I li.;. 15:57

The icon may be displayed here.

Tip ¢ If the Message Manager cannot be closed using the above procedure, shut down
Windows or log out.

@ ¢ |f an attempt is made to uninstall without closing the Message Manager, some of
the files will not be deleted. Under such situation, if an attempt is made to install
the Message Manager again, the installation will turn out to be incomplete and a
communication failure may occur in the communication between the Loader and
connected devices. Be sure to start uninstallation after the Message Manager is
closed.
If uninstallation is performed while the Message Manager is running, execute "[3]
After Uninstalling the Message Manager" after uninstallation.
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[2] Uninstallation of the Message Manager
This section describes how to uninstall the Message Manager from the start menu by selecting
[Message Manager] -> [Uninstall Message Manager].

If [Message Manager] is not listed in the start menu, or if [Uninstall Message Manager] does not
exist under [Message Manager] and if [Message Manager Start] exists under [FRENIC Loader
3.3 EN], the Message Manager can be uninstalled by uninstalling the FRENIC Loader 3.3 EN.
For information on uninstalling the FRENIC Loader 3.3 EN, refer to the user's manual for the
FRENIC Loader 3.3 EN.

Windows 10
On the Windows, select [Start] -> [All apps] -> [Message Manager] -> [Uninstall Message
Manager].

Windows 8.1
Left-click [All apps] icon and then select [Message Manager] -> [Uninstall Message
Manager].

Windows 7
On the Windows, select [Start] -> [All Programs] -> [Message Manager] -> [Uninstall
Message Manager].

On the Windows, select [Start] -> [All Programs] -> [Message Manager] -> [Uninstall Message
Manager].

8  Microsoft Edge

""m' Microsoft Solitaire Collection

€ Microsoft Wi-Fi

Message Manager - InstallShield Wizard E3 When [Uninsta” Message
Manager] is selected, the
uninstallation confirmation screen
will be displayed as shown here.

Do you want to completely remove the selected application and all of its features?

Upon confirmation, click [Yes].
Uninstallation is executed according to the above procedure.
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Message Manager - InstallShield Wizard

Uninstall Complete

InstallShield Wizard has finished uninstalling Meszage
Manager. To complete the uninstallation, you must restart pour
camputer.

e, | want to restart my computer now.

() Mo, | will restart my computer later.

Remove any disks from their drives, and then click Finish to
complete setup,

< Back Finizh Cancel
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If the system is considered to be in
a good state for restarting after
uninstallation, click [Finish].

Restarting is particularly important
if uninstallation is performed
without closing the Message
Manager. Be sure to restart the
system.



[3] After Uninstalling the Message Manager
The following actions are required if uninstallation is performed without closing the Message
Manager.

Restarting the PC

Be sure to restart the PC at the end of "[2] Uninstallation of the Message Manager" on the
previous page.

Checking the Installation Folder for the Message Manager

When the PC is started, using the Windows Explorer, access the installation folder for the
Message Manager and confirm that the installation folder is deleted.

Tip e The installation folder for the Message Manager is a folder specified under
"1.4.1.3 [2] Installation of the Message Manager" if the Message Manager has
been installed using the FRENIC Loader 4.

The default folder is as follows.

- 32-bit OS
C:¥Program Files¥Common Files¥Fuji Electric Shared¥Message Manager
- 64-bit OS
C:¥Program Files (x86)¥Common Files¥Fuji Electric Shared¥Message
Manager

Here,"C:" is a drive letter for the disk or partition where the Windows is installed. If
the Windows is installed in a different drive, substitute a drive letter for that drive.

Deleting the Installation Folder for the Message Manager

If the installation folder for the Message Manager exists, delete the installation folder.

Fuji Electric Shared

Message Manager
Message Manager

Open
Open in new window
Share with 3

Restore previous versions

Include in library 3
Send to 3

Cut
Copy

Create shortcut
% Delete
% Rename

Properties
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[4] Supplement: Presence of Files during Uninstallation
The following table shows the presence of files contained in the Message Manager installation
folder during uninstallation.

Uninstallation

Presence of files inside the installation folder

When the Message
Manager is stopped

When the Message Manager is executed

Before Starting | GommD0ini (%) Flnet_sdll M Meghing exe || Readme txt All the ﬁles
uninstallation [ COMMOBIINI | |Flretsini | |MSGMNGINI  |&|SvUsbdll required are

(& comy 2441 (| I Usbdll %] MeeMne 00141l (% =xbus s dll presen’[.

2| dinetdll %] isapledil %] Msghng08 141l |2 Usbdll

%) duplex i %) LeMetdll | pelink dll

(% ether dIl || loader_if.ini (%] pelink_pcidll

(%) Flnet_bdll %] loaderIF dII | plink dll

| Flnet bini (%] memdll (| plink_peidil
When The installation folder Some files are

. . . . | loaderIF dll
uninstallation is | does not exist. l? Meaht present.
completed | Misebine =xe
% Meghne 0214l
After restarting the | The installation folder | The installation folder | M;jMzeMneexe
PC does not exist. does not exist.
Some files may
be present.

When the The installation folder
installation folder is does not exist.
manually deleted

¢ Do not install the Message Manager when some files are present in the folder.

Otherwise, the installation will turn out to be incomplete and a communication
failure may occur in the communication between the Loader and connected
devices.
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1.5. Settings Required Before Using the FRENIC-Loader 4

1.5.1. Setting Function Codes Related to Communication on the
Inverter Side

The following section describes the function codes on the inverter side that are related to the
communication with the Loader. Be sure to perform this setting before connecting the Loader
with the inverter.

Table 1-4 Inverter Function Codes Related to Communication with the Loader

Function )
code Name Setting range
y01, yi1 Station address 1to 255
0: 2400 bps 1: 4800 bps
y04, y14 Baud rate 2: 9600 bps 3: 19200 bps
4: 38400 bps
0: Modbus RTU protocol
y10, y20 Protocol selection 1: SX protocol (Loader protocol)
etc.

The setting range and setting contents might differ depending on the model of the using inverter.

Function codes that require settings depend on where the Loader is connected to. The function
code setting ranges and guidelines by connection point are shown below.

Table 1-5 Function Code Setting Ranges by Loader Connection Point

Loader connection point
RS-485 RS-485 usB USB connector on
communication port | communication port 2 . .
: : connector on the inverter with
1 on the inverter on the inverter oo
) . the TP-E1U built-in USB port
(via a converter) (via a converter)
y0o1 1to 255 - 1to 255 -
% y04 Oto4 - - -
c| yio 1 ] ] :
R
‘8‘ yll - 1to 255 - -
T | yl4 - 0to4 - -
y20 Other than 1 1 - -
- Not used.
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Setting Guidelines

Table 1-6 Setting Guidelines when the RS-485 Ch.1 and RS-485 Ch.2 are Connected

. . . Reference section for
Function code Setting Guidelines

Loader setting

Match with the [RS-485 station address] of the Loader.

1.5.5.2.
y01, y11 For multi-drop connection, avoid giving a duplicate

. Connection Settin
address for other inverters. 9

1551

y04, y14 Match with the [Baud rate] of the Loader. o )
Communication Settings

RS-485 Communication Port 1
y10, y20 Set "1" to y10 and a number other than 1 to y20.
' RS-485 Communication Port 2

Set "1" to y20.

@ e The Loader cannot be used simultaneously by multiple communication ports of the
inverter. If the SX protocol (Loader protocol) is used simultaneously by multiple
communication ports, the Loader communicates with the communication port that
has the highest priority.

The order of priority of the communication ports is as follows: the lowest priority is
given to the RS-485 communication port 1 and the higher priority is given to the
RS-485 communication port 2, and the next higher priority to the USB (via the
TP-E1U or USB connection for the inverter with built-in USB port).

For example, if 1 is set to both y10 and y20, the Loader cannot communicate with
the RS-485 communication port 1. So, be careful with the setting.

Table 1-7 Setting Guidelines when the USB Connector on the TP-E1U is Connected

Reference section for

Function code Setting Guidelines )
Loader setting
) ) 1.5.4.2 Connection
yo1l Match with the [RS-485 station address] of the Loader. .
Settings
yl1 Not used. .

y04, y14 Not used. .

y10, y20 Not used. )

When connecting to the USB connector on the inverter with built-in USB port, there is no need to
set the function codes.
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1.5.2. Checking Communication Ports on the PC (when Using a
Converter)

The communication port (COM) is used for the interface between the Loader software on the PC
and the inverter.

Because of this, the converter to be used requires a function that operates as a virtual

communication port (COM) and it is necessary to check the communication port (COM) number of
the connected PC.

(For details about the converter to be connected, refer to "1.2.2.2. Devices Required for RS-485
Connection".)

The following section describes the procedure to check the communication port number for each
operating system.

Windows 10
Right-click the icon H and select [Device Manager] to open it.
Windows 8.1

Right-click the icon E on the [Computer], select [Properties] and then select [Device
Manager].

Windows 7

Select as follows to open the Device Manager: [Start] -> [Control Panel] -> [Hardware and
Sound] -> [Device Manager]

=y Device Manager E\@
File Action View Help
e D E|HmEl 8| E %S

4= USERNAME-PC

[ E Batteries

.M Computer

Click the " mark for Ports (COM &

i Disk drives LPT) and check the number indicated

> B Display adapters

. DYD/CD-ROM drives in the square box in "USB Serial Port
.- Human Interface Devices (comoj)”.

g IDE ATASATAPI controllers

2 Keyboards

T - . In the example shown to the left, the
.-l Mice and ofher pointing devices ) i

. M Monitors number is assigned as"COM13".

'-:." Metwork adapters
:] PCMUCIA adapters
i Portable Devices
"‘? Ports (COM & LPT)

15" USB Serial Port (COM13)
D Process
b & Sound, video and game controllers
'---Q‘- Storage controllers

> System devices

b - § Universal Serial Bus controllers
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1.5.3. Starting the Loader
Windows 10

On the Windows, select the icon [H > [B START] - [Fujielectric] > [FRENIC-Loader4
Start].

Windows 8.1
Left-click [All apps] icon and then select [Fujielectric] > [FRENIC-Loader4 Start].
Windows 7

On the Windows, select [Start] = [All Programs] = [Fujielectric] > [FRENIC-Loader4 Start].

'@ Default Programs
i Desktop Gadget Gallery
"_E Internet Explorer (G4-bit)
& Internet Explorer
‘; Windows Anytime Upgrade
& Windows DVD Maker
B Windows Fax and Scan
 Windows Media Center
@ Windows Media Player
£ Windows Update
<& ¥P5 Viewer

, Accessories

. Fujielectric

i EMEder4
B FRENIC-Loaderd Start >
FREMIC-Loaderd Unlnstall

, Games

. Maintenance
. Message Manager
| Startup

1  Back

| |Search programs and files L |
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Setting the Operating Environment
This feature is supported by version 1.0.1.0 or later.

When the Loader is started for the first time after installation, the language selection screen and
region selection screen are displayed.

These screen are displayed only once at the start of using your system.

i | | On the [Select language] window, select a language
Select language to be used for subsequent displays.

Pleaze =elect vour languaee.

| Enelish -|

@ e The language can be changed from the main menu by selecting [Setup] ->
[Language].
For details, refer to "2.4.3. Language".

i : Next, select the "regional spec." for the inverter to be
Select Region spec. used

Pleaze zelect vour region spec.

| JJBPAN -

@ e The "regional spec.” of the inverter can be found in the nameplate on the inverter. For
details, refer to "2.2.1. [1] Model, Regional Specification, Voltage, Capacity" or the
instruction manuals of relevant inverters.

@ e The "regional spec.” can be changed from the main menu by selecting [Setup] ->
[Regional spec.]. For details, refer t0"2.4.4. Region Spec.".
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1.5.4. Overview of the Message Manager

The Message Manager is software that is used to control the Loader communication.

Unless the Message Manager is started, the Loader cannot communicate with devices
connected.

1.5.4.1. Checking the Startup of the Message Manager

When the Loader is started, the Message Manager is automatically started.

Confirm that the Message Manager icon M, is displayed on the task bar.
The display examples of the Message Manager icon are as shown below.

Display Examples of the Message Manager Icon

Show hidden icons

[ 5 ' (]
e s

10:11
2015/08/18

Customize...

1 = y
0% 10/2/2017 ||

The icon may be displayed here.

Tip o If the Message Manager icon M, is not displayed even after the Loader is started,
reinstall the Message Manager.

For information on the installation procedure, refer to "1.4.1.6. Installation of the
Message Manager".
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1.5.4.2. Procedure for Closing the Message Manager

The Message Manager does not automatically close even when the Loader is closed.
Normally, there is no need to close the Message Manager. However, the Message Manager
must be closed when it needs to be uninstalled, when the USB driver needs to be installed, or
when the Message Manager needs to be restarted as a step to recover a communication
failure.

For information on procedures for closing the Message Manager, refer to "1.4.1.4. [1] Before
Installing the USB Driver]" or "1.4.2.2. [1] Before uninstalling the Message Manager".

@ o If an attempt is made to close the Message Manager while the Loader is running, a

communication failure will occur in the Loader. When closing the Message
Manager, be sure to close the Loader first.
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1.5.5. Communication Setting and Connection Setting for the
Loader

When the Loader is started, the following screen (Quick Access menu) is displayed.

By clicking an icon on the screen, you can start the corresponding function. The details of these
functions are described in the later section.

This section starts with an explanation on the communication setting function.

“ FRENIC Loader - Quick Access Menu =] |

File  Meru Setup  Wiew ifindow  Help
FHERo|/O0&L(PEXxeF»EESE(IEEEEREREEGEEER|EE
# Quick Access Menu =10 x|

FRENIC Loader is a utility tool that allows you to set up, run, control, and monitor the FREMIC series of
inverters via a PG. Glick the icon corresponding to the function you want to perform Doing so allows you:

[Function code]

To set up. edit, compare, transfer,
ar initialize function codes.

Real-time trace

Ta eraphically view the running
status of the inverter in real-time

[Operation monitor]

To open 1O monitar, system
monitar, alarm monitor, and
operation status monitar.

Historical trace!

The historical tracing screen is
indicated.

[Customizable logic]

The customizable logic is
indicated

est runl -

Ta contral/run the inverter
through Inader

[Schedule aperatian] :

The schedule operation iz
indicated

Test Run

Exit

To configure communications Ta save changed files and exit the
environment between the inwerter utilty.
and the PG

[Communication settine] :

Close

[Na-Unknawn

\
{ Communication settings J

@ o If the Quick Access menu is not displayed, click the - icon on the toolbar (the bar
with various icons below the main menu as shown below) to display the Quick Access

menu.

SHERo @ee&-q TH X EF>»E L E

Quick Access Menu ]
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1.5.5.1. Communication Settings

Click the [Comm Setting] icon on the left column of the Quick Access menu to display the
[Communication setting] window.

[Communication setting] :

To configure communications
environment between the inverter
and the PC.

Camm Setting

The [Communication setting] window can also be displayed, without using the Quick Access
menu, by selecting [Setup] -> [Communication Settings] on the main menu or by clicking the &
icon on the toolbar.

:r File  Menu | Setup | Wiew Window  Help

. DE .’E‘pr*| @”ica“u” SEW |[ [ Communication settings ]
PSSR0 7022 (2@ %p@g&&@

Referring to the following explanation, set the [Communication setting] window.

Communication setting x|

—Connection Methods

¥ Connect Loader Directly to Iwverter
) Communicate via MIDRE#-5%  5# bus address |1 vl

—Port
¥ RS-485

GOM port Im
Baud rate Im
Data leneth Im
Parity m
Stop bit [ee =

" USE IData in Inverter (via Keypad) ;I

) Communication board

Tvpe I Ethernet e I

Parameter |

Part number I

— = Click the [Connection setting] button
Communication Gonditions ———— . . .
_ . . to display the [Connection setting]
Betry count |2 times vl Connection setting .
window.
Timeout II.E [=] "I | ok I . . .
For information on the [Connection

I Gonnected Check Gancel | setting] window, refer to "1.5.5.2.
Connection Setting".
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[1] Connection Methods
Select a means to connect the Loader.

- Connect Loader Directly to Inverter
Select this for connecting the PC to the inverter.

- Communicate via MICREX-SX
Not available.

[2] Port
Set the following items related to communication.

RS-485 Connection

Select this for connecting the PC directly to the inverter via RS-485.

For information on connection examples, refer to "1.2.2.1. [1] Multi-drop Connection Using the
RJ-45 Connectors” or "1.2.2.1. [2] Multi-drop Connection Using Terminal Blocks".

- COM port
Select the communication port of the PC connected to the USB/RS-485 converter or

RS-232C/RS-485 converter.

@ e Check the communication port of the PC using the Device Manager of the OS.
Refer to "1.5.2. Checking Communication Ports on the PC (when Using a
Converter)".

- Baud rate
Set the baud rate. It must be set to the same value as the baud rate set for the inverter.

@ ¢ For information on the baud rate of the inverter, refer to "1.5.1. Setting Function
Codes Related to Communication on the Inverter Side".

- Data length
Cannot be set. It is internally fixed to "8 bits".

- Parity
Cannot be set. It is internally fixed to "Even".

- Stop bit
Cannot be set. It is internally fixed to "1 bit".

@ e For information on recommended conditions of the RS-232C/RS-485 converter or
USB/RS-485 converter, refer to "1.2.2.2. [1] Converter".

1-65



USB Connection

- Data in Inverter (printed circuit board )
Select this for connecting the PC with the inverter with built-in USB port.
For information on connection examples, refer to "1.2.3.1. [3] Connection with the Inverter
with Built-in USB Port".

When connecting the PC to the inverter using the USB connector of the TP-E1U, select
[Data in Inverter (via TP)].

- Data in Inverter (via TP)
Select this when connecting the PC to the inverter using the USB connector of the TP-E1U.
For information on connection examples, refer to "1.2.3.1. [1] Connection with the Inverter
Equipped with TP-E1U as Standard"or "1.2.3.1. [2] Connection with the Inverter via the
TP-E1U"

- Date in Keypad
Select this to access the TP-E1U memory.
Select this when using the TP-E1U as a temporary memory medium.
For information on connection examples, refer to "1.3.1.2. Connection between the PC and
the TP-E1U".

Communication board

Not available.

[3] Communication Conditions
Set the following items related to communication retries.

- Retry count
Set the number of retries for when a communication failure occurs. If you set to a high
number of retries, the possibility of recovering communication becomes high. However, the
time until the error dialog is displayed becomes long as well.
1 time or more is recommended.

- Timeout
If a response is not returned from the inverter within the time set here, the communication
error dialog will be displayed. The shorter the timeout time is set, the more quickly the error
display appears. However, if it is too short, a communication error may occur even when
communication is normal because of the time taken up by the inverter for its processing.

[4] Connected Check

The function named "Connected Check" is used to constantly monitor the state of
communication with the inverter registered under the connection setting. If you put the |v| mark in
the checkbox, the connection with the inverter is automatically checked and the state of
communication is displayed on the status bar. If a communication failure occurs due to a
disconnection or other faults in one of the inverters registered under the connection setting, the
response becomes extremely slow. Remove the faulty inverter from the list for the connection
setting.
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1.5.5.2. Connection Setting

Click the [Comm Setting] icon on the left column of the Quick Access menu to display the
[Communication setting] window. On this window, click the [Connection setting] button to display
the [Connection setting] window.

The [Connection setting] window displays information corresponding to the equipment name
(inverter) on each row as shown below. Double-click the row for the equipment to be changed or
added, and the [Advanced...] window shown on the next page is displayed.

Selection of inverters for communication

Put the mark in the checkbox to the left of the "No." column to assign the corresponding inverter
to be the communication target.
— Communication status

Displays the state of communication between the
Loader and the inverters.

Unknown: The communication status has not
been confirmed. — Model

Connected: Communication has been established.

Displays the model read from the

Disconnected: Communication has not been inverter.
established.

If communication has not been
established at all, [Unknown

Model] is displayed.
GConnection setting x| ] Pay
Advance... | Delete | J\
——— .
| Ma. Status ) | (Model ) Equipment fddress @ Equipment name, RS-485
v 1 Urknowr Urknown Mode! IV 1 station address
Il 2| |Unknown | |Unknown Model INW2 2 )
Displays what has been set on
r 3 .
the [Advanced...] window.
O ¢
- 5
! " Number of display rows
- 7
- 7 The number of rows depends on
- 7 the port selected on the
el [Communication setting] window.
| n If [RS-485] is selected, a multiple
C o hd number of rows are displayed.
Er@ OK Gancel | If [USB] is selected, only one row
is displayed.
—— Connection check
Click the [Browse] button to check whether the connection is established between the Loader and the
inverter specified by the [¥| mark in the checkbox to the left of the "No." column.
The check result is displayed in the "Status" column.

Setting

Select the row to be edited and then click the [Advance...] button to display the [Advanced...]
window shown below.

It is also possible to double-click the row to be edited to display the [Advanced...] window.
Settings on the [Advanced...] window are provided on the next page.

Delete

Used to delete the inverter registered on the selected row.
Used when removing inverters are disconnected from the Loader.
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The [Advanced...] window is used to set [Equipment hame] and [RS-485 station address].

Equipment name
Advanced... E3

Enter the name of equipment where connected inverters

. Thwerter Ma. Mo .1
are installed.
Not used for communication. Equipment name I
As shown in the display example below, the equipment RS-485 station address 1

name is used in the list menu for selecting target
inverters on each screen.

Display example of target inverters

Cancel

[Ma. 1011 NV =l

RS-485 station address

Equipment name
RS-485 station address

According to the port setting on the [Communication setting] window, follow the setting guidelines shown below to set

the address.

Port setting on the [Communication setting] window Setting Guidelines

Used for communication.

RS-485 Connection Match with the inverter's station address (function code
y01 or y11).
Data in Inverter (Direct) Not used for communication. No setting is required.
Used for communication.
UsB Data in Inverter (via TP) i i i i
Connection Match with the inverter's station address (function code
y01).
Data in Keypad Used for communication. Set to"1".
Tip For information on the station address of the inverter, refer to "1.5.1. Setting

Note

H

Function Codes Related to Communication on the Inverter Side".

If a communication failure occurs due to a disconnection or other faults in one of
the inverters registered under the [Connection setting] window, the response
becomes extremely slow. Remove the faulty inverter from the list for the
connection setting.

When using the trace function on the version 1.0.0.0, be sure to register the target
inverter for tracing in the No.1 row. Tracing is allowed only for the inverter
registered in the No. 1 row on the [Connection setting] window.

When using the operation monitor function, be sure to register the target inverter
for monitoring in the No.1 row. When you want to monitor multiple devices
connected in multi-drop connection, specify the monitored inverters serially in rows
No.1, No.2, No.3, and so on.

Example: When monitoring two inverters using the operation monitor function

Good example

No. | Communication Model
status
1 Connected G1S
2 Connected E2S
[]1]3
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Bad example
No. | Communication Model No. | Communication | Model
status status
1 Connected G1S [1]1
[]1]2 Unknown status | E1S M |2 Connected G1S
3 Connected E2S M |3 Connected E2S

When setting the date and time from the Loader for the inverter with a built-in
realtime clock (RTC), register the target inverter in the No.1 row and set the Loader
and inverter in the 1:1 connection. The date and time can be set by selecting
[Setup] -> [Date and time] on the main menu. Refer to "2.4.5. Date Time" for

details.
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Chapter 2

Function Description

This chapter describes the main functions of the loader.






Chapter 2 Functional Description

2.1. Main Window

This is the window that first appears when the loader is started. The Quick Access menu is
displayed on this screen when the loader starts. (The display has been omitted here.)

Main menu Toolbar

You can select all the loader functions. You can select the primary loader functions.

S FRENIC Loader
Menu  Setup  Wiew Window Help

T elo|/0FL 2RIxeI>BPL S EDHELEHEAE DO

[NoTConrected 1>

L Status Bar

The text that describes the selected function appears in this
area. It also displays the status of connection with the inverter
in the lower right box.

Main menu
It contains six selectable functions: [File], [Menu], [Setup], [View], [Window], and [Help].

(When the [Function Code List] window is displayed, the [Edit] and [FunctionCodeEdit] options
are added to the main menu.)

Toolbar

This allows you to select common functions quickly and easily. For example, to open a file which
contains the function code data, you should normally click [File] on the main menu and then click
[Open] under the [File] menu; accordingly two actions are required. Using the toolbar, you can
open the file simply by clicking the ﬁ icon.

Status Bar

Hover the mouse pointer over a function icon or menu displayed. Then, the text appears that
describes the meaning of the function or menu.

Display example: The following text appears when you hover the mouse pointer over the
[Perform Connection Check] icon on the toolbar.

NeH Sk ol 7

nection check

_Enable/Dizable Connected c%.! Descriptive text appears.
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The lower right box is enabled when you configure the loader to "check the connection" using
the communication settings (see "1.5.5.1. Communication Settings") or the [Connection Check]
icon on the toolbar (see the display example above).

When configured to check the connection, the loader checks the status of the devices marked
with (¥ in the [Connection Setting] window (see "1.5.5.2. Connection Setting") in the ascending
order of their numbers at certain intervals and displays the result.

Display example

| Mo 1: Alarm detection | Mo 1:Connected

i

L

No (number): Identifies each device checked.
The [Number] corresponds to the [No.] column of the [Connection Setting]
window.

No (number): Alarm status No (number): Communication status

Alarm status: Shows the inverter's alarm status.

Displayed

Description
content P

Nothing is

displayed The inverter is operating normally.

Alarm detection

) An alarm condition has occurred with the inverter.
(flashing)

The alarm status is not displayed if the connection check is disabled or the
connected device is the keypad.

Communication Shows the status of the communications between the loader and the

status: connected device.
Displayed .
Pay Description
content
Connected The communications link has been established.
Not connected The loader cannot communicate with the device.

"Unknown" appears when the connection check is disabled.
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2.2.1.

2.2. File

The [File] menu provides the following submenus:

File | Menu Setup  Wiew  Window
] Mew.
5 Open.
Ciloze
lal Save
Save fs..
= Frint.
4, Frint Preview

Print zelected Symbal
Print Preview selected Swmbol

Fage Setup..
Recent File

Exit

— [Print selected Symbol]

[Print Preview selected Symbol]
These submenus are available when the
[Customizable logic] window is open.

This section describes the main functions available under the [File] menu.

Create a New File

This function creates a new file of function code data.

From the main menu, click [File] > [New...] to open the [Select function code data to edit]

window.

Select function code data to edit

Create the function code window

Create the customizable logic function code window

Click either button to open the [Default setting] window.

2-3

Standard function code window

Select this when you want to edit standard
function codes (such as F, E, C).

Customizable logic function code
window

Select this when you want to edit
customizable logic function codes (such
as U, Ul, UA, UB).



The [Default setting] window lets you configure the information on the inverter for which you
want to edit function codes.

Default setting x|

Model

Select the following parameters Select the model number.

Model Regional specification

Beeion spec. IJ:JHPAN 4 I_ Displays the region specified by selecting
[Setup] -> [Region spec.] from the main menu.

Yoltage |3phase 200 j L

: — Voltage

Capacity |IJ.1 el e
Select the inverter voltage.

Fead date EA2017 11:43:00

Definition file  frc_E_c 0_1300acaey Chanee | Capacity

OK I CGancel | Select the inverter capacity.

‘ L Change

Change the definition file according to the
inverter ROM version.

Refer to "[2] Guidelines on Selecting a
Definition File" on the next page.

Definition file

From the definition files installed, the loader
automatically selects the most recent definition file.

[1] Model, Regional Specification, Voltage, Capacity
Correctly set these values according to the inverter for which you are editing function codes.

You can identify these values from the inverter model number printed on the rating nameplate of
the inverter.

The following example shows the format of an inverter model number. For details, refer to the
instruction manual of your inverter.

Example: In the case of FRENIC-MEGA. This example is different from the actual product
model number.

FRN 5.5 G1S—2J

Regional specification (destination market)

J: Japan U: USA

A: Asia T: Taiwan

C: China K: Korea

E: Euro G: Global (*1)

Inverter input voltage system

2: Three-phase 200 V 6: Single-phase 100 V
4: Three-phase 400 V 7: Single-phase 200 V

Model identifier code

Inverter capacity (unit: kW)
or amperage (unit: A)

(*1) If the inverter model number has a regional specification of G (global), the regional
specification will be that selected with the destination setting (function code: H101).
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You can change the regional specification by selecting [Setup] -> [Region spec.] from the main
menu. Once you have changed the regional specification, you have to quit and restart the loader.
Refer to "2.4.4. Region Spec." for details.

@ o If your specified model, regional specification, voltage, or capacity is different from
that of the inverter, an error may occur when reading or writing function codes due
to unmatched function code attributes or other reason.

[2] Guidelines on Selecting a Definition File
A definition file contains the information required to identify each inverter model and its functions.

Select the appropriate definition file based on the definition file version, revision index, and
inverter ROM version.

Definition file version and revision index

The displayed four-digit number is the ROM version, and one letter following to the version is the
revision index.

e In case of the Simplified display

OO0O00 XXXXXX
—I_— Revision index
(Initially omitted and newer revisions are given a, b, c...)

ROM version

Display example:

Definition file  1300a ROM version: 1300, and Revision index: a.

e |n case of the File name display

Format of the definition file name (Example: FRENIC-MEGA)

fnc_E_ x_3 _HOLLO_XXXXXX.csv

—I—— Revision index (Initially omitted and newer
revisions are given a, b, c...)

ROM version

Code representing the inverter model

Language (omitted for Japanese, E for English)

Display example:

Definition file  fnc_E x_ 3 3900f EMcsv ROM version: 3900, and Revision index: f.
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ROM version of the inverter

You can identify the inverter ROM version from the inverter keypad. For more information, refer
to the instruction manual of your inverter.

Tip e When FRENIC Loader 4 is connected to an inverter, you can identify the inverter
ROM version from [Inverter ROM Version] on the [System Monitor] tab of the
[Operation Monitor] window, which you can access by selecting [Operation
Monitor] from the Quick Access menu.

o When FRENIC Loader 4 is connected to an inverter, you can automatically select
the optimum definition file by selecting [Read from the Inverter] (to read the
settings from the inverter) from the [Edit data selection] window, which you can
access by selecting [Menu] -> [Setting function code] -> [Edit data selection].

@ o If the selected definition file is not appropriate for the inverter ROM version, an
error such as failure to read or set the desired function code may occur due to the
difference in the number of function codes or other reason. If this is the case, you
will have to use a different method such as the inverter keypad to access the
desired function code.

Tip ¢ If the inverter ROM version is unknown when creating a new definition file, you
can change the definition file later. For more information, refer to "2.3.1.3. [3]
Changing a Definition File".

Changing a definition file may, however, cause an error due to the difference
between definition files. You are recommended to select a definition file that is as
appropriate as possible when creating a new one.

Guidelines for selecting definition files

Some guidelines on selecting a definition file are shown below.

e |f there is a definition file of the same version as the inverter ROM version:

Select the definition file that is of the same version as the inverter ROM version and has the
newest revision index.

If there is not a definition file of the same version as the inverter ROM version, select the
appropriate definition file as described below.

e |f the inverter ROM version is 5000 or later on using FRENIC-Ace (E2), FRENIC-VP (F2S),
FRENIC-eHVAC (F2E):

Select the definition file that is of the same version as the replaced version according to the
"3.2.7. Replacement of Inverter ROM Versions" and has the newest revision index.

e [f the inverter ROM version is later than the versions of all the definition files:

The inverter may have been upgraded after the release date of your loader. Access the
technical support page on Fuji Electric website "Fe Library" and check for the latest loader
version upgrade file. If one exists, download and use it.
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Chapter 2 Functional Description

If the loader or the definition file is up-to-date but the inverter ROM version is still later than the
versions of all the definition files, select the definition file that is of the version earlier than but
closest to the inverter ROM version and has the newest revision index.

Tip e For information on how to access the technical support page on Fuji Electric
website "Fe Library", refer to "1.1.3. Obtaining this Product".

e |f there are only definition files whose versions are different and later than the inverter ROM
version:

Select the definition file that is of the version earlier than but closest to the inverter ROM
version and has the newest revision index.

The following is an example of selecting a definition file for model G1S (FRENIC-MEGA).
If the inverter ROM version is 3500 and the definition files listed in the table below are available
for selection, you should select the definition file fnc_E_x_3 3000b.csv.

Definition file
Simplified , i Applicable inverter ROM version
display File name display

00000 fnc_E_x_3_00000.csv 0000 to 0499
0500d fnc_E_x_3_0500d.csv 0500 to 0999
1000 fnc_E_x_ 3 1000.csv 1000 to 1999
2000 fnc_E_x_3_2000.csv 2000 to 2999
3000a fnc_E_x_3_3000a.csv 3000 to 3599
3000b fnc_E x_3 3000b.csv 3000 to 3599
3600 fnc_E_x_3_3600.csv 3600 to 3699
3700 fnc_E_x_3_3700.csv 3700 to 3799
3800 fnc_E_x_3 3800.csv 3800 to 3899
3800a fnc_E_x_3_3800a.csv 3800 to 3899
3900 fnc_E_x_3_3900.csv 3900 to 3999
3900a fnc_E_x_3 3900a.csv 3900 to 3999
4000 fnc_E_x_3_4000.csv 4000 to

4000a fnc_E_x_3_4000a.csv 4000 to

Tip o If an error occurs in reading or writing function codes after you have selected a
definition file in accordance with the above guidelines on selecting a definition file,
contact our Technical Support Center.
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2.2.2. Open

Selecting [Open] displays a window that allows you to open and edit or view a saved, existing
file that contains function code, realtime trace, historical trace, customizable logic, or scheduled
operation information.

B open =
Q@v‘ <« Fujielectric » FRENIC Loader4 » DATA ~ [ 43 ][ Search DATA ol
Organize New folder =~ 0 @
£ Downloads  *  Home ’ Date modified Type Size Filter
£l Recent Places o
B || CstmLogicPril.cml CML File 1KB
L 1 Function1.FNL FNL File 6 KB Select the type of files displayed
“J'D'E"ES [ Function2.FaL FBL File 31 KB
= Mn:umants |] Historical trace.HT2 HT2 File 21 KB in the list. Change the filter to
“ . “:‘( [ Real-time trace.RT2 RT2 File 2KB ) ]
;V:::: i Timerscdiz.csv Microsoft Excel 1KB display the files saved from a

loader other than FRENIC Loader
4,

8 Computer
&, Local Disk (C:)

= Local Disk (D))

File name: Loader4 files (*.FNL; *.FBL; «

Cancel

Open

Opens the selected file.

File types
FRENIC FRENIC FRENIC-HVAC/ | FRENIC Visual
Loader 4 Loader 3.3 AQUA Loader Customizer
* FNC
. * FNL
Function code data * FNB * FN1 -
* FBL
(*1)
*RT1
) * RT2 *RTM *RT1
Realtime trace data (*2)
(*2) (*3) (*4)
(*4)
. . * HIM
Historical trace data *HT2 - -
(*3)
Customizable logic project * ML i * CMX * CMX
data
Schedule data * CSV - * CSV -

(*1) If you open a FNC or FNB file, user definitions and comments will not be restored.

Tip ¢ For more information on user definitions, refer to "2.3.1.1. [7] User Definition".

e For more information on comments, refer to "2.3.1.3. File Information".

(*2) To open an RT2 or RT1 file that contains the traces of the signals added using the trace
monitor function and correctly display the signal names, units, and data step sizes, you
have to provide the customizable logic project data with which the trace monitor
information was saved.

Tip e For more information on the trace monitor function, refer to "2.3.5.11.
Combination with the Customizable Logic Function”.
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Chapter 2 Functional Description

(*3) The trace functions of FRENIC Loader 4 have been partly changed from those of FRENIC
Loader 3.3. For example, the graph position adjustment function has been changed such
that the "scale" and "display range" can be set by specifying a value per DIV.

FRENIC Loader 4

FRENIC Loader 3.3

Scale Scale
Scale [50 =] /o EEAL
Display Timeframe per 1 DIV Timeframe per window
range 1min | DIV |1min vI

Therefore, if you open an RTM or HIM file, the "scale" and "range displayed per screen”
settings will not be restored. In this case, the [Waveform Detail Settings] and
[START/STOP] buttons on the [Realtime Trace] and [Historical Trace] windows will be
disabled.

(*4) If you open an RT1 file, the [START/STOP] button on the [Realtime Trace] window will be
disabled.
Tip o The file types shown on the previous page are the types of the files available in the

[Open] dialog. For more information on the file types used in FRENIC Loader 4,
refer to "3.2.3. Type of Files Used by the Loader 4".

You can also drag and drop a file on the loader screen to open it.

4 Downloads - Mame

File  Menu Setup  Wiew Window Help
DedE0e /XL (AKX F>LHESE|EBEEH Y

oy ] -3

;
;= Recent Places

- Libraries

S FRENIC Loader - Quick Access Menu

288 EEE

F Quick Access Menu

FREMIC Loader is a wtility tool that allows you to =et up, run, control, and monitor the FRENIC series of
inverters via a PC. Click the icon corresponding ta the function wou want to perform Daing so allows wour

[Function code] :

To zet up, edit, compare, transfer,
of initialize function codes.

[Operation monitar] : [Real-time trace] :
Ta eraphically view the runnine

To open L0 monitor, system
status of the inverter in real-time

maonitar, alarm monitor, and
operation status monitor.
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To open a file saved from a loader other than FRENIC Loader 4
To open a file saved from a loader other than FRENIC Loader 4, select the [Other Loader files]
filter on the [Open] dialog.

vl Loader4 files (*.FNL; *.FBL; =|
Loader4 files (*.FML; *.FBL; *.CSV; *.RT2; *.HT2; *.CML

The dialog displays files saved from a loader other than FRENIC Loader 4. Select your desired
file.
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Chapter 2 Functional Description

2.2.3. Close

Closes the currently active window.

2.2.4. Save

This function is available when [Function Code List], [Customizable Logic], [Realtime Trace], or
[Historical Trace] window is active. Selecting [Save] saves the data in the active window.

If the data has not been saved before, the [Save] function does the same operation as "2.2.5.
Save As".

2.25. Save As

This function opens the following dialog, which allows you to enter the name of the active file
and save it under the entered name.

BSaueAs @
—~—
*9 [ 1 <« Fujielectric » FRENIC Loader4 » DATA ~ | 3 || Search DATA P
Organize » Mew folder == - IZ@]
i MName Date medified Type Size
. Libraries . . . :
— | Functionl.FMNL 9/6/21 :26 PM  FMLFile 18 KB
j Documents i _ .
. || Function2.FNL 9/6/21 126 PM FMLFile 19 KB
.J”- Music
| Pictures L
E Videos

1M Computer
&, Local Disk (C3)
cw Local Disk (Dt} -~

File name: Function3.FML -
Save as type: | Function code setting data file (*.FNL) v‘
# Hide Folders Save ] I Cancel ‘

* The types of files you can save are as follows:

- Function code data: *FNL, *.FNB
- Realtime trace data: *RT2, *.CSV
- Historical trace data: *HT2, *.CSV
- Trace data (graph image): * JPG, *.BMP
- Customizable logic project file: * CML

@ e The length of the path and file name should be up to 200 single-byte characters (up
to 100 double-byte characters). Otherwise the file cannot be saved.
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2.2.6. Print

This function allows you to specify the printer, its properties, the print range, and the number of

copies to be printed.

O x

r~ Printer
Mame: II'U'Iicrosoﬂ *PS Document Writer j Properties
Status: Ready
Type: Microsoft XPS Document Writer
Where:  XP5Port:
Comi'ﬂEH'ﬂ' I~ Prigtt file
)
r— Print range Copies
i Number of copies: |1 3:
") Pages [rom:l _to:l
S0 S22l N3 ™| Caollate
) Selection llj ﬂj SLJ

oK Cancel
| |

2.2.7. Print Preview

T
L

Printer Name

Select an available printer

Properties

Specify the detailed settings
specific to the selected printer

Print Range

Currently fixed to the [All]
option

Number of copies
Specify how many copies to
print

OK

Click this button to start
printing

This function allows you to view the print preview of the data in the currently active [Function
Code List], [Trace], or [Customizable logic] window.

Example:  Print preview of the data in the [Function Code List] window
o

& L - | @ [ @ B0 @ | dose |

Fils Mems : Fumcti onl
! Uodel : FRIE S3IE-E
Fil & fnz Bz 5 5008 B ey

Functizn Cods Hame

Data Progection
Fraquanzy Gomand 1

Fated Voltags at Base Fragunzy 1
lezimm Output Vol tepe |
Azzalae ation Tims |

I Br 18

I Braking 1 (Eraking

Starting Fraguanzy 1

Zaarting Fraguanzy | (Hol ding tim)
Sanp Fraguanzy

Motor Samd (Garri e Fraguncy)
lctor Samd Tone!

dralop Dtpet [AL 1] (e

dral op Destpot [AH 1] ol

dralog Dutpet [A 1] (Fomcei

Teewinel [i2] Fumztion
Teeminel [i] Fumztion

2-12



Chapter 2 Functional Description

2.2.8. Page Setup

This function, which is available when the [Function Code List] or [Trace] window is active,
allows you to configure page settings.

Page Setup il

— Paper
Size: IM j
Source: I.Al.rtomati-:alh' Select j
r—Orientation Margins (inches)
% Portrait Left: ID.E- Right: ICI'.EI
" Landscape Top: ID.E- Bottom: ID.E

ok | Cancel |

2.2.9. Exit

This function allows you to exit from the loader.
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2.3. Menu

[Menu] provides the following submenus:

Menu | Setup  Edit  Wiew

Function code edit...

Test run b Drive operation

Operation monitar ... Terminal operation

Customizable logic

Schedule zetting

Trace 3 Feal-time trace..

Hiztorical trace..

Cuick Access Menu..

All the options except [Terminal operation] and [Quick Access Menu] are accessible from the
[Quick Access Menu] window as well.

This section describes the main functions available under [Menu].
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Chapter 2 Functional Description

2.3.1.

Function Code Settings

Select [Menu] > [Function code edit] from the main menu or click -* on the main window
toolbar and click [Function Code] to open the [Select function code to edit] window.

[Function code] :

To =zet up, edit, compare, fransfer,
ar initialize function codes.

The [Select function code data to edit] window allows you to select the source of the function
code data you want to view/edit.

Select function code data to edit |

Select editing data source

¥ Create the function code window @

" Create the customizable logic function code window e4———

._li

Read fram the file [

Create new function setting

Read from the inverter

Select inverter :

[N 10 11N =l

Cancel

[Select inverter]

([Select keypad])

From the list of the registered inverters in the
[Connection Setting] window, select the inverter you
want to read function code data from.

Refer to "1.5.5.2. Connection Setting".

Once you select [Data in Keypad] for [USB Connection]
on the [Communication Setting] window, this label
changes to [Select keypad].

2-15

Standard function code list

Select this when you want to edit standard
function codes (such as F, E, C).

Customizable logic function code list

Select this when you want to edit customizable
logic function codes (such as U, U1, UA, UB).

[Create new function setting]

Click this button to open the [Function Code List]
window when you want to create a function code from
scratch.

Refer to "2.2.1. Create a New File".

[Read from the file]

Click this button to open a function code data file
saved in your PC.
Refer to "2.2.2. Open".

[Read from the inverter]
([Read from the keypad])

Click this button to read function code data from
the selected inverter and open the [Function
Code List] window.

Once you select [Data in Keypad] for [USB
Connection] on the [Communication Setting]
window, this label changes to [Read from the
keypad].

In this case, click this button to read function
code data from the selected keypad and open
the [Function Code List] window.



2.3.1.1. Function Code Edit

The following is the description the [Function code edit] tab of the [Function Code List] window.

This tab allows you to edit function code data while viewing the function code settings and their
ranges.
You can sort function codes based on various criteria.

When the [Function Code List] window is displayed, the [Edit] and [FunctionCodeEdit] options
are added to the main menu.

Tree view

[Function]:
[Change from Factory-set Values]:

[Contents of change (blue)]:
[R/W failure (pink)]:

[User Definition]:
[Communication Code]:

[Comparison Result]:

[Search Result]:

Edit

Display the function codes by group.

Displays the function codes with settings different from the factory-set values
(excluding communication codes).

Displays the edited function codes before written to the inverter or keypad.
Displays the function codes that could not be written to or read from the inverter
or keypad.

The user can freely define the display items.

Displays communication function codes only.

Displays the results of the comparison with the inverter or keypad function code
settings or saved files only.

Displays the result of the [Edit] -> [Search] operation only.

Function Code Edit

This menu item is added once you open the
[Function Code List] window. [Edit] provides the
following menu options: [Undo], [Factory-set] (see
"2.5. Edit"), and [Search] (see "2.3.1.1 [8]

These menu items are added once you open the [Function Code
List] window.

You can save and load function code settings in the CSV format.
This feature is useful when you want to edit function code settings

Search"). in an external application such as Microsoft Excel and then load
them into the loader.
Refer to "2.7. Function Code Edit" for details.
— View — Change of Setting
Once you open the [Function Code List] window, the following menu options are added Values
to [V'eW]: . . X X You can select the function
[Function code info]: Same as the [Function code info] button displayed at the bottom.
) - code data from the drop
[Font size]: Allows you to change the font used for function code names, etc. -
down-menu or edit window.

Refer to "2.6.3. Parameter Information and Character size" for

details.
S FRENIC Loader - Funt:tionlv— [Funvctionﬂ =0l x|
3% File  Menu  Setup FunctionGodeEdit ) Window  Help - 5 X
DSl &b LPHIXeF>PELSEIDEEERIDEEIEDIEDREE
Function code edit | Auto-tuning | File infor mation |
= Function . . -
=1 CDdE gr?jup Change | Mo | Function code name Setting value | Setting range | Defpult setting M\':almgm | Mi’;‘mgm |j
oode
- E code 0: Dizable bol *
-G code
- P code FOT_|Frequency settine | 1: Enable data protection and disable digital reference protection
H code Fi2 |Operation method % Disable data protection and enable digital reference protection
- 3 Enable both data protection and digital reference protection
- 2] cgde F03 |Maximum output frequency 1 B0 L ]
- A code
b oode Fid |Base frequency 1 50.0/26.0 to 5000 .| 500/ 250 5000/
VJCD? F05 |Rated voltage at base frequenc 5‘
- code - i
-1 code FOE |Maximum output voltage 1 Fou: Data protection
-d code Fi7 |Acceleration time 1 Setting range - 0to3
v code cosleration lme 0: Disable both data protection and digital reference protection
¥ code F08 |Deceleration time 1 1: Enable data protection and dizable digital reference protection
o code 2: Dizable data protection and enable digital reference protection
. ol code FO9 | Torque boost 1 3: Enable both data protection and digital reference protection
- ChangelFactary settf F10 |Electronic thermal overload pro : : : ,
. Tionterts of chaneafB T LT T S R | ancnlnnn nas. | aneal antl annn |
N | »i .| 1 »
Pead.. | Wirite ... | Factory et Func. code set... Func. code info. .. | Ihitialization.. | Advanced... | Print... | Ciomparison.. |
Select Inverter Mo, 10 11 INV1 - Cloze
[ |Na T:Carnected
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Chapter 2 Functional Description

The following buttons are available at the bottom of the [Function code Edit] tab:

% Bead.. | Wikite... | Factary set | Func. code set... | Func. code info. | Thitialization... | Advanced.. | Print... | Comparisan.. | ]
[ Select werter No. 10 11 TNV 'l Cloze
[ [MNa:Gonnected
[Read]: Allows you to read the function codes from the selected [Select inverter]
inverter or keypad and load them into the loader. (ISelect keypad])
[Write]: Allows you to write the edited function codes to the inverter

[Factory-set]:

[Func. code set]:

[Func. code info.]:

[Initialization]:

[Advanced]:

[Print]:

[Comparison]:

or keypad.
Resets the selected function code to the factory-set value.

Displays the selected function code setting in the [Setting
value] window. For function codes whose settings are
available for selection from the list, however, the [Setting
value] window does not appear.

Displays the selected function code information in the
[Function code info] window.

This button, available when an inverter is selected,
initializes the function code settings within the inverter.
It is not available when a keypad is selected.

Displays a dialog that allows you to change the display
items and print settings. Select [Error Clear] to delete the
list of function codes that could not be written or read so
that no function codes are displayed in [R/W failure (pink)]
in the tree view.

Prints the function code list selected in the tree in the left
pane.

Allows you to compare the inverter data with the list, the
keypad data with the list, or the function code settings in a
saved file with the list.

The results of comparison appear in [Comparison Result] in
the tree view.

[Select inverter] ([Select keypad])

Refer to the description
below.

[Close]

Closes the [Function Code
Setting] window.

Select the inverter or keypad you want to write the data to. When there is only one inverter or
keypad, you do not have to select it. When you are using RS-485 multi-drop connection, you
have to select the desired one from the list.
As described in the following table, whether you should select an inverter or keypad as the

read/write target is determined by the port setting in the [Communication Setting] window. The
list corresponds to rows marked with in the [No] column in the [Connection Setting] window,
and the number of list entries is equal to the number of v| marks.

For information on the [Communication Setting] window, refer to "1.5.5.1. Communication
Settings".
For information on the [Connection Setting] window, refer to "1.5.5.2. Connection Setting".

Table 2-1 Relationship between [Communication Setting] and your inverter (keypad) selection

o o ] ) Target inverter (Target keypad)
Port setting in the [Communication Setting] window - -
Target List entries
RS-485 connection Inverters 1 or greater
Data in Inverter (Direct) Inverters 1
usB — - X
. Data in inverter (connection via TP) Inverters 1
connection
Data in keypad Keypad 1
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[1] Read the Function Code Settings from the Inverter or Keypad
If you have selected an inverter, click [Read] button to open the following dialog.
Click [OK] to read the function code setting values from the inverter.

FRENIC Loader x|

':0:' Do you want to read the function code settings from connected inverter?

Cancel |

The above applies also if you have selected a keypad. Click [OK] to read the function code
setting values from the keypad.

@ e Be sure to read from a keypad that contains data. You cannot read from a keypad
that contains no data, as is the case when you have purchased a new keypad.

- If function codes you want to read or write are password-protected:

@ o If the inverter has password protection enabled, do not read function codes from it.
Before reading from the inverter, be sure to disable password protection. If you
attempt to read from the inverter with password protection enabled, you may fail to
read your desired function codes or the read operation may take a long time.

This applies also to the write operation. Disable password protection before writing
to the inverter.

Tip e For more information on password protection, refer to the instruction manual or
user's manual of your inverter.
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[2] Write the Function Codes from the Loader to the Inverter or Keypad
To write function codes to the inverter or remote keypad with USB, use the [Write] button
displayed at the lower left of the [List Edit] window that appears when editing function codes.

The [Select function code data write operation] window opens.

Select function code data write operation x|
Wiite function code data to the inverter.
Select function code data write operation.

GCancel |

0]

Editing function code data (blus part) anly
Regiztered uzer definition function code data only

Different fram the factory default function code data (with *) only

o e N’

Al function code data

o)

Write function code to the EEFROMWite 2 to v37)

e irite function code following w97 zetting
(Do ot write w37 function code

[~ After writing, read out the function code data from the inverter.

— These option buttons are only enabled for inverter models that have function code y97. They
are disabled (as shown below) for inverter models that do not have function code y97 or when
you write to a remote keypad with USB.

1 Wilvite function code tothe EEFREMNr e 2 to w07

IS Yikite function code following 97 setting
(D not write w87 function code)

Hereinafter in this manual, the inverter or remote keypad with USB you want to read to or write
from is referred to as the "target device".

- [Editing function code data (blue part) only]
Writes to the target device only the function code settings edited in the loader but not yet
written to the target device (blue part).

- [Reqistered user definition function code data only]
Writes to the target device only the function code settings registered as user definitions in
the [List Edit] window.

- [Different from the factory function code data (with *) only]
Writes the settings to the target device only when they are different from the factory-set
values (with *) (excluding Read-only function codes).

- [All function code data]
Writes all the function code settings to the target device (excluding Read-only function
codes).
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- [Write function code to the EEPROM (Write 2 to y97)]

This option is disabled for inverter models that do not have function code y97 or remote
keypads with USB.

Select this option if you want to:

Save your edited function codes to an inverter configured to save the data in the
temporary storage memory (i.e., with y97 set to 1) and retain them in the non-volatile
memory

Change the setting of function code y97 (from 1 to O or from O to 1)

Write a large number of changed function code settings to an inverter configured to
save the data to the non-volatile memory (with y97 set to 0)

The loader sets y97 to 2 to save the function code settings to the non-volatile memory of
the inverter. This ensures that the function code settings are saved to the non-volatile
memory even if y97 is setto 1 (i.e., the inverter is configured to write to the temporary
storage memory).

(However, some function codes such as S01 are saved to the temporary storage
memory.)

In addition, when function code y97 exists in the [Function code edit] window and you
write the function codes, the loader writes the setting of y97 as well.

@ e Therefore, when function code y97 exists in the [Function code edit] window and you

Tip

Tip

write the function codes, do not forget to edit y97 in the [Function code edit] window
as appropriate. Even if you do not select y97 as the function code to be written, the
loader writes y97. If you do not want to change y97 in the inverter, ensure that the
y97 setting in the loader is the same as in the inverter.

Be sure to select this option when you write a large number of changed function
code settings to an inverter configured to save the data to the non-volatile memory
(with y97 set to 0). You can shorten the write time by selecting this option rather than
the [Write function code following y97 setting (Do not write y97 function code)]
option.

Selecting this option causes the loader to save all function codes (including those
not selected) to the non-volatile memory.

When the inverter is configured to save the data in the temporary storage memory
(i.e., with y97 set to 1) but you want to save the selected function codes to the
non-volatile memory, follow these steps:

First select [Write function code to EEPROM (write 2 to y97)] to set y97 to 0.

Next, select [Write function code following y97 setting (Do not write y97 function
code)] to write settings to the function codes you want to change.

Finally, select [Write function code to EEPROM (write 2 to y97)] to set y97 to 1.
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Chapter 2 Functional Description

The loader writes function codes in accordance with the following flowchart when [Write
function code to EEPROM (write 2 to y97)] is selected:

Write standard function codes from Write customizable logic function codes
the [Function code edit] window to from the [Function code edit] window to
the inverter the inverter
START START

¢

[ Read y97 from the inverter (a) ]

v
[ Write 1 to y97 J Write 1 to y97 ]
O I ———— e e leteteteteteletetets it
Write settings to all the specified Write settings to all the specified
function codes function codes
v V2
[ Write 2 to y97 J [ Write 2 to y97 j

Write the setting read in (a) to y97 j
V7 Vv

( ) (
[ Write 2 to y97 J [ Write 2 to y97 J
® ®

END END

@ o |f the write operation is cancelled during the period between (b) and (c) in the
flowchart above, function code y97 is set to 1. Therefore, when you restore the
settings before the write operation after cancellation, you should also restore the
original setting of y97.
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- [Write function code following y97 setting (Do not write y97 function code)]
This option is disabled for inverter models that do not have function code y97 or remote
keypads with USB.

Select this option if you want to:

e Save your edited function codes to an inverter configured to save the data in the
temporary storage memory (i.e., with y97 set to 1) and retain them in the temporary
storage memory (you do not want to save them in the non-volatile memory).

¢ Write a smaller number of changed function code settings to an inverter configured to
save the data to the non-volatile memory (with y97 set to 0).

The setting of y97 in the inverter determines whether the function code settings written are
saved in the non-volatile or temporary storage memory of the inverter.

When you write to an inverter configured to save the data to the non-volatile memory (with
y97 set to 0), the settings are saved one by one to the non-volatile memory of the inverter.
For this reason, when you write a large number of changed function code settings, the write
time is longer than when you select [Write function code to EEPROM (write 2 to y97)].

Even if the function codes written include y97, the setting of y97 is not written to the
inverter. If you want to write the setting of y97 to the inverter, select [Write function code to
EEPROM (write 2 to y97)].

Tip e If you want to update to the latest settings after the write operation. check [After
writing read out the function code data from the inverter] .
The above applies also if you have selected a keypad. Check [After writing read out
the function code data from the keypad] @)

- What to do if the write operation fails

The loader is not able to identify function codes whose write attribute (write
enabled/disabled) dynamically change (for example, function codes that cannot be changed
during operation). If you attempt to write such function codes, the write operation may fail.

If your selected function codes include those that cannot be written, the loader attempts to
write all the selected function codes and, after the write operation, displays a list of the
function codes that could not be written.

Inverter access error (Write) o [m] |

MNum. | Function code name Error code
(1NN Terminal [%1] function (Inverter status error) It can't be written, (ficcess toward a function which f

Terminal [%2] function {Inwerter status error) It can't be written. {Aecess toward a function which of

ok | _swe. D

You can save the displayed list to a CSV file by clicking [Save...] at the lower right of the screen.
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Chapter 2 Functional Description

After you closed the error window, you can save same information in CSV format by [Export
to CSV (Last error Info.] in [Function Code Edit] (see [2.7.Function Code Edit]) on the Main
Menu.

To check the function codes that could not be written, select [R/W failure (pink)] from the
[Function code edit] tree.

Function code edit | Auto-tuning | File information |

-0 code |

ool code Chanee

: Ma.
. Changel Factory settir
artentsof change

Function code name Setting value Errar code

EN | Terminal [41] function 1 |{Inverter status error) It can'

L R failurelPink ]

: * E02 |Terminal [42] function 2 |{Inverter status error) It can't
= Uszer definition

The settings of the function codes that could not be written are displayed in pink.

Setting value

@)— Displayed in pink.

The write operation may fail due to the following reasons:

e An attempt was made to write to a function code that cannot be changed during inverter
operation.

e An attempt was made to write to a function code protected from edit via a link
(communication).
Example: When the frequency command for RS-485 communication port 1 was enabled
(with H30 set to 1) and the loader was connected to RS-485 communication port 2, an
attempt was made to write to S01 (frequency command).

e An attempt was made to write to a password-protected function code.

e Write was cancelled in the middle.

To hide function codes from [R/W failure (pink)], right-click [R/W failure (pink)] in the
[Function code edit] tree.

- ChangelFactory sett Then click [Clear] on the context menu to hide the function

- Cantents of changed] .
s iJE:Ifir=' codes that could not be read or written.
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Alternatively, you can also hide the function codes that could not be read or written by

clicking the [Advanced] button at the bottom of [Function code edit] and then clicking [Error
Clear].

Advanced... x|

Select the items to be dizplayed on the editing list.

Print zetting.. | Set printz in zimplified way.
Clear the errar infarmation of Function code.
—
Cloze |

- Writing customizable logic function codes from the list

@ ¢ When customizable logic function codes (U, U1, UA, UB, etc.) are displayed in the
[Function code edit] window and you wish to write your edited function codes by
selecting [All function code data], edit UAOO to UAG9, rather than UO1 to U70, for
customizable logic steps 1 to 14.

U01 and UAOO, U02 and UAO01, ..., U70 and UAG9 are written, respectively, to the same
memory addresses of the inverter. If you write by selecting [All function code data], UO1 to
U70 are overwritten with UAQO to UA69, which are written later.
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Chapter 2 Functional Description

[3] Change the Settings
How to change the setting varies among function codes.

(1) To change the setting of a function code that sets frequency, time, voltage, or other numeric

value, click the field of the function code setting.

Setting value

G000

Select the desired function code and click the [Set] button at the bottom of the screen or
double-click the setting field. In the [Setting value] window that appears, change the
setting.

x
Function code Mo,  FO3

| 60.03 =

Ciancel

For function codes whose settings are available for selection from the list, however, the
[Setting value] window does not appear.

(2) For function codes whose settings are available for selection from the list (for example, FOO

"data protection" or FO1 "frequency setting 1"), click the desired function code setting field
to display the = button. Then click the = button to select the desired data from the list.

0: Dizable bol | REE

0: Dizable both data protection and digital reference protection
I: Enable data protection and dizable digital reference protection
2 Dizable data protection and enable digital reference protection
¥ Enable bath data protection and digital reference protection

Tip e When the changed function code data has not been written to the inverter, the data
is displayed in blue.

e When the changed function code data is different from the factory-set values, the
[Change] column is marked with * in the [Function code edit] window.
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[4] Save
To save the function code settings opened in the loader, select [File] -> [Save] or [Save As ...]
from the main menu.

File | Menu Setup  Edit  Wiewm  Fu

] Mew.
5 Open.

Cloze

| = Save

Save Az

Print...

Print Prewiem

b W

Page Setup...
Recent File

Exit

When selecting [Save] for the data for the first time, the following dialog will open in the same
manner as when selecting [Save As ...].

Select [Save to ...] and enter the file name under which the data is saved in [File Name]. Then
click [Save] to save the file.

® lx

P—— =
\ }\‘ ) ‘ . = Fujielectric ~ FRENIC Loader4 - DATA - l‘ﬂ]l Search DATA

Organize ¥  New folder 4= -

®

4 Downloads ;I MName = | Date modified | Type
:-'4 Recent Places

|| Function 1,FML 1022017 6:54 FM FML File
7 Libraries
3 Documents
rJ.V\ Music
=] Pictures

B videos
e@ Homegroup

18 Computer
£, Local Disk (C2) =]l

File name: I Function2

Lllel |-

Save as type: IFuncnon code setting data file (*.FHL)

= Hide Folders Save I Cancel |

2

*FNL: File format specific to the loader. Standard function code data (such as F, E, C). Files in
this format can be opened only in the FRENIC Loader 4.

*FBL: File format specific to the loader. Customizable logic function code data. Files in this
format can be opened only in the FRENIC Loader 4.

Ti

p e You can also save standard function code data (such as F, E, C) in the CSV format.
For more information, refer to "2.7. Function Code Edit".

@ e The length of the path and file name should be up to 200 single-byte characters (up
to 100 double-byte characters). Otherwise the file cannot be saved.

2-26



Chapter 2 Functional Description

[5] Print
You can print the items selected from the tree in the left pane of the [Function code edit] window.

Once you select [Function] or [Code group] from the tree in the left pane of the [Function code
edit] window, function codes such as F, E, C, ... or the group name appears.

Click the [Print] button displayed at the lower right of the [Function code edit] window or select
[File] -> [Print] from the main menu to display the [Print] window.

Refer to "2.2.6. Print".

How to set simple printing...

To print only the function code numbers and setting values from among the items displayed in
the [Function code edit] window, click the [Advanced] button at the bottom of the window to open
the [Advanced] dialog and click [Print Setting]. On the [Print Setting] dialog that appears, check
[Simple Printing] and click [OK]. Note that this operation only determines the settings and
does not actually print the data.

x
| Select.. I Select the items to be displaved on the editing list.
m | et printz in simplified way.

Error clear | Clear the error information of Function code.
Cloze |

Print zetting x|

IV Prints in =implified way

] 4 I Cancel |

How to view the print preview before actually printing...

Select [File] -> [Print Preview] from the main menu.
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[6] Compare

You can compare the function code setting data you are currently editing with the function code
settings in the inverter selected in [Select inverter], the function code settings in the selected
keypad, or the function code settings saved in a file and view the results.

Setting of comparison - [Compared with inverter]

([Compared with keypad])

If the target device is an inverter, the loader
compares the function code setting data you
are currently editing with the function code

| Compared with inverter 'Ii settings in the inverter.

If the target device is a keypad, the label
changes to [Compared with keypad] and the
loader compares the function code setting
data you are currently editing with the

[T Gomparizon results include Communication code eq function code settings in the keypad.

Select destination comparizon

Compared with file =I

[T Comparison results include ReadOnly

[Compared with file]

Cloze The loader compares the function code
setting data you are currently editing with the
function code setting data saved in the file.

Close [Comparison results include

Close this dialog. ReadOnly]

Check this checkbox to include "Read-Only"
function codes in the scope of comparison.

—— [Comparison results include
Communication code]

Check this checkbox to include
"Communication Code" function codes in the
scope of comparison.

* You should select the inverters to be compared in advance by clicking = next to the [Select
Inverter] box at the bottom of the [Function code edit] window.

Upon completion of comparison, the focus automatically moves to [Comparison Result] in the
left pane tree of the [Function code edit] window and the comparison results are listed.

Function code edit | Auto-tuning | File information |

Comparigon gource |FunctionI.FNL Compatigon destination : |FRN55E2S—2.J Difference 80 pointz
- User definition 1 a -
. User definition 2 _I Change | Mo Function code name Setting value (d;g;nt?:;ﬁon: Setting range | Default setting M:gmg_l
- User definition 3
. User definition 4 M1 |Thput power i} 066|000 to 39999 0.0
- User defmitiop 5 ; M13 | Operation command (Final comm L] 0800 |0000H ta FF LYl
=- Gode for communicati
.. 5 code M4 |Operation status 1) 0x28 |0000H to FF.. 00
- M code M16 |Latest alarm contents 1] 100 to 254 (00.. 0
W code
W1 code 17 |Last alarm contents 1} 180 ta 254 {00 1]
M20 | Cumulative operation time 0 1184 |0 to 65535 1]
M21 DG link bus voltage 1] 3000 to 1000 % 0
M25 |ROM wergion G000 900 |0 to 9999 [
¥ W27 | Fremurnee refrrence nnoalaem (o | n NNAN [-A2T7RA tn B2 n =R
h 1§
Bead.. Wite.. | Factary set | Func. code =et... Func. code infa. .. | hhitialization... Advanced.. | Print... | Caomparizon... |
Select Iwerter INo. 10 111NV vl Close
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Chapter 2 Functional Description

[7] User Definition (Display desired function codes only)

Registration

To register function codes in a user definition, select your desired function code(s) from the list
of function codes displayed in the [Function code edit] window and click the right mouse button.
The available user definition group names ("User Definition 1" to "User Definition 5" in the
example below) are displayed on the submenu. Click your desired user definition name. The
selected function codes are then registered in that user definition.

Function code edit | Auto-tuning | File information |

(=1- Function - . . . 2 Minimum Mazximum
B Code group Chanee | Mo. Function code name Setting value | Setting range | Default setting e whe

F code
.. E code 0|0to 2 0 0
.G code 0 requency setting 0|0t 12
- P code
- H code
H1 code
- A code
-.b code
-t cods =
-l code
I code FO6  |Maximum output voltage 1 !ZI User definition 4

~d code FO7 |Acceleration time 1 L. .00 0.0 600

..y code T R ——— Uszer definition & w0 w0 o

K eods Freleration tme Release user definition

-0 code FO9 |Torque boost 1 I . 49 0 20.
ol code I I

- GhangelFactary settiv _ | F10 |Electronic thermal overload prote... | Tt 2 1 1

Data protection

Factory setting

User definition 1

Uszer definition 2

Uszer definition 3

-l

Display

From the list of user definition groups displayed in the tree in the left pane ("User Definition 1" to
"User Definition 5" in the example below), select and left-click your desired group to display the
function codes registered in that group.

Function code edit | Auto-tuning I File information I

= Function . f
- Code eroup Change | Mo. Function code name Setting value | Setting range | Default setting M:L'Ezm Mi);'ﬂ';m I
Change(Factory setting « -

. Contents of chanee(Blue F01 |Frequency setting 1 0{01to 12 1] 0 12

f F02 |Operation method 2|0t 3 2 0 3

F03  |Maximum output frequency 1 600|250 to BOOD .. 600 250 500.0

Fid4 |Base frequency 1 B0.0{250 to BOOD .. 500 250 500.0

User definition 3
. User definition 4 Fi% |Rated voltage at baze frequency 1 2000 ; 80 to 240 . 200 40 240
- User definition § FO7 |Acceleration time 1 £.00(0.00 to 6000 = 600 0.00 6000
ication

[----Oumparisun result F08 |Deceleration time 1 G.00{0.00 to G000 = 600 ] G000

- Search result Ji1 |PID contral (Made selection) {048 0 0 3
|

Unregistration

To unregister a function code(s), select your desired function codes and click the right mouse
button. Select your desired user definition group from among the user definition groups marked
with || on the submenu, and left-click it. The selected function codes are unregistered.

If your selected function code is registered in two or more user definition groups, you can
unregister that function code from all the user definition groups by left-clicking [Release user
definition] on the submenu.

Function code edit | Auto-tuning | File information |

= Function . .
- Code group Change | Mo Function code name ‘ Setting value | Setting range | Default setting M{gm:m ‘ Mi?;llrﬂgm I
- Change(Factory setting + . 0
.. Contents of change{Blue Frequency ing 1 . . 0
- RAW failurel Pirk) FO? |Operation methad BB Sl 2 0 3
=] Uger definition
| [ e— FO3  |Maximum output frequency 1 |7| User definition 1 .. 60.0 2510 5000
User definition 2 FO4 |Base frequency 1 Uszer definition 2 E 0.0 250 5000
User definition 3
User definition 4 F05  |Rated voltage at base freque User definition 3 .. 200 a0 240
- Uzer definition § FO7 | Acceleration time 1 User definition & S 6.00 0.00 G000
[ Caode for communication -
.. Comparisan result FO8 | Deceleration time 1 User definition § = .00 000 G000
- Gearch result J01 |PID contral (Mode selection) Fll=ss ve i ] ] 3
| "
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Renaming a user definition name

=] User definition
Jzer definition 1

- Uzer definition

To rename a user definition, left-click or
right-click one of "User Definition 1" to "User
Definition 5" in the tree in the left pane and
left-click [Name change].

[8] Search (Search function code terminologically)
Select [Edit] -> [Search] from the main menu to open the [Search] dialog.

Soarck 2l From among the words contained in the

Search string

[ o] Function code edit window, enter the keyword
Seareh canditons creel | | to be searched and click the [OK] button.

& AND  OR

[~ Capital letter # small letter iz distinguished.

I 1 byte character / 2 byte character is distinewished.

The focus automatically moves to [Search

4 Result] in the left pane tree of the [Function
code edit] window and the function codes that
include the entered keyword are listed.

Use the space delimiter
Tf you do a search to include the space,

iz uzed

The following is an example of searching keywords "voltage" and "current" with the OR
condition.

Delimit keywords "voltage" and "current” with

gearch| string a single-byte space.

Ivnltage current

Search n:l:unditil:unsl Select [OR].
’71!" BHD o OR

Function codes that include "voltage" OR "current" are listed.

Function code edit | Auto-tuning I File information I

= F.:ungtowodr; group Change | Mo. Function code name Setting value | Setting range | Default setting Mgmgm M?;'{S;m;
Chanes(Factory zetting «
Contents of changelElue F05  |Rated voltage at base frequency |1 200(0; 60 to 240 . 200 80 2
RAW failura{Pink.) FO6  |Maximum output voltage 1 200(80 to 240 V.. 200 80 2
User definition — -
Gode for communication Fé3  |[Current limiter (Mode selection) 2|0t02 2 1]
“ asult Fd44  |Gurrent limiter {Level) 180(20 to 200 % 180 0 2
- E34 |Overload early warning/current d.. 2250(000; 00110 .. 2250 0o 300
E36 |Overload early warning/current d.. 1000 {001 to G00.0.. 10,00 0.1 GO0
E37 |Current detection 2/ low current .. 2260(000; 00110 . 2260 nm an
E3%  |Current detection 2/ low current .. 1000|0071 to GO0, 1n0n nm GO0
ES5  |Gurrent detection 3 {Level) 22500000001 t0 .. 2250 oo a0
ES6  |Current detection 3 (Timer) 1000|000 to G000 1000 o GO0L
E76 |DG link bus low-voltage detectio.. 285200 to 400V .. 235 200 4[/

@ e The search target range includes all items (changes, No., function code names,
setting values, and so on).
However, the items hidden by clicking [Advanced] -> [Display Item] are also
included in the search target.

e The text of function code information are not included in the search target.
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Chapter 2 Functional Description

2.3.1.2. Auto Tuning

This function automatically measures the motor parameters and saves them to the inverter.

¢ Before performing tuning, carefully check the description of tuning (including the
settings required before tuning, machine preparation, precautions, etc.) in the
User's Manual of your inverter.

Tip e When you are using FRENIC-Mini (C1S), the [Auto tuning] tab is not displayed.

¢ If you have selected [Data in Keypad] for [USB Connection] on the [Communication
Setting] window, the [Auto tuning] tab is not displayed.

—— [Motor tuning (Select)]
Select the tuning method.

Check the condition of the machine to determine whether to perform "Inactive tuning" or "Active tuning".
(For more information, refer to the User's Manual of your inverter.)

— [Motor] — [Tuned result]

Displays the currently Clicking the [START] button causes the loader to read the
selected motor. motor parameters from the inverter and display them in
the [Before] column.

— [Tuning result]

Displays the tuning result
upon completion of tuning.

Upon completion of tuning, the loader reads the motor
parameters from the inverter and displays them in the
[After] column.

File information

Functian cade edi

(Tuned results 2

Matar tunine (Select)

Eefore After

Function code name

90 : Tnactive L!

Tuning resuligp——

G
Operating procedure

1. Select the inverter to be tuned.
2. (Only when multiple motors are connected)
Select target motor with input terminal ete.
3. Select tuning operation, and the rotation direction.
4. Press the [START] button to start tunine.
5. Upon completion, the result of tuning will be displayed.

—Motor parameter

Mumber of poles — paolez
Motor capacity — kw
Motar rated current — .y
Rated vaoltage

(—Rotation direction
& Loader (FWD)
© Loader (REW)

— Auto-tuning 1
START |

IND. 10 11 INWA vl Cloze

Select Inverter

L [Rotation [Motor parameter] [Auto tuning] [Select inverter]
direction] Clicking the [START] Click the [START] button to start Select the inverter
[Loader (FWD)]: Forward button causes the loader tuning. you want to tune.
rotation to read the motor ;

. When you click the [START]
Et?;?oer: (REV)]: Reverse parameters from the button, a confirmation dialog

inverter and display

appears. Click [OK] on the
them. P [OK]

Select either of the two
rotation directions
according to the direction
in which the machine
actually rotates.
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2.3.1.3. File Information

This function displays the information related to the currently displayed list of function codes.
You can change [Voltage], [Capacity] and [Current definition file] as you want.

— [Properties] — Comment

- If you have read function codes from the inverter, this area displays You can save a comment as needed.
the inverter information.

- If you have read function codes from the keypad, this area displays
the inverter information saved in the keypad.

- If you have opened the [Function Code Setting] window by clicking
[Create new function setting], this area displays the initial settings
for creating a new function code.

- If you have opened a saved data file by clicking [Open] under the
[File] menu, this area displays the information contained in the
saved file.

Function code edit I Auto—tunin

Propert, Uomments
< Ghanee I

File name Function1

Mode| E25

Resion spec.  JJAPAM

‘foltage dphaze 2000
Capacity 55 kW

Read date 1940942017 - 16:44:17

Current definition file fhc_E x 8 0800 cey

Saved definition file

MNote) Even if the 'Region spec’, 'voltage' and ‘capacity’ " are changed on this screen.
It does not write it in the inverter

Select werter Moo 10 11 THW 'l Close

~ [Change] x

Click this button to open the [Setting] dialog shown at

right. Select the following parameters
Mode| Jess |
Begion spec. | L JAPAN |
Voltage

Capacity 5.5 kit =]

Definition file  frc_E_x_8_0800cav Chanee |
0] 4 I Cancel |
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Chapter 2 Functional Description

[1] Changing the Input Power Supply Voltage
You can change the input power supply voltage of the inverter whose function code data is
currently displayed in the function code list.

Correctly set these values according to the inverter for which you are editing function codes.

Ti

p e You can identify the input power supply voltage from the inverter model number
printed on the rating nameplate of the inverter. Refer to "2.2.1. [1] Model, Regional
Specification, Voltage, Capacity" for details.

Changing the value in the [Voltage] box automatically modifies the [Setting], [Factory-Set Values],
[Minimum] and [Maximum] values of function codes whose factory-set values change depending
on the voltage setting (for example, function codes whose data copy attribute is set to "1").

Wnltage 3phase 200y x|
: Iphaze 200
Capacity Sphaze 200
|

A Are you sure you want to change the voltage setting?
0' Changing it automatically reverts the related function code data to
= factory defaults.

Cancel |

@ ¢ As shown in the above dialog, changing the voltage setting automatically
initializes the settings of the function codes related to the voltage. So, save the file
you are currently editing as needed.
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[2] Changing the Inverter Capacity
You can change the capacity of the inverter whose function code data is currently displayed in
the function code list.

Correctly set these values according to the inverter for which you are editing function codes.

Ti

p e You can identify the inverter capacity from the inverter model number printed on
the rating nameplate of the inverter. Refer to "2.2.1. [1] Model, Regional
Specification, Voltage, Capacity" for details.

Changing the value in the [Capacity] box automatically modifies the [Setting] and [Factory-Set
Values] values of function codes whose factory-set values change depending on the capacity
setting (for example, function codes whose data copy attribute is set to "2") to the values
associated with the new capacity value.

Capacity 5.5 kW (0012) |
0.TkW

" 0.2 kW
Definition file 04k
0.75 kW (0002)
15 kW (0004)
2.2kW (0006)
3.0 kW(0007)
5.5 kW (0012)
75 W
11 kW (0022)
15 kW (0029)
185 kW (0037) _ =
22kW (0044)
30 kW {0059)
37 kW (0072)
45 kW (0085)
55 kW {0105)
75 kW (0139)
90 kW {0168)

OB Are you sure you want to change the capacity setting?
J.-' Changing it automatically reverts the related function code data
" to factory defaults,

Cancel |

* For some models, current types are displayed enclosed in (). Example: 11 kW (0022)
@ e As shown in the above dialog, changing the capacity setting automatically

initializes the settings of the function codes related to the capacity. So, save the
file you are currently editing as needed.
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Chapter 2 Functional Description

[3] Changing a Definition File

Select a definition file appropriate for the inverter ROM version.

For example, your selected definition file may not be appropriate if you have been using a
definition file with default settings because the inverter ROM version was unknown when you
created the function code list. If this is the case, you should select a different definition file.

@ o If the selected definition file is not appropriate for the inverter ROM version, an
error such as failure to read or write function codes may occur due to the
difference in the number of function codes or other reason.

Tip ¢ If you read the settings from the inverter by selecting [Read from the inverter] on
the [Menu] -> [Function code edit] -> [Select function code to edit] window, the
loader automatically selects the optimum definition file and therefore you usually
do not have to select a different definition file.

To change the definition file, click the [Change] button on the [Setting] dialog.

Definition file  fnc_E_ 3 3900acey '
—

= Version 1.0.1.0 or later]
ROM Verzion - L. .
2000s_EN From among the definition files
3000b_EM . .
000N displayed on the list, select the
3600_EN definition file appropriate for the
3700_EM . . .
38002EN inverter ROM version and click the
gsgg-;“ [OK] button.
3900f_EN
QK I Cancel |
open x|
— ersion 1.0.0.0
g(_)ﬂ ~ FRENIC Loader4 ~ GIS(EN) « E * &) [ searchE @J
Orgerize = ”E“"‘dﬁ'_l - 0e From among the definition files
B Desktop = fnc_E_x_3_0000m.csv fc_E_x_3_38008EN, csv . .
ad EDW”‘ZTS :fnciEixi}iUUUUo‘csv :ﬁ'\ciEixiBiEQUUEN‘csv dlsplayed on the dlalogv select the
‘_‘fﬁjnc_E_x_S_DSDUE_EN.csv |_|fnc_E_x_3_3900f_EM.csv deflnltlon flle apprOprlate for the
.}e Libraries _|fncE_x_3_0850_EM.csv . . .
=) Doauments L Jfne_E_x_3_1000_EN_sampie L.csv inverter ROM version and click the
& Music __|fnc_E_x_3_1000a_EN.csv
&) Pictures L frc E x 3 2000 Enlesv [Open] button.
B videos |_|fnc_E_x_3_3000_EM.csv
|_|fnc_E_x_3_3000a_EN.csv
) Homegroup |_|fnc_E_x_3_3000b_EN.csv
fnc_E_x Ke- . .
o | A For information on how to select a
&, Local Disk (C:) S s .
- e Fx_3.3800_EHesv definition file, refer to "2.2.1. [2]
File name: | =l [poremeterfite = Guidelines on Selecting a Definition

Open |-| Cancel | File"
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Changing a definition file may, however, cause an error due to the difference between the
definition files before change and after change.

The figure below shows an example of an error that may occur when you change the definition file
from "fnc_E_x_3_3900a.csv" to "fnc_E_x_3_3000b.csv". The function code settings not affected

by the file read error are applied as-is.

Reading file error

=101 |

Function code name

Error code

-

| Mum. |

Tarque Maonitor

The addrezz of the function iz wrone.

Fefer to the comparizon result in t

E76

DS link, bus voltage Detection

The addrezs of the function is wrone.

Fefer to the comparizon result in t |

o2

Pattern operation {operation =..

The address of the function is wroneg.

Fefer to the comparizon result in t

G2l

Pattern operation stage 1 (Ope..

The addrezz of the function iz wrong.

Fefer to the comparizon result in t

G2

Pattern operation stage 2 (Ope..

The addrezz of the function iz wrone.

Fefer to the comparizon result in t

G2

Pattern operation stage 3 (Ope..

The address of the function is wrone.

Refer to the comparizon result in t

25

Pattern operation stage 4 (Ope..

The addrezz of the function iz wrong.

Fefer to the comparizon result in t

G26

Pattern operation stage & (Ope..

The addrezz of the function iz wrone.

Refer to the comparizon result in t

G27

Pattern operation stage § (Ope..

The addrezs of the function is wrone.

Fefer to the comparizan result in t -

|

|

0K |

Save.. |

Tip
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Chapter 2 Functional Description

2.3.2. Operation Monitor
You can monitor the status of the inverter during operation.

Select [Menu] > [Operation Monitor] from the main menu or click -* on the main window
toolbar and click [Operation Monitor Setting] to open the [Operation Monitor] window.

[Cperation monitar] :

To apen 1D monitar, swstem
maonitar, alarm manitar, and
operation status monitor.

Dperation Manitor

@ ¢ You should use the [Operation Monitor] window only when the loader is connected
to an inverter or keypad. The loader displays no signal if you open the [Operation
Monitor] window without connection.

¢ Depending on the communication link condition, it may take a long time to detect
the communication target. The loader does not respond until the communication
target is detected. To avoid the inability to operate the loader for a long time, you
should use the loader in an environment with as good communication conditions
as possible.

e Whenever you use the [Operation Monitor] window, specify the monitored inverter
in the No.1 row on the [Communication Setting] -> [Connection Setting] window.
When you want to monitor multiple devices connected in multi-drop connection,
specify the monitored inverters serially in rows No.1, No.2, No.3, and so on. For
information on [Connection Setting], refer to "1.5.5.2. Connection Setting".

If you have selected [Data in Keypad] for [USB Connection] on the [Communication Setting]
window and the loader is connected to a keypad, the [Operation Monitor] window displays the
inverter information saved in the memory of the keypad. For information on the memory function
of the TP-E1U remote keypad with USB, refer to "1.3.1.1 Memory Function of the TP-E1U".

@ e Be sure to read from a keypad that contains data. You cannot read from a keypad
that contains no data, as is the case when you have purchased a new keypad.
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2.3.2.1. /O Monitor (for monitoring inverter input and output terminals)

You can monitor the status of an inverter's input and output terminals.

il
wvatem monitor I Alarm monitor I Operation status monitor I
Input terminal Qutput terminal
Terminal ff[ﬁtion Mormal | Status = Terminal fL:gc;tion Marmal Status =
#1 [551] Select .. |Open 1 [RUN] Inverte... |Open
®a [552] Select .. |Open W2 [OL] Mataor av... |Open
X3 [554] Select .. |Open 30Ry [ALM] Alarm .. |Open
kL) [Ex] Coast to_. |Open
b4 [RST] Reset .. |Open
EM1 - Cloge
EM2 - Cloze
[ [EWNT Do e 07 hd hd
Terminal Furnction Unit Value = Terminal Furiction Unit Value =
12 [Mane] Y i} FM (FMW) [F-out 1] Out.. [V 0o
G1(C1 functi.. [[None] mé i} FM (FMD) [F-out 1] Out.. |mA 32767
G102 functi.. |[Mone] W 0n = FM (FMP) [F-out 1] Out.. |psfs 1] =
FM2 (FM) [-ACT Output... [V 00
FM2 (FMD) [-ACT Output... |mé 32767
Save GSV file Refregy | _ Advanceded————
|Connecting: FRMESE25-24 Target Iverter: W
|
[Save CSV file] [Refresh] [Advanced] [Target inverter]
Allows you to save the I/O Update the terminal Click this button to Select the inverter you
monitor data to a CSV file. function, status, and show/hide signals and want to monitor.
values. change the display order.

Status color

Green if a normally-open terminal is open or a normally-closed terminal is closed; orange otherwise.

Special value

If '3276.7" is displayed as the value for an output terminal, it means that the output terminal is not
associated with an output type expressed with a unit of measurement (voltage output [V], current

output [mA], pulse output [p/s]).

For example, when the value for Terminal Function Uit Walue

[Tt

terminal FM is displayed as FM (FMD [F-out 1] Out... | mé 32767
shown at right, this terminal is

not associated with current
output (unit: mA).

@ ¢ When the loader is connected to an inverter that has password protection enabled,
the functions of terminals may not be displayed (with [READ_ERR] displayed
instead). If this is the case, you should disable password protection to have the
terminal functions correctly displayed. For more information on password protection,
refer to the instruction manual or user's manual of your inverter.
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Chapter 2 Functional Description

How to show/hide signals and change the display order

Click the [Advanced] button to open the [I/O monitor display item select] window.
This window allows you to select which signals to display in the [I/O Monitor] window and
change the display order.

IO monitor display item select il

Input Output terminal setting
Tnput terminal (Dieital) Qutput terminal (Digital) Thput terminal (Analoe) Qutput terminal {Analog)

Fh (FMD
Fi (FMF)
F2 (FM)
FM2 (FMI)

Y2 1 (C1 function)
G102 function)

® Titialze | Select |
i
Initialize Select Save Close
Click this button to initialize  Click this button to open a Click this button to save Click this button to close
the settings. saved setting file. the settings to a text file the window.

To hide a signal
EM2

Left-click the signal you want to hide.

REW

= Left-click it again to activate the list box.

D

REW
Fin'Dr - ]
Select the blank from the list.
E
i
Tnput Output terminal setting i i
S e (B Gt i (B I el Gt Cutput terminal (Analoe) Click [Save] to save the settings

. to a file.
2 G1{G1 function) FM (FMD
30Ry 1 (Y2 function) FM (FMF)
FM2 (FMW)
FM2 (FMD

Thitialize Select Save Close
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To change the display order

For example, suppose you want to move [FWD] to the position of [X1].
Hide the signal you want to move.
(Refer to "To hide a signal" above.)

[FWD] is hidden in the example at left.

Left-click the destination position.

[X1] is left-clicked in the example at left.

Left-click it again to activate the list box.

Ha

W1 LI From the list, select the signal you want to move.
(The list displays the currently selected signal and the hidden
signal.)
[FWD] is selected in the example at left.

Y

Tnput Output terminal setting

Output terminal (Digital) Input terminal {Analog) Output terminal (Analog) C||Ck [Save] to save the Settings
to a file.

Tnput terminal {Digital)

w2 G1 (G function) FM (FMD)
30Ry G1 (V2 function) FM (FMP}
FM2 (FM)
FM2 (FMD

Tnitialize Select Save Cloge

@ ¢ If you close the [I/O monitor display item select] window without saving the settings,
your changes will not be reflected to the [I/O Monitor] window.
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Chapter 2 Functional Description

2.3.2.2.

System Monitor
(for monitoring the internal setup information and maintenance
status of the inverter)

The system monitor allows you to check the inverter's ROM version, model, internal setup
information, and maintenance information.

L=
IO monitor Alarm monitor I Operation status monitor I
System Maintenance
Ttem Value Ttem Value =
Type FRMEEE25-2J Cumulative run time [h] 1168
Operation command Terminal block operation com.. DG link circuit voltage [v] 300
Frequency command Kevpad Max. effective output current [ 172
Motor selection Motar 1 Tnput watt-hour [100k'Wh] 0429
Cantral methad WA control without =lip compe.. Input watt-hour data 0429
Twverter's ROM version q00 Temperature ingide the inverte.. |0
Thwerter's ROM vergion (GPL 2) (0 Max. temperature inzida the in.. |0
kevpad's ROM verzion 1] Temperature of heat zink (real.. [20
Option's ROM verzion 1 0 Max. temperature of heat zink .. |20
Capacitance of the DG link bu. |00 1
Lifetime of DG link bus capaci.. | 1160
Lifetime of DG link bus capaci.. |86440
Cumulative run time of electral..[11230
Cumulative run time of the coo.. [ 1160
Mumber of startups 176
Femaining startup times befor.. |0
Cumulative run time of motar .. [40
Remaining hours before the ne.. | 87560 -
Save G5 file |
|Oonnecting: FRNEBE2S-2J Target Iwverter: INo_ 1[01] MW ;I

[Save CSV file]

Click this button to save the system monitor data to a CSV file.
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([Target keypad])
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2.3.2.3. Alarm Monitor (for monitoring the inverter's alarm information)

Shows the inverter's alarm status. The alarm monitor allows you to check the content of the
current alarm and the various operation information recorded when the alarm occurred.

— [Alarm Reset] —[Initialize the alarm history] [Data when alarm occurred]
Click this button to reset | Click this button to initialize the This list displays the operation information
(clear) the current alarm. | connected inverter's alarm history. recorded at the time of the occurrence of the

alarm you selected from the list box.
™ Operation Monitor -3 x|
/O monitar Svstem monitgr peration statuz monitor
/Data when alarm occurred ILatest alarm Vl \
Lfizsl el Ttem Valus Unit | =
|L‘\.-r
Alarm code LY
Mumber of serial occurre.. |0
" Alarm Reszet |
Multiple alarm 1 -
Ttialize the alarm histaty | Mltiple alarm 2 -

Sub code 1

Log | Blarm .
Multiple alarm 1 gub code |0
Cutput frequency 60.00 Hz

Last alarm OH2
COutput current 009

2nd Alarm -—=
Output woltage 0 W

drd Alarm -—
Torque ] %
Set frequency 60.00 Hz
Operating status (Hex) no21 KR/ HEESZ05/255
Curmulative operation time | 1168 h
Mumber of startups 176 |
DG link circuit voltage ] W
Temperature inzide the in..|[0 dee
Temperature of heat sink. |20 deeC
Tnput terminal (Hex) 1801 HASHIFZ1/Z61

Save GEV file | -
N tout termingl (Hew o 49 394719 /7R
|Oonnecting: FRN55E2S-24 Target Iwverter: |No_ 10 11NV LI
L]

[Save CSV file]
Click this button to save the data when alarm occurred to a CSV file.

[Target inverter]
([Target keypad])

Select the inverter you want to monitor.

AWARNING

to start unexpectedly as soon as the alarm is cleared.
Failure to observe this could result in an accident.

o Carefully note that resetting the alarm with the operation command on causes the inverter

@ e The [Initialize the alarm history] button may not work on an inverter that has
password protection enabled. If this is the case, you should disable password
protection so that you can use [Initialize the alarm history]. For more information on
password protection, refer to the instruction manual or user's manual of your

inverter.
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Chapter 2 Functional Description

Hexadecimal value

If an item name in the [Item] column is followed by "(Hex)", the [Value] column shows a
hexadecimal value and the [Unit] column shows the function code information. The function
code information shows the most recent alarm, the second most recent alarm, the third most
recent alarm, and the fourth most recent alarm, respectively, from left to right.

\Version 1.0.1.0 or later]

Detailed information will be displayed by clicking [+] symbol on the "Unit" column if it is
available.

For example, when the loader is connected to FRENIC-Ace (E2) and the operation status value
for the most recent alarm is '0021' (as shown below):

Item YWalue [Init
[+IK26/ 68/ 205/250

Operating status (Hex) nn

by

Detailed information

Operating status {Hex) | x|
value : 0x0021

bit0D: 1 [FWDIForward
bit01: 0 [REV]

bitD2: 0 [EXT]

bit03: 0 [ONTI

bit0#: 0 [BRK]

bitD5: 1 [NUv]

bitD6: 0 [T1L]

bitD7: 0 [vL]

bit08: 0 L]

bit09: 0 [ACC]

bit10: 0 [DEC]

bit11: 0 [ALMI

bit12: 0 [RL]

bit15: 0 [BUSY]
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ersion 1.0.0.0

For more information on these values, refer to the data format for the function code described in
the "RS-485 Communication User's Manual" or refer to the corresponding function code
information displayed on the [Function code edit] window (see "2.3.1.1. Function Code Edit").

View the X25 function code information in the [Function code edit] window.

Default =

Setting range

Charege | Mo Function code name Setting walue

n alarm {runnine =

wap | K25: Latest info. on alarm (running status)
W28 | Setting range : 0000H to FFFFH

bitl : FWD ; During forward rotation

#29 bitl : REV ; During reverse rotation

ywan | bit2 - EXT ; During DG braking {or during pre—exciting)
bit3 : INT : Inverter shut down

w31 | bitd : BRK ; During braking

bith : NUVY ; DG link circuit voltage established {0 = undervoltage)

Haz bith : TL ; Torque limiting

bit? : VL ; During voltage limiting

#ag bit8 : IL ; During current limiting

g bitd : AGG : Durine acceleration
bit10 : DEG ; During deceleration

wag | bit11: ALM ; Alarm relay {for any fault)

bit12 : RL ; Communications effective

¥36 | bit13: -

bit1d : -

#a7 bit15 : BUSY ; During function code data writing

wnn

You can view the function code information by double-clicking the desired function code
name in the [Function code edit] window or selecting the desired function code and then
clicking the [Function code info] button at the bottom of the [Function code edit] window.

A hexadecimal value of '0021" is expressed in binary as follows:

bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Value|0‘0|0‘O‘0‘0|0‘0‘0‘0‘1‘0‘0‘0‘0‘1

Therefore, this function code information means that the inverter is in forward rotation (bit 0
is 1) and that the DC link circuit voltage has been established (bit 5 is 1).
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Chapter 2 Functional Description

2.3.2.4. Operation Status Monitor (for monitoring the inverter operation
status)

Allows you to check information such as the present output frequency and output voltage.

—inx]

0 monitorl System monitor I Blarm monito

Operation status

Ttem Walue =

Frequency reference [Hz] 0.00

Output frequency (before lip .. [0.00

Output frequency (before slip .. [0.00

Output frequency (after =lip co..|0.00

COutput current [4] 0.00

Output valtage [V] 0.0

Torque value [¥] 0.00

Motor speed [r/min] 0.0

Load shaft spead [r/min] 0.00 P
line zpeed [m/min] 0.00

Surface speed monitor [Hz] 0.00

Flux command value [¥] 0

Operation status (M14) (Hexd 0028
Operation statuz 2 (M70) (Hex) | 2484
Running status 2 (M74) (Hex)  |0000
Level of torque value & [¥] 32767
Level of torque value B [¥] 32767

PID process command 0.00 -
Save CEW | idvanced |
|00nnecting: FRMEBE2S-2J Target Iwerter: |N¢ 10 11NV LI
[Save CSV file] —[Advanced] [Target inverter]
Click this button to save the Click this button to show/hide signals ([Target keypad])
operation information to a CSV and change the display order. Select the inverter you want to
file. For more information, refer to monitor.

"2.3.2.1How to show/hide signals and
change the display order".

Special value
If the torque limit value is '32767', it means "no operation"”.

Hexadecimal value

If an item name in the [Item] column is followed by "(Hex)", the [Value] column shows a
hexadecimal value. The function code is shown in the pair of parentheses immediately preceding
"(Hex)".
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\Version 1.0.1.0 or later]

Detailed information will be displayed by clicking [+] symbol on the "ltem" column if it is
available.

For example, when the loader is connected to FRENIC-Ace (E2S) and the operation status
value is '0028' (as shown below):

Item YWalue

£+jbperatiu:un status (M14) IIHRx]I nn2a
o}

Detailed information

[+]10peration status (M14) (Hex) E2
value : 0x0028

bit0o: 0 [FWD]

bit01: 0 [REV]

bitD2: 0 [EXTI]

bit03: 1 [IMNTlInverter shut down
bit04: 0 [BRK]

bitD5: 1 [NUV]

bitD6: 0 [T1L]

bitD7: 0 [vL]

bit08: 0 [l

bit09: 0 [ACC]

bit10: 0 [DEC]

bit11: 0 [ALM]

bit12: 0 [RL]

bit15: 0 [BUSY]
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Chapter 2 Functional Description

ersion 1.0.0.0

For more information on these values, refer to the data format for the function code described in
the "RS-485 Communication User's Manual" or refer to the corresponding function code
information displayed on the [Function code edit] window (see "2.3.1.1. Function Code Edit").

View the M14 function code information in the [Function code edit] window.

Change | Mo, Function code name Setting value | Setting range | Default =
Clperatio atus 00| 0000H to FF...
M1G M14: Operation status
M17 | Setting ranee : 0000H to FFFFH

bit0 : FWD ; During forward rotation

M18 bit1 : REV ; During reverse rotation

Mig | bit2 1 EXT : During DG braking {or during pre—exciting)

bit3 : INT ; Inverter shut down

[THI] bitd : BRK ; During braking

bith : NUV ; DG link circuit voltage established {0 = undervoltage)
M1 hith : TL ; Torque limiting

bit? : VL ; During voltage limiting

M23 bit$ : IL ; During current limiting

b4 bit9 : AGG : Durine acceleration

bit10 : DEG ; During deceleration

mM25 | bit11 : ALM ; Alarm relay (for any fault)

bit12 : RL ;: Gommunications effective

M26 | bit13 : -

bit14 : -

M7 bit15 : BUSY ; During function code data writing

kA0

You can view the function code information by double-clicking the desired function code
name in the [Function code edit] window or selecting the desired function code and then
clicking the [Function code info] button at the bottom of the [Function code edit] window.

A hexadecimal value of '0028' is expressed in binary as follows:

bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

vae | 0 | 0o [ o J oo ofJofofoJolas]ol1][o]o]o

Therefore, this function code information means that the inverter is shut down (bit 3 is 1)
and that the DC link circuit voltage has been established (bit 5 is 1).
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2.3.3. Customizable Logic

The customizable logic function allows you to create logic circuits using a graphical editor tool
and transfer them to the inverter.

Also, you can debug your circuits on screen.

#

Select [Menu] > [Customizable Logic] from the main menu or click -* on the main window
toolbar and click [Customizable Logic] to open the [Select customizable logic project to edit]
window.

[Customizable logic] :

The customizable loeic i=
indicated.

ornizable Lingic

The [Select customizable logic project to edit] window allows you to select the customizable
logic you want to view/edit.
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Chapter 2 Functional Description

2.3.3.1. Select Customizable Logic Project to Edit

When you start the editor, the [Select customizable logic project to edit] window (shown
below) appears first.

Select customizable logic project x|

Select editing project.

Create new project I

Read from the file... |

Cancel |

- [Create new project]
Click this button to create a new customizable logic project.
The model and version numbers affect how many steps you can use, what types of

circuits you can create, etc. So, correctly set the model and version numbers according to
the target inverter.

Inverter model selection | Model
Select the model number of the target

Mode| I EZ25 ) ;I inverter.
YWerzion @D ) LI

Humber of step 200 »

| (0] 4 I Cancel |

Number of steps

Shows the maximum number of steps.

L Version
Select the ROM version of the target inverter.

For FRENIC-Ace (E2S) ROM version 5600 or later, interpret the ROM version in accordance with the instructions in
"3.2.7 Replacement of Inverter ROM Versions"

If the list of choices does not contain the same version as the inverter ROM version, select the version earlier than
and the closest to the inverter ROM version.

If the inverter ROM version is later than all the versions in the list of choices, the inverter may have been upgraded
after the release date of your loader. Access the technical support page on Fuji Electric website "Fe Library" and
check for the latest loader version upgrade file. If one exists, download and use it.

Tip e You can identify the inverter model number you should select in the [Model] list
box from the inverter model number printed on the rating nameplate of the inverter.
Refer to "2.2.1. [1] Model, Regional Specification, Voltage, Capacity" for details.

¢ You can identify the inverter ROM version from the inverter keypad.
For more information, refer to the instruction manual of your inverter.
When FRENIC Loader 4 is connected to an inverter, you can identify the inverter
ROM version from [Inverter ROM Version] on the [System Monitor] tab of the
[Operation Monitor Setting] window, which you can access by selecting [Operation
Monitor Setting] from the Quick Access menu.
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Tip ¢ If the inverter ROM version is unknown when creating a new definition file, you
can change the version number later. For more information, refer to "2.3.3.12.

Project Properties".

However, changing the version number changes how many steps you can use
and what types of circuits you can create. As the result, an error may occur during
step number assignment. You are recommended to select a version number that
is as appropriate as possible when creating a new circuit.

- [Read from the file]

Click this button to load a customizable logic project file saved in your PC and open a window
for editing the file data.

opea ]
(_)(_) |1~ Fujielectric + FRENIC Loader4 + DATA + |2 [ searchpata @
Organize *  New folder gz o+ EJ ':Q'
Bl Desktop ;l Name ~ | Date modified | Type
& Downloads

15 Recent Places

|| CstmLogicPrL.cml

10/2/2017 7:44 PM

CML File

-l Libraries
3 Documents
JT Music
= Pictures
B8 videos
Filter
wn% Homegroup
B Computer | Select the type of files displayed
&, Local Disk (C:) in the list.
o i 1 —— 0|
File name: ICstangi(Per(ml j roject file (*.cml) >
Qpen |~ [Open]
& .
Opens the selected file.
File types
FRENIC FRENIC-HVAC/ | FRENIC Visual
Loader 4 AQUA Loader Customizer
Customizable logic data * CML * CMX

Tip e Change the filter to display the files saved from a loader other than FRENIC

Loader 4 in the [Open] dialog.

[

Project file (*.cml)

[

Project file (*.cml)
Project file (*.cmx)

2-50



Chapter 2 Functional Description

2.3.3.2.

Editor Screen

Project management window

Toolbox

Allows you to manage the project files and function block

properties.

[Select

Select the device you
want to connect to.

inverter]
([Select keypad])

[Update]

Click this button to upd
the number of steps.

ate

Allows you to acces

s the symbols provided by the

customizable logic function.

Icons for custom

[Grid]

Click this button
change the grid size,

izable logic

— Zoon in/Zoom out

to Allows you to zoom in or
out to the layout area.

S FRENIC Loader - Gustomizable logic ~ GstmLogicPrjl - [Gustomizable logic — GstmLogicPrjll -1ol x|
= File Menu  Setp  View  Window  Hilp -8 x
DEHSRo |/ 68% ‘
€ N\
Number of use steps
Customizable Logic i Digital |Ana\og| Digital+Analoe | FB |
Yirite { u T Update:
[Basic logic -
Proeramn
1] Tnput/Output. =
S Paiect TstmlogicPr] - =
23 Main »—- —-a o
+-[Z] Programii
(2 FB {Included with the project)
24 FE (Comman) -]
Branch
—_— - — ==
Gomment
Thoueh ————————————
(. —{=—_F
% —{E—aF
K| {2 Lo | o]
Glear logf Execution cycle: ¥ [ms] I ||
:
|\« | »[)
[ [MoT:Cinknawn

[Clear log]

Click this button to
clear the messages in
the output window.

[Execution cycle]

Shows the approximate time
between two executions of a step.
The execution cycle is determined
by the model and the maximum
number of steps.

You cannot set the execution

cycle as you want.

Icons for customizable logic

»m @ O

(4) ®) (6 ()

Output window

Displays information
such as the results of
auto assignment of

function codes.

® (9 (10

Layout area

Allows you to place symbols
to draw a customizable logic
function circuit.

(1) (12) (19)

] El B 5 & B N e B M

No. Icon name Function Rela.ted
section
(1) | Toolbox Show or hide the toolbox. 2.6.4
(2) | Project management window Show or hide the project management window. 2.6.4
(3) | Output window Show or hide the output window. 2.6.4
@ | search symbol Search symlb.ols placed on the editor screen based 2335
on the specified keyword.
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. Related
No. Icon name Function .
section
. Perform auto step number assignment and circuit
(5) | Auto step number assignment P 9 2.3.37
check.
Step number assignment . .
(6) Display the screen for managing step numbers. 2.3.37
screen
Settinas for the user settin Display the list screen of function codes U121 to
9 . _g U140 and U171 to U175, the list screen of the
(7) | area and the customizable logic | . . ) . 2.3.3.6
input/output terminal properties, and the list screen
memory area . .
of the function code settings for each step.
Write to inverter ) ) o )
(8) ) Write the edited circuit to the inverter or keypad. 2.3.3.9
(Write to keypad)
. Compare the edited circuit with a circuit in the
(9) | Comparison . P ) 2.3.3.10
inverter, keypad, or saved file.
. Monitor the operation status of the circuit written to
(10) | Monitor . P 2331
the inverter.
Create and save the signal information for using the
(11) | Save trace monitor information realtime trace function to monitor the operation 23511
status of the circuit written to the inverter.
(12) | Start/stop customizable logic Start/stop the circuit written to the inverter. -
Simplify the series of operations from [Step nhumber
(13) | Online batch processing assignment] to [Write to the inverter] to [Start 2331
customizable logic] to [Start monitor].

Toolbox

X h

box R [ 1
nalog [ Digita|+.°.na|og] FE ],—: Symbol selection tab i
1
: hd 1 You can select the desired logic type group of :
...................................................................................... '
:.v‘I”'P“‘ Rl i symbols by selecting one of these tabs. '
»- -a p- = B
] 1
Eranch —— Symbol selection list box i
1
1 1 : 1 You can select the desired symbol type by i
1
Comment I selecting from this combo box. '
___________________________________ 1
LA ‘_ T .
'.'.:'-:-h:r;g‘d:é.}; .................................................................. = : Common Symb0|s i
' :EI- E {EI- ' Input/output i
H 1
I These symbols represent an input/output '
. . : 1
i terminal. i
AND I Branch :
:. o — 1 1
ﬁ i These symbols represent a circuit branch. i
: 1
| Comment :
o i | Use this symbol to add a comment. i
H 1
- —— 1
FHEHHT Poosseeoooosoeeooosooeeooooooo '
—i Logic symbols i
#OR | This area displays function symbols of the type !
'=4| =1 = =1 = 1 :
. i determined by your selected tab and list box '
1 1
| choice |
"...' ——————————————————————————————————— !

2-52



Chapter 2 Functional Description

2.3.3.3.  Workflow of Creating a Circuit

The following is the basic workflow of creating a customizable logic circuit. The steps for creating
a circuit are described in the remainder of this section.

o)

Design a customizable logic I

function circuit

Create the customizable
logic function circuit

Step number assignment

{ (Refer to Section 2.3.3.3)

E(Refer to Section 2.3.3.7) function circuit
: using the graphical
editor tool

Write to the inverter or
keypad

\
Debug

I Draw a logic

(Refer to Section 2.3.3.9)

(Refer to Section 2.3.3.11)
Online monitor

Realtime Trace
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[1] Placing Customizable Logic Function Symbols
Select the desired symbols from the toolbox and drag & drop them in the layout area.

& FRENIG Loader ~ Customizable logic — CstmLogicPril — [Customizable logic ~ GstmLogicPrjll =0 x]
o File Menu Sep View Window Help -
DEHERe| /022 eExe@>Es 36 EEER D320EE08 B
5 FEIE Select hverter Number of use steps f_“"”i‘_‘ il | ] ] |
ustomizable Logic flo T AT =] @S| igital | Analog | Digital+Analoe | FB
No AL INV1 =] Wite | Mloritor start Ostep / 200 steps  Updat Grid <
ﬁl ;I \{ \« [Basic logic =l
i3 Programun |
Tnput/Output =
‘3 Project ‘CetmlogicFriT’ =
B3 Main »— - = =g
[Z) Programn
{20 FE (included with the praject) o, . Branch
(22 FB iGommon) ! :
i =]
e WL Commant
1o : "
TP 0 i \ A
ITPTTTPPIPPTeT, . S Theough ———————————
\ — G F
N
AND = -
’—|' oR
" I = 1 FHEHEHE
Glear Iog | Exeution cyole: * [ins] x] =
T o]
WoR -
T HEHHE.
< | _'l_I

The execution order of customizable logic functions is determined by the order you placed them

in the layout area.
Refer to "2.3.3.7. Step Number Assignment” for details.

[2] Configuring Customizable Logic Function Symbols

To configure the signal selection, timer value, and other parameters of each symbol, use the
dialog you can open by selecting and double-clicking a symbol.

Alternatively, you can open this dialog by selecting and right-clicking a symbol and selecting
[Property] on the context menu.

 FRENIC Loader - Customizable logic ~ CsimLogicPril - [Customizable logic - CstmLogicPrjl] B [=[ ]
© File Menu Setup View Window Help _ax
DEH &R /OXL W xeEsaL s e @EEEREEEDNEEEHHEE
5 Tk Select Tverter Number of use steps = 100 j« Dt | | | |
ustomizable Logic [T o =] P | & ieital | Analos | Digital-Analog | F&
No 10 TDNVT =] iite || Wonitor stert Ostep / 200steps  Updat Grid
ﬁl ;I \‘* \{ [Basic logic |
4 Programin |
hput/Output ——————————— 4|
3 Project ‘CstmlogicPriT’ B
B Main - | - -]
i [T Program0d
£ FB (Ihcluded with the project) Branch
(22 FB iCommon)
-- . _ +
Connest line
Monitar select Corart
Monitar Deselect A
Trace monitor select
Thoueh
- —{—E—=
Gopy
StepNo. / Priority setting.
aop
L
Property. 2
! L= £ B AEOoee
Clear log ‘Executmn cycle: ¥ [ms] x| =4
T | Twe ] oGol ]| Weszage
MR ——
T HEHTHE.
o | _>lJ

The properties of the respective symbols are as follows.
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Chapter 2 Functional Description

- Properties of an Input Terminal

— Function code Signal name
The function code is displayed once| Displays the code and name of the configured signal.
the auto step number assignment
completes successfully.
X
Function code  Sienal name
Set Customizelogic Sienal
(0] 14 I Ganizel
+ button Signal code setting field and [SET] button
Click this button to open the list of available signals. You can specify a signal by entering its code.
T v [ e0nt ormat coen For information on what code you can enter,
| 40z b B0 ez €l refer to the setting range for function code
4003 X3 >
[ 100834 . U02 and UO03.
0100: Mone 4006: X5 >
0000 to 003001000 to 1030)  » 4010: FWD .- =
J_ 0031 to 00591031 ta 1059} » 11 REV 3 g- . . .
0072 to 009901072 to 1098} » S029: D10} & j . For details on S|gnals, refer to "2.3.3.16. List
0101 to 01941101 to 1184) b wpoo B of Input Terminal Signal Codes".
4001 to 4033(5000 to 5033)  » 4023 13(D10Y y """
8000 to 8085 » 4024 (D10} » ﬂ-
8001 to 9007 ] 4025: 15(DI0) 3
=1 4026 6DI0) ) ﬂ
3 0TIy [
4028: 18(DIO) 3
4028: 19(DI0) » a’
4030: TIOCDIOY > 0
403100 » il-:. . _'d
TS 1700 o R I
4033 113(DIOY 3 :

[Set Customize Logic Signal]

This check box is enabled if you select a terminal input signal (number 40XX or 50XX).
Checking this check box allows you to write the "disable function" settings to the function codes for which you
configure the terminal function when writing to the inverter.

For example, when you are configuring an X1 terminal, you may want to write "100[NONE]" to the X1 terminal
function EO1.

@ e Once you have written the input terminal properties with the [Set Customize Logic
Signal] check box checked, you cannot restore the original terminal function by
re-writing the properties with the check box cleared. To restore the original
terminal function, use some other method such as editing the function code list in
the loader or using the keypad connected to the inverter.

@ o With the [Set Customize Logic Signal] check box checked, you cannot write the
properties to an analog input terminal (such as terminal 12). To disable the
analog input terminal function, set the related function codes (such as FO1 and
E61) by some other method such as editing the function code list in the loader or
using the keypad connected to the inverter.
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- Properties of an Output Terminal

internal step outputs "SO01" to "S0O200".

In the [Output selection] area on the properties screen, configure the
customizable logic output signals 1 "CLO1" to 10 "CLO10" connected to the

In the [Function selection] area on the properties screen, configure the inverter signals
connected to the customizable logic output signals 1 "CLO1" to 10 "CLO10".

Hereinafter, a customizable logic output signal is referred to as a "CLO".

Output selection

CLO assignment

Displays the assigned CLO.

When you place an output terminal symbol, an
unused CLO is automatically assigned.

To change the assignment, use the * button.

Internal step output

Once the auto step number
this
automatically populated with the step number.

completes  successfully,

— Function code

corresponding to that CLO.

Once you configure a CLO, this field is
automatically populated with the function code

assignment
field is

'+ button

Select the desired CLO from the list.
You cannot select a CLO already
used by another output terminal.

To use a CLO already used by
another output terminal, temporarily
clear the selection of that CLO for that
output terminal.
Once you configure a CLO, [Fixed] is
automatically checked.

— Fixed

Output zelection:

’_Tll_r' ol

None

1:.CLo1
+ 2:CLo2
3:CLO3
4:CLO4
5:CLO5
6:CLO6
7:CLO7
8:CLO8
8:CLO9
10:CLO10

You can select whether to allow or
disallow the auto CLO assignment by
the auto step number assignment.

[]: Allow the auto assignment
[M]: Disallow the auto assignment

x|

Functiencode  Sienal name.

Function selection: a1

—Digital Cutput

>\:‘+

SET

[T Set GLO signal to dieftal output terminal

-

— Analoe Output

[T Set GLO signal to andloe output terminal

-

o1

Gancel |

Function selection

— Function code

Once you configure a
CLO, this field is
automatically populated
with the corresponding
function code.

Digital output

Refer to the next page.

L Analog output

Refer to the next page.

Signal name
Displays the code
and name of the
inverter signal
connected to the
CLO.
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+ button L Signal code setting field and
Select the [SET] button

desired signal You can specify a signal by
from the list. entering its code.

For information on what code you
can enter, refer to the setting
range for function code U81.



Chapter 2 Functional Description

Digital Output
[~ Set GLO zignal to digital output terminal

| I

Analog Cutput
[~ Set GLO signal to analog output terminal

| I

— Digital output

Select the digital output terminal (Y terminal) you want to connect to the CLO.
Checking this check box allows you to write the [CLO assignment] setting to the function code for which you
configure the terminal function when writing to the inverter.

Digital Cutput

For example, if you select CLO1 for the [CLO assignment] setting
¥ Set GLO signal to digital output te

(see the previous page) in the [Output selection] area and select
"E20:[Y1]" under [Digital output], you can write "111 [CLO1]" to E20

Analog output

Configure the analog output terminal connected to the CLO.
Checking this check box allows you to write the [CLO assignment] setting to the function code for which you
configure the terminal function when writing to the inverter.

For example, if you select CLO1 for the [CLO assignment] setting Analog Output

(see the previous page) in the [Output selection] area and select F# Set GLO signal to analog cutput &

"F31:[FM]" under [Analog output], you can write "111 [CLO1]" to F31.

e Once you have written the properties with the [Digital output] or [Analog output]
check box checked, you cannot restore the original terminal function by re-writing
the properties with the check box cleared. To restore the original terminal
function, use some other method such as editing the function code list in the
loader or using the keypad connected to the inverter.
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- Properties of a Link Terminal (output)

]

Mumber

Connect to: @ {1 - 200

Comment:

0] 4 I Cancel

- Properties of a Link Terminal (input)

x|
Mumber
Connect from: {1 - 200)
Outy :
: ;1: i{
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Terminal number
Specify the number to identify the symbol.

The number must be unique to this
particular terminal.

Specifying a number already used by
another terminal would cause an error
during the auto step humber assignment.
Comment

You can add a comment.

Your entered comment will be displayed
next to the symbol.

Terminal number

Specify the terminal number of the
connection source link terminal (output).

Output terminal selection

From the list, select the terminal number of
the connection source link terminal
(output).

The list displays the terminal numbers of
link terminals (output) existing in the layout
area along with comments.
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- Properties of a Function Block

&

i

etc.
Step
— Step No. — Output
Once the auto step number assignment| Once
completes  successfully, this field is

automatically populated with the step number.

The customizable logic steps will be executed
in the ascending order of step numbers.

the auto step number
successfully, this field is automatically populated with the
internal step outputs "SO01" to "SO200".

assignment completes

x|
—atep
~ § . .
S No.w ouput 5001 D Logic function
Function code
Function code  Function name Once the auto step number
Logic function: La00 T AND + On% assignment completes successfully,
this field is automatically populated
[~ Logic selection with the function code.
Thput 1: /fﬁlorpen ' Normal cla )
Tnput2: * Maormal open £ HNaormal clos Function name
This field is populated with the block
selection code and the function block
Parameter 1: name.
For details on function blocks, refer
Parameter & to "2.3.3.18. List of Logic Symbols".
) Parameter 1, Parameter 2
Explanation:
i | Each logic symbol represents a
different function.
For example, the "AND + ON" delay
logic lets you specify the ON-delay
=l time for [Parameter 1].
,TI E—— For a Furjctlon Code logic, specify
the function code type and the

— Logical selection

Input 1, Input 2

function code number.
Description

Describes the functions of the logic
symbol.

These buttons are enabled for a logic symbol with digital input. Use them to specify the input terminal

logic.

For example, this feature is useful when you want to input

the logical inversion of an internal step output.

The following is an example of using a negative logic for input 1 in step 2.

Step 1

Step 2
pEE— ——
- ——
~[*H ol
A0 +0n Delay " =
OR + On Delay
T/
TP 2 TG
TF 2
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The contact symbols of - 4 and 4
represent a positive logic and a negative
logic, respectively.



- Properties of a Comment

Property

/Qommem:

cotiment

I>_/|i

Ll_L

Gancel |

oF |
comment

Connect line

Monitar zelect

Monitor Deselect

Cut
Gaopy

Trace monitor zelect

Delete

StepMo. / Prickity setting..

| Fant (M)

Property...

Caomment:

Cancel |
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Comment

You can add a comment.

[Font]

To display the [Font] window, right-click
the comment symbol and select [Font] on
the context menu.

The [Font] window allows you to change
the font size for comments.

Your changes to the font size are applied
to all comments.

You can change the font size within the
range of 8 to 99.

If you specify a value smaller than 8, the
font size is set to 8; if you specify a value
greater than 99, it is set to 99.
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[3] Connecting Logics
To connect logics, select and right-click the symbol and select [Connect line] on the context menu.

& FRENIC Loader — Gustomizable logic — GstmLogicPri1 — [Customizable logic — GstmLogicPrj1] _oj xi
> File Menu Setp  View Window Help -8 x
DEEERO/OES 2hixe sl s e BAED:SR GE28RE
]
5 Eh Select Inverter Number of use steps ,' m”f, il | | | |
ustomizable Logic e LW =] @ = . igital | Anaiog | DigitalAnalog | FE
Mo. 10 11 INV1 - iikite Ianitar start 0 step / 200 steps Update Grid o ~ i
e || ‘k { [Basic logic |
3 Frogamy |
bput/Output —— 4]
3 Project CstmLogicPrjT =
B3 Main [ - [ -]
i LJZ] Programng
12 FB {hcluded with the project) Branch
[ FE (Gommon) —_ - ==
: —
H Comment
% Conneot line A
¥ Manitor select .
Monitor Deselect = | _E
Gopy
Delete 2HiD)
ey
ron
Property. bl
4 i I < | _’I_I OR
ol St i o F—TEHEHEHEEHE
[ | Twe | Gode | Message ﬁ
XOR.
4 »

The connection line appears. Hover the mouse pointer on the red square at one end of the
connection line and move it to the symbol you want to connect while holding down the left
mouse button.

FiD

-
1 -

o

-
" -

Once the connection line is connected to the symbol, the square at one end of the connection
line changes from red to black.

e SHE

When you release the left mouse button, the square at one end of the connection line changes
from a black square to a gray circle, indicating that the connection line is complete.

F""['-— & _—
”‘-—:I |i'1- L e
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[4] Creating a Function Block (FB)

To create a function block (FB), select and right-click [FB (Common)] from the tree and select
[New...] on the context menu.

The [New function block] dialog appears. Enter necessary information and click [OK].

3 70V 1HE CetmlogicPrjt’

B2 Main

@ Programai

L[ FE (Iheluded with the praject)
[BE]FE (Commaon)

Paste

FB SelectMode
FE SelectMode Stop

Import

Mew function block =f— Name

Hame: Fea
Mumber of Inputs:@ |1 5 Number of inputs

Number f O _ Specify the number of inputs for the FB.
umber of Luitput ( !1 ? > Specify the exact number of signals you want

to use. You can also create a FB without input

You can enter a name of your choice.

(Explanatior:
el : B by specifying '0".
— Number of outputs
¢ Specify the number of outputs for the FB.
j Specify the exact number of signals you want
Ll _,l to use. You can also create a FB without output

by specifying '0'.

8114 I Cancel |

L Description

You can enter any description you want.

Ti

p ¢ You can change these parameters even after you create the FB. To change them,
right-click the FB symbol or name under [FB (Common)] in the project management
window and select [Properties] on the context menu.

@ o Be sure to specify the exact number of inputs/outputs you want to use.
The following example shows a FB symbol with the number of inputs set to 5 and
the number of outputs set to 2 placed in the layout area.

If the circuit that contains this FB symbol use four
inputs and one output only, and you perform the

il auto step number assignment, an error message
will appear indicating that the setting of the number
of input terminals differs from that in the actual logic
or that the setting of the number of output terminals
differs from that in the actual logic.

Tip e The input/output terminals for an FB are numbered 1, 2, ... from top to down.
In the above example, the terminals on the left side are numbered [Inputl],
[Input2], ...[Input5] from top to down, and the terminals on the right side are
numbered [Outputl] and [Output2] from top to down.

2-62



Chapter 2 Functional Description

Select [FB001] (or a FB with your specified name) that appears in the tree and double-click it to
display the [FBOO1*FB (Common) edit*].

J Program0 I

a Project 'GetmLogicPrjl'

E| a Main

¢ L.JE] Programin

------ D FB (lhcluded with the project)
{3 FE {Cammon)

4 Programio : FBUDI*FB(ODmmDn)edlt*E

ﬁ Project 'GetmLogicPril’

E a Main

¢ L[] Programi0

------ [:l FB (Included with the project)
ﬁ FB {Comman)

To edit the internal customizable logic functions of a new function block, do the following steps:
(1) Place input/output symbols in the layout area.
(2) Assign the required functions to the input/output symbols.
(3) Select the logic symbol from the toolbox, configure the logic, and connect the input/output
symbols.
An example is shown below.

To edit the input for the FB, select [Function block input] -> [Input1].

“ FRENIG Loader - Gustomizable logic - - [Customizable logic =] ]
- 5 X

Z> File Menu Setup  View Window Help

DEH &R /O35 (PWke e s e BRES (8 EE|EE

[ x|

elkst Ty Moty @ oes sers

Customizable Logic Digital | Analog | Digitakt Analog | FB
= Wo. Il I =] e | blenier st Ustep £ 200 steps Lipdate Grid \+{ { | | | [ ] o
Basic logic hd

[ FProgramn FBO01 +FE (Commen) editk |
putfOutput ———————————— 4|
3 Project TstmLogicPrj T
B3 Main - - [ -]
[Z] Proeram0n
(2 FB {lncluded with the project) e Branch
R FB(Commor) [ P — -
[ FeO01 i —t —_— _|_
)
Comment
Function code  Signal name
bot [ = [ = A
100 Hone:
™ Set GustomizeLoeic Sienal 1000 4o 0030C1000 42 10305 » Through
0 - 0031 to 059E1031 to 1058)  » . - i=l
ance|
0070 to 00991070 to 1098} »
0101 to 019401101 10 1194)  » - @
4007 to 403305000 to 5033} » D
6000 to 6007(7000 to 7007} » =
{C—CHCEHEHEHE
000 to 8065 »
9001 to 9007 3 ._-,
4 | AL | (= HEd
Function black input v hw( 1 [;

Clear log ‘Exenut\un cycler 2 [ms]

[ | Twpe | Gode | L=e ﬂ_ﬂE
2
4] | Ll_l
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To edit the output for the FB, select [Function block output] -> [Outputl].

< FRENIC Loader - Customizable logic - - [Gustomizable logic - CstmlogicPrjl] oy =] 3
> File Meru Setup  Wisw Window Help -8 x
DsdSRo THXLPEFOEHL S BlxEaIEIHEEEE® |

Select Inverter Numbar of use steps 100%
Customizable Logic @) & - Digital | Analog | Digital+Analog | FB
B No. IL INVT ] Whice | Wlanior start Dstep / 200 steps | Update Grid d’{ = | o | igta Aol | I

p [Basic logic |
[ Program00 FBODT #FB {Gommon} edit+ | ;
put/Output ——————————————————————— ~|

13 Project OstmlogicPrj "

B3 Main - - [ -]
[Z] Programon

(21 FB {Included with the project) - o Branch
15 FB (Common) »—
= Pt - -~ 4+
Property x|
Gomment

Function code
Output selection: | - I — = | F| Fived A

Throueh

Function code  Signal name . . ol
Function selection: [ — [ [r el =
0100: None
[ Disital Qutput ———— 0000 15 003001000 to 1030) @

I™ Set GLO sienal to dieital output terminal 0082 10 00581032 to 1058) A
jv 0060 to 009901060 to 1087)
{=HEk* HO

—#nalog Qutput 0130 10 019401120 to 1194)
Qutput 1 I L

il | » [l | I~ Set OLO signal to analog output terminal G000 o G0

- Funstion black output
Glear log ‘Execuhnn oyole: 2 [ms]
e S - FH—HEEHEEHE
=
4 | _'l_l

Tip ® Youcan select [Function block input] and [Function block output] on the FB edit tab
only.

When you are finished editing the FB, select and right-click [FB (Common)] from the tree and
select [Save] on the context menu.

“ FRENIC Loader - Customizable logic - GstmLogicPrj1 - [Customizable logic - CstmlogicPrj1] -0 5‘
T+ File Mens Sewp View  Window  Help .8 x
DEEEGRO /ORI (PHIXKeEI>EHLIE DlaEEEEEEEE@®
Select Tverter Number of use steps 100}%
; 7 @ [ | = | vital
Ou=miEl:s Lo Mo 1L TTINVI  [=]  White || Motor stert Ostep / 200 steps Update arid d'{ = e [

|Basic loeic =
4 Prosramii FEDUI*FE(CDmmun)ad\(*l

put/Output ]
3 Project TstmLogicPrj T =
1423 Main »- - b= =
-] Program00
~+{Z1 FB (lcluded with the project] Ineut | g Brarch
24 FB (Common) = ..
=l EEmR 0 —_. -0 |
Open
Comment
Save B
- A
Copy Through

Lock.
Unlock... _@'
Export AND

<| ) Y
Glear log ‘Exacutmn oycle: 2 [ms]

OR =

N
4| I B

o e
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Once you save an [FB (Common)], the FB symbol appears on the [FB] tab of the toolbox.

Tool box X
Digital | Analoe | Digital+fnaloe
|FB =

Thput Output

»—- - >»> X

Branch
1 1
| |
Comment

i FB (Common)‘g

FEON

Tip e Once you save an FB (Common), you can use the same FB in another project.

Return to the [Program00] sheet, select the FB symbol from the toolbox and drag & drop in the
layout area.

& FRENIC Loader — Gustomizable logic — — [Customizable logic ~ CstmLogicPrjl] =101 |
D File Menu Setp View indaw Help -8 x
DEESR_e | O (2 kedrsee SeHEEHRDEE00DEEE |
5 o Select Inverter Nurmber of use steps ‘{_“””f_‘ | | o
ustomizable Logic e i 00T =] P @ ([ Digital | Analog | Digital+Analog
Mo, 10 11 IMW1 | ite Ienitar start 1 step /' 200 steps Update Grid i
e | vt | [ s oo | _on | RIS P8 -
4 Program00 | FBOO1 *FB (Common) editt |
put/Output
A Project 'CstmlogicPrj1" =
EFZH Main | - » -
i i3] Programon

QFBeohded withthe project) | e, Branch
23 FB (Gomman) : s

3] Feo0 e — H . ¥ -+
= =

D+ On Delav 3 H Gomment
0 A
TPow s
FBtommonk

FBOOT |}

4 |

Clear log ‘Executmn oyole: 2 [ms]

& b

[ | Twpe | Code | Message
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Once you place "FB001_1" in the layout area, "FB001_1" is added to the project management
window. Select and double-click "FB001_1" to open the edit tab for "FB001_1".

S FRENIC Loader — Gustomizable logic — — [Customizable logic — CstmlogicPrjll

Ir File Menw Setup  Wiew  Window  Help

DSE&ERo /022 2 xed> LS BEAES HEEA=E
[
Select Inverter Mumber of use steps

Customizable Logic . ;
I = [No i0 T =] ibite | benitor stare | Ostep / 200 steps  Update | arid |

a Project GstmlogicPrl' | T

B3 Main

L @ Programii =]
323 FB (nclued with the prajest) e 5p————amo
5,,,|,@_FB_U@_1'| ALK -
a_ FE {Common) *e
L[] FeO0Y

@ e "FB001_1"is an FB that belongs to the project and therefore is handled
separately from FB (Common) "FB001". Changes made to either of the two FBs
will not be automatically reflected to the other.

Tip ¢ You can check the circuit you edited with the auto step number assignment.
For more information on the auto step number assignment, refer to "2.3.3.7. Step
Number Assignment".

@ e The function blocks (FBs) under [FB (Common)] are not checked by the auto step

number assignment. To check the function blocks (FBs) under [FB (Common)],
you should add them to the project.
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2.3.3.4. Precautions to Take when Creating a Circuit

[1] Timer Time
A circuit that uses a timer does not operate exactly according to the timer time setting if:

The timer time setting is smaller than the execution cycle

The timer time will become equal to the execution cycle if the timer time setting is smaller than
the execution cycle.

Example: If the execution cycle is 20 ms, the timer time setting of 0.01 s is changed to 0.02 s
when the circuit operates.

The timer time setting is not equal to a multiple of the execution cycle

The timer time will be rounded up to the next multiple of the execution cycle if the timer time
setting is not equal to a multiple of the execution cycle.

Example: If the execution cycle is 20 ms, the timer time settings of 0.03 s and 0.05 s are
changed to 0.04 s and 0.06 s when the circuit operates.

[2] "CLC" and "CLTC" Functions of General-purpose Input Terminals
The "CLC" and "CLTC" of a general-purpose input signal are signals for customizable logic.

"CLC" : Allows you to stop the customizable logic circuit operation.
"CLTC" : Allows you to clear all the customizable logic timers.

However, you cannot set "CLC" or "CLTC" (E01=80, 81) in the [Function selection] area on the
editor screen.

To configure these functions, use some other method such as editing the function code list in
the loader or using the keypad connected to the inverter.

[3] Circuit Read From the Inverter
The editor screen cannot display a circuit read from the inverter.

However, you can load a circuit as a function code by selecting [Function code edit...] -> [Read
from the inverter] from the Quick Access menu (or, for some models, checking the [Open the
customizable logic setting screen] check box).

[4] Function Block 3001: conversion 1, 3002: conversion 2
To write a circuit to the keypad and then write it to the inverter using the keypad's copy function,
use [Manually set the conversion coefficient].

The [Auto calculate the conversion coefficient] setting is ignored by the keypad's copy function.
Even if you set it, you cannot write the circuit to the inverter.

When you write the circuit directly from the loader to the inverter, you can use either [Manually
set the conversion coefficient] or [Auto calculate the conversion coefficient].
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2.3.3.5.

Useful Features

[1] Undo/redo
You can select the undo or redo command from the right-click menu of the layout area.

' 551

H -
A+ 0On Delay
Fazte TG
TF
[Inda D
Feda >

Undo

You can undo up to 3 previous layout changes such as

moving and deleting a symbol or connection line.

You can also use [Ctrl] + [Z].
You cannot undo changes to the properties.

[2] Copy/paste

T -

—

Conrect line

Maonitor select
Monitor Deselect

Trace monitor select

Cut

Copy

Delete
StepMo. /£ Priority setting...
Fant (M}

Property ..
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Redo

You can redo the last action. You can also use [Ctrl] + [Y].

You can select the copy command from the
right-click menu of a symbol. You can also
use [Ctrl] + [C].

You can select the paste command from the
right-click menu of the layout area (rather
than a symbol). You can also use [Ctrl] + [V].



Chapter 2 Functional Description

[3] Range Selection

You can select a range by dragging the mouse pointer in the layout area while holding down the
left or right mouse button.

Once you release the mouse button, the symbol(s) in the range is selected.

FWo

BB
i}

&L= £

|- =
— -

AD + On Delay

1

T/C
TP 2

Tip e You can select all the symbols by pressing [Ctrl] + [A].
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[4] Symbol Search

The [Symbol search] feature allows you to search for a symbol in the layout area.

Click the [Symbol search] icon on the toolbar.

R B G EQE B EEE

My
Humber of USy mbal search

| 0 step /200 steps

|
Update | Grid |

The [Search] dialog appears.

10n%

K&l

x|

Condtion P

[~ \Step number (1)

ogic name [2)

Bres, |

*

Condition
. Combo box

Enter the search keyword.

r
I~ logic number (2}
[ In/Out terminal number {4)
[T h/0Out sienal name (&)

[T Link terminal (froms/to) (G

[ [Gomment ()

Search |

—Search results

Search result

Mo. |

Frogram name

Check boxes

Use these check boxes to specify the search
conditions.

If you check two or more check boxes, they will
be ORed.

Once you select at least one check box, the
[Next], [Prev], and [Search] buttons are enabled.

Search results
The search results are displayed.

When you double-click one of the search results,
the focus moves to the matching symbol.

The following is an example of searching for symbols that use an X terminal as an input terminal.

Condition: I}{

[ Step number (1)

[T Logic name {2

[~ Logic number (3

[T Ih/Out terminal number (4)
¥ In/Out zignal name (&)

[7 Link terminal {from/ta) {6}
[~ Comment ()

j Mext |
Frew |

Search |

X

Search results

Mo. Program name Search result

1 |Program0n 4001: X1

Out-Freql

&

Double-clicking one of the search results moves the

focus to the matching symbol.
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2.3.3.6.

Settings for the User Setting Area and the Memory Area

You can use function codes U121 to U140 and U171 to U175 as you want.
You can use these function codes as analog inputs by reading them with the function code read

logic.

For example, when you want to double the input of terminal 12, you can use function code U121
by setting it to the constant of 2.00 as shown below.

Step 2 434
ALY ey g s Lot
' —— o-gm
. X JT\ 43 4
StEp 1 h"i.l|‘ti|:l|'l.l'
Read UL o100
L0

___________

To use function codes U121 to U140 and U171 to U175, click the [User parameter/Customizable
logic storage area setting] icon on the toolbar.

find o
) =

=2

Help
SR A= - B S

> E

il [5] EIE %J Sl falc]

Select Iverter

[Mo 1L TIT =] kit | Benitor st |

The [User parameter/storage area,

— Logic version

U197 and U199 read from the inverter.

—Q_Iser parameter & storage | Thput # Ou .@

V\}USer parameter 4 Customizable o

Number of use steps L (=3 istorage area Settllj'lg-L
0 step / 200 | | Q[ e

step steps Update Girid { —{ k
IElaSi

input/output and logic] window appears.

Clicking the [Read from the inverter] button on the [User parameter/storage] tab displays the settings of function codes

User parameter / storage area. input f output and logic

Logic check

Function code name

Customizable logic (User parameter 1)

Customizable logic (User parameter 2

Ihwerter zetting value
{before initialization)

You can view the list of the settings
for each step.

123

Customizable logic (User parameter 3)

0.

124 Customizable logic (User parameter 4)

n.an

— User setting area
- Customizable logic storage area

— Input/output check

You can view the list of the settings of input and output terminals.

You can edit function codes U121 to U140 and

U171 to U175.
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Open the [User parameter/storage] tab.

— Inverter settings before initialization
You can configure the settings of function codes U121 to U140 and U171 to U175.

If you open this window by clicking [User parameter/Customizable logic storage area setting] on the toolbar, '0.00'
appears.

If you click [Write] or [Write to the inverter] and have this window automatically displayed upon completion of write, the
settings read from the inverter before write appear.

User parameter / storage area. input / output and logic x|

{lser parameter 7 storage | Input / Qutput | Logic |

Logic Version:

Tnverter zetting value

{before niialization)

w121
U2z

Gustomizable logic (User parameter 1)

Customizable logic (User paramstar 2,

000
000

U2z

Gustomizable logic {User parameter 3

oon

U2

Gustomizable logic (User parameter &

oo

ui2s

000

U126

Customizable logic (User parameter 6,

000

uiaz?

Customizable logic (User parameter 7,

i)

unza

)
)
)
Customizable logic (User parameter 5)
)
)
)

Customizable logic {User paramster 8

oon

ur2g

Gustomizable logic (User parameter 8)

oo

uisn

Gustomizable logic (User parameter 10)

oo

st

Customizable logic (User parameter 11)

000

U3z

Customizable logic (User parameter 12)

000

U133

Customizable logic (User parameter 13

i)

[LAKE

GCustomizable Iogic (Liser paramster 14

oon

u13s

Gustomizable logic (User parameter 15

oo

U136

)
)
)
)

Customizable logic (User parameter 16

oo

sz

Customizable logic (User parameter 17)

000

ui3g

Customizable logic (User parameter 18)

i)

U3

Customizable logic (User parameter 19)

i)

NAEYI]

Customizable loeic (|lser parameter 200

00n

Write to the inverter

(Write to the keypad)

Bead from the Inverter
Class

Save param file... Load param file.

Wirite to the Inverter

Write the settings of function codes
P U121 to U140 and U171 to U175 to
the inverter or keypad.

Save param file — Load param file

Click this button to save
the settings to a CSV file.

— Read from the inverter (Read from the keypad)

Click this button to load a Click this button to read the settings from the inverter or
saved setting file. keypad.

Configure necessary settings in the [Inverter setting value (before initialization)] column.

When you finish configuring the settings, save the parameters by clicking [Save param file].

@ e Once you close the [User parameter/storage area, input/output and logic] window
without saving the settings, they are lost and will not be restored the next time
you open the window. Whenever you want to save the settings, be sure to click
[Save param file].

Before writing to the inverter, check that the inverter can operate safely if function codes U121 to
U140 and U171 to U175 are written to it.

e You can write function codes U121 to U140 and U171 to U175 while the inverter
is operating and while the customizable logic function is starting but the inverter
may exhibit unexpected behavior, which can be very dangerous.

If you cannot ensure the safety, stop the inverter and the customizable logic
function before the write.

Tip e The [User parameter/storage] tab is not available with inverters that do not have
function codes U121 to U140 and U171 to U175.
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2.3.3.7. Step Number Assignment

Once you created a customizable logic function circuit, you have to assign step numbers to the
respective symbols and FBs. There are three methods of assignment.

Tip e The customizable logic functions are executed in the ascending order of step
numbers.

Assignment method 1: Auto step number assignment (function check)

Click the [Step No. automatic allotment] icon on the toolbar to perform auto step number
assignment and circuit check.
File Menu Setup View Window  Help

Ir
NEFH&R O /OXL PEXe @ s e ERERRD B0 EE A @]

mﬁpNo. automatic_allatment] |—
T

l— Select Inverter Mumber of use
Customizable Logic . ; |
£ IND. 10 11 TN - il ite | Manitor start | 0 step / 200 steps Update | Grid | |

If no error is detected as the result of the circuit check, step numbers are assigned.

= FRENIG Loader — Gustomizable logic — GstmLogicPrjl - [Gustomizable logic ~ GstmlogicPrj1] o [=] =
I File Menu Setup View Wirdow  Help -5 x
DEE RO OE2 7Hxed>H: s e BEEER 8888 EE
3 R Select hverter Nurmber of use steps = ‘""f“ il | | | |
ustomizable Zic lﬁ . +) (=) . ieital | Anslog | Digitak+Analog | FB
No 1L TINW1 | White | Bonitor stare Istep / 200 steps  Update Grid NS i
—I —I & { [Basic loeic |
4 Progamid |
Input/Output Al
3 Project CatmlogicFrjT =
23 Main [ - - -]
t i-[Z] Program0
i{2] FB (Included with the project) Eranch
{4 FB (Gomman) o
i3] FB001 - o —r —_ _|_
- -
Comment
Twoueh ————————
—{E—{=—F
AND
o I3 O HEHEHEF
Glear log. ‘Exel:uhun cycle #% [ms] x || G
TR = 5 F—THEEHGEHE
1) [Information 2017-09-25 131255 Logic check end. Errorl , Warningl
i) |Information 2017-08-25 131255 The allotment of the function code nas started
i) Information 2017-09-25 131258 The allotment of the function cods was finished
> o —————————— o _’Ij
-
Step numbers are assigned even if a warning occurs.
= FRENIG Loader — Gustomizable logic — GstmLogicPril — [Gustomizable logic — GstmLogicPrjl] _1ox|
o File Menu Setp Wiew Widow Help -
DEE SR o OE2 (2HxedsH: s e BEE:R 88 ERAEE
5 h Select hverter Nurmber of use steps = ‘""fn Gl | | | |
ustomizable Logic [Fe T TR =] Wi o) | | igital | Anslog | DigitabAnalog | FB
No 1L TINW1 | White | Blonitor stare Istep / 200 steps  Update Grid NS i
—I —I { { [Basic loeic |
L3 Progamid |
Tnput/Output Al
'3 Project CatmlogicFrjT =
G423 Main »—- -a- p—- =
i i-[T] Programiin
(2] FB (Included with the project) Branch
3 FB (Gommon)
i-[g] Feo0l FID e —— _|_
-
Comment
Twoueh ————————
—{E—{E=—F
AND
) i BiSE =
GClear log ‘Execumr\ cycle 2 [ms] x| 02 . . .
1 1 1 =
TGl o -
ij Information 2017-08-26 13:17:33 Logic check start. H
A\ |Warnine 0100 _|The Output 1 of AND + On Delay is disconnected
Information 2017-08-25 1%17.33 Logic check end. :Errorll, Waming 1
Information 2017-08-25 1%17:33 The allotment of the function code s started T _>|j
) nfrymatioe 117-08-25 13:17:33 The allatment of the function code was finished > =
shiomatig e e e e
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If any error is detected as the result of the circuit check, step numbers are not assigned.

= FRENIC Loader - Customizable logic ~ GstmLogicPrjl - [Gustomizable logic - CstmLogicPrj1] -0 x|

o Ele Mo Setup Mew Widow Help -

D ERo | OEL XA LHELE =IEEEEEEREE |
100 %

Nurmber of use steps

Select Iverter
Customizable Logi @ = Digital | Analog | DigitakAnalog | FB
LEneImEEE e No Il TN =] White || Monitor start Tstep 7 200 steps Update Grid d’.‘ | [ ol | ittt | I =

[Basic loeic
4 Frogramil |

Tnput/Cutput gl
4 Project ‘CstmlogicPrjT
B3 Main »— -a = =
i i[T] Programin PO TR
i FB (Included with the project) Branch
3 FB (Common) .
S5l Fomn - - —_ -0
f o
Gomment
0 A
TP 2
Through

e E

4] 1]
Clear log \Execumn cycle: # [ms] 3 R
T T e g 5 F—THEH=Ha=HE
) [Information 2017-08-25 13:21:33 Logic check start
IED 0100 | The Input 2 of AND + On Delay is disconnected
AL [Warnine 0100 |The Output 1 of AND + On Delay_is discannected o
IR 0100 | The Input 1 of Output_is disconnected H [ =
g JE— |
: 5 &
LI < MI=77 aLipe it conssted

If this is the case, you can double-click the warning or error message displayed in the output
window to jump to the symbol in which the error occurred.

& FRENIG Loader — Gustomizal ic - GstmLogicPrjl - [Gustomizable logic — GstmLogicPrj1] _1ol x|
4> Fil Menu Setup View MWindow Help _ &%
Deld SR v LIRHIXeEDHE S E Bl8EaREEE |

Select hverter Number of use steps 1%
. . @ o= Digital
sustamzae Lage P =l e | e | i e | en | R|R] | = onlbaiminlie )
Basio logic -
x| ngramﬂﬂl —— =
3 Project CstmLogicPrjT"
B2 Main [ — - -]
i iw[Z] Prosram0n
(2] FB (Included with the project) Eranch
3 FB (Comman) %
i) roont " : - — 4
m— :
: Comment
Thoueh
— G5
AND
" i | EET
Glesr o | Execution cycle: % [ms] x] O; - = =
1 1 1 3 A R
T oo — -
1) [ Pformation 2017-09-25 182199 Loeic check start.
@ [Enor 0100 |The Input 2 of AND + On Delay is disconnected
i Wifawning. « . |« LD, . [Tha Cuatput .ot AND % O Dela e, dissonpestad.
Frior 0001 |line is oot connected -4 E—
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- Rules of auto step nhumber assignment

The rules of the auto step number assignment to customizable logic function symbols are

as follows:

(1) The step numbers are assigned in the ascending order from top to down in the layout area.

(2) If two or more symbols are at the same height in the layout area, they are assigned step
numbers in the ascending order from left to right.

& FRENIG Loader - Gustomizable logic - GstmLogicPrj1 - [Gustomizable logic - GstmLogicPrill =101 x|
> File  Menu  Setup  View  Window  Help -8 x
DSEISRe | /0Z ke dsWe s e BREESIEDEIEEE3EE |
IW Select Iwerter Humber of use steps e m”f_ - TR '|
Lotombabel o lMTT[ it | et ot | [ e samse | wpawe | e | LS| IE IO::‘ﬂel ezl [FD_| =
X | Program(0 -
=4 Project GstmlogicPrjl’ || e -
i — Smaller step numbers I:> Larger step numbers » - p <
{21 FB (Included with the project) Branch
3 FB (Comman; J —r—
[7] FBOM (1) (2) (3) —_— —|—
Comment
4 A
Through ———————————————————
®) ®) oG
(7) AND
B—THEH*HEHEHE
Larger step numbers
o I3 ) | Lo LEHEHEHEE
Glear Iog | Execution cycle: % [e] x| — =
T T o | e CH—EHE ST
- -
A f—
An example is shown below.
Step 1 i
S =1 D 1:2 @) See i (3)
< o»—— | < .| { I -
I & ey OR Fize Edge
I Sfep 4i 4
% — ) OR
* -
xOR
Step 5 (5) XOR Step 6 (6)
! > S -
w5 R Q E o d H r — -4 D
SR-FF Eath Edee + Off Delay

7 TG
st 7 (7) TP 2
I
1 D_ I H | _- 551
Through + On Delay

T/C
TR 0

In the above example, the XOR circuit is assigned Step 4, and the OR circuit Step 2.
As the result, the output of Step 4 is connected to the input of Step 2

In this case, the output of Step 4 is input to Step 2 in the next execution cycle.

Execution cycle

Execution order

Current cycle

Next cycle

1) -> 2 ->@©)->(4)-> ) ->6)-> 1)

/Output of Step 4

@) > (2) -> (3) > (4) -> (5) > (6) -> (7)

To input the output of the XOR circuit to the OR circuit in the same execution cycle as the
OR circuit, adjust the positions of the symbols.
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The following example shows the result of moving down (2), (3), (6), and (7) shown on the
previous page and then performing the auto step number assignment again.

Step 1
xl
- — &
e
D
'StepS Step 4
w2 - .21
x4 1
- - - 4
OR
Step § XOR oR Fize Edge
e - OR
* - R _°
SRFF
Step B
|
-~ l——| — -4 F#D
—
Eoth Edege + Off Delay
Step 7 ?;O 3
[ — ’
1 D- H I - =
p— |

Through + On Delay

T/C

TF 0

Now the XOR circuit and the OR circuit are assigned Step 2 and Step 3, respectively.
This means that the output of the XOR circuit is input to the OR circuit in the same
execution cycle as the OR circuit.
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Assignment method 2: Manual step number assignment

You can opt to manually assign step numbers.
To do so, select and right-click a customizable logic function symbol and select [Step
No./Priority setting] on the context menu.

S FRENIG Loader — Gustomizable logic ~ GstmLogicPrjl - [Customizable logic — GstmLogicPrjl] _1o x|
o File Mens Setp Viem Windaw Help -
DEESRe 7682 tExedsRS s [@EE2EE0 0L OLIARDD |
]

[T s | Select hverter Hurmber of use steps = s | Diit s | |

Customizable Logic ffo T T =] @ || Digital | Analog Dieital*fnalog | FE

Mo AL INVI v Sinie | Wonitor start Ostep /200 steps  Lpdate Girid =
—I —I { [Function Gode 3|
[ Frozramtl |
Tnput/Qutput
‘3 Proiect OstmLogicPri 1" -
B2 Main o »—- - p—- =g
2] Frosramil e = -

{21 FB (Included with the project) O, | Eranch
{23 FB (Common) AT+ On Dalay

& B0t - — 4+

TG
P Cormment

E: ................ A

Function Gode

: .. ’ W
i | W anctin cods | 1 =
: i Gonnect line

: H - oo

i *  Monitor select

"""""""" Monitor Deselect

Trace maonitor select

Cut =
4 P 1) T Cery o
Delet
Olear log | Execution cycle: * [ms] e a

StepHo. / Priority setting

[ | Twe | Code | Message
Font (N)
Property
Specify your desired step number.
< FRENIG Loader — Gustomizable logic — GstmLogicPrjl — [Gustomizab _1af x|
o File Menu Setp Wiew ‘Window Help -
D @Ro| 78032 eMxeds>Pe e EEDRRBDREDNLOEHRARR |
]
= T Select Inverter Number of use steps ,_“””’:_‘ | it | |
ustomnizable Logc [feo T TH =] A == Digital | Analoe Diitel+Analo | FE
No 1L 11INW1 o] Uhitz | Monitor start Ustep / 200 steps  Updats Grid W | 4
i‘ ;I { { [Function Gode =
3 Frogamil |
Thput/Output
{4 Project 'CstmLogicPrj1' =
553 Main -, »— -- = =
5] Froeramii | ot mmm— ? -
{23 FE (hcluded with the praject) LU = Branch
75 Gomnor T i
8] Feooi —_ 04— =
T/C StepNo. assigned automatically
IR Gomment
User fssign—————————————————

A

WEFreT

i vite
oo

& | Whting function code | 3 Priarity i
i N

* When assiening a step number, a "stepMo.”
and “priority” can be specitie

Funetion Cade

q v L |

Claar Iog | Exeoution oyols: & [ms]

g e

[ 1 Twe | Gode | Messaze

Click the [Step No. automatic allotment] icon on the toolbar to check the edited circuits.

File Menu Setup  Wiew Window  Help

r
DEHSRO /O 2w xeE>»Ey s EONORRARD B0 00@H 3]

[5idpo. automatic allotment] I
=

l— Select Inverter MNumber of use
Customizable Logic . ; |
d INo. 10 11N 'I irite | Monitor start 0 step / 200 steps Update | Grid | 1

@ ¢ You have to perform the auto step number assignment even if you have manually
assigned a step number.
Without performing the auto step number assignment, you cannot write to the
inverter.
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@ o If the inverter is one in which the execution cycle depends on the maximum step
number and you specify a larger step number, the execution cycle will follow the
specified step number even if you use one step only.

Assignment method 3: Step number priority setting

You can specify the priorities applied when automatically assigning step numbers.
To do so, select and right-click a customizable logic function symbol and select [Step
No./Priority setting] on the context menu.

& FREMIG Loader — Customizable logic ~ GstmLogicPril — [Gustomizable logic ~ CstmLogicPrjl] ] 3]
> File  Menu Setp Viem ‘Window Help -8 X%
DzEHE@Ro| /022 eMxerEsPHe s EEERBEDNOD6AR® |
l— Select Iverter Number of use steps mn L | Ditale ek | |
Customizable Logic [t T =] . Digital | Analos Digital+Analoe | Fg
No ([ INWT v rite | Wity stare Ustep / 200 steps  Update Grid i
—I —I [Function Code =l

[ Programid |

Tnput/Output

i Project GstmlogicPrjT

B3 Main o [ - [o— -]
[Z] Programin e -H -

++{2 FB (Included with the project) e — | Branch

23 FB (Gommen) 6D+ On Delay.

i) roonn _ e =
e
TRt Comment
Step 2 A
tfren! g —

@ Function Gode
e F—

Whiting finction eode  o=%"

i :  Cornect line
2 Monitor select
=| I Manitor Deselect
2 Trace monitor select
Ioout
-------------- Ci -
4 1] Lol | opy ’_d
Delete i
Glear log ‘Execmmr\ cycle: ** [ms] P T PP PP PPP PP Nx]
T e [ooe] = Stepho. / Priority setting. o
Fant (N)
Praperty..

Specify your desired priority by entering a number equal to or greater than 1. The smaller the
number, the higher the priority and the smaller the step number assigned.
« FRENIG Loader — Gustomizable logic — GstmLogicPril - [Gustomizable logis =10l x|

3> File Menu Setup  View Window Help - 8 X

DEHERO| 70822 2K XxeEsHg s BERREEED HIODDEEBE

TUU%

[Gusmomeate Tge Select Iverter Number of use steps | Dt s | |
Customizable Logic l—_[ . * "Digital | Analog Digital*Analog | FB
No. 1L TIINW1 = Gifit= | Honitor start Ustep / 200 steps Update: Grid i
—I —I [Function Code =l

£ Progamid |

[ Tput/Output
3 Project CstmlLogicPri1" u
B3 Main - »—- -a- - =
[5) Programin - — -
] FB (Ihcluded with the project) Op—-—
£3 FB (Qamman) yrryih Dg‘ ™ Priority / Step No_ setting x|
-2 FBO0I —_— ==
@ 16 Stepho. assigned automatically
PO
User Assien |
Sep s Stephlo
t-Frent g [ -
om0 | e, =]
WHTINE Fncticn code & 1% Briority —. .
it 5 —I
o thhen assigning a step number, 3 “stepho”
and “priority” can be specifie:
< 1x] sl |
Glear log ‘Execmmr\ cyle: o [ms] a
[ 1 Twpe | GCode | Message
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Click the [Step No. automatic allotment] icon on the toolbar to perform auto step number
assignment.

File findow

DEH &R0 /O 9 X ED
| I Customizable Logic

Menu  Setup  Wiew Help

¢ % & REER{ENE B (60 EHH R
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0
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o | Select buerter Number of use steps 108 W‘Wﬂ
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Thput/Output
13 Project GstmLogicPr] T o s =
B3 Msin - = » -a p— =
[) Programin g — -
{23 FB (Ihcluded with the project) A - Bl
423 FB (Commen) D On Dery
-] Feonl _-_— e
TG
TR0 Comment
Step A
ut-Frest
N - Function Gad
ol +—
s [
Step |
uin
-
Fesdne Ainction cods
U1t
4 13 Ll | _>l_I
Clear log ‘Execuhnn cycle: % [ms] x|
Type | Code Message -
i) |Information 2017-08-25 18:20:53 Logic check end. Errorl . Warning |
1) |Information 2017-08-25 182063 The allotment of the function code was started
1) [Infor mation 2017-08-25 18:20:53 The allotment of the function code was finished
L e S —

The above three step number assignment methods are prioritized as follows:
Auto assignment < priority setting < manual step number assignment

To check the step number assignment

The step number assignment screen allows you to view and change the assignment status.

File Window

FESRG /O 2EKe > S e [BEEES

Select Inverter
Customizable Logi l— I | |
ustomizable gic Mo, 10 1] NV - Wiite lanitar start

Menu  Setup  Wiew Help

a3
{¥4epho. assign window
MNumber of uze stepz

3 steps / 200 steps Lpdate | Grid | |

.9
s

GstmLoeicPrjl]

=10ix]

Ywhen use the Automatic allotment function, The StepNo. will be allocated order of [Top to Battom] and [Left to Right] by every program

find you can chanee the Automatic alltment function's allocate order by manually as following the order of prior ity
fssien 1and 2 in window, and push [Auto Layout] button

1. Assigned stepNo. by use. Assigned stepMo. by user fized check

2. Assiened priority by user setting

3. Display location (Top ta Battom, Left to Right)

Information : Order of line connection will not considered in automatic allotment

If backeround color is gray, which iz invalid data.

Mo | e oo | MELAG™ | Umoe | Uredie | R
PG Proeram00
2 AND + On Delay 3 r
3 Wtiting function code 2 2 2
] Reading function code 1 r 1

All fixed setting is tumed OFF. |

|The uged number of steps: 3 (The number of the reserved Steps:0) / The number of steps which can be uzed : 200

Get uger-defined [Order of priority, StepMo]

information from layout information

Automatic allotment
execution

Cloze
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2.3.3.8.

Circuit Check

You can view the lists of the input/output terminal properties and the settings for each step.

Click the [User parameter/Customizable logic storage area setting] icon on the toolbar.

Window  Help

IR (?HIXe > S ([EEER R

%J SEEIE]E

Select Iverter

[Mo 1L TIT =] kit | Benitor st |

Mumber of uze steps

0 step S 200 steps Update I

lﬂ‘}USer parameter 7 Customizable logic storage area setting]

Grid |@ Q o
IElaSi

The [User parameter/storage area, input/output and logic] window appears.

Tip

¢ A limited set of functions is available with some inverter models. Refer to

"1.1.2Loader Functions by FRENIC Series Inverter Model" for details.

[1] Input/output Check

To view the list of the input/output terminal properties, open the [Input/Output] tab.

User parameter / storage area. input / output and logic

_

User parameter / storage  Iiput / Output | Logic |

Logic Wersion:

—Ihput terminal

Output terminal

x|

GLO0

4001: 1 Mormal Open
8000 Out-Freql
400% X3 Mor

Allozation

e |Exclu3|ve | Terminal |

oooo Mo =

( Save CEV file.. | )

Close
Gl | y

Input terminal
Allocation number

Shows the signal code of the input terminal.
Exclusive

Displays [Yes] if the [Set Customize Logic Signal]
check box is checked on the input terminal properties
window.

Terminal

Displays the function code assigned to the terminal
function if [Exclusive] is [Yes]. You can write the
"disable function" setting to this function code when
writing to the inverter.

Description

Displays the assigned number and signal name.
This signal name is the same as shown on the input
terminal properties screen.

[Save CSV file]

Click this button to save the displayed information to
a CSV file.
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Output terminal —
Name

Displays customizable logic output signals 1 "CLO1" to
10 "CLO10".

Allocation number

Displays the inverter signal codes connected to
customizable logic output signals 1 "CLO1" to 10
"CLO10".

Exclusive

Displays [Yes] if the [Output terminal digital] or [Output
terminal analog] check box is checked on the output
terminal properties window.

Terminal

Displays the function code assigned to the terminal
function if [Exclusive] is [Yes]. You can write customizable
logic output signals 1 "CLO1" to 10 "CLO10" to this
function code when writing to the inverter.

Description

Displays the assigned number and signal name. This
signal name is the same as shown on the output terminal
properties screen.



Chapter 2 Functional Description

[2] Logic Check
To view the list of the settings for each step, open the [Logic] tab.

User parameter / storage area. input / output and logic

Logic Wersion: I I

User parameter / storage | Thput / Cutput Logic |

—Logic
Step Mo\ | Func Mame | Func 1 | Th | rml | Prm2
2 Feading function code G001 - - 39 hal
3 + On Delay oo 4010 40m 2 -

& Save 05V file.. m

Cloge
o | y

— Step No. In1, In2

Displays the step number. Displays the signal code of the input terminal
connected to the logic symbol.

For information on what code you can enter,

Func Name . .
refer to the setting range for function code U02
Displays the function block name. and U03.
Func Prm1, Prm2
Displays the block selection code. Displays the [Parameter 1] and [Parameter 2] settingg

For information on this code, refer to the setting on the logic symbol properties window (or the function
range for function code UO1 or "2.3.3.18. List of code type and the function code number).
Logic Symbols".

—— [Save CSV file] Export

Click this button to save the displayed information to  Converts and displays the listed contents in the
a CSV file. "Function Code Edit" window. (Version 1.0.1.0 or later)
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2.3.3.9. Write

Your edited circuits are assigned step numbers and converted to the inverter function code
settings when the function check completes successfully.
Once the conversion completes successfully, the [Write] button is enabled.

[1] To Write to the Inverter

To register these settings in the inverter, check that the inverter is stopped and then click the
[Write] button or the [Write to the inverter] icon on the toolbar.

I> File Menu Setup  Miew Window Help 4 ;
DEHERo | /O&22 2HE xe @oe s BEERE:S af =l === =)
Select Inverter G Mumber of use steps [hites n inverter] [

Customizable Logic ey -
I £ INU- 10 1INV 'Ig Witite l Manitar start | 3 steps / 200 steps Lipdate | Grid |

Click [OK] to start the write operation.

FRENIC Loader |

& Do you initialize the function code in an inverter and stop
)| customizable logic.
And write in the function code preset value of customizable logic?

@ ¢ The write operation fails while the inverter is running. Stop the inverter and then
perform the write operation.

o If you stop the customizable logic function while the inverter is running, an "ECL:
Customizable logic error" alarm occurs.

e The write operation may fail with an inverter that has password protection
enabled. If this is the case, you should disable password protection to perform the
write operation. For more information on password protection, refer to the
instruction manual or user's manual of your inverter.
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Chapter 2 Functional Description

Upon completion of write, you are presented with a dialog that prompts you to confirm the write
operation to the user setting and customizable logic memory area (function codes U121 to U140
and U171 to U175).

FRENIC Loader x|

Is setting values of "User parameter and Customizable logic
storage area” written in the inverter?

Cancel |

At this time, the settings of function codes U121 to U140 and U171 to U175 in the inverter have
been initialized to 0.

Click [OK] if you want to restore the setting of function codes U121 to U140 and U171 to U175 in
the inverter.

Click [Cancel] if you do not use function codes U121 to U140 and U171 to U175 or you accept
the settings of 0.

When you want to write new settings to function codes U121 to U140 and U171 to U175, click
[Cancel] and, upon completion of write, perform the write operation from the [User
parameter/storage area, input/output and logic] window.
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[2] To write to the Keypad

If you have selected [Data in Keypad] for [USB Connection] on the [Communication Setting]
window, you can write your edited circuits to the TP-E1U remote keypad with USB. In this case,
the write operation to the inverter uses the keypad's copy function.

Use the copy FRENIC series

function Inverter
Write edited Bring the to perform
PC circuits keypad to the write
the field operation

FRENIC Loader |:> HE -—-2 HE |:>

Remote Keypad

Figure 2-1 Workflow of writing circuits to a keypad

Preparation

The write operation through the keypad's copy function writes, not only the customizable logic
related function code data, but also all other function code data (such as F codes, E codes, and
C codes) to the inverter. Therefore, you should write the function code data other than related to
the customizable logic to the keypad in advance.

To write the function code data to the keypad, use one of the following two methods:

(1) Read the function code setting data from the target inverter to the keypad using the copy
function. (As needed, read the data from the keypad to the loader and write the data back to
the keypad after editing the data in the loader.)

FRENIC series
Inverter

Read the function
code settings
from the keypad.

FRENIC Loader | 0Ve the data
to afile.

PC

As needed, edit the data in the
[Function code edit] window
and write the F, E, and C code
and other data to the keypad.

Read the data from
the target inverter
using the copy
function.

Tip ¢ When you read data from the keypad to the loader for backup or similar purposes
and work with the inverter that has the customizable logic function codes, be sure to
save both the list of basic function codes (such as F, E, C) and the list of the
customizable logic function codes.
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Chapter 2 Functional Description

(2) From the loader to the keypad,

write the function code setting data
for the target inverter you have

created from scratch or loaded FRENIC Loader |:>

from a saved file.

Tip

Remote Keypad
PC

From the [Function code edit]
window, write the F, E, and C
code and other data.

e To the inverter that has the customizable logic function codes, write the list of basic
function codes (such as F, E, C). In this case, you do not have to write the list of the
customizable logic function codes. The customizable logic function codes are written
from the customizable logic editor screen.

The workflow of the preparation is shown below:

[Read the function code

data from the inverter]

START

[Prepare the function code data in the loader]

From the target inverter to the keypad Loader
Read the function code setting data into Create the function code setting data for
the keypad, using the copy function the target inverter from scratch or load it
from a saved file
[Data backup or edit is
ired
required] From the keypad to the loader
Read the function code setting
[Data backup or edit data into the loader
is not required]
Loader
Edit and save the function code setting
data
From the loader to the keypad
Write the function code setting data (such
L as F, E, and C codes) to the keypad
END
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Write the edited circuits to the keypad

Click the [Write] button or the [Write to the keypad] icon on the toolbar

Help
2w xedE>He s e BEES DGR R @&
Keypad @ Mumber of use steps uﬁites in keypad | 100 %

TUIWT ] kit tonior st | [ 8steps /200 steps  Updste | Grid | \-‘?'{

f
5

Read the precautions displayed on the dialog box that appears.

x

l b MHotes about write to kevpad.
N

If thiz project's voltage, capacity and verzion informations are different from the inverter

which iz tryine to write, May occurs “GPEr warning when write to the inverter fram the kevpad.
In this caze, press the "PRG/RESET * key and vou can continue writing.

In addition, pleaze check the zettingz after complete writing.

i ite start I Chanee information.. Cancel

Click [Change information] to open the project properties window.

Correctly configure the model, regional specification, voltage, capacity, and inverter ROM
version according to the target inverter. For more information, refer to "2.3.3.12. Project
Properties".

@ o If the model, regional specification, voltage, capacity, and inverter ROM version
are not correctly configured, the write operation from the keypad to the inverter
may fail with a [CPEr] warning or error displayed.

Click [Write start] to open the following dialog.
Click [OK] to start the write operation.

FREMIC Loader E

& The data in the keyvpad iz initialized, If the model stored in the kewpad
| and the selected model of this project are different.
SR iould wou write the setting values of customizable logic?

Cancel |

Upon completion of write, you are presented with a dialog that prompts you to confirm the write
operation to the user setting and customizable logic memory area (function codes U121 to U140
and U171 to U175).
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Chapter 2 Functional Description

FRENIC Loader x|

WE setting values of "User parameter and Customizable logic
P/ storage area” written in the keypad?

Cancel |

At this time, the settings of function codes U121 to U140 and U171 to U175 in the keypad have
been initialized to 0.

Click [OK] if you want to restore the setting of function codes U121 to U140 and U171 to U175 in
the keypad.

Click [Cancel] if you do not use function codes U121 to U140 and U171 to U175 or you accept
the settings of 0.

When you want to write new settings to function codes U121 to U140 and U171 to U175, click
[Cancel] and, upon completion of write, perform the write operation from the [User
parameter/storage area, input/output and logic] window.
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[3] Workflow of Writing the Circuits
The workflow of writing the circuits is shown below:

Write to inverter START

Click [Write] or [Write to the inverter]

v

Are you sure to write?

Write to keypad START

®

to the keypad

Preparation: Writing the function codes

-

V

Click [Write] or [Write to the keypad]

SRRYEE)Y

\

Check the model, regional
specification, voltage, capacity, and
inverter ROM version

—

[Cancel]
[OK]

(a)User setting area/memory area )

(U121,..., U140, U171,..., U175)

are read

- J
4 - N

Customizable logic area (Uxx)

\_ is initialized
[Completes [Fails]

@ Cancel the write operation

Automatically performed

Automatically
* The customizable logic function stops.
* The terminal functions are not initialized.
* If the write target is inverter, HO3=12 is written.

successfully]

~

Write customizable logics (U,UA,...,UJ)
Write "disable function" settings to
input terminal functions (such as E01)
Write customizable logic output signals
1to 10 to the output terminal functions
K (such as F31 and E20) j

)

User setting area/memory area
(U121,..., U140, U171,..., U175)
Are you sure to write to the above?

[Cancel]

@ Cancel the write operation

* Write operation fails while inverter is running

Automatically

* The "disable function" settings are written to
input terminal functions if the [Set Customize
Logic Signal] check box is checked on the
input terminal properties window.

* Customize logic output signals 1 to 10 are
written to output terminal functions if the
[Output terminal digital] or [Output terminal
analog] check box is checked on the output
terminal properties window.

[OK]

[ Write the values read out in (a) j

Automatically

®

END
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Chapter 2 Functional Description

2.3.3.10. Comparison

Your edited circuits are assigned step numbers and converted to the inverter function code
settings when the customizable logic function check completes successfully.

Once the conversion completes successfully, [Compare] on the toolbar is enabled.

Click [Compare] to compare the settings of the edited circuits with those in the inverter, keypad, or
saved file.

I> File Menu Setup  View Window Help G
DERSRO| /O 2R xrEsHE s EEO D00 GEREDAE

Select Keyvpad Mumber of use steps \—Iobmparlson |

I Customizable Logic - ’
£ [No T Tt = write | lonitor st | 3steps / 200 steps Update | Grid |
Setting of comparison =l

—Select destination comparizon

If the target device is a keypad, the label

Compared with inverter\
| eus - changes to [Compared with keypad].

Ciompated with file... |

—Comparative result dizplay

Comparative result dizpla.. |

Close |

The comparison results are displayed using the inverter function codes. You can save the
comparison results to a CSV file.

~inixd
Gomparison start date:  2017-09-26 09:25:42
Comparison source: GatmlogicPril cmx (E25)
Gamparizon destination: FRMEEE25-2.J
Camparizon result: The difference of 3 affairs was detected.
“=": Unused
“#": Locked
Function code | Saurce | Destination
[NEH] - 3
Lat1s i jann

Close
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Differences are displayed for symbols as well.

Customizable lo [Customizable lo (ol x]
o Ele Menu Setp View Window Help -8 x
DEE SR /O&ES 2 Xe@2WLGE |
]
(oo b | Select verter Mumber of use steps \mn 5 - bl | | | |
Customizable Logic et AT =] @ e | igital | Analoe | Digitalfinalog | FB
No Il DINVI x| White | Momiior start 3Isteps /200 steps Update Grid e
—I —I [Basic Ingic =l
13 Programit |
- - Tnput/Output =
3 Praject CstmlogicPril =
B2 Main o [ - o= -
[T Programi - -
(2 FB (ncluded with the project) [ Erareh
‘23 FB (Common)
] Feno - — 4+
TG
™ 2 Comment
Out-Freqt
g Toowey ———————
[ =
e S S —— o —{u—E
S steps
E Fieading function code AND.
fum :
< [ L _l’I T
Olear Iog | Exzcution eycle: 3 [ns) B o
T == g E—CHDEHEHEHD
1) [Information UA1S has & difference. (GstmLogicPrilem: 71.00 / Iverter: 7200)
) [emoion | [T dfnce o o s ctcts
i) |nformation Comparison execution time: 2191 [ms] =
= Al B
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Chapter 2 Functional Description

2.3.3.11. Debug Function

Using the online monitor or the trace monitor, you can check how the customizable logics written
to the inverter operate on the inverter. In addition, the online batch processing is a useful feature
that reduces the number of button clicks when you edit circuits.

Tip e You can use all of the online monitor, the trace monitor, and the online batch
processing when the loader is connected to the inverter. These features are not
available if you have selected [Data in Keypad] for [USB Connection] on the
[Communication Setting] window.

Ti

p o Alimited set of functions is available with some inverter models. Refer to "1.1.2.
Loader Functions by FRENIC Series Inverter Model" for details.

[1] Online Monitor

The online monitor allows you to monitor the timer values or signals for a symbol as numeric
values.

Once you convert the customizable logic function settings you created, perform the step number
assignment, and write the settings to the inverter or you confirm that there are no differences the
result in the comparison results, you can run the online monitor on your selected symbol.

Select and right-click the symbol you want to monitor and select [Monitor select] on the context
menu.

= FRENIG Loader - Gustomizable logic - - [Customizable logic - GstmLogicPrjl] _1ol x|
D File Meu Setup View Window Help -8 x
DER SRe | +O22 (2Hxe @okis e BEE]E 0E598 R
]
[ g Select Iverter Humber of use steps UL | ] =
Customizable Logic o T TR =] e Digital | Analog | Digital+Analog
No Il TNV x| kite | benitor start 4steps / 200 steps Update Grid NS i
e | v | [ _n | _wn | R o -
3 Frogramll |
= = Iput/Qutput ————————————————————
‘4 Project ‘GstmlogicPrj I Step 1
D53 Wi - Sten 8 » -—a >» -«
: SEEEEEEF —
i3] Program0n -»- Ehb— — -,
EE3 FB Uncluded with the project) YO — 9 FBN01_1 Branch
/% FBOD11 HE + On Delay
3 FB (Comman) e ——
i-[a] FBoot TG
o2 Comment
Step 2 A
out-Fregt
- Wite Gonnect line B (i) ———————
- ‘
W Tinatin oot Vi et : FBO0I
Monitor Deselect
um
Trace monitor select - cLooz
Gut
Gopy
Delete
StepMo. / Priority setting -
| (IS | v
Fonit (H)
Dlear e | Exeoution cycle: 2 [ms) %]
[ | Twpe | Gode | Ry
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The following example shows the result of selecting [Monitor select] for all the symbols in the
layout area shown on the previous page.

Step 3 Step 4
FWD £
- _I"'l_ | | I - o
- - FEOOT 1
AR+ On Delay
TAC
TF 2
Step 1
Out-Fraql - i pryw
o
‘Witing function code
Step 2
Read ' cLO?
Feading function code
Start the inverter customizable logic.
Window  Help ‘

‘Rl eEsE s BREORBEHEGEEDRA

Bl

[Glistomizable logic start/stop]c
Select Inwverter Mumber of use steps = = ]
. . (=) | () Die

Ma. 10 11 TNV A Wiite | IManitor start | 4 stepz /200 steps Update Grid d. S
[ =l | | RN =

Gustomizable logic startf=top x|

Select nverter: . )
No. 1L 1] INV] f Stop |

Once you start the inverter customizable logic, the online monitor starts.

Window  Help 4 9

V2L 2@ xeEs DS e BEES 2 8ff2 R e
Select Inverter Mumber of use steps %inine monitnlr, : 1
IND. 10 11 IV vI Write | Monitor start E | 4 steps / 200 steps Update | Grid | ‘:ﬁ-{
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Chapter 2 Functional Description

You can check the status of the inputs/outputs, logic symbols, and function blocks (FBs)
highlighted in red in the layout area.

Step 3 i Ston ¢

P FWD: 1 =P

Ciie—— 8 8 _;.._.. ™ {8
FRA] S SEERSEEr Y - FeOOL1 Wnnd

ETET * AL+ On Delay

{Dut-Freql : - e

e e——————— & vnite

i x3: [ Y
o:

i 3 Whiting function code

Reading function code

The display examples are shown below.
- Digital input
The logical values of OFF and ON are 0 and 1,
xl.., respectively.
10 -e— The status of "0: Open /1: Closed" is shown under the
function name.

1 The "~" character prefixed to the function name

i -e represents logical inversion.

For logical inversion, the status of "0: Closed /1: Open" is
shown under the function name.
- Analog input
Out-Fregl. A value is shown under the function name.

i1 00 - e For information on the meaning of this value, refer to the
page regarding "U code (customizable logic)" in the
User's Manual of your inverter.
Example: For Out-Fregl, the unit is % and "100%"
means the maximum output frequency.

2-93



- Customizable logic function symbol

Step 3 S

“BHE

The output data is shown at the upper right.

=8—— Functions (1) and (2) are shown under the symbol.

AR+ On Delay
T/G 0
TP i

List of function names

Monitor name Name Range

T.P Timer period 0.00t0 9990 s

CNT Count 0.00 to 9990

U.L Upper Limit -9990 to 0 to 9990

L.L Lower Limit -9990 to 0 to 9990

1ST 1st Additional Value -9990 to 0 to 9990

2ND 2nd Additional Value -9990 to 0 to 9990

DEV Deviation -9990 to 0 to 9990
HYST Hysteresis Width -9990 to 0 to 9990

REF Reference Value -9990 to 0 to 9990

MAX Maximum Scale -9990 to 0 to 9990

MIN Minimum Scale -9990 to 0 to 9990

KA Factor KA -9990.0 to +9990.0

KB Factor KB -9990.0 to +9990.0
T.C(T/C) Time constant 0: No filter / 0.01 t0 5.00 s
FIX Fixed as O

ACC ACC 0: No limit. 0.01 to 600 s
DEC DEC 0: No limit. 0.01 to 600 s
Gain Gain ratio 0 to 200%

Frg Lower frequency limit 0 to 500 Hz

Vall Set Value -9990 to 0 to 9990

Val2 Set Value2 -9990 to 0 to 9990

Step Step number 1to 200

Tip e The value of the online monitor is displayed with 3 significant digits.
Minimum step in each range of value is shown in following table.

Range of value Minimum step
+0.00 - 9.99 0.01
+10.0 - 99.9 0.1
+100 - 999 1
#1000 — 9990 10

[2] Trace Monitor

The online monitor allows you to monitor the timer values or signals for a symbol as waveforms.

Refer to "2.3.5.11. Combination with the Customizable Logic Function”.
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Chapter 2 Functional Description

[3] Online Batch Processing

Until your desired circuits complete, you will repeat a series of tasks such as editing circuits,
performing step number assignment, wiring to the inverter, starting the customizable logic, and
starting monitors.

During such time, you can simplify the series of tasks from performing step number assignment
to starting monitors by using the online batch processing.

Prior to using the online batch processing, make sure that the inverter is stopped and that
[Monitor select] has been selected for at least one of the symbols in the layout area.

To use the online batch processing, click the [Online operation] icon on the toolbar.

BEE= &6 8686 A EE
| [Ofline operation]

- :
\__{ L

The loader compares the circuits you are editing with those in the inverter and, if all the
comparison results match, automatically starts the monitors.

Mumber of uze steps

| 4 zteps /200 steps Ipdate | Grid | H-{

If the comparison results do not match each other, the [Comparison result] window appears.

=l0lx| Click the [Write to Inverter and Start] button
Comparizon start date:  2017-09-26 13:12:53 .
Comparison source: CstmlogicPrjlomx (E25) at the lower left of the [Comparlson reSUIt]
Comparizon destination: FRNSSE25-2. WindOW to Write to the inve rter and
Comparizon result: The difference of 2 affairs was detected. i .
v rnrend automatically start the monitors.
=" Unuse
“#": Locked
Function code | Source | Destination
Lg2 400 100

Write To Inverter and Start Gancel |

4
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2.3.3.12. Project Properties

The project properties window allows you to add a version and comment to the created
project.

To open this window, right-click the project name displayed at the top of the project
management window and select [Property...] on the context menu.

Ea Main Lock..
- @ Proers Unlock...
B4 FB {Ihelug

L..[E] FEO0T Property..

The [Property] window opens.

Logic version

Use these fields if you want to version-control your project. This is different from the
inverter ROM version.

When you write the edited circuits to the inverter or keypad, the settings are written to
function codes U197 and U199.

x|
- - .
Filz name CztmlogicPril (—Explanation — Explanation
Logic Vergion II] i ;I You can add a
comment.

Model EZs
Region spec. JJAPARN
Vaoltage Iphaze 200
Capacity 0.1 ki
Werzioh T
Mumber of steps 200

— -

Kl _>I_I
S —
ak | Cancel |

Edit Inverter model selection x|

Click the [Edit] button to open the [Inverter model selection]

window shown at right. Mode!

. . . Begion spec. JJAPAN -
This window allows you to change the model, regional - P I —I
specification, voltage, capacity, and inverter ROM version. Voltaze | 1phase 200y =]
Configure these settings correctly according to the target Sapacity [0.1 ki =
inverter.

Wersion |?DIJ ;I

Which items you should configure varies depending on how
you write to the inverter. Refer to the Table on the next Humber of steps  [200

page.
ol 4 I Cancel |
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Table 2-2 List of the items you should configure on the [Inverter model selection] window

) = When writing from the loader
When directly writing
o to the keypad and then
Setting item from the loader to the o
] writing from the keypad to the
inverter .
inverter
Model O O
Regional
e — (*2)
specification
voltage — O
Capacity — O
Version (*1) O O
O: Configuration required —: Configuration not required

(*1) This is the inverter ROM version. Here, you can change the version you set when
creating a new project in "2.3.3.1. Select Customizable Logic Project to Edit".

(*2) You can change the regional specification by selecting [Setup] -> [Region spec.]
from the main menu. Once you have changed the regional specification, you have
to quit and restart the loader. Refer to "2.4.4. Region Spec." for details.

Tip e You can identify the inverter model number you should select in the [Model] list
box from the inverter model number printed on the rating nameplate of the inverter.
Refer to "[1] Model, Regional Specification, Voltage, Capacity" in "2.2.1. Create a
New File" for details.

e You can identify the inverter ROM version from the inverter keypad.
For more information, refer to the instruction manual of your inverter.
When FRENIC Loader 4 is connected to an inverter, you can identify the inverter
ROM version from [Inverter ROM Version] on the [System Monitor] tab of the
[Operation Monitor] window, which you can access by selecting [Operation Monitor
setting] from the Quick Access menu.
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2.3.3.13. Lock Function

The lock function allows you to protect your created circuits from view and edit.

@ e The lock function is only available on your PC. If you write circuits with the lock
function enabled, they can be freely viewed and edited on the inverter. To
restrict the view and edit of circuits on the inverter, use the inverter's password
protection. For more information on password protection, refer to the instruction

manual or user's manual of your inverter.

[1] Locking the Project

Locking the project protects it from view and edit. (However, this feature does not protect FBs

under [FB (Common)] from view and edit.)

To lock the project,

™ Lack..

Unlock ..

Property .

E3 FB (Gommon}_ ‘

@ FENN

Project iz locked.

Pleaze enter a pasaword.

(& half-width alphanumeric character,
4 - 12 characters

Please input ohce again for a check.

|
0]:9 I Canhcel

Right-click the project name displayed at
the top of the project management window
and select [Lock...] on the context menu.

Enter the password and click [OK].

@ e The password you use to lock the project is not within the knowledge of Fuiji

Electric.

Take sufficient care in configuring and managing the password because there is
no way to release the password in the event you have lost it.

FRENIC Loader x|

& CstmlogicPril has been changed.
J.-' Do you save data?

It cannot lock, when not saving,

Cancel |

X]

k1 Project 'CstmlLogicPrit’

Click [OK] to save the project.

The icon preceding the project name
changes to a locked one £, meaning that
the circuits in the project are protected
from view.
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To release the lock,

Lock..
e FEIIJD| Un ok,
Property ..
Project Unlock

The lock of Project is removed.
Please enter password.

|
OF I Cancel |

[2] Locking FBs (Common)

Right-click the project name displayed at
the top of the project management window
and select [Unlock...] on the context menu.

Enter the password and click [OK].

If your entered password is correct, the
circuits are no longer protected from view.

You can protect an FB under [FB (Common)] from view and edit. (However, this feature does not

protect the project itself from view and edit.)

To lock an FB under [FB (Common)],

e ] FEUU_I
{3 FB (Common)
-

Cpen
Save
Cut
Copy
Delete
Lock ...
nlack. ..
Export
Propertw ..

FEB (Gommon) iz locked and saved.

Pleaze enter a pasaword.

(& half-width alphanumeric character,
4 - 12 characters)

Pleaze input once again for a check.

|
0]:9 I Canhcel |

Right-click an FB name under the [FB
(Common)] in the project management
window and select [Lock...] on the context
menu.

Enter the password and click [OK].

The FB protected with the password is
then automatically saved.

@ e The password you use to lock an FB is not within the knowledge of Fuiji Electric.
Take sufficient care in configuring and managing the password because there is
no way to release the password in the event you have lost it.



Ela EY
P b (] Programin
B3 FB ilhcluded with the pr

The icon preceding the FB changes to a
locked one [i], meaning that the FB is
protected from view.

If you place a locked FB from the FB tab of the toolbox to the layout area, a locked mark appears

on it.

Select Inverter

Program0 I

Mumber of use steps

a e
IND. 10 111NV 'I hirite Manitar start | 4 steps £ 200 steps Lipdate | Girid \"F{ \--{

100 %

.Dlgltall F\nalogl Digital+Analog  FB
|FE

=

AND + On Delay
TG
TR 2

Out-Freql
X3

| Whirite
-
‘Witing function code

Ui

£ Project 'CetmlogicPril’
B3 Main
@ Proerami
El-“23 FB {hcluded with the pro
[ %] FBO01_!
[ FBO01_2

To release the lock,

'a FE {CGammon)

Cpen
Save
it

Copy

Delete

Lock....
Unlock ...

Export

Property .

o —
-—

Read

- 55! o
FE001_1

' ooz

Reading function code

Ui

2-100

Tnput./Output

- -aa >

Eranch
e _ _l_
Comment

A

o +EB.{Gomman),
lreon |

In addition, an FB with a locked icon is
added under [FB (Included with project)] in
the project management window.

Double-clicking an FB with a locked icon
does not display the circuits.

Right-click an FB name under the [FB
(Common)] in the project management
window and select [Unlock...] on the
context menu.
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x| Enter the password and click [OK].
The lock of FB (Gommon) is removed. If your entered password is correct, the

Please enter password.
icon becomes an unlocked one and the

I circuits are no longer protected from view.

OF I Cancel |

[3] Locking an FB under [FB (Included with project)]
You can protect an FB under [FB (Included with project)] from view and edit. (However, this
feature does not protect the project itself from view and edit.)

To lock an FB under [FB (Included with project)],

3 Project CstmLogicPril Right-click an FB name under the [FB
Elﬁ %ﬂ"; " (Included with project)] in the project
P e rogram .

B3 FEB (Ihcluded with the project) management window and select [Lock...]

L @W on the context menu.
a FE (Commaor Cpen
L[ Fen
Copy
| Lock...
Unlock..
Property ..
x| Enter the password and click [OK].

FB ({Included with the project) is locked.

Fleaze enter a pazaword.

{& half-width alphanumeric character,
4 - 12 characters)

Pleaze input once again for a check.

|
0]4 I Cancel |

@ e The password you use to lock an FB is not within the knowledge of Fuiji Electric.
Take sufficient care in configuring and managing the password because there is
no way to release the password in the event you have lost it.

a Project 'CetmLogicPrjl’ The icon preceding the FB changes to a
E"a Main locked one [#], meaning that the FB is

P (] Programn _ _ protected from view.
B3 FE (Included with the proje

o @ FEOOT_1

£ FB {Comman)

L. [T FEO0T
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Step 4

551
=&l

To release the lock,

£ Project 'CztmlogicPril
Ela Main
- @ Programin
Ela FB (Included with the project]

'a FB (Comman COpen
Copy

Lock ..
| nlack..

Froperty ..

FB (Included with the project) x|

The lock of FB (Ihcluded with the project)
is removed.
Pleaze enter passward.

(6]4 I Cancel
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In addition, a locked icon appears on the
FB when you place it in the layout area.

Right-click an FB name under the [FB
(Included with project)] in the project
management  window and  select
[Unlock...] on the context menu.

Enter the password and click [OK].

If your entered password is correct, the
icon becomes an unlocked one and the
circuits are no longer protected from view.



Chapter 2 Functional Description

2.3.3.14. Importing/exporting an FB under [FB (Common)]

The import/export function allows you to use your created FB in the FRENIC Loader 4 software
installed on another PC.

[1] Exporting an FB
You can save the desired FB(s) to a file.

=] Project ‘CetmLogicPrjT Right-click [FB (Common)] in the project
El@ %3"; 00 management window and select [FB Select
Freee FoOgram
B33 FE {heluded with the project] Mode] on the context menu.
..[%] FEOO11
a FE (o
L] FEOD New..
Fazte
| FE SelectMade

FB SelectMode Stop

Impart
o= giect ‘CetmLogicPril’ Check boxes appear on the left side of the
B-C3 Main icons in the project management window.
PoEe O] Programin prol J .
ED@ FB {Inchuded with the pre
L..[]/%] FEOO1_1
(MR E (Common
-] FBOOT
O3 Project ‘CetmLogicPrj T From among the FBs under [FB (Common)],
ED%E'; 00 select the FB(s) you want to save to a file by
L. r'Dgr’am . .
EI:I@ FE (Included with the proje checking their check boxes.
L FEOD11 . .
O FI:BI(%Inmmnn)_ Right-click the FB name and select [Export]
[T W on the context menu.
Cpen
Save
@ e [Export] does not appear on
Cut the context menu of an FB
Copy other than under [FB
Bl (Common)].
Lock...
@ e You cannot export any FBs
Unlock.. other than under [FB
Export (Common)].
Property .
@ e You can also export a locked

FB.
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|

—~r
s | ~ Fujielectric = FRENIC Loader4 ~ DATA - m” Search DATA

o Select [Save to ...] and enter the file nhame

B

Organize v  New folder

£l RecentPlaces 4] pame - | pate mocified

[roee

- @ under which the data is saved in [File

|| FBODL.exfbl 10/2/2017 10: 11PM

4 Libraries
= bocuments

o Music

k=] Pictures

B videos
) Homearoup

1% Computer
&2, Local Disk (C3)

=l

EXFBL File

Name]. Then click [Save] to save the file.

File types

- FB export file: "*.exfbl"

File name: | FBOO2

Lelel o

Save as type: [FB exportFie (%.exfbl)

“ Hide Folders

v

FRENIC Loader |

:' Do you want to export FB?

Cancel

[2] Importing an FB

Click [OK].

You can import FBs saved in a file to the project.

£ Project 'CztmlogicPril
Ela Main
- @ Programii
Ela FB (Included with the project)

Pazte

FB SelectMade
FB SelectMode Stop

Import

Right-click [FB (Common)] in the project
management window and select [Import] on
the context menu.

[open T .
OO [T+ Fuiekectrc = FRENIC Loader4 - DATA ~ & [ searchoaTa #2) SeIeCt an FB flle .
Organize v New folder =~ 0@
B Deskton 2l ame - | pate modied [ rype
s Dawrloads

017 10:11PM

=l Recent Places

4 Libraries
[ Documents

o Music

] Pictures

B videos
* Homegroup

18 Computer
£, Local Disk ()

|
=] [Fe exportFite (extol) =l

=4l

File name: [FBO0L.extbl

EXFEL File

i

VA
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FRENIC Loader x|

0 Do vou want to import FB?

£ Project 'CztmlogicPril
Ela Mair
- @ Frogramii
B3 FE {lhcluded with the pr
L.[E] FEO01_1

FE {(Camman)

FEON FEO01_1
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Click [OK].

The imported FB(s) is added under [FB
(Common)] in the project management
window.

The imported FB(s) are added to the [FB]
tab of the toolbox.



2.3.3.15. Printing the Customizable Logic

When the [Customizable logic] window is active, you can print the content of the layout area by

selecting [File] from the main menu.

File | Merw  Setup  Wiew  ifindow
] Hew.
[ Open.
Ciloze
[ml Save
Save bz
= (Print..

_,L Print Preview

Print selected Swmbol
Print Preview selected Swmbol

Fecent File

Exit

Page Setup.. L

[Print]

When the [Customizable logic] window is active, select this
command to print the content of the layout area.

For more information on the [Print] dialog, refer to "2.2.6. Print".

[Print Preview]

When the [Customizable logic] window is active, select this
command to view the print preview of the layout area.

For more information on the [Preview] window, refer to “2.2.7. Print
Preview".
[Print selected Symbol]

This command is available when the [Customizable logic] window is
active. Select it to print only the symbol selected in the layout area.

[Print Preview selected Symbol]

This command is available when the [Customizable logic] window is
active. Select this command to view the print preview of only the
symbol selected in the layout area.

The following is an example printout. [Page Setup] is not available. The content of the layout
area is automatically adjusted to fit in one A4 landscape page.

Project Name : CstmLogicPril
Program Mame : Program{{
Explanation :

L

B .'.' i
s H E V
7o
T
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2.3.3.16. List of Input Terminal Signal Codes

This section describes the signal codes specified in input terminal properties. Reference
this section when creating circuits. The numbers up to 60XX represent logical value
(ON/OFF) input signals. Numbers 80XX and greater represent numeric value input signals.

For information on the input terminal properties, refer to "Properties of an Input Terminal" in
"2.3.3.3. Workflow of Creating a Circuit".

Restrictions

The signal codes described below are only available when supported by the inverter. For
information on the available signal codes, refer to the description of function code U02 and
U03 in the User's Manual of your inverter. Alternatively, you can refer to the description of
function code U02 and UO03 in [Function code information] on the [Function code edit]
window (also with selecting the "Create the customizable logic function code window",
depending on the applied inverter models).

Numbers from 0000 to 12XX
Almost the same as general-purpose output signals (i.e., signals selectable for E20).
(Some signals are excluded from the signals selectable for E20.)

For information on these signals, refer to the description of function code E20 in the User's
Manual of your inverter.

Numbers 4000 to 50XX
These numbers represent the digital terminal input signals to the inverter.

Refer to the function codes U02 and U03 in the user's manual for the signals that can
actually be used for each inverter model.

An example is shown below.

Allocation number
i i Signal Details
Active Active name
ON OFF
4001 to 4009 5001 to 5009 X1, X2,... | Represent the ON/OFF status of the inverter terminal
4010 5010 FWD blocks if the remote operation command is disabled.
Represent the ON/OFF status of each bit of function
4011 5011 REV . .
code S06 when the remote operation command is
enabled.
4021 to 4033 5021 to 5033 11, 12, ... Represent the ON/OFF status of input signals for
option cards with digital terminal input signals.
4101 to 4109 5101 to 5109 X1(Term), | Represent always the ON/OFF status of the physical
X2(Term), | inverter terminal blocks even if the remote operation
command is enabled.
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@ e When you configure input terminals for these signals, be aware that other functions
that use the configured signals can operate. For example, if you set the X1 terminal
function selection (function code EO1) to '0' ([SS1] multi-step frequency selection)
and then turn the X1 terminal from OFF to ON, the multi-step frequency selection is
enabled from disabled state in parallel with the change of the input terminal logical
value. Care must be taken especially for the X terminal, the FWD terminal, and the
REV terminal, whose functions are configured with the factory-set values.

Tip * To use a signal exclusively as the customizable logic input, you must check the [Set
Customize Logic Signal] check box on [Properties of an Input Terminal] or explicitly
set the signal function selection to "100[NONE]".

Numbers 6000 to 70XX
These signals cannot be selected for general-purpose output signals (i.e., signals
selectable for E20).

Refer to the function codes U02 and UO3 in the user's manual for the signals that can
actually be used for each inverter model.

An example is shown below.
Each function is described assuming the active ON logical (positive logic).

Allocation number

Signal o
Active Active g Description

name
ON OFF

Final operation command RUN. Turns ON when the operation

6000 7000 FL_RUN .
- command is issued.

Final operation command FWD. Turns ON when the forward

6001 7001 FL_FWD . . ..
- rotation operation command is issued.

Final operation command REV. Turns ON when the reverse

6002 7002 FL_REV . . .
- rotation operation command is issued.

6003 7003 DACC Turns ON when acceleration starts.
6004 7004 DDEC Turns ON when deceleration starts.
6005 7005 REGA Turns ON when regeneration avoidance starts.

6006 7006 DR_REF Turns ON when the dancer is in the reference position.

Turns ON when an alarm occurs and the alarm can be reset

6007 7007 ALM_ACT (with no alarm cause identified).

Numbers 80XX
Almost the same as inverter analog general-purpose output signals (i.e., signals selectable
for F31). These assigned numbers are codes created by adding 8000 to F31 signal codes.
(Some signals are excluded from the signals selectable for F31.)

Numeric values are expressed in the unit of %.

Refer to the function code F31 in the user's manual of each inverter model for the
assignment number, function, and the definition of 100% of each signal.
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An example of signal name is shown below.

Signal name
Out-Freql Output frequency 1 (before slip compensation)
Out-Freg2 Output frequency 2 (after slip compensation)
F-out 1 Reference speed (Final)
F-out 2 Primary frequency
Out-I Output current
Out-V Output voltage
Torque Output torque
Load Load factor
In-Power Consumed power
PID-PV PID feedback value
Speed Detected speed value/estimated speed value
DC-Link-V DC intermediate circuit voltage
M-out Motor output
PID-SV PID command
PID-MV PID output
Deviation Position deviation during synchronous operation
H-sink-tmp Cooling fin temperature
Internal-tmp Internal air temperature
F-ref Set frequency
PG-fb PG feedback value
PID-PV 1 PID feedback value 1
PID-SV 1 PID command 1
PID-PV 2 PID feedback value 2
PID-SV 2 PID command 1
EPID1-PV External PID feedback value 1
EPID1-SV External PID command 1
EPID1-Out External PID final output 1
EPID2-PV External PID feedback value 2
EPID2-SV External PID command 2
EPID2-Out External PID final output 2
EPID3-PV External PID feedback value 3
EPID3-SV External PID command 3
EPID3-Out External PID final output 3
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Numbers 90XX
These numbers represent the analog terminal input signals to the inverter.

Refer to the function codes U02 and UO3 in the user's manual for the signals that can
actually be used for each inverter model.

An example is shown below.

Allocation . .
Name Detalils Numeric value
number
9001 Al-[12] Analog terminal 12 input signal

Analog C1 terminal input signal
or

Analog C1 terminal input signal (C1
function)

9002 | Al-[C1]

Analog V2 terminal input signal
or Scale-transformed physical
guantity obtained by applying
gain/bias to the input signal

9003 | AI-[V2] o .
Analog C1 terminal input signal (V2

function)

Analog terminal 32 input signal
9004 Al-[32] (input signal for option card with
analog input)

Analog terminal C2 input signal
9005 Al-[C2] (input signal for option card with
analog input)

Temperature detection Pt channel 1 | Filtered temperature

9006 PtChl (Input signal for option card with a | (From the function code
temperature measuring resistor) setting field, you can select
Temperature detection Pt channel 2 | one of the following units:
9007 PtCh2 (Input signal for option card with a | [Kl. [°C], and [°F].)

temperature measuring resistor)

To help understand the numeric values for an input terminal for which one of the numbers
from 9001 to 9005 is selected, the following example shows the results of applying a gain
and bias to each of the [12] and [C1] terminals:

. If the gain = 100% and the bias = 0% | If the gain = 200% and the bias = 0%
Input terminal
Input value After application Input value After application
12] Oto+10V 0 to 100% 0to +5V 0 to 100%
-10 to OV -100 to 0% -5 to OV -100 to 0%
1] 4 to 20 mA 0 to 100% 4to 12mA 0 to 100%
0to 20 mA 0 to 100% 0to 10mA 0 to 100%

The numeric value for an input terminal
will be the value created by
transforming the scale after the gain | Maximum scale
and bias application from "0 to 100%"
to "minimum to maximum".

Input terminal value

Minimum scale 0% 100% Analog input value

(After bias and gain application)
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@ e When you configure input terminals for these signals, be aware that other

Tip

functions that use the configured signals can operate. For example, if you set the
frequency setting 1 (function code FO01) to '1' (terminal 12) and then change the

input voltage for terminal 12, the step frequency setting changes in parallel with
the change of the input terminal numeric value.

To use a signal exclusively as the customizable logic input, you must explicitly
configure the FO1, C30, E61, E62, E63, and other related function codes not to
use the signal configured for the input terminal.

By factory default, the FO1, C30, and other related function codes are configured
not to use such a signal.

2-111



2.3.3.17. List of Output Terminal Signal Codes

This section describes the signal codes specified in output terminal properties. Reference
this section when creating circuits. The numbers up to 12XX represent logical (ON/OFF)
signal value output signals. Numbers 80XX and greater represent numeric value output
signals.

For information on the output terminal properties, refer to "Properties of an Output Terminal”
in "2.3.3.3. Workflow of Creating a Circuit".

Restrictions

The signal codes described below are only available when supported by the inverter. For
information on the available signal codes, refer to the description of function code U81 in
the User's Manual of your inverter. Alternatively, you can refer to the description of function
code U8L1 in [Function code information] on the [Function code edit] window (also with
selecting the "Create the customizable logic function code window", depending on the
applied inverter models).

Numbers from 0000 to 12XX
Almost the same as general-purpose input signals (i.e., signals selectable for E01).
(Some signals are excluded from the signals selectable for EO1 and 98[FWD] and 99[REV]
are added.)

For information on these signals, refer to the description of function code EO01 in the User's
Manual of your inverter.

Numbers 80XX
Almost the same as inverter analog general-purpose input signals (signals selectable for
E61). These assigned numbers are codes created by adding 8000 to E61 signal codes.
(Some signals are excluded from the signals selectable for E61.)

Except for some signals, numeric values are expressed in the unit of percentage.

Refer to the function code E61 in the user's manual of each inverter model for the definition
of the assignment number, function, and numerical value of each signal.

An example of signal names is shown below.

Signal name
Aux-freql Frequency auxiliary setting 1
Aux-freq2 Frequency auxiliary setting 2

Speed command (Not reversible operation

N-Ref Unipolar by polarity)

Speed command (Reversible operation by

N-Ref Bipolar polarity)

PID-SV1 PID command 1
PID-SV2 PID command 2
PID-PV1 PID feedback value
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Signal name
Ratio set Ratio setting
Trg-lim.A Analog torque limit value A
Trg-lim.B Analog torque limit value B
Trg-bias Torque bias
Trg-cmd Torque command
Trg-curr Torque current command
LampRatio Acceleration/deceleration time ratio setting
Freg-lim.H Upper limit frequency
Freg-lim.L Lower limit frequency
Spd-lim.F Forward rotation (FWD) speed limit value
Spd-lim.R Reverse rotation (REV) speed limit value
Ai-mon Analog input monitor
PID-PV2 PID feedback value 2
Aux-SV1 PID process command auxiliary setting 1
Aux-SV2 PID process command auxiliary setting 2
FlowRate Flow sensor
EPID1-SV External PID process command 1
EPID1-PV External PID feedback value 1
EPID1-MU External PID manual command 1
EPID2-SV External PID process command 2
EPID2-PV External PID feedback value 2
EPID2-MU External PID manual command 2
EPID3-SV External PID process command 3
EPID3-PV External PID feedback value 3
EPID3-MU External PID manual command 3
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2.3.3.18. List of Logic Symbols

This section describes the respective function blocks. Reference this section when creating

circuits.

Restrictions

The function blocks described below are only available and displayed on the toolbox when
supported by the inverter. Additionally even if the function blocks are displayed on the toolbox,
some blocks might be not available depending on the version of the inverter.

For information on the available function blocks, refer to the description of function code UO1 in
the User's Manual of your inverter. Alternatively, you can refer to the description of function code
U01 in [Function code information] on the [Function code edit] window (also with selecting the
"Create the customizable logic function code window", depending on the applied inverter

models).

2.3.3.18.1.

To select a basic logic symbol, choose [Basic
logic] from the [Digital] tab.

10 to 15: Through

[Digital] - Basic Logic

Tool box
Digital | Analog | Digital+Analog | FE |

I Basic logic

Flip—Flop
Edes detection
Digital Other

Bloc_k Symbol Function block
selection
Input Output
|Logical| |Logicall
10 Through output Through output without a logical circuit
Input Output . . .
> N Turning ON the input starts the ON-delay timer.
n Logical [Logical] | Through output When the timer time has elapsed, the output
i _I"'l_ + ON-delay timer turns ON. Turning OFF the input turns OFF the
- I output.
Input Output
Logical Logical| | Through output Turning OFF the input starts the OFF-delay
12 - + OFF-delay timer timer. When the timer time has elapsed, the
—_— output turns OFF.
=
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Bloc_k Symbol Function block Description
selection
Turning ON the input starts the timer. The
output remains ON until reaching the timer time.
While the output is ON, the timer operation
continues without regard of the input status.
Input Output . . .
> - Setting the timer time to 0 turns OFF the output.
Logical [Logicall Through output g P
13 i _|"'|_ + Pulse (1 shot)
_— Input OFF [ oN Jorf[ | [] OFF
Output OFF ON OFF ON OFF
Timer time
Turning ON the input starts the timer. The
output remains ON until reaching the timer time.
If an OFF to ON edge at the input occurs while
the output is ON, however, the output remains
Input Output ON from that time until reaching the timer time.
. . Setting the timer time to O causes the output to
14 Logical Logical Through output . turn OgN when the input turns ON. P
— + Retriggerable timer
"1
OFF [ ON  |OFF [ on ]
Input
Output OFF ON OFF | ON OFF
Timer time
Outputs a pulse signal with a period twice the
timer time and a duty of 50%. Useful for flashing
a light emitting device.
Turning ON the input turns ON the output and
starts the timer. When reaching the timer time,
the output turns OFF and the timer restarts.
Input i Ougpult When reaching the timer time again, the output
15 [Logicall [Logicall | Through output turns ON and the timer restarts.
] || + Pulse train output Setting the timer time to 0 turns OFF the output.
I

OFF | ON ON
Input
OFF ON OFF ON
Output
Timer time
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20 to 25: AND

Block

; Symbol Function block Description
selection
Input 1 Output
[Logical| [Logical]
20 &1 Logical product (AND) | This is a combination of an AND circuit with 2
+ Through output inputs/1 output and a through output.
Input 2
Logical
Input 1 Output
|Logical| |Logical| o L o
This is a combination of an AND circuit with 2
) inputs/1 output and an ON-delay timer.
& —— Logical product (AND) . o
21 - |—-| p— N-del . Turning ON the AND circuit output starts the
- + ON-delay timer ON-delay timer. When the timer time has
elapsed, the output turns ON. Turning OFF the
Input 2 AND circuit output turns OFF the output.
Logical
Input 1 Output
[Logicall [Logicall This is a combination of an AND circuit with 2
inputs/1 output and an OFF-delay timer.
& - Logical product (AND) Turning ON the AND circuit output turns ON the
22 _I_-l_ + OFF-delay timer output.
Turning OFF the AND circuit output starts the
OFF-delay timer. When the timer time has
Input 2 elapsed, the output turns OFF.
Logical
Input 1 Output
|Logical| |Logical|
This is a combination of an AND circuit with 2
& —— Logical product (AND) inpu.tsll output and a pulse (1 shot) output.
23 = |--| = + Pulse (1 shot) For information on the operation of a pulse (1
— shot), refer to Block selection 13 "Through
output + Pulse (1 shot)".
Input 2
Logical
Input 1 Output
[Logical [Logical This is a combination of an AND circuit with 2
& mm Logical product (AND) inpu_ts/l output and a retrigge_rable timer.
24 . H—-| ™ | + Retriggerable timer For information on the operation of a
— 99 retriggerable timer, refer to Block selection 14
Inout 2 "Through output + Retriggerable timer".
Logical
Input 1 Output
[Logicall [Logicall This is a combination of an AND circuit with 2
& — Logical product (AND) inpu'tsll output and a pulse train output. _
25 . | | ™ | + Pulse train outout For information on the operation of a pulse train
St p output, refer to Block selection 15 "Through
Input 2 output + Pulse train output".
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30to 35: OR
sel?le%(t:ilén Symbol Function block Description
Input 1 Output
[Logical| [Logical]
30 121 i Logical sum (OR) This is a combination of an OR circuit with 2
- + Through output inputs/1 output and a through output.
Input 2
Logical
Input 1 Output
|Logical| |Logical| " — o
This is a combination of an OR circuit with 2
) inputs/1 output and an ON-delay timer.
31 1211 _I"'|_ || Logical sum (OR) Turning ON the OR circuit output starts the
- - + ON-delay timer ON-delay timer. When the timer time has
elapsed, the output turns ON. Turning OFF the
Input 2 OR circuit output turns OFF the output.
Logical
Input 1 Output o o o
[Logicall [Logicall This is a combination of an OR circuit with 2
inputs/1 output and an OFF-delay timer.
411 [=— Logical sum (OR) Turning ON the OR circuit output turns ON the
32 - [ H B OFF-delay timer output. -
] Turning OFF the OR circuit output starts the
| 2 OFF-delay timer. When the timer time has
’—p—‘&g‘{ial elapsed, the output turns OFF.
I
Input 1 Output
|Logical| |Logical|
This is a combination of an OR circuit with 2
- 21 _— Logical sum (OR) inpu_ts/l output and a pulse (1_ shot) output.
33 = |--| = + Pulse (1 shot) For information on the operation of a pulse (1
= — shot), refer to Block selection 13 "Through
Inbut 2 output + Pulse (1 shot)".
npu
Logical
Input 1 Output
Logical Logical
[Logicall [Logicall This is a combination of an OR circuit with 2
- =11 [== Logical sum (OR) inputs/1 output and a retriggerable timer.
34 =™ H—-| ™ | + Retriggerable timer For information on the operation of a
= — 99 retriggerable timer, refer to Block selection 14
Input 2 "Through output + Retriggerable timer".
Input 1 Output
[Logical| [Logical] . o R
This is a combination of an OR circuit with 2
-1 >1 Logical sum (OR) inputs/1 output and a pulse train output.
35 = ™ | | ™ | + Pulse train outout For information on the operation of a pulse train
= ——— P output, refer to Block selection 15 "Through
Input 2 output + Pulse train output".
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40 to 45: XOR

Block

; Symbol Function block Description
selection
Input 1 Output
[Logical| [Logical]
0 1=11 Exclusive OR (XOR) This is a combination of an XOR circuit with 2
- + Through output inputs/1 output and a through output.
Input 2
Logical
Input 1 Output
[Logical] [Logical] This is a combination of an XOR circuit with 2
) inputs/1 output and an ON-delay timer.
-1 =1 —f— Exclusive OR (XOR) . o
41 == |—-| = ON-delav ti Turning ON the XOR circuit output starts the
- —- + ON-delay timer ON-delay timer. When the timer time has
Inout 2 elapsed, the output turns ON. Turning OFF the
npu XOR circuit output turns OFF the output.
P P
Input 1 Output
|L:gical| |Logicpa|| This is a combination of an XOR circuit with 2
inputs/1 output and an OFF-delay timer.
-1 =1 -I_T Exclusive OR (XOR) Turning ON the XOR circuit output turns ON the
42 - — + OFF-delay timer output.
Turning OFF the XOR circuit output starts the
Input 2 OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input 1 Output
|Logical| |Logical| o o o
This is a combination of an XOR circuit with 2
- =1] [ Exclusive OR (XOR) inputs/1 output and a pulse (1 shot) output.
43 - ] _h_ B + Pulse (1 shot) output | For information on the operation of a pulse (1
shot), refer to Block selection 13 "Through
Input 2 output + Pulse (1 shot)".
Input 1 Output
[Logical| [Logical] o o o
This is a combination of an XOR circuit with 2
- =1 mm Exclusive OR (XOR) inputs/1 output and a retriggerable timer.
44 - B m B + Retriggerable timer For information on the operation of a
retriggerable timer, refer to Block selection 14
Input 2 "Through output + Retriggerable timer".
Logical
Input 1 Output
Logical Logical
[Logicall [Logicall This is a combination of an XOR circuit with 2
-1 =1 — Exclusive OR (XOR) inputs/1 output and a pulse train output.
45 - ™1 | | B + Pulse train output For information on the operation of a pulse train

Input 2
Logical

output, refer to Block selection 15 "Through
output + Pulse train output".
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2.3.3.18.2. [Digital] - Flip-flop

To select a flip-flop symbol, choose [Flip-Flop] Ll

from the [Digital] tab.

50 to 55: SR-FF

Diital | Analoe | Digital+Analoe | FE |

Bazic logic

Bazic logic

Edee detection
Digital Other

seElale%(t:ii:)n Symbol Function block Description
Input 1 Output
Logical Logical
[Logical [Logicall Set priority
; This is a combination of a set priority flip-flop
e —— ﬂl -ﬂo
50 R Q +F')rhropugh output and a through output.
Input 2
Logical
Input 1 Output L o o
[Logical| [Logical| This is a combination of a set priority flip-flop
— Set priority and an ON-delay timer.
51 | s Q4 |—-| = flip-flop Turning ON the flip-flop output starts the
R — + ON-delay timer ON-delay timer. When the timer time has
Input 2 elapsed, the output turns ON. Turning OFF the
flip-flop output turns OFF the output.
Input 1| Oufpult This is a combination of a set priority flip-flop
[Logicall [Logicall Set oriorit and an OFF-delay timer.
- et priori
(o] % |_,,| = . P y Turning ON the flip-flop output turns ON the
52 R — flip-flop _ output.
Inout 2 + OFF-delay timer Turning OFF the flip-flop output starts the
@ OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input 1 Output
|Logical| [Logical| Set priorit This is a combination of a set priority flip-flop
_— .e priority and a pulse (1 shot) output.
3 R QM b | | flip-flop For information on the operation of a pulse (1
ot 2 — + Pulse (1 shot) shot), refer to Block selection 13 "Through
output + Pulse (1 shot)".
Input 1 Output
|Logicall [Logicall Set priorit This is a combination of a set priority flip-flop
mm 'e prionity and a retriggerable timer.
54 R Q- m B ﬂ'p'ﬂof’ i For information on the operation of a
| > + Retriggerable timer retriggerable timer, refer to Block selection 14
Ii]fgu'tcal "Through output + Retriggerable timer".
I
Input 1 Output
|Logicall [Logicall Set priorit This is a combination of a set priority flip-flop
_— _e priority and a pulse train output.
55 R Qr |"""| = | fliflop For information on the operation of a pulse train
| > + Pulse train output output, refer to Block selection 15 "Through
Eo;'ial output + Pulse train output".
I

Tip e |Initial state of the flop-flop is OFF(0) just after started the customizable logic
function.
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60 to 65: RS-FF

Bloc_k Symbol Function block Description
selection
Input 1 Output
Logical Logical
| gS | [Logicall Reset priority
= ; This is a combination of a reset priority flip-flop
e — ﬂl -ﬂo
60 =R Q p-op and a through output.
+ Through output
Input 2
Logical
Input 1 Output L. L -
[Logical [Logical . T_hls is a combination of a re reset priority
S Reset priority flip-flop and an ON-delay timer.
61 (n] = |_..| - flip-flop Turning ON the flip-flop output starts the
R = + ON-delay timer ON-delay timer. When the timer time has
Input 2 elapsed, the output turns ON. Turning OFF the
Logical flip-flop output turns OFF the output.
Input 1 Output This is a combination of a reset priority flip-flop
[Logicall |Logicall and an OFF-delay timer.
- - Reset priorit . .
S Qp- |_,,| - ) P y Turning ON the flip-flop output turns ON the
62 =R — flip-flop _ output.
+ OFF-delay timer Turning OFF the flip-flop output starts the
Input 2 . ) :
OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input 1 Output
|Logical| [Logical| Reset briorit This is a combination of a reset priority flip-flop
-5 —— _ese priority and a pulse (1 shot) output.
63 =R QM H_ B flip-flop For information on the operation of a pulse (1
Input 2 + Pulse (1 shot) shot), refer to Block selection 13 "Through
output + Pulse (1 shot)".
P (- shot
Input 1 Output
|Logicall [Logicall Reset priorit This is a combination of a reset priority flip-flop
B mm _ese prionty and a retriggerable timer.
64 - Qr- m B fI|p-roP i For information on the operation of a
| > + Retriggerable timer retriggerable timer, refer to Block selection 14
l%'tcaﬂ "Through output + Retriggerable timer".
I
Input 1 Output
|Logical| |Logical| Reset priorit This is a combination of a reset priority flip-flop
-5 _— .ese priority and a pulse train output.
65 -R Q| || | flie-flop _ For information on the operation of a pulse train
| > + Pulse train output output, refer to Block selection 15 "Through
’ﬂ% output + Pulse train output".
Logical

Tip

¢ |Initial state of the flop-flop is OFF(0) just after started the customizable logic

function.
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2.3.3.18.3.

To select an edge detection symbol, choose

[Digital] - Edge Detection

[Edge detection] from the [Digital] tab.

70, 72, 73: Rise Edge

Tool box o X
Digital IHnaIDg I Digital+fnaloe I FE |
Bazic logic LI
Bazic logic

Flip—Flo

Digital Other

Block

; Symbol Function block Description
selection
Input Qutput This is a combination of a rise detection with 1
Logical Logical| | Rise edge detection + input/1 output and a through output.
70 ] Through output Once a rise of an input signal is detected, the
_‘L [ ON signal is output until the end of one
execution cycle time.
This is a combination of a rise detection with 1
Input Output input/1 output and an OFF-delay timer.
Logical Logical| | Rise edge detection + | When arise edge is detected, the output turns
72 -I'T OFF-delay timer ON.
— Turning OFF the rise edge detection starts the
OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input Qutput This is a combination of a rise detection with 1
Logical Logical| | pise edge detection + input/1 output and a pulse (1 shot) output.
73 —— Pulse (1 shot) For information on the operation of a pulse (1
|"'| shot), refer to Block selection 13 "Through

output + Pulse (1 shot)".

80, 82, 83: Fall Edge

Block

; Symbol Function block Description
selection
Input Output This is a combination of a fall detection with 1
Logical Logical| | Fall edge detection + input/1 output and a through output.
80 T Through output Once a fall of an input signal is detected, the
Al ) ON signal is output until the end of one
— execution cycle time.
This is a combination of a fall detection with 1
Input Output input/1 output and a general-purpose timer.
Logical Logical| | £5) edge detection + When a fall edge is detected, the output turns
82 -I_T OFF-delay timer ON.
— Turning OFF the rise edge detection starts the
OFF-delay timer. When the timer time has
elapsed, the output turns OFF.
Input Qutput This is a combination of a fall detection with 1
Logical Logical| | £ edge detection + input/1 output and a pulse (1 shot) output.
83 —— Pulse (1 shot) For information on the operation of a pulse (1
|"'| shot), refer to Block selection 13 "Through

output + Pulse (1 shot)".
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90, 92, 93: Both Edges

Block

; Symbol Function block Description
selection
Input Qutput . This is a combination of a rise and fall detection
Logical Logical (F;'?e fti_”d fall edge with 1 input/1 output and a through output.
etection
90 h h Once arise or fall of an input signal is detected,
md + Through output the ON signal is output until the end of one
execution cycle time.
Input Qutput . This is a combination of a rise and fall detection
Logical Logical (F;'?e fti_”d fall edge with 1 input/1 output and an OFF-delay timer.
etection
92 - delav fi Turning OFF the rise and fall edge detection
- + OFF-delay timer starts the OFF-delay timer. When the timer time
has elapsed, the output turns OFF.
Input Output | Rise and fall edge This is a combination of a rise and fall detection
Logical Logical| | detection with 1 input/1 output and a pulse (1 shot) output.
93 —— + Pulse For information on the operation of a pulse (1
+TH H h shot), refer to Block selection 13 "Through
- (1 shot)

output + Pulse (1 shot)".
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2.3.3.18.4.

To select a "digital other" symbol, choose [Digital
Other] from the [Digital] tab.

100 to 105: Hold

[Digital] - Digital Other

Tool box o X
Digital IHnaIDg I Digital+fnaloe I FE |
Bazic logic LI

Bazic logic
Flip=Flop
Edee detection

seElale%(t:ii:)n Symbol Function block Description
Input 1| Ou?pult This is a combination of a "hold previous value"
[Logicall [Logicall function with 2 inputs/1 output and a through
- output.
HOLD fr— Hold + Through output
100 - 9 P Input 2 is the hold control signal.
Input 2 Turning OFF Input 2 outputs Input 1.
Turning ON Input 2 holds the previous output
value.
Input 1| Ou?pult This is a combination of a "hold previous value"
[Logicall [Logical function with 2 inputs/1 output and an ON-delay
- —— timer.
101 Hotopd = | | Hou _ .
- = + ON-delay timer Turning ON the hold output starts the ON-delay
Inout 2 timer. When the timer time has elapsed, the
- output turns ON. Turning OFF the hold output
turns OFF the output.
Input 1 Output
|Logical| [Logicall . i .
This is a combination of a "hold previous value"
102 g -_I"'| || Hold function with 2 inputs/1 output and an
= — + OFF-delay timer OFF-delay timer.
Input 2 Turning ON the hold output turns ON the output.
Input 1 Output o o )
[Logical| [Logical| This is a combination of a "hold previous value"
Hold function with 2 inputs/1 output and a pulse (1
103 ool __I"'| | o shot) output.
- - + Pulse (1 shoy) For information on the operation of a pulse (1
Input 2 shot), refer to Block selection 13 "Through
Logical output + Pulse (1 shot)".
Input 1 Output . L .
[Logical [Logical] This is a combination of a "hold previous value"
function with 2 inputs/1 output and a
104 Thook- ﬁ:"|_ || Hold retriggerable timer.
= — + Retriggerable timer For information on the operation of a
Input 2 retriggerable timer, refer to Block selection 14
m "Through output + Retriggerable timer".
Input 1 Output . L )
[Logicall [Logical This is a combination of a "hold previous value"
Hold function with 2 inputs/1 output and a pulse train
- — o
105 HOLH | [ |, puise tain outout output.
- TTTITS uise train outpu For information on the operation of a pulse train
Input 2 output, refer to Block selection 15 "Through
Logical output + Pulse train output"”.
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110, 120, 130: Counter/Timer

Bl .
oc'k Item Details
selection
Category | Counter/Timer
Function block | Up counter
Function 1: Target value
-m Input 1 -
Symbol P /:l_l' - Output
Input2 =
Function 2: Not used
This is an up counter output with a reset input.
Function 1 sets the target value.
Input 2 is a reset signal. Turning ON Input 2 sets the counter value to 0.
110 Description | If the counter value is less than Function 1, +0.01 is added to the counter value at
the rise of Input 1.
When the counter value is equal to or more than Function 1, the output turns ON.
When the output is ON, nothing is added to the counter value.
Stopping the customizable logic sets the counter value to 0.
Inout 1 Logical value: When the count signal changes from OFF to ON, +0.01 is added to
P the counter value.
Input 2 | Logical value: Turning ON the input signal sets the counter value to 0.
Output Logical value: ON when the counter value is equal to or more than the target
P value
) Function 1: Target value: 0.00 to 9990 (significant digits: 3 digits)
Property settings
Function 2: Not used
Category | Counter/Timer
Function block | Down counter
Function 1: Counter initial value
Input1
Symbol ‘l_;,\- Output
Input2 =
Function 2: Not used
This is an down counter output with a reset input.
Function 1 sets the initial value.
Input 2 is a reset signal. Turning ON Input 2 sets the counter value to Function 1.
120 Description | If the counter value is more than 0, +0.01 is subtracted from the counter value at
the rise of Input 1.
When the counter value is equal to or less than 0, the output turns ON. When the
output is ON, nothing is subtracted from the counter value.
Stopping the customizable logic sets the counter value to Function 1.
Inout 1 Logical value: When the count signal changes from OFF to ON, +0.01 is
P subtracted from the counter value.
Input 2 | Logical value: Turning ON the reset signal sets the counter value to Function 1.
Output | Logical value: ON when the counter value is equal to or less than the 0.
. Function 1: Target value: 0.00 to 9990 (significant digits: 3 digits)
Property settings

Function 2: Not used
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Block
selection

Item

Details

130

Category

Counter/Timer

Function block

Timer with a reset input

Symbol

Function 1: Target time
Input 1 - \:
Input2 = O

Function 2: Not used

Output

Description

This is an OFF-delay timer output with a reset function.
Function 1 sets the target time.
Input 2 is a reset signal. Turning ON Input 2 sets the timer current value to 0.

Turning ON Input 1 turns ON the output and starts the timer. While the timer is
operating, the output remains ON without regard of the status of Input 1.

When the timer current value is equal to or more than the target time, the output
turns OFF without regard of the status of Input 1. Also, the timer stops and the
timer current value becomes 0.

If both Input 1 and Input 2 are turned ON, Input 2 takes precedence.

Stopping the customizable logic sets the timer current value to 0.

Input 1

Logical value: When the signal changes from OFF to ON, the timer is started.

Input 2

Logical value: Turning ON the reset signal sets the timer current value to 0.

Output

Logical value: ON during the period from when Input 2 turns OFF and Input 1
turns ON to when the timer current value becomes less than the target time.

Property settings

Function 1: Target time: 0.00 to 9990 [s] (significant digits: 3 digits)

Function 2: Not used
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2.3.3.18.5. [Analog] - Basic Operator
Calculator
2001: Addition
BI .
oc_k Item Details
selection
Category | Calculator
Function block | Addition
Function 1: Upper limit value
QEED nput1 - n
Symbol —|— - —}  oOutput (TEED
@ED nput2 - 3
Function 2: Lower limit value
This is a combination of an addition circuit with 2 inputs/1 output and an output
limiter.
This function block performs an addition between Input 1 and Input 2 and outputs
2001 Description | the result.
The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | output =Input 1+ Input 2
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
. Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2002: Subtraction

Block .
OC. Item Details
selection
Category | Calculator
Function block | Subtraction
Function 1: Upper limit value
QEED nput1 4 s
Symbol — H—F output =D
@RED nput2 - 3
Function 2: Lower limit value
This is a combination of an subtraction circuit with 2 inputs/1 output and an output
limiter.
This function block performs a subtraction between Input 1 and Input 2 and
2002 Description | outputs the result.
The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | output =Input1-Input 2

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990

. Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2-126




Chapter 2 Functional Description

2003: Multiplication

Bloc'k Item Details
selection
Category | Calculator
Function block | Multiplication
Function 1: Upper limit value
m Input 1 - s
Symbol X H=—F output (=D
w Input 2 = 1
Function 2: Lower limit value
This is a combination of a multiplication circuit with 2 inputs/1 output and an
output limiter.
This function block performs a multiplication between Input 1 and Input 2 and
2003 Description | outputs the result.
The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | output =Input 1 x Input 2
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
. Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings ) o R . .
Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
2004: Division
Bloc'k Item Details
selection
Category | Calculator
Function block | Division
Function 1: Upper limit value
Q@EED npur L) [
Symbol — H=—} output JEED
@EED nput2 - i
Function 2: Lower limit value
This is a combination of a division circuit with 2 inputs/1 output and an output
limiter.
This function block performs a division between Input 1 and Input 2 and outputs
2004 Description | the result.
The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | output =input1+ Input 2
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
. Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings . o R o .
Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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2006: Absolute value

Bloc'k Item Details
selection
Category | Calculator
Function block | Absolute value
Function 1: Upper limit value
Symbol @@ e 4\/} =L ouput (EED
L]
Function 2: Lower limit value
This function block determines the absolute value of the input and outputs the
2006
result.
Description | The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2007: Inverse addition

Bloc'k Item Details
selection
Category | Calculator
Function block | Inverse addition
Function 1: Offset
Symbol EED nput - Inv. output (CEED
Add
Function 2: Bias
This is an inverting circuit with 1 input/1 output.
It corrects the sign inversion value of the input based on Function 1 (offset) and
Function 2 (bias) and outputs it.
2007 Description | The output is limited by +9990.
This is similar to the function block "inverse addition switchover (4002)". For
information on the inverse addition switchover, refer to "4002: Inverse addition
switchover" in "[Digital + Analog] - Basic operator".
Calculation Output = - (Input - Function 1) + Function 2

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990 (limit value: £9990)
Function 1: Offset: -9990 to +9990 (significant digits: 3 digits)

Property settings

Function 2: Bias: -9990 to +9990 (significant digits: 3 digits)
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2103: Average

Bloc.k Iltem Details
selection
Category | Calculator
Function block | Minimum selection
Function 1: Upper limit value
@RED nput1 <
Symbol Avel=——|= Output @
EED nput2 = .
Function 2: Lower limit value
Outputs the addition average value of Input 1 and Input 2.
o The output is limited by the upper and lower limit values assigned to Function 1
2103 Description .
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Calculation | Output = 7Input1-;lnput 2

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output | Numeric value: -9990 to +9990
Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)

Property settings

Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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Limiter

2005: Limiter
Bloc'k Iltem Details
selection
Category | Limiter
Function block | Limiter

2005

Symbol

Function 1: Upper limit value

Function 2: Lower limit value

Description

This is an upper/lower limiter circuit with 1 input/1 output.
This function block determines the limited value of Input 1 and outputs the result.

The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.

If the upper limit value is equal to the lower limit value, the upper limit value is
interpreted as +9990 and the lower limit value as -9990. In this case, "Through"
appears under the symbol.

If the upper limit value is less than the lower limit value, the upper limit value is
output.

Input

Numeric value: -9990 to +9990

Output

Numeric value: -9990 to +9990

Property settings

Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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2008: Variable limiter

Block
selection

Item

Details

2008

Category

Limiter

Function block

Variable limiter

Symbol

Function 1: Input 3 (step number)

@EED input 1

Q@D nput2 —\j;— - output (EXED
m Input 3: Function = \j

block output

Function 2: Not used

Description

You can apply variable upper and lower limits to Input 3.

The output is limited by the upper and lower limit values assigned to Input 1 and
Input 2.

If Input 1 (upper limit value) is less than Input 2 (lower limit value), Input 1 is
output.

Input 3 accepts the connection of the output of a function block (a symbol that
allows step number assignment). You cannot connect an input terminal directly to
it.

If you do not connect Input 3, the variable upper and lower limit values are applied
to the output (SOxx) with step number xx specified in Function 1.

If you connect Input 3, performing the auto step number assignment overwrites
Function 1 with the step number specified by Input 3.

Calculation

The lower limit is applied first and
Input 1 then the upper limit is applied.

~"_Outpu If you do not connect Input. 3, replace
Input 3 Input 3 shown to the left with the

SN .
Input 2 output of the step number specified
in Function 1.

Input 1

Numeric value: -9990 to +9990

Input 2

Numeric value: -9990 to +9990

Output

Numeric value: -9990 to +9990

Property settings

Function 1: Step number: 1 to maximum step number

Function 2: Not used
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Selector

2101: Maximum selection

Bloc.k Item Details
selection
Category | Selector
Function block | Maximum selection
Function 1: Upper limit value
QEED input 1 <
Symbol Max el s e Output w
Q@EED nput 2 Sel.| |
Function 2: Lower limit value
Compares Input 1 and Input 2 and outputs the larger of the two.
2101 o The output is limited by the upper and lower limit values assigned to Function 1
Description .
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

2102: Minimum selection

Block .
. Iltem Details
selection
Category | Selector
Function block | Minimum selection
Function 1: Upper limit value
@EED nput1 il [
Symbol Minf vt ] oppu (EED
QEED nput2 <Sel) |
Function 2: Lower limit value
Compares Input 1 and Input 2 and outputs the smaller of the two.
2102 . The output is limited by the upper and lower limit values assigned to Function 1
Description .
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990

Property settings

Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

2.3.3.18.6. [Analog] - Comparator

Comparator
2051: Comparison 1

Block
selection

Iltem Details

Category | Comparator

Function block | Comparison 1

Function 1: Deviation judgment value

m Input 1 -
Symbol @ Output
(Numeric JT TR

Function 2: Hysteresis width

Digitally outputs the comparison result of the two input deviations (including any

. equal sign).
Description . .
2051 If both the output ON and OFF conditions are true, the ON condition takes
precedence.
L i > . . .
Calculation Output ON condition: Input 1 - Input 2 = Function 1 + |Function 2|

Output OFF condition: Input 1 - Input 2 = Function 1 - |Function 2|

Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990

Logical value: ON when the output ON condition is true; OFF when the output
OFF condition is true.

Output

Function 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 digits)

Property settings . o L - -
Function 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)

2052: Comparison 2

Block .
. Item Details
selection
Category | Comparator
Function block | Comparison 2
Function 1: Deviation judgment value
@ Input 1 -
Symbol b Output
QEED nput2 2
Function 2: Hysteresis width
- Digitall h i It of th i iati includi
Description igita )_/outputs the comparison result of the two input deviations (not including
equal signs).
2052
L i S . + .
Calculation Output ON condition: Input 1 - Input 2 > Function 1 + |Function 2|

Output OFF condition: Input 1 - Input 2 < Function 1 - |[Function 2|

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Outout Logical value: ON when the output ON condition is true; OFF when the output

P OFF condition is true.
) Function 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 digits)
Property settings . o L o o

Function 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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2053: Comparison 3

Bloc.k Item Details
selection
Category | Comparator
Function block | Comparison 3
Function 1: Deviation judgment value
@ Input 1 - 5
Symbol > Outpu
QD nput2 3
Function 2: Hysteresis width
Digitally outputs the comparison result of the two input deviations (absolute
o values) (including any equal sign).
Description . -
2053 If both the output ON and OFF conditions are true, the ON condition takes
precedence.
I i > . + .
Calculation Output ON condition: |Input 1 - Input 2| = Function 1 + |Function 2|

Output OFF condition: |Input 1 - Input 2] = Function 1 - |Function 2|

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Output Logical value: ON when the output ON condition is true; OFF when the output
OFF condition is true.

) Function 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)

2054: Comparison 4

Block .
OC. Item Details
selection
Category | Comparator
Function block | Comparison 4
Function 1: Deviation judgment value
QIED input1  =fr—ABS
Symbol Output -Logical
@ED nput2 E 4
Function 2: Hysteresis width
_ Digitally outputs the comparison result of the two input deviations (absolute
Description . . .
values) (not including equal signs).
2054
. Output ON condition: |Input 1 - Input 2| > Function 1 + |Function 2|
Calculation
Output OFF condition: |Input 1 - Input 2| < Function 1 - |Function 2|

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Outout Logical value: ON when the output ON condition is true; OFF when the output
P OFF condition is true.
) Function 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 digits)

Property settings

Function 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

2055: Comparison 5

seEile(z:(t:il:)n Item Details
Category | Comparator
Function block | Comparison 5
Function 1: Judgment value
Symbol @ED nput - h Output
Function 2: Hysteresis width
Digitally outputs the comparison result of the input and the judgment value.
2055 Description | The hysteresis width is configurable but takes effect only if the OFF condition is
true.
Calculation Output ON condition: Input = Function 1
Output OFF condition: Input 1 < Function 1 - |Function 2|
Input | Numeric value: -9990 to +9990
Output Logical value: ON when the output ON condition is true; OFF when the output

OFF condition is true.

Property settings

Function 1: Judgment value: -9990 to +9990 (significant digits: 3 digits)

Function 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)

2056: Comparison 6

Block .
OC. Item Details
selection
Category | Comparator
Function block | Comparison 6
Function 1: Judgment value
Symbol @D nput - m Output
Function 2: Hysteresis width
Digitally outputs the comparison result of the input and the judgment value.
2056 Description | The hysteresis width is configurable but takes effect only if the OFF condition is
true.
— S .
Calculation Output ON condition: Input = Function 1
Output OFF condition: Input 1 < Function 1 + |Function 2|
Input | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
P OFF condition is true.
_ Function 1: Judgment value: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits)
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2071: Window comparison 1

Bloc.k Item Details
selection
Category | Comparator
Function block | Window comparison 1
Function 1: Upper threshold
Symbol @EED nput - || > Output [Logical
1
Function 2: Lower threshold
Digitally outputs the comparison result of Input 1 and the upper/lower thresholds.
2071 Description | |f nput 1 is within the range between the upper threshold and the lower threshold
(including equal signs), ON (true) is output.
) Output ON condition: Function 1 = Input = Function 2
Calculation B ) )
Output OFF condition: (Input > Function 1) or (Function 2 > Input)
Input | Numeric value: -9990 to +9990
Outout Logical value: ON when the output ON condition is true; OFF when the output
P OFF condition is true.
Function 1: Upper threshold: -9990 to +9990 (significant digits: 3 digits)
Property settings ) o o o
Function 2: Lower threshold: -9990 to +9990 (significant digits: 3 digits)
2072: Window comparison 2
Bloc_k Item Details
selection
Category | Comparator
Function block | Window comparison 2
Function 1: Upper threshold
Symbol QD Input - @ Output
2
Function 2: Lower threshold
Digitally outputs the comparison result of Input 1 and the upper/lower thresholds.
2072 Description | |f nput 1 is within the range between the upper threshold and the lower threshold
(not including equal signs), ON (true) is output.
) Output ON condition: Function 1 > Input > Function 2
Calculation
Output OFF condition: (Input = Function 1) or (Function 2 = Input)
Input | Numeric value: -9990 to +9990
Output Logical value: ON when the output ON condition is true; OFF when the output

OFF condition is true.

Property settings

Function 1: Upper threshold: -9990 to +9990 (significant digits: 3 digits)

Function 2: Lower threshold: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

2.3.3.18.7. [Analog] - Converter
Converter
2009: Linear function
BI .
oc_k Item Details
selection
Category | Converter
Function block | Linear function
Function 1: Coefficient K 5
Symbol QD Input = k - output (THED
Function 2: Coefficient Kpg

This function block calculates the linear function passed as input.
It calculates the output value based on the predefined linear function (one

2009 o indicated in the "Calculation” field below). The coefficients of the linear function

Description | 5o given by Function 1 and Function 2.
The output is limited by the internal limiter.
When Function 1 is set to 0.00, no error occurs even if the input is not connected.
Calculation | Output = Ky xInput+ K p
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990 (limit value: £9990)
Function 1: Coefficient KA: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Coefficient Kg :-9990 to +9990 (significant digits: 3 digits)

2151: S13 function code input
Bloc.k Item Details
selection
Category | Converter
Function block | S13 function code input
Function 1: Value output when S13 is 20000
Symbol ‘%113 - - Output m
T
Function 2: Value output when S13is 0

Converts the settings "0 to 20000/0 to

2151 o 100%" of function code S13 (PID command Output
Description | value) so that the values specified in
Function 2 and Function 1 are output when Function 1
S13is 0 and 20000, respectively.
Calculation | Output= (Function1- Function2) S13 + Function 2 Function 2 =——— > 513
20000 0 20000
(0%) (100%)
Output | Numeric value: -9990 to +9990 (limit value: £9990)
) Function 1: Value output when S13 is 20000: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Value output when S13 is 0: -9990 to +9990 (significant digits: 3 digits)
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2201: Inverse scale transformation

Bloc'k Item Details
selection
Category | Converter
Function block | Inverse scale transformation
Function 1: Value input when the output is 100
Symbol TEED nput  —] = output (TIED
Function 2: Value input when the output is O
Inversely transform the scale of Input 1 from "minimum to maximum" to "0 to 100%".
Use this function block for the connection to an analog output terminal.
Description | The maximum number of steps that can be
2201 used is two. Output
If you set both Function 1 and Function 2 100
to the same value, the output is 0.
Calculation | Output =100 x Input - Function 2 o2 > Input
FUnCtion 1_ FUnCtion 2 Function 2 Function 1
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990 (limit value: £9990)
. Function 1: Value input when the output is 100: -9990 to +9990 (significant digits: 3 digits)
Property settings ] ) ) o o o
Function 2: Value input when the output is 0: -9990 to +9990 (significant digits: 3 digits)
2202: Scale transformation
Bloc.k Item Details
selection
Category | Converter
Function block | Scale transformation
Function 1: Value output when the input is 100
Symbol @ Input — = Output m
Function 2: Value output when the input is 0
Inversely transform the scale of Input 1 from "minimum to maximum" to "0 to 100%".
o For input selection, you can only use a setting from 8000 to 8085
Description
The maximum number of steps that can be used is
2202 Output
two. p
Function 1
Calculation | Output = (Function i)gunctlon 2) x Input + Function 2
Function 20 Input]
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990 (limit value: £9990)
. Function 1: Value output when the input is 100: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Value output when the input is 0: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

3001: Conversion 1

Block .
. Iltem Details
selection
Category | Converter
Function block | Conversion 1
Function 1: Upper limit value
\Ll"
Symbol @ED nput - )L /H=F outpu (EED
L]
Function 2: Lower limit value
This function block calculates the quadratic function passed as input.
It calculates the output value based on the predefined quadratic function (one
indicated in the "Calculation" field below).
The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.
For more information on the limit operation, refer to "2005: Limiter".
You can select whether to manually set or automatically calculate coefficients
Ka: Kg, K¢
To manually set the conversion coefficients
You can set each coefficient using an exponent. For example, you can specify
a mantissa and an exponent part to define Kaas follows:
K a = (Mantissa) x 10(Exponent part)
The same appliesto Kz and K.
To automatically calculate the
i fficients Output
Description conversion coe
Specify the input-output
relationship using three points: Y3 .aperating
3001 (X1, Y1), (X2, Y2), and (X3, Y3). point 3
Then each coefficient is set to (X3,Y3)
an automatically calculated
value.
The maximum number of steps 2
that can be used is one for both 2 i Operating
Conversion 1 (3001) and i point2
Conversion 2 (3002). 7] — ’ .Operatingg (X2,Y2)
When you use both Conversion 1 p)‘()i”\‘(1
(3001) and Conversion 2 (3002), 0 X X, ‘))‘( %
Conversion 1 (3001) takes 1 2 3 Input
precedence.
If you use two or more instances of Conversion 1 (3001), the one with the
smallest step number takes precedence.
Do not select Auto Calculation when you want to write to the keypad. Refer to
"2.3.3.4. [4] Function Block 3001: conversion 1, 3002: conversion 2" for details.
Calculation | Output = K p x (Input)2 + Kpg xInput+ K¢
Input | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990 (limit value: £9990)
To manually set the conversion coefficients:
Mantissas of K,, Kg,and K¢:-9.999 to 9.999
Exponent parts of K,, Kg,and K¢:-5t05
Property settings | To automatically calculate the conversion coefficients:

X1, Y1, Xo, Yo, X3, Y3:-9990 to +9990 (significant digits: 3 digits)
Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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3002: Conversion 2

Block

. Item
selection

Details

Category

Converter

Function block

Conversion 2

Symbol

Function 1: Upper limit value
rH= output (THED

Function 2: Lower limit value

@D input

Description

3002

L]
This function block calculates the output value based on the predefined function
(one indicated in the "Calculation” field below).

The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.

For more information on the limit operation, refer to "2005: Limiter".

You can select whether to manually set or automatically calculate coefficients
Ka, Kg, K¢

To manually set the conversion coefficients

You can set each coefficient using an exponent. For example, you can specify a
mantissa and an exponent part to define K , as follows:

Ka= (Mantissa) x 1O(Exponent part)

The same appliesto Kz and K.
To automatically calculate the

Y

Operating

conversion coefficients
Specify the input-output ff(’;”\t(j
relationship using three points: i
(X1, Y1), (X2, Y2), and (Xs, Ya).
Then each coefficient is set to
an automatically calculated
value.

Operating
point 2
(X2,Y2)

The maximum number of steps
that can be used is one for both
Conversion 1 (3001) and
Conversion 2 (3002).

When you use both Conversion 1
(3001) and Conversion 2 (3002),
Conversion 1 (3001) takes 0
precedence.

Operating
point 1
(X1,Y1)

X4 X X3

If you use two or more instances of Conversion 2 (3001), the one with the
smallest step number takes precedence.

If the calculation result inside ./ is a negative value, '0' is output.

Do not select Auto Calculation when you want to write to the keypad. Refer to
"2.3.3.4. [4] Function Block 3001: conversion 1, 3002: conversion 2" for details.

Calculation

Input +
Output = MXKC
KB

Input

Numeric value: -9990 to +9990

Output

Numeric value: -9990 to +9990 (limit value: £9990)

Property settings

To manually set the conversion coefficients:

Mantissas of KA, Ks , and Kc: .9.999 t0 9.999

Exponent parts of KA, Keg , and Ke. 5105
To automatically calculate the conversion coefficients:

Xl, Yl, XZ, Y2, X3, Y3:.9990 to +9990 (significant digits: 3 digits)
Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)
Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

2.3.3.18.8. [Digital + Analog] - Basic operator

Basic operator
4001: Hold

Block

. Iltem Details
selection

Category | Basic operator

Function block | Hold

Function 1: Upper limit value

@EED nput1 o s

Symbol HOLD oy = = Output w
Input2 = M

Function 2: Lower limit value

Turning OFF Input 2 (logical value) outputs Input 1 as-is.
Turning ON Input 2 (logical value) holds the output value.

4001 Description | The output is limited by the upper and lower limit values assigned to Function 1
and Function 2.

For more information on the limit operation, refer to "2005: Limiter".

Input 1 | Numeric value: -9990 to +9990

Logical value: OFF: Input 1 is output.

Input 2 . .
ON: The previous output value is output.

Output | Numeric value: -9990 to +9990

Function 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits)

Property settings . . N . .
Function 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits)

4002: Inverse addition switchover

se?(lac():(t:ilgn ltem Details
Category | Basic operator
Function block | Inverse addition switchover
Function 1: Offset
m Input 1 - O
Symbol Inzut , - g‘o' = output (TIED
Function 2: Bias
Turning OFF Input 2 (logical value) outputs Input 1 as-is.
Turning ON Input 2 (logical value) outputs the calculation result of the expression
Description indicated in the "Calculation" field below.
This is similar to the function block "inverse addition (2007)". For information on
4002 the inverse addition, refer to "2007: Inverse addition” in "[Analog] - Basic

Operator".

Calculation | Output when Input 2 is ON = -(Input 1 - Function 1) + Function 2

Input 1 | Numeric value: -9990 to +9990

Logical value: OFF: Input 1 is output.

Input 2 ON: Outputs the calculation result of the expression indicated in
the "Calculation" field above.

Output | Numeric value: -9990 to +9990 (limit value: £9990)

Function 1: Offset: -9990 to +9990 (significant digits: 3 digits)

Property settings ) ) L . -
Function 2: Bias: -9990 to +9990 (significant digits: 3 digits)
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4005: Low pass filter

Bloc'k Item Details
selection
Category | Basic operator
Function block | Low pass filter
Function 1: Time constant [s]
@ED nput1 LPF
Symbol Output w
y 2 AL ’
Function 2: Fixed to O
Turning OFF Input 2 outputs Input 1 as-is.
Turning ON Input 2 outputs Input 1 after applying a low pass filter to it.
Description | The low pass filter calculation uses the previous output value. When Input 2
4005 changes from OFF to ON, the previous output value is the output value before the

low pass filter is applied. The previous output value is '0' when the customizable
logic is started or the CLC terminal is turned ON.

Input 1 | Numeric value: -9990 to +9990

Input 2 Logical value: OFF: Input 1 is output.

ON: Outputs Input 1 after applying a low pass filter to it.

Output | Numeric value: -9990 to +9990

Function 1: Time constant: 0.01 to 5.00 [s] (A value of 0.00 disables the filter.)
Property settings

Function 2: 0
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Chapter 2 Functional Description

4006: Change rate limit

Block
selection

Item

Details

4006

Category

Basic operator

Function block

Change rate limit

Symbol

Function 1: Rise time [s]

w lnpUt 1 - Ramp
- Output
nput2 L1 uout (D

Function 2: Fall time [s]

Explanation

The change rate limit function block limits the change amount per unit time of
Input 1.

You can also set the limit value by specifying the time for Input 1 to change from 0
to 100. You can specify the limit values separately for the rise amount and the fall
amount.

Turning OFF Input 2 outputs Input 1 as-is.
Turning ON Input 2 outputs Input 1 after applying the change rate limit to it.

The change rate limit calculation uses the previous output value. When Input 2
changes from OFF to ON, the previous output value is the output value before the
change rate limit is applied. The previous output value is '0' when the
customizable logic is started or the CLC terminal is turned ON.

Input 1

Numeric value: -9990 to +9990

Input 2

Logical value: OFF: Input 1 is output.
ON: Outputs Input 1 after applying the change rate limit to it.

Output

Numeric value: -9990 to +9990

Property settings

Function 1: Rise time: Time for Input 1 to change from 0 to 100
0.01 to 600 [s] (significant digits: 3 digits) (When set to 0, no limit is
applied.)

Function 2: Fall time: Time for Input 1 to change from 0 to 100
0.01 to 600 [s] (significant digits: 3 digits) (When set to 0, the same
time as Function 1 is used.)
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6101: PID dancer output gain frequency

Block
selection

Item

Details

6101

Category

Basic operator

Function block

PID dancer output gain frequency

Symbol

Function 1: Gain ratio [%0]

QUED npur 1 Dancer PID 0 Numeric)
2 - utput
input2 =MV mode sw P

Function 2: Frequency lower limit value [Hz]

Description

This function block is used in the dancer control PID.

You can select whether to calculate the frequency correction amount by assuming
that the 100% of the PID output is equivalent to the maximum output frequency or
the commanded frequency (by the line speed command).

Setting Input 1 to 0 outputs 0.

Setting Input 1 to a non-zero value outputs the value calculated using the
expression indicated in the "Calculation” field.

The output is intended for use in monitoring.

If the dancer control is enabled (i.e., function code JO1 is set to 3), the function
block calculates the frequency correction amount using the expression indicated
in the "Calculation” field below and reflects it to the output frequency.

The maximum number of steps that can be used is one. If you use two or more

instances of PID dancer output gain frequency (6101), the one with the smallest
step number takes precedence.

Function 1

Maximum output
frequency | ———, %0

[z \OJI—HI»E[ ~l Output

0

Set frequency

I g
—_— —d
I o Turns ON when dancer
[Hz] |

control is enabled

0.01

PID output
[%]

Output
frequency
[Hz]

Input 1

Input 2

Calculation

Output

Input 1 Input 2 | Function 1 Output

0 OFF/ON | Not used 0
OFF Not used | If set frequency is equal to or more than
Function 2, the set frequency is output.

0 If the set frequency is less than
ON Function 2, Function 2 is output.

Non-zero

Function1
100

PID output [%]

100
Output frequency - Set frequency + Frequency correction amount

Non-zero x Maximum output frequency

Frequency correction amount = x Output
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Chapter 2 Functional Description

Bloc'k Iltem Details
selection
Numeric value: If setto 0, 0 is output.
Input 1 o
If set to a non-zero value, the calculation is performed.
Logical value: OFF: Calculates the frequency correction amount from the set
frequency.
Input 2 ON: If Function 1 is 0, same as OFF.
6101 If Function 1 is non-zero, the function block calculates the

frequency correction amount from the maximum output
frequency.

Output | Numeric value: -9990 to +9990

Function 1: Gain ratio: 0 to 200 [%)]

Property settings . o
Function 2: Frequency lower limit value: 0 to 500 [Hz]
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2.3.3.18.9. [Digital + Analog] - Selector
Selector
4003: Selection 1
BI .
oc_k Item Details
selection
Category | Selector
Function block | Selection 1
Function 1: Value output when the Input 2 is ON
ED nput1 /o
Symbol 0..40- = Output w
mpuz A 2F T
Function 2: Not used
o Turning OFF Input 2 outputs Input 1 as-is.
4003 Description
Turning ON Input 2 outputs Function 1.
Input 1 | Numeric value: -9990 to +9990
Input 2 Logical value: OFF: Input 1 is Ol-Jtput.
ON: Function 1 is output.
Output | Numeric value: -9990 to +9990
] Function 1: Value output when Input 2 is ON: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Not used

4004: Selection 2

Bloc'k Item Details
selection
Category | Selector
Function block | Selection 2
Function 1: Value output when the Input 2 is OFF
_ @aro
Symbol Input = @_g-o- L output (TIED
Function 2: Value output when the Input 2 is ON
4004 _ Turning OFF Input 2 (logical value) outputs Function 1.
Explanation ) ) i
Turning ON Input 2 (logical value) outputs Function 2.
Input Logical value: OFF: Function 1 is output.
ON: Function 2 is output.
Output | Numeric value: -9990 to +9990
] Function 1: Value output when Input 2 is OFF: -9990 to +9990 (significant digits: 3 digits)
Property settings

Function 2: Value output when Input 2 is ON: -9990 to +9990 (significant digits: 3 digits)
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Chapter 2 Functional Description

5001 to 5014: Selection 3-1to 3-14

Bloc'k Item Details
selection
Category | Selector
Function block | Selection 3-1 to 3-14
[Example in 5001] Function 1: Not used
m InpUt 1 o =) o w
Symbol — utput
@D o> 050
Function 2: Not used
Turning OFF the output (SOxx) with step number xx (where xx is 1, 2,..., 14)
5001 outputs Input 1.
to o Turning ON the output (SOxx) outputs Input 2.
Description )
5014 The output (SOxx) must be a logical value.
S001 to SO14 Logical value: OFF: Input 1 is output.
ON: Input 2 is output.
Input 1 | Numeric value: -9990 to +9990
Input 2 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Function 1: Not used
Property settings )
Function 2: Not used
5101 to 5114: Selection 4-1to 4-14
Bloc'k Item Details
selection
Category | Selector
Function block | Selection 4-1 to 4-14
[Example in 5001] Function 1: Not used
m [[a]]V] 9t NS m—_
Symbol 0,40- = Output w
input 2 {222
Function 2: Not used
5101 Turning OFF Input 2 outputs Input 1.
to Description Turning ON Input 2 outputs the output (SOxx) with step number xx (where xx is 1,
2,...,14).
5114 .
The output (SOxx) must be a numeric value.
Input 1 | Numeric value: -9990 to +9990
Input 2 Logical value: OFF: Input 1 is output. .
ON: The output (SOxX) is output.
Output | Numeric value: -9990 to +9990
Function 1: Not used
Property settings

Function 2: Not used
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5000: Selection 3

Bloc'k Item Details
selection
Category | Selector
Function block | Selection 3
Function 1: Step
number
tim Input 1
Symbol i n °
ymbo (NumericlTT T M. L output (D
Input 3: Function _|
block output
Function 2: Not used
Input 3 accepts the connection of the output of a function block (a symbol that
allows step number assignment). You cannot connect an input terminal directly to
it.
Turning OFF Input 3 outputs Input 1.
5000 Turning ON Input 3 outputs Input 2.

Description )
Input 3 must be a logical value.

If Input 3 is not connected, the function block uses the output (SOxx) with step
number xx specified in Function 1 instead of Input 3.

If you connect Input 3, performing the auto step number assignment overwrites
Function 1 with the step number specified by Input 3.

Input 1 | Numeric value: -9990 to +9990

Input 2 | Numeric value: -9990 to +9990

Logical value: OFF: Input 1 is output.

Input 3 )
ON: Input 2 is output.

Output | Numeric value: -9990 to +9990

Function 1: Step number: 1 to maximum step number
Property settings .
Function 2: Not used
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Chapter 2 Functional Description

5100: Selection 4

Bloc'k Item Details
selection
Category | Selector
Function block | Selection 4
Function 1: Step
number
@ED nput1 S
Symbol mput2 L output QIED
w Input 3: Function - _A
block output
Function 2: Not used
Input 3 accepts the connection of the output of a function block (a symbol that
allows step number assignment). You cannot connect an input terminal directly to
it.
Turning OFF Input 2 outputs Input 1.
5100 o Turning ON Input 2 outputs Input 3.
Description )
Input 3 must be a numeric value.
If Input 3 is not connected, the function block uses the output (SOxx) with step
number xx specified in Function 1 instead of Input 3.
If you connect Input 3, performing the auto step number assignment overwrites
Function 1 with the step number specified by Input 3.
Input 1 | Numeric value: -9990 to +9990
Input 2 Logical value: OFF: Input 1 is output.
ON: Input 3 is output.
Input 3 | Numeric value: -9990 to +9990
Output | Numeric value: -9990 to +9990
Function 1: Step number: 1 to maximum step number
Property settings

Function 2: Not used
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2.3.3.18.10. [Digital + Analog] - Function Code

Function Code
6001: Function code read

Block .
OC_ Item Details
selection
Category | Function Code
Function block | Function code read
Function 1: Function code group
Symbol @_’ Read = Output w
Function 2: Function code number
This function block outputs the function code data specified by Function 1 and
Function 2.
It can correctly read out the following data formats:
[11. [2], [3]. [4]. [5]. [6]. [7], [8]. [9], [10],
[12], [22], [24], [29], [35], [37], [45], [61],
67], [68], [74], [92], [93
6001 [][][][]_[_]. N )
However, the value is limited within the range of -9990 to 9990. In addition, for
Description [29], the function block displays 20000 as 100%.
Do not use any other data format than above because the function block cannot
correctly read other formats.
If an attempt is made to read out a non-existent function code, the output will be 0.
For more information on the data formats, refer to Chapter 5 of the Appendix
"RS-485 Communication User's Manual (24A7-J-0082)".
Alternatively, you can refer to the data format for each function code on the
[Function code edit] window accessible from the [Function Code List] window. For
more information on [Function code edit], refer to "2.3.1.1. Function Code Edit".
Input | None
Output | Numeric value: -9990 to +9990 (limit value: £9990)

Property settings

Function 1: Function code group

Function 2: Function code number: 00 to 99
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Chapter 2 Functional Description

6002: Function code write

Block
selection

Item

Details

6002

Category

Function Code

Function block

Function code write

Symbol

Function 1: Fixed to function code group Ul

@ED nput1
Write
[Logical| Input 2 -_@

Function 2: Function code number

Description

Select the function code you want to write to, using Function 1 and Function 2.
You can select function codes U171 to U175. The written value is retained even if
the power is turned off.

Turning ON Input 2 writes Input 1 to the selected function code.
If Input 2 is OFF, nothing is written.

The values written to function codes U171 to U175 are stored in the volatile
memory (RAM) and, once the inverter detects low voltage, stored in the
non-volatile memory (EEPROM).

The maximum number of steps that can be used is one per function code.

If you use two or more instances of function code write (6002), the one with the
smallest step number takes precedence.

When you perform the auto step number assignment, a warning that states
"Output 1 for function code write is not connected" appears but you can ignore it
safely.

Input 1

Numeric value: -9990 to +9990

Input 2

Logical value: OFF: Nothing is written.

ON: Input 1 is written to the function code selected by Function
1 and Function 2.

Output

None

Property settings

Function 1: Function code group: Ul

Function 2: Function code number: 71 to 75
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6003: function code change

Block
selection

Item

Details

6003

Category

Function Code

Function block

Function code change

Symbol

Function 1: Function code group

@D nput1
Input 2

_;gcmm'de

Function 2: Function code number

Description

Select the function code whose setting you want to change, using Function 1 and
Function 2.

Turning ON Input 2 changes the setting of the selected function code to Input 1.

However, this does not change the setting stored in the non-volatile memory
(EEPROM).

Turning OFF Input 2 restores the original setting of the selected function code.
The maximum number of steps that can be used is one per function code.

If you use two or more instances of function code change (6003) for the same
function code, the one with the smallest step number takes precedence.

Before reading and writing function codes from the loader or copying them to the
keypad, be sure to restore the original setting of the selected function code by
turning OFF Input 2.

If you use the function code change (6003) function block to change the setting of
a function code and then load the setting into the loader or copy it to the keypad,
the data that is being changed is read, rather than the data stored in the
non-volatile memory. Moreover, if you select [Write 2 to y97] and write the data
from the loader, the data that is being changed by the function code change
(6003) function block is stored in the non-volatile memory.

Before stopping the customizable logic, you are recommended to turn OFF Input
2.

Stopping the customizable logic with Input 2 still ON retains the data that is being
changed by the function code change (6003) function block. To restore the
original setting from this state, you must (1) start the customizable logic and turn
OFF Input 2, (2) turn off the power to the inverter, or (3) restore the original setting
using a keypad, etc.

Input 1

Numeric value: -9990 to +9990

Input 2

Logical value: OFF: Nothing is written.

ON: Input 1 is written to the function code specified by Function
1 and Function 2.

Output

None

Property settings

Function 1: Function code group

Function 2: Function code number
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Chapter 2 Functional Description

2.3.4. Schedule

You can configure the timer operation conditions for an inverter model that has the timer
operation function based on a realtime clock (RTC).

Tip e To check if your inverter has the timer operation function based on a realtime clock
(RTC), refer to its instruction manual.

e To use the timer operation function based on a realtime clock (RTC), you have to
configure the inverter date and time in advance. For more information, refer to the
User's Manual of your inverter. You can also configure the settings from the loader.
For more information, refer to "2.4.5. Date Time".

Select [Menu] > [Schedule operation] from the main menu or click - on the main window
toolbar and click [Schedule operation] to open the [Schedule operation] window.

[Schedule operation] :

The schedule operation is
indicated.

Schedul
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2.3.4.1. Schedule Setting

This section describes the [Schedule Setting] tab of the [Schedule operation] window.

— Display Setting — Timers 1, 2,3, and 4
[Both]: Displays both the inverter operation and You can create up to four time schedules.
external signal time schedules.
[Run] : Displays the inverter operation time Save
schedule. You can save your created time schedule
[Output] : Displays the external signal time schedule. to a CSV file.
Clear Open
Initializes the loader schedule settings. Reads time schedules from a
CSV file.
& FREMIC Loader — Scheduler ScheduleSetl — [Scheduler ScheduleSetl] 10Ol x|
File  Menu Setup  Wiew Window Help - 8 X
DedSRo|/OES(PHIKeF>EESGEIEBEDRIEEEHIEDEEGE,
o
- apen Save |
ScheduleSetting | HolidaySetting I
€ &isplaySetting: iaoth vi D) O‘rear | —{ Timer1 | Timer2 | Timer3d | - ]
Start Stop
00 03 06 09 12 13 18 21 24
Mon
Tue
Wed
Thu
Fri
Sat
Sun
Mo. 1[0 11 INWT - it Regd from inverter
g O we | Fegtomerr |
I I I
[Select inverter] Write Read from inverter

Select the inverter you want to Writes the schedule and non-working Reads the schedule and non-working
write to and read from. day settings to the inverter. day settings from the inverter.

@ o |[f the loader is connected to an inverter that has password protection enabled, you
may not be able to perform [Write] or [Read from inverter]. If this is the case, you
must disable password protection to perform [Write] and [Read from inverter]. For
more information on password protection, refer to the instruction manual or user's
manual of your inverter.
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Chapter 2 Functional Description

Clicking [Timer 1], [Timer 2], [Timer 3], or [Timer 4] on the [Schedule operation] window opens

the [Schedule Setting] dialog.

Enable/disable — [Start] slider [Stop] slider
the setting Drag this slider to adjust the start Drag this slider to adjust
[} Enable time. the end time.
[} Disable
Start Stop
The currently set start time is The currently set end time is shown.
shown.
ScheduleSetting |
: T Timerl ® ®
Start 50:00 _|:' Stop 50:00 _|:l
00 Today 24 Tomorrow 42
Run Qutput
- -
N
ALL Mon Tue Wed Thu Fri Sat  Sun
- r r r r In - -
J
ok Ganeel ol
ance ea;_l

Select the start day of week
Sets the start day of week.

[]: Enable

[ ] Disable

Select the timer operation mode

Run

: Active (The inverter starts at the scheduled time.)

[ ] Inactive

Output

Clear —

Click this button to initialize
the settings.

: Active (Digital output terminals "TMD", "TMD1", "TMD2", "TMD3", and "TMD4" turn ON at the scheduled

time.)

[ ] Inactive
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The following example shows how to configure the settings, taking the case of [Timer 1].

ScheduleSetting x|
imerl
[ Start  0:.00 = Stop  [08:00 = %
00 Today 24 Tomorrow 48
Run Qutput
~ ~
ALL  Mon Tue Wed Thu Fri Sat Sun
r v ¥~ ¥ [ [
oK GCance| Clear
Run Output
i v
— ALL Mon Tue Wed Thu Fri Sat Sun
r i I 7 r - - r
15|
File  Meru Setun  Miew Window  Help x

DEHESRo|/OXLfRIXeE>HLSEIDD0EHDDIEDEDRRE |

Cear |

el Ter2 | Timers | |[meO]

Open Save

12 19 18 21 24

ScheduleSetting | HolidaySsttine |
DisplaySetting: |Both =
Start Stop
00 03
2000 40
Mon
2000 10
Tue
2000 40
Wed ‘ ‘
Thu ‘ ‘
Fri ‘ ‘
Sat ‘ ‘
Sun ‘ ‘
No Il TNV x Wiite

Read from inverter
4

The same applies to [Timer 2], [Timer 3], and [Timer 4].
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Checking the check box at the
upper left makes the settings
editable.

Configure the start and end
times.

po: T =
([«J] Alternatively, you can

use the sliders to configure
these settings.)

Select the timer operation
mode (Run/Output). (You can
select either or both of these
settings.)

Select the start day of week.
(You can select one or more
check boxes.)

When you are finished, click
[OK].

The new settings are reflected
to the [Schedule Setting]
dialog.



Chapter 2 Functional Description

2.3.4.2. Non-working Day Settings

You can configure up to 20 non-working days annually. This is useful when you want to
inactivate the timer operation on holidays or other special days on which the timer operation
would otherwise be active in your schedule. On the non-working days, the timer operation is not
activated even if within the timer operation schedule.

You can configure non-working days in two ways:
1. Specify the day of month (example: January 01)
2. Specify the day of week (example: January Second Sunday)

The following is how to use the [Holiday Setting] tab of the [Schedule operation] window.

Chk — Month — Day
Enable or disable the setting. Displays the When you specify the day of month, the
: Enable month. days are displayed.
) When you specify the day of week, the
D' Disable weeks are displayed.
 SchedulsSetting
———@ Clear |
Mo, | GChk Manth Day Week @
Il January 01
2 [ January 01
3 [ January 01
4 - January 01
1] [ January 01
i [ January 01
7 [ January 01
8 [ January 01
] - January 01
10 - January 01
" - January 01
12 - January 01
13 - January 01
14 - January 01
15 - January 01
16 - January 01
17 - January 01
18 - January 01
19 Il January 01
mn - January 01
Clear Week
Initializes the loader's When you specify the day of month, the [week]
non-working day settings. column is not displayed.
When you specify the day of week, the day of week
are displayed.
e OIE" ! e e ek Select and click a cell in the [Month],
I,
e | F Jaruary u b [Day], or [Week] column to
a " . = open the [Holiday Setting] dialog.
IQDIT/DW/DW -I
_(h Wegk ————————
January b
1=t vl IMnnday -
0K Cancel
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[1] Setting by the Day of Month

Select and click a cell in the [Month], [Day], or [Week] column on the [Holiday Setting] tab to

open the [Holiday Setting] dialog.

Mo. Chk Da:

Week

T (T
2 [ ! Januar | m

L

HolidaySetting x|
—i{* Day
Cpoirneszr T2

4 eptembe | [ 3

Mon Tue Wed Thu Fri Sat Sun

T Week| T T 3
4 B B 7T 8% 9 Mm

[44n 112 13 14 15 16 17
[dr] 18 18 20 21 22 23
(2 ER 25 29 30 1

2 3 4 5 B 7 3

[ Today: 2650952017

K STt t
f |

fanth

September

[2] Setting by the Day of Week

Select the [Day] radio button.

[2017/I827 =]

Directly enter the day of
month.

Alternatively, you can click = and
select the day of month from the
calendar.

Click [OK].

Check the check box to enable the
setting.

¢ When you specify the day of month, the year is ignored.

Select and click a cell in the [Month], [Day], or [Week] column on the [Holiday Setting] tab to

open the [Holiday Setting] dialog.

HolidaySetting x|

— Day

|2IJ1'."I'IJ1,"[I1 .I

—* ek

ISeptember

ILast V|

fdanth

September
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Select the [Week] radio button.

From the list boxes, select the month,
week, and day of week.

Click [OK].

Check the check box to enable the
setting.



Chapter 2 Functional Description

2.3.5. Trace

Trace function
You can observe the inverter operation status as continuous waveform information.

The loader provides the following two types of the trace function:

(1) Realtime trace: Reads the sequential waveform data from the inverter and displays it
in a graph.
This is suitable for long-time monitoring.

(2) Historical trace: Reads the waveform data of the inverter operation status based on an
arbitrary trigger saved in the inverter's memory and displays it in a
graph. This is suitable for monitoring with small sampling times.

Tip e The trace function can be used in [Data in the inverter (control Pt board)] or [Data in
the inverter (via TP)] when [USB connection] is selected in the [Communication
Settings] window.

@ ¢ Whenever you use the trace function with the version 1.0.0.0, specify the inverter
you want to trace in the No.1 row on the [Communication Setting] -> [Connection
Setting] window. For information on [Connection Setting], refer to "1.5.5.2.

Connection Setting".

Offline setting function
When the loader cannot communicate with the inverter to be traced, you cannot use the trace
function but you can configure the advanced waveform settings. This is useful when you want to

prepare the trace settings in advance.
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2.3.5.1. Trace Function

Select [Menu] > [Trace] from the main menu or click -* on the main window toolbar and
then click [Real-Time Trace] or [Historical Trace] to open the corresponding trace function
window.

[Real-time trace] : [Histarical trace] :

The higtarical tracing screen is
indizated.

To eraphically wigw the running
, ztatuz af the inverter in real-time.

Realtirme Trace

Version 1.0.1.0 or late]  [Select Online/Offline] window is displayed first.

Realatimepines Select [Online], then select [Target Inverter]
in the dropdown list.
Target Iverter:  [No. 10 11 INV1 =] Click [OK].
" Diffline

QK I Cancel

The real-time trace window (see [2.3.5.2.Realtime Trace]) or the historical trace window (see
[2.3.5.3.Historical Trace]) is displayed.

Tip e Forthe [Target Inverter], the model registered in [Connection Settings] (see
[1.5.5.2.Connection Setting]) is displayed.
e Select an inverter that can communicate with the loader in the [Target Inverter]. If
communication is not established, an error is displayed and the trace window is not
displayed.

ersion 1.0.0.0 [Select Online/Offline] window is not displayed.

If the loader can communicate with the inverter registered in [Connection Setup] (see
[1.5.5.2.Connection Setting]), the trace window automatically is displayed.
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Chapter 2 Functional Description

2.3.5.2. Realtime Trace

The following is the description of the [Realtime Trace] window.

— Subwindow — Click this button to save the trace data
- [Monitor], [Graph position adjustment], and (Refer to "2.3.5.5. Saving the Trace Data")
[File information] tabs
(Refer to "2.3.5.8. Subwindow") —— Click this button to copy the waveform monitor

The trace operation status is displayed — (Refer to "2.3.5.6. Copying the Trace Data Screen")

(Refer to "2.3.5.4. Starting/stopping the
Monitoring of the Trace")

Display time frame and sampling time

— Click this button to start/stop the trace operation
(Refer to "2.3.5.4. Starting/stopping the Monitoring of
the Trace")

Cursor setting and position display

The position is displayed only when "vertical"
is selected.

(Refer to "2.3.5.8. [1] Cursor")

Cursor position

Trace type is displayed

Show/hide the

subwindow . .
Scrollbar for moving the vertical cursor

o]

¢ Real-time trace RT2

Curzaor (me)

/Mnmtw [ Graph position adjustment | File information & Vertical & - ~
* Vertical & Gursor Cursor B Gursor AH

~Cursor :
Horizontal - (gpg 13000 (B

Gursor & Cursor B Cursor B _ | ij
A-GHI Quiput frequency (before s.. Tims - 96185 START/STOP  OFF

HZJ

\d [650 [0 [55 ampling Tterval 9os /4]

A-CH2 Output voltage W = ol | ; | ; | ; I | ; | ; | ; | —5\
340 7000 6 r : | : | : | : | : | : | :

D-GH1 —— FWD terminal A-GHI 01~
o o I Qutput frequency r
g = (before slip)
D-GH2 —— 1 terminal S0lH2/div]
[on [on [

[ [ I A-GH2 -

P Qutput voltage
10004 div]
I J [
! I I Bl 0 : N O S
A FWD) terminal r : :
@ External signal impart_| Advarced. o | 7] A u: [ 7777777777777777777777777777777777777777777777777777 P
Segting J 1 terminal [ : : ‘ N ‘ : ‘ : ‘ : L4
\60ms  2MBs 416 | GiB  MiSs  ILIGe  T2ifs| 18ifs 16M6s 1EiGe  200Bs 2208 D4l%s 2606 3
\_ ° JEinl ° C
[Setting] ——— Waveform screen Cursor A Cursor B Waveform —
Click this button to . . screen vertical
importiexport the Scrollbar for moving the horizontal cursor scrollbar
settings. d d f :
(Refer t0 "2.3.5.10 Advanced waveform settings Waveform screen
Setting Export/Setting Advanced settings for each channel. horizontal scrollbar
Import") (Refer to "2.3.5.9. Advanced Waveform
Settings")

— External signal import

Click this button to import the customizable logic trace data. This button appears once you save the trace monitor
information.
(Refer to "2.3.5.11. Combination with the Customizable Logic Function")

Tip e The realtime trace works even if without a trigger setting.
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2.3.5.3.

Historical Trace

The following is the description of the [Historical Trace] window.

— Subwindow

- [Monitor], [Graph position adjustment], and

[File information] tabs

(Refer to "2.3.5.8. Subwindow")

The trace operation status is displayed —
(Refer to "2.3.5.4. Starting/stopping the

Monitoring of the Trace")

Display time frame and sampling time —

Cursor position

Trace type is displayed

Show/hide the
subwindow

*- Historical trace

Click this button to save the trace data
(Refer to "2.3.5.5. Saving the Trace Data")

— Click this button to copy the waveform monitor
(Refer to "2.3.5.6. Copying the Trace Data Screen")

 Click this button to start/stop the trace operation

(Refer to "2.3.5.4. Starting/stopping the Monitoring of
the Trace")

Cursor setting and position display

The position is displayed only when “vertical"
is selected.
(Refer to "2.3.5.8. [1] Cursor")

Scrollbar for moving the vertical cursor
-1/

aritor | @raph position adjustment | File informatior top e apy J (?”672(’”?’ - - -
[ Cursor *+ Wertical * Cursor A Cursor B Cursor AB)
Gursor A Gursar B Cursor AB ) P mont ™ Horizantal =
L_g ACHI Output frequency (before .. Hz:i Tre — B50s mﬁw C OFF — — —
[rs7 Jeoze [1827 mpling Interval Bms— 4] | : v
A-CH2 Qutput valt: W - H H ' ' | 1
[i7a | D|:7Y]D = [0 j o ; :
| | | 0 I [
| | == Suni
D-CHI ——— FIWD tarminal o of 5 :
Jor Jor [ Output frequency r : H :
D—ollz)zN — t:lacr;:\na\ | TR g | —_J' - T
e
J— r L |
| | [ a-cH 1f "“_"__/ [
P Qutput voltage [ : : H |
| | | 1000 4] !
_____________ .
: : : o | - !
= FWD terminal 5 |
Advanced "J Do 0 | B o
S@ine J ¥1 terminal B ‘ : ‘ : 1o ‘ : ‘ ‘ : ‘
Ome  500me 100 | 180s  200s  280s  800s [ 350:  400s  450s  500s 550z 60D 650c j
- L * 2]
t
[Setting] Waveform screen Cursor A Cursor B Waveform —
Click this button to screen vertical
import/export the Scrollbar for moving the horizontal cursor scrollbar
settings. Advanced waveform settings Waveform screen horizontal

(Refer to "2.3.5.10.
Setting Export/Setting
Import")

Advanced settings for each channel.
(Refer to "2.3.5.9. Advanced Waveform

Settings")

scrollbar

To use the historical trace, you must configure the trigger settings. For

information on trigger settings, refer to "2.3.5.9. [2] A-Ch1 to A-Ch4 (analog
settings)" and "2.3.5.9. [3] D-Ch1 to D-Ch8 (digital settings)".
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2.3.5.4. Starting/stopping the Monitoring of the Trace

To start the monitoring of the realtime or historical trace, click the [START/STOP] button around
the top center of the trace screen.

To stop the monitoring, click the [START/STOP] button again.

START/STOR

(Startfﬁtup manitorine

The [START/STOP] button is available when the loader can communicate with the inverter
specified in the No.1 row on the [Communication Setting] -> [Connection Setting] window.

Be aware that the [START/STOP] button is not available:

¢ If you have opened a saved trace data file (i.e., a file with an extension of RT2, HT2, RT1,
RTM, or HIM)

o If you have opened the [Realtime Trace] or [Historical Trace] window without being able to
communicate with the target inverter

Once you start monitoring, the trace type displayed around the top center of the trace screen
starts flashing.

FReal-time trace Histarical trace

Also, the trace operation status displayed around the top center of the trace screen changes as
follows:

If no trigger is used for the realtime trace:

| Stop __ | Running

If a trigger is used for the realtime or historical trace:

| sStop o | Pre Trigeer _g |'I.I'I.I'ait Trigeer _o | Running
Trace type displayed Description
Stopped The trace operation is stopped.
The trace operation is active and capturing the data preceding the
Pre Trigger trigger point.
Note: In this state, no trigger is detected.
Wait Trigger The trace operation is active and waiting for a trigger to be detected.
Running T_he trace operation is active and displaying the data on screen with a
trigger detected.

@ ¢ If you stop the historical trace while its operation status is [Pre Trigger], [Wait
Trigger], or [Running], no waveform is displayed.
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2.3.5.5. Saving the Trace Data

To save the trace data, click the [Save] button around the top center of the trace or select [File]
-> [Save As...].

Save |

When selecting [Save] for the data for the first time, the following dialog will open in the same
manner as when selecting [Save As ...]. Select [Save to ...] and [Save as type] and enter the file
name under which the data is saved in [File Name]. Then click [Save] to save the file.

Organize *  Mew folder B==

Xl
\_) \\_) | .+ Fujielectric = FRENIC Loader4 ~ DATA ~ &3] searchDaTA \QJ
.9.

=] Recent Places ;I Name ~ | Date modified

= Libraries
3 Documents
J“. Music
=] Pictures

E Videos

*& Homegroup

1M Computer |
£, Local Disk (C:)
_ 1l | .
File name: I Real-time trace j

Save as type: IReaI-time trace waveform data File (*.RT2) j
ace waveform data File (*.RT2)
Real-time trace waveform data File (*.C5V)

" Real-time trace graph image(*.JPG)
< Hide Folders Real-time tracegraEh image = BMP)

- Realtime trace waveform information: * RT2, *.CSV (comma separated format)
- Realtime trace graph image: * JPG, *.BMP
- Historical trace waveform information: *HT2, *.CSV (comma separated format)
- Historical trace graph image: *JPG, *.BMP

@ e Once you save a *.CSV, *.JPG, or *.BMP file, you cannot reload it into FRENIC
Loader 4.

@ ¢ Opening a saved *.RT2 or *.HT2 trace data file in FRENIC Loader 4 makes the
[START/STOP] button unavailable.

If you plan to run the trace with the same settings as the saved trace data, save

the settings by selecting [Setting] -> [Setting Export]. For more information on
[Setting Export], refer to "2.3.5.10. Setting Export/Setting Import".
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Chapter 2 Functional Description

2.3.5.6.

Copying the Trace Data Screen

To copy the content of the trace data screen, click the [Copy] button around the top center of the
trace screen. The data is copied to the clipboard, from which you can paste the data to a
document or elsewhere.

Copy |

© YPNBA LV —ART

2R USTMEME | o tee |

. s L e H
YRR [0 = g 16ms - 26165 STAR/STORD, o,
'_" €ieotil P N 20 ]
B = =1 P N of
18 X 100 = r
pad
Ero— Y |
BB EIR) coon ® \
VeISIRABIEN) coo W f
A-oHI
e bt o RS GBI
r AWlH/dv] -
OMCETISHE | \
25 ~| /o [
4 A-CH2 0
PR B d 2 v |8
‘ Conn s o
BORES). t
oot 0f——
oz £
AEMERAA-ID SRTRREND VT DOHY
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2.3.5.7.

To print the trace data, select [File] -> [Print] with the trace screen active. The following is an
example printout of trace data:

Printing the Trace Data

[Trazs sl

[F115 nams]
[nwrtar m2:1]
[Frinting tims]
[Tracs atart tim]

Faal-tims tracs
Faal-tins trace.RT2
FRIE EE25-1
20070877 09:42:04
20708/H 1500 F

[Trigger gmaratim data]

[Zamling Intsral]
[Timatrams par 1 00V]

1ms
FEN A

T L T N T T T T S T T T g T S T
[mama1] [Flite]  [Triger wnditims]  [EaR] [Curaar 2] [wracr €]
Bl Ipf-120me  Clsablad et (-8 0. oo
&1 Ipf-120me  Clsablad et oo oo
-l Claablad s FF OFF
O-thi Claablad s FF OFF
[comant]

FIT T

[Cursar 26]
o
o

FTT A TS

[owy wz ]
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2.3.5.8. Subwindow

[1] Cursor
The boxes on the cursor subwindow display the measurement value or status of each channel at
the respective cursor positions.

— Cursor value monitoring area Cursor settings
Analog: 4 channels Vertical: 2 (either cursor A or cursor B or both)
Digital: 8 channels Horizontal: 2 (either cursor A or cursor B or both)
Channels not visible in the monitoring area can be Hide

displayed using the vertical slides bar at the cursor
value monitoring area.

Analog channel —— Show/hide the Slides bar for moving
cursor value subwindow the vertical cursor
a e trace.R - ol x|
h " — D l’— = s G [ Cursor (ms)
(E;\r:;r' Graph position adjustmeml File infarmatiol Real-time trace op . ave 0pY. @ Verlial & Gusorf, ¢ Ousor B Cursor AD
Cwsor A Cursor B Gurzor AR | 5000 Start/Stop monitaring " Herizontal e el T —
= Sz e B\ (G s IV swarreror || orr
[0 [F0D [F% | Sampline Tterval 20ms K| ol |
A-GH2 Output valtage | : i ' : '

ok

L——@ 240 200.0 166

= SNEP TR NG

J |
i ]
- FWO terminal N Ao 1o e . L S S \
[on [on I Output freauency r : i i : i o i : : : : :
before sli - H | h " h h H h h H \ h
D’CE)ZN_V‘ ‘ng‘"a‘ | ¢ » 0[Heddi] | . : L : ]' [ SO
r 1
[ — [ [ A-CH2 n: // rrrrrr -- : B it AECECE LT EREE e -
P Output voltage r I
1000¥/div] i
| | ] SR i OIS U SO R S B
1
: : I ® D-GH1 n: E II
\ / /Ll _I FWD terminal S R B ) |
External sienal import_ | Advanced. | | - D3 L B i . I .
Setting J 1 terminal : : | | : ; ; : : : H : : H
LI 160ms 21‘63 dlés ﬁlés HTIﬁs TD{ES IQT‘ﬁs Iﬂlﬁs 16{53 IET‘ES QEITIES 22{53 ZI{ES 251‘63 ;I
Kl T 2
I
— Digital channel Cursor value Cursor A Cursor B Waveform screen
cursor value monitoring area horizontal scrollbar

vertical slides bar

Use the scroll bar to move to the waveform screen to be analyzed and click the point to be
observed in the graph. The cursor will move to that position. The cursor movement position is
the sampling point (time point) closest to the clicked point. The trace data of all channels on the
cursor appears on the [Monitor] tab at left.

Alternatively, you can move the cursor using the cursor movement scrollbar or by dragging the
mouse.

The cursor keys on the keyboard are also available.

However, while tracing, neither waveform screen nor cursor can be moved.
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Chapter 2 Functional Description

[2] Adjust Graph Position
The graph position adjustment subwindow allows you to adjust the graph position for each

channel.

Monitor  Graph position adjustment | File information |=l

Scale

ISEI E OIS

Beszet positioning |

Cptimize Y-axiz |

Peak detection |

—Pozitioning
r-axis I 150 E
K-axis IIJ Eﬁ

Amplitude I 1.00 E

Timeframe per 1 DY

|28 vl ADIY

Mumber of auxiliary lines
T

]

Stvle line.. |

—Select Channel

Wizible
~ ACHI
C A-GH2

r
-
C D-CH1 ™
 D-CH2 W
r
-
-
r
r
-

Graph position reset

Select Channel

Select the channel for which you want to adjust the
graph position and color.

Display
Display only the channels you have marked with .

Y axis display position

Set the Y axis display position of the selected channel.
The upper edge is position 0.

X axis display position

Set the X axis display position of the selected channel.
The left edge is position 0.

Amplitude

Set the amplitude of the selected channel by
maghnification.
Change the magnification using point O for reference.

As you change the amplitude, the [Scale] value
changes accordingly and the graph display also
changes according to the [Scale] value.

Scale

Set the scale of the selected channel.

Enter the numeric value per DIV for the Y axis.
This setting applies to the analog setting channels
only.

Reset the display position and amplitude setting of the selected channel to the initial values.
Chl = 50 and the value increments by +50 for the subsequent channels.

- Y axis display position:
- X axis display position:
- Amplitude: 1.00

Optimize Y axis graph

Each Channel =0

Arrange the Y axis display position and scale of the displayed channels without overlapping by channel.
Reset the amplitude setting to the initial value.

- 'Y axis display position:

- Scale:

Detect waveform peak

Ch1 = 100 and the value increments by +100 (analog) or +50 (digital) for subsequent

channels.

Set the scale value based on the multiple of 50 so that the maximum value can be within

two grids.

For example, 50Hz/DIV if the maximum value is 1Hz or 100Hz/DIV if the maximum value

is 53Hz.

Move Cursor A to the maximum value of the selected channel automatically. If there are two or more peaks, the cursor

moves to the earliest one.

This setting applies to the analog setting channels only.

Display range in one DIV

Set the time to be displayed in one DIV for the X axis on the waveform screen.

Historical trace: 1 ms to 10 min
Realtime trace: 20 ms to 60 min

You cannot specify a time smaller than the sampling time.

Number of grid auxiliary lines

Set the number of grid auxiliary lines for the Y axis.
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Color setting

The color setting data is held. Once you obtain the waveform, you can change the color setting.

Line property x| Channel line

Select the line color, type, thickness for the selected channel.

Select tem to chanee the line property.
Cursor line A
& Ghannel Select the line color, type, thickness for Cursor A.
' Gursor & )
Cursor line B
¢ Cursor B Select the line color, type, thickness for Cursor B.
' Trigeer . .
Trigger line
" Grid Select the line color, type, and thickness of the trigger line.
€ Backeround
e Grid line

Select the line color, type, and thickness of the grid line.

o] Caesl Graph background color setting

Select the waveform monitor background color.

The line color, type, and thickness settings are as follows:

- Color
Style line === Color =]
Basic colors:
| = =
Color — B .
L N
Type of line —_— u o
| o .
| N
Thickness —
Custom colors
Caution : Dashed line is a thin line. — —
[ - r
OK ] [ Cancel [ Define Custom Colors »3> ]
0K Cancel
- Line type - Line thickness
Style line [===a) Style line (=)

Color

oo (EE—

Type of ine _ i Type of line —_—
Thickness - i Thickness — :
Caution : Dashed I_

OK Cancel OK —
| ok ]

Caution : Dashed | -.

2-168



Chapter 2 Functional Description

[3] File Information
The file information subwindow displays the date/time information for the trace. Also, you can
add a comment.

The date/time information uses the clock managed by the operating system of the PC. Even if
you trace an inverter model that has a realtime clock (RTC), the loader uses the clock managed
by the operating system of the PC.

The content of the file information subwindow is saved to trace data files (RT2 and HT?2 files).
When you open a saved file, the information contained in it is displayed. The content of this
subwindow is not contained in a file saved by selecting [Setting] -> [Setting Export] (i.e., an
EXRTM or EXHIM file).

The content of the file information subwindow is included in the printout of a waveform.

i=l Refresh

Click this button to update the time information (such

Refresh | as the trace start date) displayed in the file

information subwindow.

Monitar I Graph position adjustment

Trace start date 3017/09/27 When you start the trace with the file information
subwindow open, its display content will not be
Thems shert Hine 093318 automatically updated. It will be updated when you

click the [Refresh] button or open a different
Trigger generation date  2017/09/27 subwindow.
Trace start date

Trieger generation time  0%:33:27 The date when the trace was started.

Camments .
Trace start time

The time when the trace was started.

Trigger detection date

The date when a trigger was detected.

Trigger detection time

The time when a trigger was detected.

Comment

You can add a comment.

2-169



2.3.5.9. Advanced Waveform Settings

[1] Channel Configuration
You can set the configuration of analog channels and digital channels to be traced. For more
information on the settings for each channel, refer to [2] to [5].

The loader stores in memory the settings for each inverter model. One you open the [Realtime
Trace] or [Historical Trace] window, the [Advanced settings] window displays the previous
settings for the inverter model you want to trace this time.

Ch configuration settings

Select the number of channels you want to use.
The number of analog channels can be up top 4, and the total number of analog and digital channels can be up to 8.
However, if you select 4 analog channels, then you cannot select digital channels.

Advanced setting
Gonfiguration | Analos Ch | Digital Ch | Analog Gh chack | Digital Gh check | Other |
(Th canfiguration settings
—Analog —Digital
Lo} Mot available
—fnalog —Digital
0 2 oy Ll
3 ! Disabled
L5
—#nalog —Digital
(ol | (Ol 3 (o'}
o  Di
2 Disabled 5 B
—Analog —Digital
1 oy Wy Lol
(ol | € Dizabled
B ol r6 (ol
—fnalog —Digital
o oy oy (ol
o o
Dizabled Dizatiled 5 5 o s
Select Inverter INY Selection
[Mo. 1L 1IN LM,
[ ]

[Select inverter]

Version 1.0.1.0 or later |
Displays the inverter selected in the [Select Online/Offline] window (see [2.3.5.1.Trace Function]).

ersion 1.0.0.0

Displays the inverter registered in the No. 1 line in [Communication Settings] > [Connection Settings].

You can trace only the inverter displayed here.
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Chapter 2 Functional Description

[2] A-Ch1 to A-Ch4 (analog settings)
You can configure analog channel settings.

zl
'Gonfieuration Analoe Ch | Digital Gh | Analee Ch check | Digital Gh check | Giher |

A=Ch1 | A-Gh2 | A-Cha | A-Chd |

Sienal —Filter

—Trigger ——————————————
Select Signal —Filter setting —Trigger setting ———————
IOutput frequency (before slip) LI * OFF ¥ Dizabled
 Manual filter " Enabled
[~ Alternate name " Peak filter
I  Buto filter Trigeer level
555 35
Time constant
e

Set the filter time constant to Walue [000 E [Hel

twice or more the sampling time

Trigeer edee
C g ) Dawn

Gancel |

Signal

From the list box, select the signal you want to trace. You can select, for example, the output

frequency, the output current, or the output voltage. (Available signals differ depending on the
inverter model.)

Alternative name

You can assign an alternative name to the signal.

Once you assign an alternative name, that name appears in the waveform screen and
subwindow.

You cannot use single-byte @, #, and \ characters.
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Filter

The filter settings for each channel are as follows:

—Filter OEE
—Filter zetting ——— Select this if you do not want to use a filter.
" OFF
. Manual filter
& Manual filter anual filte
Traces the data after a low pass filter is applied.
" Peak filter ) ) )
Select the filter time constant from the list box below.
 Buto filter
Peak filter
Time conztant Traces the maximum value within the sampling time.
|1[I[I "I [inz]
Auto filter

Traces the data after a low pass filter is applied.

Set the filter time constant to

twice or more the zampling time.

Note

H

Tip

The filter time constant is given by the following expression:

Filter time constant = Sampling time x 3.2

Filter time constant

Select the filter time constant when you use the manual filter.
The valid range is 1 [ms] to 100 [ms].

The filter time constant should be at least twice the sampling time.

To use a filter for the realtime trace, the dedicated communication command
must be supported by the inverter model. For more information, refer to "Table
1-1"in "1.1.2. Loader Functions by FRENIC Series Inverter Model".
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Trigger

The trigger settings for each channel are as follows:

—Trigeer Trigger setting
—Trigger setting ————————— Select the channel for which you want to configure a trigger.
"~ Dizahled An analog channel accepts only one trigger.
* Enabled

Trigger level

Select the appropriate trigger level depending on the data quantity handled

Trigger level
for the monitor item selected for each channel.
55 a6
| Trigger edge
Select the trigger rise or fall edge.

alue |n_nn =] [Hl

Trigger edee
o« Up " Down

Tip e To use a trigger for the realtime trace, the dedicated communication command
must be supported by the inverter model. For more information, refer to "Table
1-1"in "1.1.2. Loader Functions by FRENIC Series Inverter Model".
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[3] D-Ch1 to D-Ch8 (digital settings)
You can configure digital channel settings.

zl

Gonfieuration | Analoz Ch  Digital Gh | Analeg Ch check | Digital Gh check | Giher |

D-Ch1 | D-h2 | D-Cha | D-Ché | D-Chs | D-Ché | D-Gh7 | D-ché |

Signal

Select sienal block

I]nput terminal LI
Select signal
IFWD terminal LI

™ ARernate name

—Trigger setting

& Disabled

 Law level

" High level

" Up edee

" Down edee

Gancel |

Select signal

From the list box, select the signal you want to trace. You can select, for example, the X or Y
terminal. (Available signals differ depending on the inverter model.)

Alternative name

You can assign an alternative name to the signal.
Once you assign an alternative name, that name appears in the waveform screen and

subwindow.

You cannot use single-byte @, #, and \ characters.

Trigger setting

The trigger settings for each channel are as follows:

— Trigger setting

' Dizabled

 Low level

= High level

" Up edee

" Down edee

Trigger setting

Select one of the following: Low (L) level, Hi (H) level, Up edge, Down edge.

A digital channel accepts one or more trigger settings.

You can specify triggers with the "OR" or "AND" condition.

* Refer to "Trigger_detection conditions" in "[5] Other Settings".
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To use a trigger for the realtime trace, the dedicated communication command
must be supported by the inverter model. For more information, refer to "Table
1-1"in "1.1.2. Loader Functions by FRENIC Series Inverter Model".

Tip °

[4] Ch Setting Check (analog/digital)
The data configured for each channel is listed. To save the settings, click the [OK] button. To

cancel the settings, click the [Cancel] button.

ﬂ

Gonfiguration | Analoz Ch | Digital Gh £ # |9§__9h_§h§§!<___§| Digital Gh check | Other |

Waveform name Visible Filter Trigeger TNV No.
| A-Gh1  Output frequency (hefore slip) ON Ipt-100m= Dizabled 1 |
| A-Gh?  Ouput voltae ON Ipt-100ms Disabled | |
A

x

Configuration | Analoe Ch | Digital Gh | Analos Gh check | other |
Waveform name Wizible Trigeer INY Mo
| D-Gh1  FWD terminal ON Up ede= I |
| D-h? Y1 terminal oN Disabled | |

Cancel |
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[5] Other Settings (including sampling time setting)
Configure the advanced settings for the waveform monitor.

Advanced setting

.Cnnflguratlon I Analog Ch | Digital Ch I Analog Ch check I Digital Ch check  Other I

—Sampling Time

Time |5Ums vl
—Pre-Trigger Position
I
v | 100= counts

—Detection conditions of frigeer
* Detects on OF conditions.

" Detects on AND conditions.

—Trace command

¥ | Enablz bufferitie trace command

—5et frace start time and date

[~ Start at specified time and date

Time 21:20:4 1 =
Date 201909713 -
—Auto Save

[~ Save data automatically after detecting the trigeer.

File name |Rea|—t|me Trace RT2

Erowee.. |

Mote : This setting does not take effect if trace window is not apen.

—File size of saving
¥ Divide savine file

Sampling counts of one file I ?5003 counts
Total file size I IUE MB

Cancel |

Sampling time setting

The following sampling time settings are

Sampling Time

available.
Time Im
Realtime
Sampling | When using the dedicated communication command (*) | When not using the
sgg;ﬁg If the pgrt s.pecifie('j in . If the pgrt specified in _ corii:ilijilail(t::\?ion Historical
[Communication Setting] is | [Communication Setting] is command
RS-485 connected USB connected
1ms X X X O
2ms X X X O
5ms X X X O
10 ms X X X @)
20 ms O (note) X X O
50 ms O (note) O (note) X O
100 ms O O X O
200 ms ©) O ©) ©)
O: Selectable X: Not selectable

(*) You can only use the dedicated communication command with an inverter model that

supports it.

@ ¢ If you want to set the sampling time to 50 ms or smaller for the realtime trace, set
the communication settings to RS-485 connection and set the baud rate to

38400 [bps].

Otherwise, the graph display may be incomplete.
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Pre-trigger position

Set the number of sampling points of data preceding the trigger position.

Pre-Trigger Position

p—

1
A | 100 == counts

The setting can be up to 999 counts for the realtime trace or up to 499 counts for the historical
trace.

Trigger detection conditions

Configure two or more trigger detection conditions for digital channels with the "OR" or "AND"
condition.

Analog: 1 channel only
Digital: 1 to 8 channels

Detection conditions of trigeer

{* Detects on OF conditions.

" Detects on AMND conditions.

@ e To configure the sampling time setting, pre-trigger position, and trigger detection
conditions for the realtime trace, you have to check the [Enable buffering trace
command] check box on the [Advanced waveform settings] -> [Other settings]
window.

Enable buffering trace command

Check this check box to have the realtime trace use the data buffered in the inverter's memory.

Trace command

¢ Enable buiferine trace command

Tip e This setting is not available for the historical trace.
e The dedicated communication command must be supported by the inverter
model. For more information, refer to "Table 1-1"in "1.1.2. Loader Functions by
FRENIC Series Inverter Model".
e |Version 1.0.3.0 or later If the dedicated communication command is supported
by the inverter model connected, this check box is enabled automatically, and
cannot be unchecked.
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Trace start time and date

Set the date/time when to start the trace.

—aet trace start time and date

W Start at zpecified time and date.

Tirne [o0:00:00 =
Date [o1/01/2017 =l
Auto Save

Use this setting if you want to have the trace data automatically saved.

—Auto Save

v Save data automatically after detecting the trigeer.

[G#Frogram Files¥Fuii Electric¥F RE

Mote : This setting does not take effect if trace window is not open.

File name

The data is automatically saved:

e When you stop the realtime trace by clicking [START/STOP].

e When the accumulated trace data becomes more than can be written to the specified

number of split files during the realtime trace.

e When the size of all split files exceeds the total file size during the realtime trace.

« After the historical trace waveform has been drawn.

File size of saving (available for the realtime trace only)

This setting is available if the trace auto save check box is checked.

—File =ize of saking

W [ivide savine file
mnne file I 7500 = count
P\
W [ 0= M
'\

Sampling count of one file

(= 7500 x 20 ms).

— Total file size

Divide saving file

Currently this check box
always checked.
Split files are always saved.

This represents approximate data counts per channel saved in one file. This setting is fixed to 7500 counts.
For example, if the sampling time is 20 ms, one file contains the data from 0 ms to approximately 150,000 ms

is

Specify the total file size in MB. If the size of all saved files exceeds this size, the realtime trace is stopped and

no more files are saved
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Chapter 2 Functional Description

The file name of a split file is the file name specified under [Auto Save] suffixed by a serial
number such as 1, 2, 3 before the file name extension.

For example, if the file name specified under [Auto Save] is "Realtime_Trace.RT2", the names of
the split files will be

"Realtime_Trace-1.RT2", Warnine X
"Realtime_Trace-2.RT2",
"Realtime Tr -3.RT2"  Exceeded the total file size.

€a e_lrace-o. ) l % Exit to zave the file,

and so on.

When the size of all split files exceeds the total file
size, the dialog at right appears and the realtime
trace is stopped.
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2.3.5.10. Setting Export/Setting Import

With FRENIC Loader 4, you cannot open saved trace data files with an extension of *.RT2 or
*HT2 and run the trace.

To run the trace with the same settings as the saved trace data, you should follow these steps:

Step 1: When you save the trace data, save the settings separately from the trace data by
using the [Setting Export] function.

Step 2: When you run the trace, first open the same trace screen as step 1 (the [Realtime
Trace] or [Historical Trace] window) with the loader connected to the inverter you want
to trace.

Step 3: Load the settings by using the [Setting Import] function.

[=]
I
Advanced... |

To use [Setting Export] and [Setting Import], click the =
[Setting] button under the [Advanced Waveform Settings]
button.

The [Settings] window appears.

—————————— Setting Export
w X Saves the advanced waveform settings to a file.

Click this button to open the [Save As...] dialog.

| Setting Export e I

Setting Import °—|—— Setting Import

Loads the advanced waveform settings from a file.
Click this button to open the [Open] dialog.

Cance| '—|—— Cancel

Click this button to close the [Settings] dialog.

File types

*EXRTM: Realtime trace format. You can import these files only when working with the
[Realtime Trace] window.

* EXHIM:  Historical trace format. You can import these files only when working with the
[Historical Trace] window.

The inverter model must match the currently selected one on the trace window. If it does not
match, it performs followings according to the version.

Version 1.0.1.0 or later : Awarning dialog displays, then blocks to import settings.

Version 1.0.0.0 : The settings is imported, however it is not applied to the current
trace screen. When opening newly the trace screen for the same
inverter model as imported, the imported settings is applied to the
trace screen.
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2.3.5.11. Combination with the Customizable Logic Function

After writing your created settings for the customizable logic function to the inverter or if the

comparison result shows no difference, you can monitor your selected symbol using the
realtime trace.

@ * A limited set of functions is available with some inverter models. Refer to "1.1.2.
Loader Functions by FRENIC Series Inverter Model" for details.

[1] How to Monitor a Customizable Logic Signal Using the Realtime Trace

The following is the basic procedure for monitoring a customizable logic signal using the
realtime trace:

Write the circuits to the (Refer to Section

inverter 2.3.3.9)

|

Select the trace monitor (Described in
this section)
\

Save trace monitor file (Described in
this section)

Use the customizable logic
editor screen

(Described in

External signal import i )
this section)

(Described in this

Advanced waveform settings section. Also refer to | Use the [Realtime Trace]
Section 2.3.5.9.) window
Start the realtime trace (Refer to Section
2.3.5.4)

Start the customizable logic

function

)

2-181



- Selecting the Trace Monitor

On the customizable logic editor screen, right-click the symbol whose waveform you want to
monitor.
Select [Trace monitor select] on the context menu.

S FRENIC Loader — Gustomizable logic — - [Customizable logic — CstmLogicPrj1] =0l x|
£ Fie Menu Setwp View iWindow Help _ 8 x
DEHSRo| /023 2@ xe @62 [BEE Esam®
Select Twerter Mumber of use steps 100]2
i i @ e Digital F
Customizable Logic T TS e —— [ toranes [ TEE it d:* \{ I igital |Ana\ng| Digital+finalog | FE | -
(G || [[& | Basic logic =
3 Programil |

putOutput ———— A
{23 Project ‘CstmlogicPrj1’

t
524 Main Step 8 Step »— - [

Fun
i (2] Programn e = -
B3 FE (Included with the praject) YO 1 FEODT_1
~[E] FB001_1 -

RO+ On Datay
23 FB (Camman)
T2 FE0n o, — Branch
L3 Feoor_t annzct line
—_— = ==

Manitor select
e j\;:::z By B Maniter, Pasglietenneenennnns Gomment
- — [ Treee monitr el A
iting function) GCut Through ————
G
m | o R —5—G)
StepMa. / Priority setting.. —@'
Font (H) AND
) N E 9=
Clear log |Execuhnn cycle: 2 [ms]
[ | Twee | Gode | Messaee
OR
F—FHE =

Tip e [Trace monitor select] is applicable to a function block only. It is not applicable to
an input or output terminal or function block (FB).

- Save Trace Monitor File

Click [Trace monitor file] on the toolbar to save the information of the symbol for which you
selected the trace monitor.

BE0] = G 8 A= &
T e g R [Save trace monitor file

@ o
| 4 steps /200 steps pdate | Grid | \t{

£

- External Signal Import

Select ~ on the main window toolbar and click [Realtime Trace] to open the [Realtime Trace]
window.

[Feal-time trace] :

To eraphically wiem the running
gtatuz of the inverter in real-time.

Realtirne

Alternatively, you can open the [Realtime Trace] window without using the Quick Access
menu by selecting [Menu] -> [Trace] -> [Realtime Trace] from the main menu.
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¢ Real-time trace

Giraph position adjustment I File infor mation |A
|

—Cursar
Cursor A Curzor B Cursor 8B
A-GHI Output frequency (before s.. Hz j
| | |
A-GH2 Output voltage W
| | |
| | |
I I I
D-CGH1 FWD terminal
| | |
D-GH2 —— 1 terminal
I I I
Click the [External signal import] button at the
I I I lower left of the [Realtime Trace] window.
| | | , , -
(Using the customizable logic editor screen,
[ [ [ load the information saved by clicking [Save
hd trace monitor file].)

———
@rnal signal imm Bdvanced.. |
Setting |

Tip e The [External signal import] button appears once you click [Save trace monitor
file].

- Advanced Waveform Settings

- Next, click the [Advanced...] button at the right

Gorfiguration  Analog Ch |Digita| Ch | Analog Ch ch of the [External signal import] button and
A-Ch1 | a-ch2 | A-Ch3 | A-Chd | configure the channel settings.
Signal
Select Signal
Step 3 Timer =] To select a signal within the customizable logic
Ay AP onitor 2l function, use the [Analog Ch] tabs for both

FID eommand analog and digital signals.
PID output

FID command 1

FID feedback 1

Terminal [12] input voltage

Terminal [C1] input current (G function]

'[germinal Eloﬂ input voltaze 0W2 function) 4 The customizable logic signals are added at
e spee R i
Qutput frequency (pu the bottom of the [Select Signal] list.

Rotation speed (r/min)
Torgue command
Ctput torque

Torgue current commangd
Torgue current

taenetic—flux command . . .
DG link circuit voltage For information on other settings, refer to
iyt sl "2.3.5.9. Advanced Waveform Settings".

Temperature inzide the jrverter
Temperature of heat =i
Cutput current

Mator output power (%)

Syrehronous—deviation anele
Step & Timer

Step 3001
Step 3012
Step 3 DD

4]
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- Graph Position Adjustment

Manitor  Graph position adjustment | File informatio

—Positiohing —————— —Select Ghannel —
; Wizible
Y-dis 200 : CoacHl W
H-axiz II] E = AcH &
Amplitude |1.[I[I Eﬁ ~ acHI
Scale
; =l C A-CHE |

To monitor a digital signal, set [Scale] to '2' on
the [Graph position adjustment] tab.

To start the trace, click the [START/STOP] button at the top of the trace screen.
Refer to "2.3.5.4. Starting/stopping the Monitoring of the Trace" for details.

[2] Saving the Customizable Logic Signal Trace Data
You can save the customizable logic signal trace data in the same way as other trace data.
Refer to "2.3.5.5. Saving the Trace Data" for details.

At this time, however, you should save the customizable logic project data as well.

The same applies when you perform [Setting Export] from [Settings] under the [Advanced
waveform settings] button. Be sure to save the customizable logic project data as well.
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Chapter 2 Functional Description

[3] Opening the Saved Customizable Logic Signal Trace Data
Before you open a file that contains the customizable logic signal trace data (i.e., an RT2 or

RT1 file), you should click [External signal import] to load the same signal information as when
the trace data was collected.

@ ¢ If the signal information you load by clicking [External signal import] is not
appropriate, the loader will not correctly display the signal names, units, and
data step sizes.

Therefore, you should follow these steps to open the trace data:
First, open the customizable logic project data used when the trace data was collected.

Next, select [Trace monitor select] -> [Save trace monitor file] -> [External signal import],
similarly to when you collected the trace data.

For more information on [Trace monitor select] and [Save trace monitor file], refer to
"2.3.5.11. [1] How to Monitor a Customizable Logic Signal Using the Realtime Trace".

Finally, open the trace data.

GO

Open the customizable logic

project file

Trace monitor select

Use the customizable logic

| editor screen

Save trace monitor file

External signal import

Open the trace data

C e D

Use the [Realtime Trace]

window

The same applies when you perform [Setting Import] from [Settings] under the [Advanced
waveform settings] button.

Before you use [Setting Import] to load the customizable logic signal settings saved using
[Setting Export], you should use [External signal import] to load the same signal information as
when you performed [Setting Export].
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2.3.5.12. Offline setting function

You can make setting up the trace function without communication to any inverter. It is useful
in case you want to prepare setting in offline situation in advance.

Select [Menu] > [Trace] from the main menu or click ~* on the main window toolbar and then
click [Real-Time Trace] or [Historical Trace] to open the corresponding trace function window.

[Real-time trace] : [Hiztarical trace] :
To eraphically wiew the running

_ ; _ The historizal tracing screen is
ztatuz af the inverter in real-time.

indizated.

Realtirme Trace

Historical Trace

Version 1.0.1.0 or late]  [Select Online/Offline] window is displayed first.

Real-time Trace E Select [Offline].
" Online Click [OK].
Tareet [reerter: |No_ 10 1] IMW1 =]

ersion 1.0.0.0 [Select Online/Offline] window is not displayed.

If the loader cannot communicate with the inverter registered as No.1 in [Connection Setup]
(see [1.5.5.2.Connection Setting]), the [Offline Settings] window automatically is displayed.

Offline Settine %] Select the inverter model to be configured.

9 Select the Model Click [OK].

814 | Caticel |

The real-time trace window (see [2.3.5.2. Realtime Trace]) or the historical trace window (see
[2.3.5.3. Historical Trace]) is displayed.

Tip e The model list shows only the inverter models that support the tracing function (see
[1.1.2.Loader Functions by FRENIC Series Inverter Model]).
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Chapter 2 Functional Description

The Trace window displayed as offline cannot perform the trace function, as the START/STOP
buttons disabled.

In order to make setting up the Trace function, open [Detailed Waveform Settings] (see
[2.3.5.9.Advanced Waveform Settings]).

To save or restore your settings, use Export/Import function. (see [2.3.5.10.Setting
Export/Setting Import]).
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2.3.6. Test Run

Select [Menu] -> [Test run] -> [Drive operation] from the main menu or select -+ on the main
window toolbar and click [Test run] to open the [Drive operation] menu under the toolbar.

[Test run] :

To controlfun the inverter
through loader.

Test Fun

Tip e You cannot perform operations if you have selected [Data in Keypad] for [USB
Connection] on the [Communication Setting] window. If you cannot perform
operations for another reason, refer to "2.3.6.3. If You Cannot Use the [Drive
operation] Menu".

@ e You should use [Test run] only while connected to the inverter.

e Depending on the communication link condition, it may take a long time to detect
the communication target. The loader does not respond until the communication
target is detected. To avoid the inability to operate the loader for a long time, you
should use the loader in an environment with as good communication conditions
as possible.

¢ Do not attempt operations with an inverter that has password protection enabled.
If the loader does not respond or is forcibly terminated, the means to stop the
inverter may be limited, which can be very dangerous.

— Drive operation buttons Test Run
FWD: Click this button to rotate the motor in the Click this button to open the [Drive operation] menu under the
forward direction. (The button appears toolbar. Click it again to close the [Drive operation] menu.

depressed during rotation.)

REV : Click this button to rotate the motor in
the reverse direction. (The button
appears depressed during rotation.)

STP : Click this button to stop the inverter.

RST

Frequency command/operation command change (update)

Sends the frequency/operation command source to the

inverter.
: Click this button to reset the alarm.

S FRENICG Loader — Quick Access Menu
Eile Window
NEHESRO|/02L

Menu  Setup  View Help

o

Frequency

(update) Select the device you want to test-run.

Sends the frequency command
[Hz] to the inverter. Update

Click this button to synchronize the display of the drive operation buttons,

the frequency command, and the frequency command/operation
command change with the inverter.

To close the [Drive operation] menu, click the [Test run] button on the toolbar (see above).
Alternatively, you can close it by selecting [Menu] -> [Test run] -> [Drive operation] from the main
menu.
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In addition, you can display the terminal operation buttons under the [Drive operation] menu by
selecting [Menu] -> [Test run] -> [Terminal operation] from the main menu.

S FRENIC Loader — Quick Access Menu

File | Meru | Setup  Wiew Window Help

; 0 & Furction code edit... B @ %’;lg

| Test run k|| ¥ | Drive operation

Operation monitor... v | Terminal operation
1

Customizable logic

Schedule setting

Trace 3

Quick Access Menu..

S FRENIC Loader - Quick Access Menu
File  Menu Setup Wiew Window Help
DeH&GRe| 70X PR XEEs2L S D004 /E0E08/020E &G
I UUUE Apply | |3 : Freq. = Loader, Ope. = Loader ;I fpply | IND. 1011 1N 'I
i) il el £

bt

Terminal operation buttons

X1, X2, ...,X9: These buttons allow you to turn ON X1 to X9 terminals. The number of terminals you can operate
varies depending on the inverter model.

XF: Click this button to turn ON the FWD terminal.

XR: Click this button to turn ON the REV terminal.

To hide the terminal operation buttons, select [Menu] -> [Test run] -> [Terminal operation] from the
main menu, similarly to when you display them.

@ ¢ When you use the terminal operation buttons to operate a terminal, the logical
inversion settings of the terminal function are ignored.
The following example shows what occurs when the free run command "BX" is
selected with EO1.

Function ] ) Loader's terminal operation
Physical terminal
code data button
; Free run when the X1 terminal is ON
(normally open) Free run when the [X1] button is
1007 Free run when the X1 terminal is OFF ON (normally open)

(normally closed)

You should be careful, especially when you configure the forced stop ("STOP")
using a logical inversion (E01=1030). If the physical terminal is enabled, you can
run the inverter by turning OFF the X1 terminal. However, if the operation
command from the loader is enabled, you cannot run the inverter unless you turn
ON the [X1] button.

Once you open the [Drive operation] menu, the [Frequency command/operation command
change] field shows "0: Freq = Inverter, Ope = Inverter", which means that you cannot use the
loader to change the frequency command or start/stop the inverter. Hence, you cannot click the
operation buttons [STOP], [FWD], and [REV] on the loader screen.

Similarly, once you display the terminal operation buttons, you cannot click the [X1], [X2], [X3],
[X4], [X5], [X6], [X7], [X8], [X9], [XF], and [XR] buttons.

The drive operation and terminal operation buttons are enabled only when "Ope = Loader" is
shown in the [Frequency command/operation command change] field.

Also, the frequency command is enabled only when "Freq = Loader" is shown.

However, the [RST] button is always enabled.
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2.3.6.1.

Operating the Inverter from the Loader

Click ™ next to the [Frequency command/operation command change] field and select

"1: Freq = Loader, Ope = Inverter", "2: Freq = Inverter, Ope = Loader", or "3: Freq = Loader,
Ope = Loader" from the pull-down list depending on the command you want issue from the
loader. See the table below.

IE: Freq. = Loader, Ope, = Loader

=]

0 : Freq. = Inverter, Ope. = Inverter
1: Freq. = Loader, Ope= Inverter
2 : Freq. = Ihwerter, Ope. = Loader
3: Freq. = Loader, Ope. = Loader

Command vou want [Frequency Frequenc Drive operation | Terminal operation
issue from %lhe loader command/operation corgmang buttons [FWD], buttons [X1] to
command change] [REV], [STOP] |[X9], [FWD], [REV]
0: Freq = Inverter, Disabled Disabled Disabled
None Ope = Inverter (Not operable) (Not operable) (Not operable)
(default)
Frequency command 1: Freq = Loader, Enabled Disabled Disabled
q Y Ope = Inverter (Operable) (Not operable) (Not operable)
Operation command 2: Freq = Inverter, Disabled Enabled Enabled
P Ope = Loader (Not operable) (Operable) (Operable)
Frequency command | 3: Freq = Loader, Enabled Enabled Enabled
Operation command Ope = Loader (Operable) (Operable) (Operable)

To issue both the frequency command and the operation command from the loader, follow these

steps:

1) From the [Frequency command/operation command change] field, select "3: Freq = Loader,
Ope = Loader" and click [Apply].

2) This enables the frequency command field as well as the drive operation buttons [STOP],
[FWD], and [REV], the terminal operation buttons [X1], [X2], ... (hnumber of terminals you can
operate varies depending on the inverter model), and the [FWD] and [REV] buttons.

3) Enter a frequency in the frequency command field and click [Apply]. To rotate the motor in the
forward direction, click the [FWD] button. To rotate the motor in the reverse direction, click
the [REV] button. To stop it, click the [STOP] button.

=

Tip e When you close the [Drive operation] menu, the loader automatically writes "0:
Freq = Inverter, Ope = Inverter".

2.3.6.2. Monitoring the Inverter Operation Status from the Loader

You can monitor the inverter operation status using the operation monitor and the realtime trace.

Refer to "2.3.2. Operation Monitor" and "2.3.5.2. Realtime Trace.
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Chapter 2 Functional Description

2.3.6.3. If You Cannot Use the [Drive operation] Menu

You may be unable to use the [Drive operation] menu in the following cases:

[1] A communication Error Has Occurred
If a communication error has occurred between the loader and the inverter and you attempt to
use the [Drive operation] menu or a terminal operation button, the following dialog appears:

FREMNIC Loader x|

. TR ; ; i
[ | Communication iz impossible with an inverter.

W Does it retry?

Cancel |

If you respond by clicking [Cancel], the drive operation buttons, the frequency command field,
the [Frequency command/operation command change] field, and the terminal operation buttons
will be disabled. Even if the communication is restored, the loader will not automatically resume
the communication with the inverter with which a communication error occurred.

If this is the case, check the communication status by clicking [Browse] on the [Connection
Setting] window.

If "Connected" is shown in the [Status] column, it means that the communication between the
loader and the inverter has been resumed and you can enable the [Drive operation] menu and
the terminal operation buttons by clicking at the right of the [Drive operation] menu.

x
Advance.. | Delete |
| Ma. Status Mode| Equipment Address -
T [Unknavn Unkriown to . (TN 1
v 2 Linknawn Unknown Mo [INW2 2
- 3
- 4
r ]
- fi
- 7
- i
r q
| Click [Browse].
- 1
|l 12 hd
[}
Browse | (0]4 | Gancel |
x
Advance.. | Detete—] Check if "Connected" is shown.
1
| Mo. Status L fodel Equipment Address -
1 (Cornested > |E25 NV 1
2 2 Dizconnected Unknown Mo [INW2 2
- F]

If "Connected" is shown after you click [Browse] but the [Cannot communicate with inverter]
dialog appears when you attempt to use the [Frequency command/operation command change]
field, the inverter may have password protection enabled. If this is the case, you must disable
the password protection of the inverter. For more information on password protection, refer to
the instruction manual or user's manual of your inverter.
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[2] "LE" Enable Communications Link Is Assigned

If "LE" Enable communications link is assigned to the general-purpose input signal (X terminal)
and "LE" is OFF, you cannot use the drive operation buttons and the frequency command field
even after you change the [Frequency command/operation command change] field to a

non-zero setting.

The drive operation buttons and the frequency
command field are disabled.

nnn= Gpply |3: Freq. = Loader, Ope. = Loader ;I Bpply I

In this case, you can enable the [Drive operation] menu and the terminal operation buttons by
clicking at the right of the [Drive operation] menu after enabling "LE" or unassigning "LE".

You can check the assignment and ON/OFF status of "LE" Enable communications link, using
the [Operation Monitor] > [I/O Monitor] window. The following example shows what is displayed
when "LE" Enable communications link (E01=24) is assigned to the X1 terminal and "LE" is OFF

(i.e., the X1 terminal is OFF).

M Operation Monitor

I/ monitor |5ystem manitar I flarm monitor I Cperation status monil

Ihput terminal

Terminal | Function name Hormal | Status

=1 [LE] Enable communications link... |Open -

To assign "LE" Enable communications link, use function codes EO01, E02, and so on. For more
information, refer to the User's Manual of your inverter.

[3] The Inverter Has a Realtime Clock (RTC)
If the loader is connected to an inverter model that has a realtime clock (RTC) and the realtime

clock (RTC) is not configured (or it is initialized), you cannot operate the inverter with the timer
operation function enabled. To operate the inverter, you should configure the inverter's date and

time or disable the timer operation function.
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AWARNING

e Carefully note that resetting the alarm with the operation command on causes the inverter
to start unexpectedly as soon as the alarm is cleared.
Failure to observe this could result in an accident.

¢ If the loader goes down or is forcibly terminated during the operation with the test run
screen open, it will be impossible to stop the inverter operation with the loader. If this is the
case, stop the inverter by doing one of the following:
Failure to observe this could result in an accident.
<How to stop the inverter when the loader goes down or is forcibly terminated>
1) If an emergency stop switch is available, use the switch to stop the inverter.
2) Turn off the inverter power.
3) Turn off the inverter operation command and switch the inverter from "remote command
mode" to "local command mode".
More specifically, do one of the following:
- Turn off the terminal to which the "LE" command is assigned.
- Zero the data for the link function for support (function code: y99).
- Zero the data for the link function (function code H30).

¢ Do not remove the RS-485 cable, USB cable, or keypad during the operation with the test
run screen open. Doing so would be dangerous because it would be impossible to stop the
inverter operation with the loader.

Failure to observe this could result in an accident.

Even after you have stopped the inverter by doing one of the above, the settings of the inverter's
frequency command via internal communication (communication dedicated function code S05),
operation command (communication dedicated function code S06), and link function for support
(function code y99) will be retained. If you attempt to operate the motor in this state, the motor

may suddenly start. For safety, reset the data of the above function codes (S05, S06, and y99)
to 0 by following these steps:

1) Turn off the power to the inverter. Wait for the inverter to completely stop. Then turn back
on the power.

2) Zero the data of the link function for support (function code y99) using a keypad. Then start
the loader and zero the data of the frequency command via communication (communication
dedicated function code S05) and the operation command (communication dedicated
function code S06) on the [Function code edit] window.
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2.4. Setup

The [Setup] menu provides the following submenus:

Setup | Wiew  Window  Help

Communization Setup...
Browze

Language 3
Fegion spec. 3
Date time

This section describes the main functions available under the [Setup] menu.

2.4.1. Communication Settings

Refer to "1.5.5.1. Communication Settings".

2.4.2. Browse

Not available.
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2.4.3. Language
This feature is supported by version 1.0.1.0 or later.

You can configure the language settings of the loader. From the main menu, click [Setup] ->
[Language] to select the desired language and then exit from the loader.

& FRENICG Loader — Guick Access Menu

File  Meru | Setup | View  Window  Help

= | Communication Setup.. ' | S B M I
Browse
| Languags 3 |
Region zpec. 3 Erelish
Date time

Restart the loader and the selected language will be displayed.

* The selected language will not be displayed until you restart the loader.

FpAEFEY  AZa—iM) | FebFeWS) | FniV) D ALITH)

‘Dl &[  #EEEo P I e @

B E(S)

=3 R |
Hrat b FIE(E)

Bt 853

Tip ¢ Depending on the language supported by the operating system, you may not be
able to select Japanese language.
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2.4.4. Region Spec.
This feature is supported by version 1.0.1.0 or later.
You should configure [Region spec.] correctly according to your inverter.

Tip ¢ You can identify the inverter region spec. from the inverter model number printed
on the rating nameplate of the inverter. For more information, refer to "2.2.1. [1]
Model, Regional Specification, Voltage, Capacity" or the instruction manual of
your inverter.

If the region spec. you specify in the loader does not match the region spec. of the inverter, the
following problems may occur.

e The inverter model you want to connect is missing from the list box on the [Default setting]
window accessible by clicking [Function code edit...] -> [New...] -> [Default setting] from the
Quick Access menu.

e The communication wirings and the inverter and Harning
loader communication settings are correct but A P o gt th e ol rfcemtion
an attempt to communicate with the inverter fails =
with the message "Failed to get the inverter
model information” displayed.

You can change the loader's region spec. setting by clicking [Setup] -> [Region spec.] from the
main menu.

S FRENICG Loader — Quick Access Menu

File  Menu Yiew  Window  Help

0= E Ciommunication Setup...

Browze

Laneuage

Reegion zpec. . JJAPAN

Date time 8 ASIA
C:GHINA,
E-ELROPE
LIS A
K:KOREA

When you are finished changing the setting, exit from the loader.
Restart the loader to apply the new region spec.

* The new region spec. will not be applied until you restart the loader.

Tip o Normally, you set the region spec. once when you start the loader for the first time.
Refer to "Setting the Operating Environment" in "1.5.3. Starting the Loader" for
details.
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2.45. Date Time

You can configure the date and time settings for an inverter model that has a realtime clock

(RTC).

Connect the loader to the inverter in a one-to-one connection and select [Setup] -> [Date time]

from the main menu.

&= FREHNIC Loader — Guick Access Menu

File  henu Wiz

Wi c

Help

el

Browmze

Language

Communication Setup..

k

Fegion spec.

k

Date time

Date and Time Settings

Date |10/ 3/2017

-

Time | 7:28:55 FM

M Transmit the same date and time as 05,

oK | Cancel

=

* Check the [Transmit the same date and time as OS] check box to send the date and time

managed by the OS to the inverter.

Date and Time Settings

Date I'l[l'f 32m7v 'l
Time: I T:38:55 FM 3:

™ Transmit the same date and time as 05.

oK | Cancel |

X

x
Date [10/ 3/2017 [

El ocober.2017
Sun Mon Tue Wed Thu Fi Sat

24 25 26 27 28 29 3D
1 2R ¢+ 5 & 7
8 9 10 1 12 13 14
15 16 17 13 19 20 21
2 23 24 3/ B 7 B!
29 30 31 1 2 2 4

1 Today: 10/3/2017

* Clear (remove |v| from) the [Transmit the same date and time as OS] check box to send your
specified date and time. Click [OK] to send the date and time to the inverter.
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* Attempting to send the date and time to an inverter model without a realtime clock (RTC) will
result in an error.

Eror x|

9% Failed to update the date / time of the inverter.

[ |

"M ) Pleaze check the communication line connection.
2 Pleaze check whether the target model supports

time information.

@ o Whenever you configure the date and time, connect the loader to the inverter in
a one-to-one connection and specify the inverter model in the No.1 row on the
[Communication Setting] -> [Connection Setting] window. For more information
on [Connection Setting], refer to "1.5.5.2. Connection Setting".

You cannot specify the target inverter on the [Date and time Settings] window. If
you click [OK] when the loader is connected to two or more inverters, which
inverter receives the settings is unknown.
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2.5. Edit

Once you open the [Function Code List] window, the [Edit] option is added to the main menu.

& FRENIC Loader - Functionl — [Function1]
e File  Menu Setup | Edit | View  FunctionCodeEdit  Window  Help

DEezE & o Undo o Ed SEEE

Factary shipping walie

Function code edit I Suto-

Search

[Undo]: Click this button to restore the second most recent setting of the
function code you edited in the [Function code edit] window.

[Factory shipping value]: Click this button to reset the function code setting selected in the
[Function code edit] window to the factory-set value.

[Search]: Refer to "2.3.1.1. [8] Search (Search function code terminologically)".

Tip e You can open the [Function Code List] window by selecting [Function Code] from
the Quick Access menu. Refer to "2.3.1. Function Code " for details.
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2.6. View

You can specify which elements to display on the loader screen.

& FRENIC Loader — Guick Accezs Menu

File  Merw Setup | Wiew | Window  Help
0o H &R | Toolbar , Main
Statuz Bar

Toolbox

Project management windom

Ctput window

2.6.1. Toolbar

You can show or hide the toolbar.

Showing the toolbar allows you to use your desired feature (such as the Quick Access menu) by
just clicking its icon.

Toolbar

S FRENIC Loader 10| =|
ile Menu Setup  Miew  Window  Help

Status Bar

2.6.2. Status Bar

You can show or hide the status bar.

For information on what is displayed on the status bar, refer to "2.1. Main Window".

2-200



Chapter 2 Functional Description

2.6.3. Parameter Information and Character size

These menu items are added once you open the [Function Code List] window.

Wiew | FunctionCodeEdit  Window | — Parameter Information
Toolbar » This menu item provides the same function as the [Function code
Status Bar information] button on the [Function code edit] window.
- Select it to display the information of your selected function code in

Parameter Ihformatiol ' . 'SP y ! . .' you unct !
the function code information window.

Character zize

Tonlbo:x L— Character size

Project management window Select this menu item to open the [Font] window (as shown below).

Output window The [Font] window allows you to change the font for the function
code names in the [Function code edit] window.

Fort style:
Microsoft Sans Serf] IHeguIar
Microsoft Sans Serif B Regular B
Palatino Linotype Obligue
Seqoe Print i Bold
Segoe Scipt Bold Oblique
Segoe UI | =l
rEfects———————— ~Sample
[~ Strikeout
[ Underine AaBbYyZz
Script:
I‘Nestem ;I

Example: Default font

Auto-tuning I File information I

[=)- Function a
(- Code group Chanee
- F code

Ma. Function code name Setting walue

FO0 | Data protection

FO1 |Frequency setting 1 ]

After you change the font to Tahoma, Bold Oblique, 18 pt

Function code edit | Auto-tuning I File information I

=) Function -
=l Code group

Change No. | Function code name Setting value
-F code
Ecode FO0 | Data protection

-C code

e FO1 | Frequency setting 1 1

Tip e Once you close the [Function Code List] window, the font settings will be reset to
the defaults. You cannot save the font settings.

¢ The font settings are ignored when you print the data.

e You can open the [Function Code List] window by selecting [Function Code] from
the Quick Access menu. Refer to "2.3.1. Function Code " for details.

¢ The [Function code edit] window is actually a tab of the [Function Code List]
window.
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2.6.4. Toolbox, Project Management Window, Output Window

These menu items are activated once you open the [Customizable logic] window. They allow

you to show or hide the windows relating to the customizable logic function. For information on
these windows, refer to "2.3.3.2. Editor Screen".

Yiew | Window  Help

Toolbar 1 Toolbox
Statuz Bar Show or hide the toolbox.
~

Project management window, —— Project management window
Cutput wirdow ‘\ Show or hide the project management window.

mi?

Output window

Show or hide the output window.
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2.7. Function Code Edit

Once you open the [Function Code List] window, the [FunctionCodeEdit] option is added to the
main menu.

& FRENIC Loader — Functionl - [Functioni]

%% File  Menu Setup  Edit  View | FunctionCodeEdit | Window  Help
DERERO | /03 - S

Export

I Auto-tuning I File inf

Export to G5V ( Last errar Infa. ) Communication (read or write)

3.2 loader compatible write

Function code import

[=1- Functiaon - o
- Gode eraup Chanee ‘ Ma. ‘ Function code name Change the definition file

2.7.1. Import and Export

This function allows you to save the function code setting data to a file in CSV format and
restore from the CSV file.

This is useful when you want to edit function code settings in an external application such as
Microsoft Excel and then load them into the loader.

Import

Allows you to import function code settings from a function code data file in the CSV format and display them

in the [Function code edit] window. Before you import the settings, you should open the [Function Code List]
window.

After selecting a CSV file to be imported, [Import setting] dialog is displayed.

— Import target selection

Select whether to import data that has different set values depending on the voltage series and
capacity, and read-only data such as for monitoring.

For more information for such data, refer to the “User's Manual” or "RS-485 Communication User's
Manual" for your inverter.

& Import setting

x| Continue
W Import voltage / capacity dependent data. Click this button to proceed the

import operation.

M— Cancel

Click this button to cancel the
import operation.

Import read-only data.

Y

Additional information

Displays messages if the CSV file to be imported differs from the inverter model, voltage, capacity,
version, or etc. in the current [Function Code List] window. If it is the intended import operation,
press the [Continue] button to proceed the operation. In that case, some data may not be imported
correctly, therefore make sure that the intended result is obtained after the operation.

Nothing is displayed here if the settings of the CSV file to be imported matches to [Function Code
List] window.
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Export

Allows you to export the function code settings in the [Function code edit] window to a CSV file.
Before exporting the settings, you should select the function code you want to export from the tree view of
the [Function code edit] window.

E"'m For example, to export all the function code settings, select the [Function] node at the top
E G_l:lle graup of the tree.
i iwF code
----- E code
=- Function To export a particular function code group, select the function code group you
El Ciode group want to export from within the tree.

E code

After selecting the function code(s), click [Export].

You can edit the exported CSV file in an external application such as Microsoft Excel.

Tip e You can open the [Function Code List] window by selecting [Function code edit...]
from the Quick Access menu. Refer to "2.3.1. Function Code " for details.
¢ The [Function code edit] window is actually a tab of the [Function Code List]
window.
o If two or more instances of the [Function code edit] window are open, the imported
settings are displayed in the active instance of the [Function code edit] window.

¢ You cannot use [Import] or [Export] on the customizable logic function code list.
@ ¢ You cannot import a CSV file saved from FRENIC Loader 3.3.
[1] CSV File Format
The following example shows the format of a CSV file that contains the exported function code
data. For more information on the format, refer to "CSV File Format" in "3.2.4. Function Code

Setting Specifications".

Column number

1 2 3 4 5 6 7 8
1 | FRNLDR4, G1S, 3900, 3900, 8, J, 3, 2017/01/01 - 00:00:00
5 Func, Function code Setting Factory default
name
3 | F0o, Data protection !0, ‘: 0
Row 4 | FO1, Frequency 10, EO
number . setting 1, i '
I 1
! ;
[comment]

Editable

Figure 2-2 Format of a CSV file that contains function code settings
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Chapter 2 Functional Description

[2] Editing a CSV File

To avoid import failures, you are recommended to edit an exported CSV file to create a CSV file
for import. In addition, you are recommended to save the function code settings to the FNL
format as well as the CSV format and manage both the FNL and CSV files. You can avoid import
failures by opening that FNL file while you are importing the data.

Basically, you should only edit the settings of the exported CSV file (the portion enclosed in
dotted lines in Figure 2-2 above). You should edit the settings correctly in accordance with the
following input rules.

Setting input rules

(1) Afunction code setting should be configured using a decimal or hexadecimal value. You
cannot use a string such as "OFF".

When using a decimal value: You can use single-byte numbers (0 to 9), minus
sign (-), and decimal point (.).

When using a hexadecimal value: Prefix the value with 0x. You can use single-byte
numbers (0 to 9), alphabets ato f and Ato F.
Example: A decimal value of 32767 is expressed in
hexadecimal as OX7FFF.

(2) Enter a value within the valid range for the function code. A value outside the valid range will
not be imported. You can check the valid range for a function code in the [Function code edit]
window.

(3) You can enclose the setting in double quotation marks.

Example:  You can enter "32767" to represent a decimal value of 32767.

(4) The setting of 999 has a special meaning and is treated as a decimal value of 32767
(OX7FFF in hexadecimal).

Example:  The valid range of FRENIC-Ace (E2S) F40 torque limit value 1 (drive) is O to
300 %; 999,
where '999' means "no operation" rather than representing a percentage and it
is treated as 32767 in a CSV file.

(5) Strings such as "OFF", "Auto", and "Inherit" are treated as a decimal value of either O or
32767 (0x0 or OX7FFF in hexadecimal) depending on the function code. For more
information, refer to the description of the data format in the "RS-485 Communication
User's Manual” for your inverter. Or export function code settings that include strings, open
the exported CSV file, and check the numeric values.

Example:  The valid range of FRENIC-Ace (E2S) F50 electronic thermal (for breaking
resistor protection) (rated discharge withstand current) is 1 to 9000 kWs; OFF,
where "OFF" is treated as a decimal value of 32767 (Ox7FFF in hexadecimal).

Tip o If in Microsoft Excel you convert an exported CSV file to a different format such as
XLS, edit it and re-export it to a CSV file, you may be unable to import the
resulting file. If this is the case, open the CSV file in a text editor (such as
Windows Notepad) and check if it complies with the rules described in "Figure 2-2
Format of a CSV file that contains function code settings".
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Tip e |f a warning such as "Model mismatch", "Voltage mismatch", "Capacity
mismatch”, or "Some function codes cannot be loaded" appears when you
attempt to import a CSV file, there may be a mismatch in model, voltage,
capacity, or inverter ROM version between the CSV file and the [Function code
edit] window.

To check for any mismatch, abort the import and export the function codes from
the [Function code edit] window. Then compare the CSV file you are going to
import with the exported CSV file.

For more information on the CSV file format, refer to "Figure 2-2 Format of a
CSV file that contains function code settings".

If a mismatch is found, correct the CSV file you are going to import so that it
matches the exported CSV file.

[3] Recommended Way of Use
You are recommended to primarily use the [Function code edit] window when you configure
function code settings and use the [Export] and [Import] functions as needed for assistance.

An example of use is shown below:

Edit the function code settings in the [Function code edit] window.

A fr e e f8 P feesleds gy -
O ENs Q8- THAEgo A

Export some of the function
code data and edit it using a
spreadsheet application or a text
editor.

A fr e e f8 P feesleds gy -
O ENs Q8- THAEgo A

e
vme

Import the function code settings from a
CSV file to the settings you edited in the
[Function code edit] window.

.u- | .-.;. ; pamarye | Wy | Wi i | i | i | I.q-

= Rakes

Tip e To avoid import errors, save the function code data to the FNL format as well as
the CSV format.

Before you import the function code settings, select [Function Code] -> [Read from
the file] to open the FNL file you saved when you exported the data.
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Chapter 2 Functional Description

2.7.2.

Export to CSV (Last error Info.)

This feature is supported by version 1.0.1.0 or later.

This function is same as the [Save...] button in the error window as shown below. This is used to
save the error information to the CSV file in case closed the error window without save the
information.

An example of the error window with the [Save...] button

Inverter access error (Write) 10l x|

Mum. | Function code name Error code
(IR Terminal [1] function (Trverter statuz error) It can't be written. (Access toward a function which c

Terminal [%2] function (Inverter status error) It can't be written, (ficcess toward a function which f

ok | s D

The submenu shown in right hand is activated ﬂ Communication (read or write)
after the error window is displayed even once. Fumction code import

Change the definition file

FMRE

2.7.2.1. Commuication (read or write)

If the error window with the [Save...] button is displayed even once at reading/writing data
from/to the inverter in the [FunctionCodeEdit] window, this menu becomes available.

This is used to save the error information to the CSV file in case closed the error window
without saving the information.

2.7.2.2. Function code import

If the error window with the [Save...] button is displayed even once at importing data from a file
in the [FunctionCodeEdit] > [Import...] on the Main Menu, this menu becomes available.

This is used to save the error information to the CSV file in case closed the error window
without saving the information.

2.7.2.3. Change the definition file

If the error window with the [Save...] button is displayed even once at changing the definition file
on the [File Information] window, this menu becomes available.

This is used to save the error information to the CSV file in case closed the error window
without saving the information.
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2.7.3.

Use with defaut setting except in the special case.
Click to toggle the function enable or dislable.

Loader 3.2 compatible writing

If the following problems occur in case of the writing function code data to the inverter via

keypad (TP-E1U), this function might suppress the warnings.

A warning message[Parameter is abnormal.] (Shown in

the right figure) is often displayed.

[-Ld-] is displayed sometimes on the keypad (TP-E1U)

during processing.
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Chapter 2 Functional Description

2.8. Window

You can arrange the windows on the loader screen.

= FREMIG Loader k Access

Wind o
Cazcade

Tile

File Menu Setup  Wiew Help

DedE&E o] -

Arranee Ioons

Tile wertically

| Quick Access Menu

2.8.1. Cascade

Click [Window] -> [Cascade] to cascade windows.

S FRENIG Loader - Functionl 101 x|

File Menu Setup Edit View FunctionGodeEdit Windom Help

D Slbe " OES TR NI 0B HD 1HEEEREG

TR
Function code edit | Aute-tuning | File nformation |
Change | No. Function cade naie Setting value | Setting range | Default setting | Mrmum | Msximum g | Chﬂ”EE.W*‘E’iI
value value running
FO0 [Data protection [EE [} 0 3 |- Enable
FO1 |Frequency setting 1 1ot 12 [ 0 12 1| - | Dissble
F02 | Operation method 2003 f ] 3 1| = | Dissble
F03 | Maximum output frequency 1 50.0[25.0 10 5000 .. 500 50 5000 01| He | Disable
FO4 | Base frequency 1 50.0]250 to 6000 500 %60 5000 01| He | Disable
FO5 |Rated vohaee at base frequency 1 2000 80 to 240 . 200 ] 240 i[ v | Disable
FOG | Maximum output voltaee | 2008040 240 V. 200 El 240 1| v | Dissble
FO7 | Accsleration time 1 500[0.00 10 6000 s G0 100 soon| 01| s Erable
| F08 | Deceleration time | £.00(0.00 12 6000 5 500 | 100 5000 001 = Ename_,j
. 5
Factory set | Funo_code sst. |  Funo cods info. . | Iniialization.. | Advanced | Brint | Camparison |
Select Iverter Mo 1L 1INW1 = &I
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2.8.2. Tile

Click [Window] -> [Tile] to tile windows.

& FRENIG Loader ~ Function| i [ 1]

File  Meru Setup Edit View FunctionCodeEdit Window Help

DEd ko  OXS T XeE»EHIGE DEDRD0ELEDHEEE |

—Eix

Function cade edit | Aute-tuning | File information |

Ghanes | Mo Function cade name Setting value | Sstiting range | Default setting | Mimum | Maximum |y | gy | Chanse vhen | g0, | Datacopy | g,
=] Cud: grzuu value value running property
E oo F00 |Data protastion 10103 1 0 3 1 - | Enable 0
- gmdde FO1 |Frequency setting 1 00012 it 0 12 1 - Disable 0
P code
- H code F02 | Operation method I 2 [} 3 1| = | Dissble [}
H1rode - LT Y TS ennlacna cann enn acn conn sl s P, n -
< | 3 < | >

Read | White | Facmqse«l Func. code set. | Fune. code info | Initalization. | Advanced | Brint | Comparison

oot arer [0 L U1 =] Glose |
_iolxi

™ Operation Monitor

VO monitor | System monitor | Alarm monitor | Gperation status manitor |

Input terminal Quiput terminal
[Terminal [ Fumetion ] ormal [Status [ Terminal | Fumction [ Hormal [ Status

B [ILE] Erable c.. |Open [ T

[Terminal [ Fumction it | vahe [ Terminal [ Fumction | i [ valee

12 [IHone] v [on [P Jrrou 0w v na

Save CEV file Befresh Advanced

Tareet [nverter: Mo 10 11TV -

[Gornestine: FRND 75E25-2.1

2.8.3. Arrange Icons

Click [Window] -> [Arrange Icons] to minimize windows and arrange the icons at the bottom of

the main window.

& FRENIC Loader - Functionl

File  Menu Setup Edit  Miew  FunctionCodeEdit  Window  Help
DEEERo| /OES (TEHIXe @D L o &[5 D& BlEEE A= G
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Chapter 2 Functional Description

2.8.4. Tile Vertically

Click [Window] -> [Tile vertically] to tile windows vertically.

FRENIG Loader ~ Function| i [ 1]

File  Meru Setup Edit View FunctionCodeEdit Window Help
DEed e FO&S Xe@E>HLGRHEODREEIAAQDEHERE
REE REDS]

{Fimclion ode edif "] Auta-tuning | File information | VO monitor | System manitar | Alarm manitor | Cperation status monitar |
Tnput tertinal Cutput terinal
5 Function - - Terminal Funtion MNarmal = Terminal Function Normal =
- Gode eroup = | Ghanee | MNo. Function code name Setting value | S e e
F code X1 [LE] Enable c... |Open Vi [RUNI verte... | Open
E code FO0 |Data protection 0ot
X2 [552] Select .. |Open o v [0L] Motor ov...|Open |
- gmdde FO1 |Frequency setting 1 oot
P code
P oode P02 [Operation methad Tt K3 [554] Select .. |Open 30Ry [ALM] Alarm .. |Open
:1 Ezde FO3 | Maximum output frequency 1 60025 s [BX] Coast to.. | Open
code
b code F04 |Base frequency 1 50.0|25. X5 [RST] Reset .. Open
1 code FO5 |Rated voltese at base frequency 1 200[0 ENT — Close

Acceleration time 1

J code
I rode FO6 | Maximum output voltage | 20080 BE 1 _I—I <I | _I_I
~d code FO7 500(00

oy code
K code F08 |Deceleration time 1 6.00(0.0 — —

Unction - unction =
ocode F09 | Torque boost 1 1300 Terminel e it = | Terminel o G =
of code ~

Ghange(Favtory seti F10 |Electronic thermal averlaad prote.. Tt 12 [Hene] v FMAFMV)  TF-out 1] Out.. ¥
miﬂ‘s D'(;hakr;ge(ﬁ F11 |Electronic thermal overload prote 225000 G1(C1 functi... |[None] mé _ FM (FMD [F-out 1] Out.. mA L
ailre(Pink)
5 User definition F12 [Electronic thermal overload prote 5005 G 1 (%2 functi... |[Nane] v Fh (FMP) [F-out 1] Qut.. |p/e
- H:: ::::::::g:; F14 |Restart mode after momentary po.. 10t FM2 MV |[FAC] Output. |V
.. User definition 3 F15 |Frequency limiter (Upper limit) 700[00 FH2CFHD) | ILAC] Outprt
b HSEF gez\mtmn; F16 |Frequency limiter (Lower limit) 00
ser definition
- Gode for c F18 |Bias (for frequency setting 1) 0.00
41 - | il | 4 | 4 |
Save GSV file Refresh | Advanced |
Read. | Wiite. | Factory set | Func. code set. | Fun. code info | |

Select Tverter IND I OmvT =] Clese | [Connectine: FRND 75E25-2J Tnwerter: |No.1[ 1INV
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2.9. Help

2.9.1. Search the Topics

Not available.

2.9.2. About

Displays the version and copyright information

for this loader.

S FREMIC Loader

le  Meru Setup  Wiew  Window

Ei
‘0 O &

FE &0 0

Search the topics

About ...

Version 1.0.3.0 or later]

Implemented the management function of the additional definition library files.

Version number and copyright

Xl

FRENIC Loader 4
[

_~ Version

P

The main version that integrates

Version 1.0.3.2

executable and definition files.

ki

Add-IN Setting .. |

Copyright (C) 2017-201% Fuji Electric Co., Ltd.

211 rights reserved. . .

File Version 1.0.3.2 @ File Version

[Definitions Library]@ Version of the executable file itself.
Base set 0039 \

Definitions Library
Installed definition file library type and
version are listed here.

Add-IN Setting
Displays the Add-in setting window which manage

s additional definition library files.

The files will be provided as needed by Fuji Electric.
Add-in setting x|
=l
Add an add-n |
Lp IV Add with Sort
o]
|
=] OK |
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Chapter 2 Functional Description

Version 1.0.2.12 or previous|

Displays the version and copyright information.

Version number and copyright

FRENIC Loader 4

_—

Version 1.0.2.12 @

Copyright (C) 2017-2019 Fuji Electric Co., Ltd.
All right reserved.

File Version 1.0.2.5 @
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2.10. Global Model Country Setting

@ e This screen is not displayed with inverters for the Japanese market because
they have the regional specification set to "J: Japan". You can use the loader
without configuring the regional specification. Also, you should not change the
factory-set value of H101.

This screen is applicable to the inverter models for overseas markets that have the regional
specification setting (function code H101).

You should first configure the regional specification setting (function code H101) when you
turn on your inverter for the first time. You cannot operate an inverter for which the regional
specification is not selected (i.e., function code H101 is set to 0).

When you attempt an operation relating to the read or write of function codes from the loader to
an inverter for which the regional specification is not selected (i.e., function code H101 is set to
0), the [Global model country setting] window appears as shown below. Configure the regional

specification according to your environment.

X[ select country
Select the inverter's regional
o Sk ey specification setting.
| LJAPAN =l
[T OWfrite save file to the inverter. [ Write save file to the inverter

| Sruiz |/ Select this check box to write the
[T Wikite (plustomizable  oeic save file to thel imverter standard function code data saved in

| B |] an FNL file to the inverter. You should

select the file that contains the

regional specification setting (H101).

Of \irite function code to the EEPROM{rite 2 to 597)

o Mbite function code followine v 97 settine X . .
@ (Do not write ¥97 function code ) Write customizable logic save

file to the inverter

These options are enabled once you
(&lpply settines ’ P Y

——— select [Write save file to the inverter].
Select this check box to write the
customizable logic function code
data saved in an FNB file to the
inverter.

Apply settings

Click this button to write the settings to the inverter.

— Write function code to EEPROM

These options are enabled once you select [Write save file to the inverter].

Select this check box to write '2' to function code y97 immediately before the completion of write so that the
written function code settings will be stored in the non-volatile memory. Refer to "2.3.1.1. [2] Write the
Function Codes from the Loader to the Inverter or Keypad" for details.

L Write function code following y97 setting

These options are enabled once you select [Write save file to the inverter].

The setting of function code y97 in the inverter determines whether the function code settings written are
saved in the non-volatile or temporary storage memory of the inverter. Refer to "2.3.1.1. [2] Write the Function
Codes from the Loader to the Inverter or Keypad" for details.
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Chapter 3

Reference Information

This chapter provides information on troubleshooting and standard specifications.






Chapter 3 Reference Information

3.1. Frequently Asked Questions

3.1.1. Loader Specifications

Q1. | What is the supported OS?

Al. | The supported OS is Microsoft Windows 7, 8.1, and 10.

Q2. | Can the FRENIC-Loader 4 coexist with the older version (FRENIC Loader 3.3 or
earlier versions)?

A2. | Yes, it can.

Q3. | Can the FRENIC-Loader 4 coexist with other loader models such as the VG Loader
or Servo Loader?

A3. | Yes, it can.

Q4. | Is it OK to uninstall the older version?

A4. | If the Message Manager has been installed together with the software, the Message
Manager will also be uninstalled.

If it is uninstalled, the new version will not operate because the Message Manager is
also used by the new version. Close all the running loader applications and then
reinstall the Message Manager.

= Refer to "1.4.1.6. Installation of the Message Manager".

Q5. | What are the differences from the older version (FRENIC Loader 3.3 or earlier
versions)?

A5. | The new version supports the following and improvements have been made,
including its functional improvement.

- Support for Windows 8.1 and 10

- Integration of the following support tools
- FRENIC Loader 3.3 (Older version)
- FRENIC-HVAC/AQUA Loader
- FRENIC Visual Customizer

Q6. | How can | import into the new model the function code set data stored in the
discontinued model?

A6. | Currently, the new model is not equipped with a function to convert the data stored in
the discontinued model.
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Q7.

Is the Loader software applicable to the discontinued model?

A7.

Sorry to say, but the software is applicable only to the selectable models.
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3.1.2. Communication-Related Information

3.1.2.1. Connection Methods and Connection Devices

m Recommended Cables

Q1. | Can we get these cables through Fuji Electric? Where can we get these cables?

Al. | Cables For Connecting RJ-45 Connectors

Can be procured with the following designation: Model: CB-UJIS (=1, 3, 5). Please
consult the nearest dealer or Fuji Electric sales office. Other commercially available
LAN cables can also be used.

Cables for Connecting Terminal Blocks
Not available from Fuji Electric.

Recommended cable is as follows.

Manufacturer: Furukawa Electric Co., Ltd. AWM2789 Long distance connection
cable and so on.

For these products, please contact Furukawa Electric Co., Ltd. or their distributor.

USB Cable

Please use commercially available USB cables.

= Referto "1.2.2.2. [2] Cables (for RJ-45 connector connection)”.
= Refer to "1.2.2.2. [3] Cables (using terminal blocks)".

m Connection Methods

Q2. Is it possible to connect the RJ-45 connector on the inverter to the LAN terminal of
the PC directly using the LAN cable?

A2. | Both the inverter and the PC may be damaged. Never connect them directly.
They must be connected via the RS-232C/RS-485 or USB/RS-485 converter or

the TP-E1U.

For information on the specific connection methods, refer to "1.2.2" and "1.2.3".

= Refer to "1.2.2. RS-485 Communication Port Connection".

= Refer to "1.2.3. USB Communication Port Connection".
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m RS-232C/RS-485 or USB/RS-485 converter

Q3.

Can we get these converters through Fuji Electric? Where can we get these
converters?

A3.

Not available from Fuji Electric.

The recommended converters are as follows:

System Sacom Industry Corp.

- KS-485PTI (RS-232C/RS-485 converter)

- USB-4851 RJ-45-T4P (USB/RS-485 converter) and so on.

For these products, please contact System Sacom Industry Corp. or their distributor.

Q4.

The converter is not recognized by Windows 8 or later version. Any solution?

A4.

The converter may not be supported by Windows 8 or later version.

Please contact the converter manufacturer because Fuji Electric does not handle the
converters.

If the converter is supported by Windows 8 or later version, it is possible that you
failed in installing the converter drive software. Please reinstall the software.
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3.1.2.2.

USB Communication

m USB Communication
Communication target: Inverter via the TP-E1U Remote Keypad with USB port

. Inverter with built-in USB port
: TP-E1U Remote Keypad with USB port

Q1.

USB communication does not work.

Q1.

The following message is displayed: "Failed to obtain the inverter model
information."

Al-1.

Power may not have been supplied to the inverter.

Al-2.

The USB driver may not have been installed.

Confirm that [FRENIC] is displayed under [Loader USB device] on the Device
Manager of the Windows PC.

For information on the specific confirmation procedure, refer to "1.4.1.5".

= Refer to "1.4.1.5. Checking the USB Driver".

If [Unknown device] is displayed instead of [FRENIC], set up the USB driver again.
For information on the specific procedure, refer to "1.4.1.4".

= Referto "1.4.1.4. USB Driver Installation Procedure".

If neither [FRENIC] nor [Unknown device] is displayed, refer to "Q2".

= Refer to "Q2.".

Al-3.

If you are using the USB hub, stop using the hub.

Al-4.

The Message Manager may not have been installed.

Confirm that the Message Manager icon M, is displayed on the task bar of the
Windows PC while the Loader software is running.

For information on the specific confirmation procedure, refer to "1.5.4.1".

= Refer to "1.5.4.1.Checking the Startup of the Message Manager".

If the Message Manager icon M| is not displayed on the task bar of the Windows
PC, uninstall the Message Manager and then reinstall it.

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this
instruction manual.

== Refer to "1.4.2.2. Uninstallation of the Message Manager".
= Refer to "1.4.1.6. Installation of the Message Manager".

If the Message Manager icon M. is displayed on the task bar of the Windows PC,
refer to "Q3".

= Refer to "Q3.".
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A1-5. | The timeout setting for the Loader may be too short.
If the timeout is set to a value smaller than 1.5 s, a communication error may be
detected before the Loader receives a response from the communicating device.
Set to a value larger than the default value and try to see if communication is
possible.
Set the timeout setting on [Communication Conditions] on the [Communication
setting] window. Refer to "1.5.5.1. [3]" of this instruction manual.
= Referto "1.5.5.1.[3] Communication Conditions".

A1-6. | When the communication target is the inverter via the TP-E1U Remote Keypad with
USB port
The inverter may not be applicable to the communication via the TP-E1U.
For the correspondence table, refer to "1.1.1" of this instruction manual.
= Refer to "1.1.1. Features".

A1-7. | When the communication target is the inverter via the TP-E1U Remote Keypad with
USB port
The TP-E1U may have been connected to the RS-485 communication port 2 of the
inverter.
Connect to the RS-485 communication port 1.

A1-8. | When the communication target is the inverter via the TP-E1U Remote Keypad with
USB port
If a LAN cable is used for the connection between the TP-E1U and the inverter, the
LAN cable used may be a cross cable. If a cross cable is being used, replace it with
a straight cable.

A1-9. | When the communication target is the inverter via the TP-E1U Remote Keypad with
USB port
The port setting on the [Communication setting] of the Loader may not be correct.
Make sure that the setting is as follows: [USB connection], [Data in Inverter (via TP)].
For information on the specific setting procedure, refer to "1.5.5.1".
= Refer to "1.5.5.1. Communication Settings".

A1-10. | When the communication target is the inverter via the TP-E1U Remote Keypad with
USB port
The address set on [Address] (for the RS-485 station address) on the [Connection
setting] window accessed from the [Communication setting] window of the Loader
may not the same as the station address of the inverter. Make sure that the address
is the same.
For information on the specific setting procedure, refer to "1.5.1" and "1.5.5.2".
= Refer to "1.5.1. Setting Function Codes Related to Communication on the
Inverter Side".
= Refer to "1.5.5.2. Connection Setting".

A1-11. | When the communication target is the inverter with built-in USB port

The port setting on the [Communication setting] of the Loader may not be correct.
Make sure that the setting is as follows: [USB connection], [Data in Inverter (Direct
connection)].

For information on the specific setting procedure, refer to "1.5.5.1".

= Refer to "1.5.5.1. Communication Settings".
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Al-12.

When the communication target is the TP-E1U Remote Keypad with USB port

The port setting on the [Communication setting] of the Loader may not be correct.
Make sure that the setting is as follows: [USB connection], [Data in Keypad].

For information on the specific setting procedure, refer to "1.5.5.1".

= Refer to "1.5.5.1. Communication Settings".

Al-13.

When the communication target is the TP-E1U Remote Keypad with USB port

The address set on [Address] (for the RS-485 station address) on the [Connection
setting] window accessed from the [Communication setting] may not be 1. Make
sure that the address is set to "1".

For information on the specific setting procedure, refer to "1.5.5.2".

= Refer to "1.5.5.2. Connection Setting".

Q2.

When it is checked whether the USB driver is recognized by the Device Manager,
"Unknown device" is not displayed. How can | make the Device Manager properly
recognize the driver?

A2-1.

The connection between the PC with the USB device may be incomplete.

Check the connection by disconnecting and then reconnecting the USB cable,
connecting to another USB port on the PC, or replacing the USB cable.

A2-2.

It is necessary to connect the PC to the USB device to display "Unknown device".
After that, install the USB driver.

= Refer to "1.4.1.4. USB Driver Installation Procedure".

Q3.

Although the Message Manager is running, communication does not work.

A3-1.

The USB driver may not have been properly recognized by the Message Manager.

In such a case, the Message Manager must be restarted. Close the Message
Manager, and restart the Loader software.

For information on procedures for closing the Message Manager, refer to "1.4.1.4".

= Refer to "1.4.1.4. [1] Before Installing the USB Driver".

A3-2.

The Message Manager itself or its registry may have been damaged due to some
reason.

Uninstall the Message Manager and then reinstall it.

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this
instruction manual.

= Refer to "1.4.2.2. Uninstallation of the Message Manager".

= Refer to "1.4.1.6. Installation of the Message Manager".
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Q4. | After changing the function code from the Loader, | checked it using the keypad and
found that the function code was not changed.

A4. | If you are using the TP-E1U, the port setting on [Communication setting] of the
Loader may be set to [USB connection], [Data in Keypad]. If that's the case, change
the setting to [Data in Inverter (via TP)].

For information on the specific setting procedure, refer to "1.5.5.1" of this instruction
manual.
= Refer to "1.5.5.1. Communication Settings".

Q5. | Set the Loader to work offline from the inverter (for example, bringing the Loader to
your office), edit the function code on the Loader, and write the edited result in the
TP-E1U.

Is it possible to copy the edited data to the inverter just by using the TP-E1U (at the
work site) without using the Loader?

A5. | Yes. It must be noted, however, that it is possible only with the models that support
the TP-E1U as standard or as an option. For information on the TP-E1U support
details, refer to "1.1.2. Table 1-1" of this instruction manual.
= Refer to "1.1.2. Table 1-1 Correspondence between FRENIC Series Inverter
Models and Loader Functions".

If customizable logic is used, care must be taken.

If the customizable logic is used for the inverter that supports the setting specified in
[Open customizable logic setting screen] under [Function code setting], both the
basic function code settings (such as F, E, or C codes) and customizable logic
setting (Uxx) must be written when writing the data from the Loader to the TP-E1U.
For reference information, refer to "2.3.3.9" of this instruction manual.

= Refer to "2.3.3.9. [2] To write to the Keypad".

Q6. | The Loader is directly connected with the inverter with the built-in USB port
(FRENIC-HVAC/AQUA). Communication is possible while the inverter remains
stopped. However, communication is not possible when the inverter is started.

A6. | Noise may be the cause.

Implement an appropriate noise countermeasure such as by passing the USB cable
through the ferrite core.
Connect the USB cable to the USB 3.0 terminal of the PC.
Q7. | USB communication is not possible after the PC enters the standby (sleep) state.
A7. | Disconnect and then reconnect the USB cable. If the communication cannot be

recovered even after that, restart the PC.
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Q8. | The seven-segment LED display on the TP-E1U shows "-Ld-". What does that
mean?
A8. | It means that the connection between the TP-E1U and the inverter is not established

and only the PC side is connected.

If this is displayed while using the Loader software, communication with the inverter
is not possible. Check the connection between the TP-E1U and the inverter and take
necessary actions.
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3.1.2.3.

RS-485 Communication

m RS-485 communication
Communication target: Inverter via the USB/RS-485 converter

: Inverter via the RS-232C/RS-485 converter

Q1.

RS-485 communication does not work.

Al-1.

Power may not have been supplied to the inverter.

Check whether the power is properly supplied.

Al-2.

When using the USB/RS-485 converter
The USB driver may not have been installed.

Confirm that [USB Serial Port (COMO)] is displayed under [Port (COM and LPT)] on
the Device Manager of the Windows PC.

For information on the specific confirmation procedure, refer to "1.5.2".

= Refer to "1.5.2. Checking Communication Ports on the PC (when Using a
Converter)".

If [Unknown device] is displayed, set up the USB driver again. For information on the
specific procedure, refer to the instruction manual of the converter currently used.

Al-3.

When using the RS-232C/RS-485 converter

The Loader does not allow switching with RS-232C flow control signals (RTS or
DTR) from the PC. The transmission and reception switching must be done
automatically through monitoring transmission data.

If a converter other than the ones we recommend, confirm the transmission and
reception switching method specified in the instruction manual of the converter
currently used.

There is no problem with the converters we recommend because the transmission
and reception switching is done automatically through monitoring transmission data.

= Refer to "1.2.2.2. [1] Converter".

Al-4.

The number of the COM port on the Windows may not match with the COM port
setting on the Loader. Check the COM port. For information on the specific
procedure, refer to "1.5.2" and "1.5.5.1" of this instruction manual.

= Refer to "1.5.2. Checking Communication Ports on the PC (when Using a
Converter)".

= Refer to "1.5.5.1. Communication Settings".
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Al-5. | The Message Manager may not have been installed.

Confirm that the Message Manager icon M, is displayed on the task bar of the
Windows PC while the Loader software is running.

For information on the specific confirmation procedure, refer to "1.5.4.1".

= Refer to "1.5.4.1. Checking the Startup of the Message Manager".

If the Message Manager icon M, is not displayed on the task bar of the Windows
PC, uninstall the Message Manager and then reinstall it.

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this
instruction manual.

= Refer to "1.4.2.2. Uninstallation of the Message Manager".

Refer to "1.4.1.6. Installation of the Message Manager".

If the message Manager icon M, is displayed on the task bar of the Windows PC,
refer to "3.1.2.2. Q3".

= Refer to "3.1.2.2. USB Communication Q3".

A1-6. | The timeout setting for the Loader may be too short.

If the timeout is set to a value smaller than 1.5 s, a communication error may be
detected before the Loader receives a response from the communicating device. Set
to a value larger than the default value and try to see if communication is possible.

Set the timeout setting on [Communication Conditions] on the [Communication
setting] window. Refer to "1.5.5.1. [3]" of this instruction manual.

= Refer to "1.5.5.1. [3] Communication Conditions".

Al-7. | The port setting on the [Communication setting] of the Loader may not be correct.
Make sure that it is set to [RS-485 connection].

For information on the specific setting procedure, refer to "1.5.5.1".

= Refer to "1.5.5.1. Communication Settings".

A1-8. | The [Baud rate] for the RS-485 connection set under the [Communication setting] of
the Loader may not be the same as the [Baud rate] of the inverter.

Make sure that the baud rate is the same. For information on the specific setting
procedure, refer to "1.5.1" and "1.5.5.2".

= Refer to "1.5.1. Setting Function Codes Related to Communication on the
Inverter Side".

= Refer to "1.5.5.2. Connection Setting".

A1-9. | The address set on [Address] (for the RS-485 station address) on the [Connection
setting] window accessed from the [Communication setting] window of the Loader
may not the same as the station address of the inverter. Make sure that the address
is the same.

For information on the specific setting procedure, refer to "1.5.1" and "1.5.5.2".

= Refer to "1.5.1. Setting Function Codes Related to Communication on the
Inverter Side".

= Refer to "1.5.5.2. Connection Setting".
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A1-10. | Some models have a multiple number of RS-485 communication ports. (Example:
MEGA (G1) series)
If a communication port on the terminal block is used instead of the communication
port for keypad connection, the default value of the function code for setting the
communication protocol must be a value other than the SX (Loader) protocol. Make
sure that it is set to "SX (Loader) protocol".
For information on the specific setting procedure, refer to "1.5.1".
= Refer to "1.5.1. Setting Function Codes Related to Communication on the
Inverter Side".

Al-11. | When using the inverter with two RS-485 ports
If both the RS-485 settings 1 and 2 of the inverter are set to "SX (Loader) protocol”,
communication is not possible when the Loader is connected to the RS-485
communication port 1. Connect the Loader to the RS-485 communication port 2 or
change the protocol option for the RS-485 setting 1 to a value other than [SX
protocol].

Q2. | Is it possible to use the Loader while communicating with the inverter with two
RS-485 ports?

A2. | It is possible to use the general-purpose communication together with the Loader.
Likewise, with the communication using the field bus option, the Loader can be used
at the same time.

It must be noted that, if the function code is changed from both of them, the data
changed later becomes valid.

Q3. | When using the Loader to control a multiple of inverters equipped with two
RS-485 ports, is it possible to connect one port to the PC and to use the other
port to make a multi-drop connection with other inverters?

A3. | No, it's not possible to use them that way.

Use either one of the ports.

A multiple of inverters can be controlled using the Loader only if they are directly
connected.

* Such connection is not allowed not only for the Loader, but also for ordinary
RS-485 communication. It is because a unique station address must be assigned to
each port.

Q4. | With using the inverter equipped with two RS-485 ports, what will happen if both of
the two ports are set to the Loader (SX) protocol?

A4. | We do not recommend that kind of setting.

If the ports are set that way, the one on the terminal block side has the higher priority.
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3.1.2.4. Common to Communication

Q1. | We use the inverter in an application where its continuous operation cannot be
stopped halfway. If the Loader is connected, will it cause the inverter to stop?

Al. | Even if you connect the Loader, it will not cause the inverter to stop working.
However, care must be taken because if you switch to test run, the inverter may stop.

If the operation is controlled using the keypad, care must be taken because the
inverter will stop if you disconnect the keypad by mistake when connecting the
Loader.
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3.1.3. How to Use the Loader

3.1.3.1.

Function Code Settings

Q1.

When | tried to make new settings by editing the function codes for the inverter with
400-V specification, it was set to 200-V specification. How can | change the setting to
400-V specification?

Al.

From the Quick Access menu or main menu, select [Function code setting], select
[New] on the [Select data to edit] window, and on the [Initial setting] window, set
models, capacities, and voltage series for the inverter you will be using.

= Refer to "2.2.1. Create a New File".

Q2.

Is it possible to compare function codes set values for two or more inverters?

A2.

The function codes for two inverters can be compared simultaneously on the Loader
software screen.

When comparing the codes for a multiple inverters, read the function code set values
for every converter, save them as a set data file using the file function, and then
compare a data file with the next one opened one after another.

For information on the comparison function, refer to "2.3.1.1. [6] Compare" of this
instruction manual.

The set data can also be saved in CSV format, so the data can be compared using a
commercially available software.

For information on saving in CSV format, refer to "2.7" of this instruction manual.

[ Refer to "2.3.1.1. Function Code Edit [6] Compare".
[1 Refer to "2.7. Function Code Edit".

Q3.

| want to perform offline tuning using the Loader software, but P04 is not present in
the function code under [Function code edit]. How can | perform offline tuning?

A3.

From the Quick Access menu or main menu, select [Function code edit] and then
select [Autotuning] tab on the [Function code list] window to perform the tuning.

= Refer to "2.3.1.2. Auto Tuning".
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Q4.

| cannot read the file where Loader's function code settings are saved.

A4.

For some reasons, the definition files required for executing the Loader software may
have been lost.

When the function code settings are saved, they are linked to the definition files in
correspondence with the ROM number. Therefore, you cannot read the file if the
definition file that the Loader refers to does not exist when the file is opened.

The definition files are generated when the Loader software is installed. To generate
the definition files, uninstall the Loader software once and then install it again.

= Referto "1.4.2.1. FRENIC Loader Uninstallation Procedure".
= Refer to "1.4.1.3. FRENIC Loader Installation Procedure".

Q5.

| cannot select models on [New] under [Function code settings]. (Selection options
are not displayed.)

A5.

For some reasons, the files (such as INI file, DLL file) required for executing the
Loader software may have been lost or the environment definitions (such as registry
setting) may have been corrupted. Uninstall the Loader software once and then
install it again.

= Referto "1.4.2.1. FRENIC Loader Uninstallation Procedure".
= Refer to "1.4.1.3. FRENIC Loader Installation Procedure".

Q6.

Model names that are not listed in the catalog are displayed as optional items.

AG.

The Loader software is common to applications in Japan or abroad. Therefore, all
the applicable models that we sell in Japan and abroad are displayed.

If models not listed in the catalog are displayed, the [Regional spec.] may be set to
an optional item other than [J: JAPAN]. On the main menu, select [Setup] and set [J:
JAPAN] for [Regional spec.]. Then restart the Loader software.

= Refer to "2.4.4. Region Spec.".

Q7.

After writing function code data in the inverter using the Loader software, | read the
written data. The values read were different from what | just wrote in.

A7.

Some function codes (H42, H43, H44, H47, H48, etc.) including those related to
the run time or service life are set as monitor only or updated according to
operation. Therefore, the read value may be different from what was written in.

Applicable function codes are different depending on the inverter models. Refer to
the instruction manual or user's manual for the inverter model currently used.
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Q8.

With the inverter models provided with the password function, it is not possible to set
or change the password from the Loader software.

A8.

Password setting or changing via communication is disabled on the inverter side to
prevent malicious password decoding.

Unlock the password from the keypad.

3.1.3.2.

Alarm History

Q1.

When | checked the alarm history using the Loader software, | only found numerical
data in the function code settings.

Al.

The numerical data that can be confirmed on [Function code edit] window indicates
alarm code numbers.

Refer to the alarm code table provided separately in the RS-485 Communication
User's Manual.

If you access the [Alarm monitor] tab on the [Operation monitor] window selected
from the [Operation monitor settings] on the Quick Access menu, the alarm codes
can be checked in the same format as those displayed on the keypad.

= Refer to "2.3.2.3. Alarm Monitor (for monitoring the inverter's alarm information)".
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3.1.3.3. Customizable Logic

Q1. | What should | enter in the [Version] displayed for [Inverter model selection] when |
select [New] after selecting [Customizable logic] and [Select edit data] on the Quick
Access menu?

Al. | Setthe ROM version of the inverter.

For information on checking the ROM version, refer to the instruction manual or
user's manual for the inverter model currently used.

If the Loader software is connected to the inverter, you can confirm the ROM version
on [Inverter ROM version] displayed on the [System monitor] tab on the [Operation
monitor] window that can be accessed from the [Operation monitor settings] on the
Quick Access menu.

The set values entered in [Model] and [Version] affect the usable number of steps
and usable circuit types. The entry in [Version] can be changed at a later stage.
However, if any change is made to [Version], an error may occur when step numbers
are assigned. You are recommended to select a version number that is as
appropriate as possible when creating a new circuit.

= Refer to "2.3.3.1. Select Customizable Logic Project to Edit".

= Refer to "2.3.2.2. System Monitor
(for monitoring the internal setup information and maintenance status of the
inverter)".

= Refer to "2.3.3.12. Project Properties".

Q2. | The newly created project does not work properly.

A2-1. | Check whether the customizable logic is started.

If "UOQ", the inverter’s function code, is 1, it means that the customizable logic has
been started.

A2-2. | Use the comparison function to check if the project is properly written in the inverter.

= Refer to "2.3.3.10. Comparison".

A2-3. | Check if the user set values required for the customizable logic and the set values
for the storage area are properly written.

= Refer to "2.3.3.6. Settings for the User Setting Area and the Memory Area".
= Refer to "2.3.3.9. Write".

A2-4. | Use the on-line monitoring function to check if symbols and FB inputs and outputs
operate properly.

= Refer to "2.3.3.11. Debug Function".

A2-5. | The process execution sequence may not be correct. Check the execution
sequence.

The execution sequence is represented by step numbers.

= Refer to "2.3.3.7. Step Number Assignment".
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Q3.

How can | debug a newly created project?

A3.

After you finish assigning the step numbers, use the following functions to debug the
project.

- On-line monitoring function that displays status in the vicinity of symbols

- Trace monitoring function that displays 1/0O of symbols in waveforms as a realtime
trace

= Refer to "2.3.3.11. Debug Function".

= Refer to "2.3.5.11. Combination with the Customizable Logic Function".

Q4.

Can | print the newly created project?

A4.

Either the project layout area or the selected portion of the area can be printed.

= Refer to "2.3.3.15. Printing the Customizable Logic".

Q5.

The newly created project may contain unique know-how. Is it possible to hide
symbols or their connections or to disable any changes to them?

A5.

You can hide or display with a password by using the lock function.

However, it must be noted that the lock function is enabled on the PC, but disabled
on the inverter. If you write the circuit that is protected with the lock function into the
inverter, the circuit can be freely displayed and edited on the inverter. To apply
restrictions to display or edit of the circuit on the inverter, you need to use the
inverter's password function (H197, H198, and H99)

= Refer to "2.3.3.13. Lock Function”.

Q6.

When | open the newly created project with the FRENIC-Visual Customizer, the
display contents are changed.

AG.

The display specification of the FRENIC-Visual Customizer has been reviewed and it
is upgraded with additional functions. Furthermore, three inputs are provided for the
following symbols to improve its readability.

- 2008: Variable limiter
- 5000: Selection 3
- 5100: Selection 4

Due to these changes, if you open a project file that is created on the FRENIC-Visual
Customizer, the inputs newly added to the symbol appear unconnected. It can be
used without any problem.

= Refer to "2.3.3.18. List of Logic Symbols" and the following items: "2008: Variable
limiter, "5000: Selection 3", and "5100: Selection 4".

3-18




Chapter 3 Reference Information

Q7.

Is it possible to operate processes with different cycles within a project?

A7.

It is not possible to set a different cycle for each of the process within a project.

However, it is possible to make it appear to process with multiple cycles by adjusting
the process I/O refresh timing.

The project execution cycles are different depending on the inverter models.
AR1. AQ1: 5ms

E2: As shown in the following table, the execution cycle depends on the
maximum step number of the project.

Maximum step No. [Execution cycle]

1-10 2 ms

11 - 50 5ms

51-100 10 ms

101 - 200 20 ms

For example, for a project whose number of steps for the E2 model is 75, the
execution cycle is 10 ms. It is not possible to allow processes with cycles such as 2
ms or 5 ms that is shorter than 10 ms.

With the above example for 75 steps, the basic execution cycle is 10 ms.
Accordingly, the latch function or hold function will be added so that the 1/O signals of
the target processes are updated at the integer multiple of 10 ms.

If 75 is manually assigned to the step number even if only one step is used, the basic
execution cycle becomes 10 ms, the same time as for the 75 steps.

Q8.

Is it possible to share the newly created function blocks (FBs) with other people or
with other PCs?

A8.

The import/export function allows you to use your created FB in the FRENIC Loader
4 software installed on another PC.

= Refer to "2.3.3.14. Importing/exporting an FB under [FB (Common)]".
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Q9. | Can | use the newly created project on different models?

A9. | If a project is created using only the symbols that are common to different models,
the whole project can be set as an FB so that it can be used among different models
using the import/export function.

By clicking the [Change] button on the [Properties] screen of the project, you can
also change the model on the [Inverter model selection].
If symbols that are not common among different models are used, the newly created
project cannot be used when the number of steps of the created circuit exceeds the
maximum number of steps of another model.
= Refer to "2.3.3.3. [4] Creating a Function Block (FB)".
= Refer to "2.3.3.14. Importing/exporting an FB under [FB (Common)]".
= Refer to "2.3.3.12. Project Properties".

3.1.3.4. Trace

Q1. | Is it possible to use the waveform data obtained through the realtime trace or
historical trace on a commercially available software?

Al. | The waveform data can be saved in CSV format and thus the data can be used with

commercially available software applications.

Besides, if the waveform data has already been saved in the file formats (extensions:
RT2, HT2, RTM, HIM, or RT1) dedicated to the Loader, read the data on the Loader
software by clicking [File] -> [Open], and then save the data in CSV format by clicking
[Save as].

Note that the data saved in CSV format cannot be opened with the Loader software.

== Refer to "2.3.5.5. Saving the Trace Data".
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3.1.3.5. Test Run

Q1. | When | try to change [Switching frequency/operation command], the following
message appears and | cannot make any changes: [Cannot communicate with the
inverter. Retry communication?]

Al1-1. | An error may have occurred in the communication between the Loader and the
inverter.

Access the [Connection setting] window from the [Communication setting] window of
the Loader and then click the [Browse] button on the [Connection setting] window to
check the state of communication. For information on checking methods, refer to
"2.3.6.3" and "1.5.5.2" of this instruction manual.

= Refer to "2.3.6.3. If You Cannot Use the [Drive operation] Menu".

= Refer to "1.5.5.2. Connection Setting".

If "Not connected" is displayed, check communication cable connections or
communication settings. For information on checking methods, refer to "3.1.2.2. Q1."
and "3.1.2.3. Q1." of this instruction manual.

= Refer to "3.1.2.2. USB Communication Q1".
= Refer to "3.1.2.3. RS-485 Communication Q1".

If "Connected" is displayed, refer to "A1-2" on the following section.

A1-2. | If you cannot change [Switching frequency/operation command] even if "Connected"
is displayed when the the [Browse] button is clicked, the inverter may be rejecting the
[Switching frequency/operation command] request. With the inverter provided with
the password function, the cause could be that the password protection has been
enabled.

If the [Password protected] dialog is displayed when [Read from Inverter] is selected
on [Function code setting], it means that the password protection is enabled.

If that dialog is not displayed, select [Read from Inverter] on [Function code setting],
and then try writing in the function code y99 on the [Function code edit] window. If the
[Password protected] dialog is displayed, it means that the password protection is
enabled.

If the password protection is enabled, it needs to be removed.

For information on password protection, refer to the instruction manuals or user's
manuals of relevant inverters.

3.1.3.6. Date and Time

Q1. | I cannot set the date and time.

Al. | You must be attempting to set the date and time for the inverter that is not equipped
with the realtime clock (RTC). To check if the inverter is equipped with the realtime
clock (RTC), refer to the instruction manuals or user's manuals of relevant inverters.
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3.1.4. Terminology

Q1.

What does the "Message Manager" (hereinafter referred as "the MM™)?

Al.

It is a software that controls communication between our Loader and the inverter. If
the Message Manager is not installed, if it was deleted, or if the existing one was
overwritten by reinstalling the Message Manager, communication may be disabled.

= Refer to "1.5.4. Overview of the Message Manager".

Q2.

What does the "definition file" mean?

A2.

It is a file that contains information required to identify various models and their
functions.

If new function codes are added as functional improvement to a certain model, a new
definition version (file name) is given to the new one of the same model.

Our naming rule specifies that a file name must include the ROM number. When
function codes with attributes are read from the inverter, optimum definition files are
automatically detected. If you attempt to write function code set values in the inverter
with different ROM number, a warning will be displayed.

In such a case, select definition files again and perform writing. Writing should be
normal now.

= Refer to "2.3.1.3. [3] Changing a Definition File".

Q3.

What does the "regional spec." mean?

A3.

"Regional spec." for inverters

Power supply specifications (voltages and frequencies) are different depending on
countries. We divide countries into several regions and provide a lineup of inverter
models with function code default values for typical power supply specifications and
other relevant specifications by region. The set of specifications classified by region
is called the "regional spec.".

The "regional spec." lineup is different for each inverter model.

The "regional spec." is represented by alphabet which is indicated at the end of the
model number on the nameplate of the inverter for easy identification.

[Regional spec.] that is displayed on the [Initial setting] window when the function
code setting is newly made
Same as the "regional spec." for inverters.

= Refer to "2.2.1. [1] Model, Regional Specification, Voltage, Capacity".
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3.2. FRENIC Loader Standard Specifications

Iltem

Specification

Remarks

Name

FRENIC Loader 4

Supported inverters

FRENIC-Mini (C1) (C2)
FRENIC-Eco
FRENIC-Multi
FRENIC-MEGA (G1) (GX1)
FRENIC-HVAC/AQUA
FRENIC-Ace

FRENIC-VP
FRENIC-eHVAC
FRENIC-eFIT

FRENIC-Lift (LM2A/LM2C)

Note 1:

Numb

er of connected

inverters

For USB connection: Only one inverter
For RS-485 connection: 31 inverters max.

Only one inverter can be used
when using the date and time
setting (refer to "2.4.5. Date
Time").

Recommended cable

RS-485: Shielded twisted-pair cable for long
distance transmission

For connecting to the TP-E1U
(Note 2)

USB cable (mini B connector)

USB:

RS-485 connection: Refer to
"1.2.2. RS-485 Communication
Port Connection".

USB connection: Refer to "1.2.3.
USB Communication Port
Connection".

Supported OS Microsoft Windows 7 SP1 or higher 32hit/64bit
Microsoft Windows 8.1 Japanese/English
Microsoft Windows 10
E Memory 2 GB or more 4GB or more is recommended
E Hard disk Approx. 750 MB or more of free space
o
S | Serial port RS-232C, USB In case of RS-232C, conversion
o to RS-485 is required to connect
I to the inverter.
IS In case of USB, TP-E1U or
8 conversion to RS-485 is required
o to connect to the inverter not
equipped with USB.
Monitor Monitor with 1024 x 768 or higher resolution | FHD (1920 x 1080) or higher is
recommended.
Communication | COM1 to COM255 PC port used for loader
port
Baud rate USB connection: 19200 bps or faster is
12 Mbps between the Loader and the recommended
Remote Keypad with USB port (The FRENIC-Mini (C1S) does
c Between the Remote Keypad with USB | not support 38400 bps.)
-.% port and the inverter
£ 19200 (bps)
é For RS-485 connection:
; 38400, 19200, 9600, 4800, 2400 (bps)
@ | Character length |8 bits Fixed
a
= | Stop bit length 1 bit Fixed
Parity Even Fixed
Retry count None, 1 to 10 times Retry count to communication
timeout error detection
Timeout setting | 100 ms, 300 ms, 500 ms, 1.0 sto 1.9 s, 2.0 to | Set a time longer than the y09 or
9.0s,10.0t060.0 s y19 response interval time.
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Note 1: -This Loader cannot be used with a device that does not support the SX protocol (Loader protocol).

- With special inverters other than standard series models, function codes may not be properly displayed.

Note 2: - Except for the FRENIC-MEGA or some other models, the TP-E1U is an optional product.
- Some models including the FRENIC-HVAC/AQUA do not support the TP-E1U. For information on the
TP-E1U support detail, refer to "1.1.2. Table 1-1 Correspondence between FRENIC Series Inverter Models

and Loader Functions" or catalogs of relevant inverters.
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3.2.1. Functional Comparison with the FRENIC Loader 3.3

B Supported inverters

Table 3-1 List of Supported Inverters

FRENIC Series Inverters FRENIC Loader 3.3 FRENIC Loader 4
FRENIC-Mini (C1) (C2) (@) (@)
FRENIC-Eco O O
FRENIC-Multi O O
FRENIC-MEGA (G1) o) o)

For driving permanent magnet
synchronous motors

FRENIC-MEGA (GX1)
FRENIC-HVAC/AQUA
FRENIC-Ace
FRENIC-VP

(@)
(@)

FRENIC-eHVAC
FRENIC-eFIT
FRENIC-Lift (LM2) X

O: Supported X: Not supported

X|O|0O|O|X

C|O0|O|O|O|O

B Supported OS
Compatible with Microsoft Windows 8.1 and Microsoft Windows 10

Table 3-2 List of Supported OS

Operating system FRENIC Loader 3.3 FRENIC Loader 4

Microsoft Windows 2000 O -

Microsoft Windows XP SP2 or higher O
Microsoft Windows Vista O -
O

Microsoft Windows 7 SP1 or higher O
Microsoft Windows 8.1 - O
Microsoft Windows 10 - O

O: Supported - No operation guarantee or not supported

B |anguage
With the FRENIC Loader 4, the displaying language can be selected either from Japanese or
English (Version 1.0.1.0 or later).
With the FRENIC Loader 3.3, the Loader must be installed for each language.

Table 3-3 List of Supported Languages

FRENIC Loader 3.3 FRENIC Loader 3.3
Language . . i FRENIC Loader 4
(Japanese version) (English version)

Japanese Supported Not supported Supported

Version 1.0.0.0: Not supported

English Not supported Supported )
Version 1.0.1.0 or later: Supported
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Function

[Function code edit...]

e  Storage files
Function code information is saved in the binary format designed for use with the
FRENIC Loader 4.

e CSV format files
Can import function code set values in CSV format. It is convenient to use for
editing and importing function code set values through Microsoft Excel.
(*) Any CSV files saved by the FRENIC Loader 3.3 cannot be opened.

e  Error processing in reading or writing function codes
If there is no fatal error such as a communication error, the error function code is
skipped to continue reading or writing.

Operation monitor

Eliminated a meter indicator and added an operation status monitor. With the meter
indicator, only two data could be monitored at the same time. With the operation status
monitor, you can monitor more than two sets of data at the same time.

Customizable logic

The FRENIC Visual Customizer functions can be used. Besides, an "Undo" function
useful for editing work and an "Online batch operation” function that simplifies zone
selections or debugging operations are newly added.

Scheduled operation
Time operation setting is possible with the inverter models equipped with the realtime
clock (RTC).

Realtime Trace and Historical Trace

Different names can be given to signals.

Using the offline setting function, trace setting is possible without connecting to the
inverter.

The customizable logic I/O can be displayed in waveforms in the realtime trace.

Test Run

The test run screen is simplified not to take up much screen space based on an
assumption that it will be used together with other screens for realtime tracing or
operation monitoring.

3-26



Chapter 3 Reference Information

3.2.2. Compatibility with the Existing FRENIC Loader

The files saved by the FRENIC Loader 4 cannot be used for the FRENIC Loader 3.3,
FRENIC-HVAC/AQUA Loader, or FRENIC Visual Customizer.

FRENIC Loader 4 can use the following files saved by the FRENIC Loader 3.3,
FRENIC-HVAC/AQUA Loader, or FRENIC Visual Customizer.

Table 3-4 Usability of the Files Saved by the FRENIC Loader 4

Loader | FRENIC Loader FRENIC-HVAC/ FRENIC Visual
File types 3.3 AQUA Loader Customizer
_ O (*.FNC)
Function code data - © (*.FN1) -
_ O (*.FNB)
Function code data (Custom) 1 - -
O (*.RT1)
_ O (*.RTM) O (*.RT1)
Realtime trace data *2
*2 *2
*3
o O (*.HIM)
Historical trace data * - -
Customizable logic data - © (*.CMX) © (*.CMX)
Schedule data - © (*.CSV) -

©: Usable

Those in parentheses indicate file extensions.

*1 User definitions and comments are not imported.

*2 Possible to display only. Tracing cannot be started.

O: Usable (with restrictions) - : No files

*3 The customizable logic project data that is used to save the trace monitor information is
necessary to open the RT1 file that has traced signals added using the trace monitoring
function of the customizable logic, and to correctly display signal names, units, data

incrementing widths.

¢ The files saved in different formats by the FRENIC Loader 3.3,

FRENIC-HVAC/AQUA Loader, or FRENIC Visual Customizer can be read by the
FRENIC Loader 4. When the read files are saved by the FRENIC Loader 4, they
will be saved in the file format designed for the FRENIC Loader 4. The read data
can be edited, but cannot be saved in the original format.
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3.2.3. Type of Files Used by the Loader 4

Table 3-5 List of Files Used by the FRENIC Loader 4

File File operation
File types extension Related section
* Save | Open
(*1) P
2.2.2
224
FNL O O
Standard Function #2
function 2.3.1.1.[4]
codes code data ENL
( ) X O 2.2.2
(FNC)
CSsv O O 2.7
Function 522
code setting -
; 2.2.4
Cu§tom|zaple Function FBL o O 292
logic function code data 2.5
codes 2.3.1.1. [4]
(FNB) X @) 222
Error information
- File read error Ccsv O X —
- Inverter access error
o Monitor data Csv O X
monitoring Display  item TXT O O 2321
selection
Moni f th
. on!tor data of the system csv o % 2399
Operation monitor
monitor i
Mon?tor data of the alarm csv o % 2323
monitor
Operating Monitor data CcSsv O X
state Display  item o o 2.3.2.4
monitoring selection TXT
2.2.2
2.2.4
CML O O
_ 225
Project data 2331
2.2.2
(CMX) X @)
2.3.3.1
Customizable | User  setting area and
logic customizable logic memory CSsv O O 2.3.3.6
area
Input/output check Csv O X 2.3.3.8.[1]
Logic check Csv O X 2.3.3.8.[2]
Comparison results Csv O X 2.3.3.10
Common function blocks EXEBL o o 23314
(FBs)
Schedule data Ccsv O O 2.3.4.1

O: Possible

(*1) Those in parentheses indicate file extensions of the loader other than the FRENIC Loader 4.

X: Not possible
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File File operation
File types extension Related section
* Save Open
(*1) P
2.2.2
224
RT2 O O
2.25
Waveform data 2355
Realtime (RT1) X O 222
trace (RTM)
Csv O X
225
JPG O X
Waveform images 2355
BMP O X
Advanced EXRTM O O 2.3.5.10
2.2.2
224
HT2 O O
2.25
Waveform data 2355
Historical (HIM) X O 2.2.2
trace csv O x
225
JPG O X
Waveform images 2355
BMP O X
Advanced EXHIM O O 2.3.5.10

O: Possible X: Not possible
(*1) Those in parentheses indicate file extensions of the loader other than the FRENIC Loader 4.
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3.2.4. Function Code Setting Specifications
Bm  CSV File Format

The following section shows an example of CSV file format when the function code data is
exported by selecting [Export] on the [FunctionCodeEdit] window accessed from the main

menu.
Column number
1 2 3 4 5 6 7 8
1 | FRNLDR4, G1S, 3900, 3900, 8, J, 3, 2017/01/01 - 00:00:00
5 Func, Function code Setting Factory default
name
F0o, Data protection 0, 0
Row 4 | FO1, Frequency 0, 0
number setting 1,
[comment]
1st row
Sl?rl‘:tr:]e r: Iltem name Description Itr:r;;c;rtt
1 Loader name Fixed at "FRNLDR4". O
2 Inverter model Indicates the model number of the inverter O
3 Inverter ROM | Indicates the ROM version of the inverter o
version
4 Fungtion code set | Indicates the function code version. o
version
5 Capacity code Refer to "Table 3-6" shown below. O
6 Regional J: Japan, A: Asia, C: China, E: Europe, U: USA, T: Taiwan, i
specification K: South Korea
T votegecote |00V, 4 tveophase a0y | ©
8 Date and time Indicates the date and time when the data is exported. -
O: Used for importing. -: Not used for importing.
Table 3-6 List of Capacity Codes
Code Capacity Code Capacity Code Capacity Code Capacity Code Capacity
[kw] [kw] [kw] (kW] (kW]
1 0.1 8 5.5 15 37 22 160 29 400
2 0.2 9 7.5 16 45 23 200 30 450
3 0.4 10 11 17 55 24 220 31 500
4 0.75 11 15 18 75 25 250 32 560
5 15 12 18.5 19 90 26 280 33 630
6 2.2 13 22 20 110 27 315 - -
7 3.7 14 30 21 132 28 355 - -
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2nd row

Indicates the item name for the 3rd row and onwards. Not used for importing.

From the 3rd row down to the row above the [comment]

Column . Import
Item Description P
number target
. Same as the No. column on the [Function code edit
1 Function code ) [ ] O
window.
5 Function code Same as the function code name on the [Function code
name edit] window.
Numerical values that correspond to the set values on the
3 Set value ) I O
[Function code edit] window.
Numerical values that correspond to the factory default
4 Factory default . o -
values on the [Function code edit] window.
O: Used for importing. -: Not used for importing.

Row below [comment] and onward

Same as the comment on the [File information]. Not used for importing.
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3.2.5. Tracing Specifications

Table 3-7 Tracing Specifications

Item Realtime Historical

When using the special communication
commands (*1)

For RS-485 connection: 20 ms to 200 ms

Sampling ]
) For USB connection: 50 ms to 200 ms 1 ms to 200 ms (*2)
time
When not using the special communication
commands
200 ms

15000 points/channel

1 *
Number of samplings (Number that can be continuously displayed) "3
Number of displayed | Analog: 4 channels Analog: 4 channels
data items Digital: 8 channels (*4) Digital: 8 channels (*4)

(*1) The special communication commands can be used by the inverters that support those
special commands.

(*2) The historical trace can be used by the inverters that support the historical trace function.

(*3) The number of samples for the historical trace depends on the inverter models.

FRENIC series Inverter
Ace MEGA VP
(E2) (G1) (F2S)
(GX1)
eHVAC eFIT Lift
(F2E) (EF1) (LM2)
Number of samplings (points/channel) 500

(*4) If four analog channels are selected, digital selection is not possible.

3-32



Chapter 3 Reference Information

3.2.6. Customizable Logic Specifications

B Number of steps

Depends on the inverter models.

FRENIC Series Inverters
Ace (E2) VP (F2S) HVAC (AR1)
eHVAC (F2E) | AQUA (AQ1)
eFIT (EF1)
Lift (LM2)
Version 300 or earlier
100
Number of steps 200 14
Version 400 or later
200
B [Execution cycle]
Depends on the inverter models.
FRENIC Series Inverters
Ace (E2) HVAC (AR1)
VP (F2S) AQUA (AQ1)
eHVAC (F2E)
eFIT (EF1)
Lift (LM2)
Execution cycle Depends EZITE\?viT;)t(;n;IZ r)n step No. 5ms

Maximum step
No. [Execution cycle]
(*1)
1-10 2ms
11 -50 5ms
51-100 10 ms
101 - 200 20 ms

(*1) If 75is manually assigned to the step number even if only one step is used, the maximum
step No. becomes 75 and the execution cycle becomes 10 ms.
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3.2.7. Replacement of Inverter ROM Versions

When selecting definition files for the function code settings, when newly creating a
customizable logic, or when setting the version using the customizable logic project

properties, for the following inverter models, replace the ROM version and select it according
to the table.

FRENIC-Ace(E2S)

ROM version Replaced version
5600~5690 600

5900 700

6000 800

6100 900

FRENIC-VP(F2S)

ROM version Replaced version
5100 200
5110 210

FRENIC-eHVAC(F2E)

ROM version Replaced version

5200 300

3-34






MEMO



Inverter Support Software

FRENIC-Loader 4

PC Loader Instruction Manual

First Edition: June 2019
Second Edition: September 2019
Third Edition: November 2020

Fuji Electric Co,, Ltd.

The unauthorized reproduction or reprinting of this instruction manual, in part or in full, is prohibited.
The content of this instruction manual may be subject to change without notice.

Every effort has been made to ensure the accuracy of the content of this instruction manual, however, please
contact Fuiji if there is anything that is unclear, or if any errors or omissions and so on are found.

Notwithstanding the above, Fuji Electric accepts no responsibility for any adverse effects occurring through the
use of this product.



|
Fuiji Electric Co., Ltd.

Gate City Ohsaki, East Tower, 11-2, Osaki 1-chome, Shinagawa-ku, Tokyo 141-0032, Japan
Phone: +81 3 5435 7058 Fax: +81 3 5435 7420
URL http://www.fujielectric.com/

2020-11



	Cover Page
	Table of Contents
	Preface
	Chapter 1  Before Use
	1.1. Overview
	1.1.1. Features
	1.1.2. Loader Functions by FRENIC Series Inverter Model
	1.1.3. Obtaining this Product
	1.1.4. Product Warranty
	1.1.5. Menu Command and Operation Button Notation

	1.2. Connecting Inverters to the PC
	1.2.1. Connection Methods
	1.2.2. RS-485 Communication Port Connection
	1.2.2.1. Basic Connection Drawings
	[1] Multi-drop Connection Using the RJ-45 Connectors
	[2] Multi-drop Connection Using Terminal Blocks

	1.2.2.2. Devices Required for RS-485 Connection
	[1] Converter
	[2] Cables (for RJ-45 connector connection)
	[3] Cables (using terminal blocks)
	[4] Branch Adapter for Multi-drop Connection

	1.2.2.3. Noise Countermeasures for RS-485 Communication

	1.2.3. USB Communication Port Connection
	1.2.3.1. Basic Connection Drawings
	[1] Connection with the Inverter Equipped with TP-E1U as Standard
	[2] Connection with the Inverter via the TP-E1U
	[3] Connection with the Inverter with Built-in USB Port

	1.2.3.2. USB Specifications
	[1] USB Specifications for the TP-E1U
	[2] USB Specifications for the Inverter with Built-in USB Port



	1.3. Connection between the PC and the Keypad
	1.3.1. Connection between the TP-E1U and the Inverter
	1.3.1.1. Memory Function of the TP-E1U
	1.3.1.2. Connection between the PC and the TP-E1U
	1.3.1.3. Connection between the TP-E1U and the Inverter


	1.4. Installation and Uninstallation
	1.4.1. Installation Methods
	1.4.1.1. Flowchart of Installation Procedures
	1.4.1.2. Perform Pre-installation Check.
	1.4.1.3. FRENIC Loader Installation Procedure
	[1] Installation of Required Software
	[2] Installation of the Message Manager
	[3] Installation of the FRENIC Loader

	1.4.1.4. USB Driver Installation Procedure
	[1] Before Installing the USB Driver
	[2] Installation of the USB Driver.

	1.4.1.5. Checking the USB Driver
	1.4.1.6. Installation of the Message Manager

	1.4.2. Uninstallation Methods
	1.4.2.1. FRENIC Loader Uninstallation Procedure
	1.4.2.2. Uninstallation of the Message Manager
	[1] Before uninstalling the Message Manager
	[2] Uninstallation of the Message Manager
	[3] After Uninstalling the Message Manager
	[4] Supplement: Presence of Files during Uninstallation



	1.5. Settings Required Before Using the FRENIC-Loader 4
	1.5.1. Setting Function Codes Related to Communication on the Inverter Side
	1.5.2. Checking Communication Ports on the PC (when Using a Converter)
	1.5.3. Starting the Loader
	Setting the Operating Environment

	1.5.4. Overview of the Message Manager
	1.5.4.1. Checking the Startup of the Message Manager
	1.5.4.2. Procedure for Closing the Message Manager

	1.5.5. Communication Setting and Connection Setting for the Loader
	1.5.5.1. Communication Settings
	[1] Connection Methods
	[2] Port
	[3] Communication Conditions
	[4] Connected Check

	1.5.5.2. Connection Setting



	Chapter 2  Function Description
	2.1. Main Window
	2.2. File
	2.2.1. Create a New File
	[1] Model, Regional Specification, Voltage, Capacity
	[2] Guidelines on Selecting a Definition File

	2.2.2. Open
	To open a file saved from a loader other than FRENIC Loader 4

	2.2.3. Close
	2.2.4. Save
	2.2.5. Save As
	2.2.6. Print
	2.2.7. Print Preview
	2.2.8. Page Setup
	2.2.9. Exit

	2.3. Menu
	2.3.1. Function Code Settings
	2.3.1.1. Function Code Edit
	[1] Read the Function Code Settings from the Inverter or Keypad
	- If function codes you want to read or write are password-protected:

	[2] Write the Function Codes from the Loader to the Inverter or Keypad
	- What to do if the write operation fails
	- Writing customizable logic function codes from the list

	[3] Change the Settings
	[4] Save
	[5] Print
	[6] Compare
	[7] User Definition (Display desired function codes only)
	[8] Search (Search function code terminologically)

	2.3.1.2. Auto Tuning
	2.3.1.3. File Information
	[1] Changing the Input Power Supply Voltage
	[2] Changing the Inverter Capacity
	[3] Changing a Definition File


	2.3.2. Operation Monitor
	2.3.2.1. I/O Monitor (for monitoring inverter input and output terminals)
	2.3.2.2. System Monitor (for monitoring the internal setup information and maintenance status of the inverter)
	2.3.2.3. Alarm Monitor (for monitoring the inverter's alarm information)
	2.3.2.4. Operation Status Monitor (for monitoring the inverter operation status)

	2.3.3. Customizable Logic
	2.3.3.1. Select Customizable Logic Project to Edit
	2.3.3.2. Editor Screen
	2.3.3.3. Workflow of Creating a Circuit
	[1] Placing Customizable Logic Function Symbols
	[2] Configuring Customizable Logic Function Symbols
	- Properties of an Input Terminal
	- Properties of an Output Terminal
	- Properties of a Link Terminal (output)
	- Properties of a Link Terminal (input)
	- Properties of a Function Block
	- Properties of a Comment

	[3] Connecting Logics
	[4] Creating a Function Block (FB)

	2.3.3.4. Precautions to Take when Creating a Circuit
	[1] Timer Time
	[2] "CLC" and "CLTC" Functions of General-purpose Input Terminals
	[3] Circuit Read From the Inverter
	[4] Function Block 3001: conversion 1, 3002: conversion 2

	2.3.3.5. Useful Features
	[1] Undo/redo
	[2] Copy/paste
	[3] Range Selection
	[4] Symbol Search

	2.3.3.6. Settings for the User Setting Area and the Memory Area
	2.3.3.7. Step Number Assignment
	Assignment method 1: Auto step number assignment (function check)
	Assignment method 2: Manual step number assignment
	Assignment method 3: Step number priority setting
	To check the step number assignment

	2.3.3.8. Circuit Check
	[1] Input/output Check
	[2] Logic Check

	2.3.3.9. Write
	[1] To Write to the Inverter
	[2] To write to the Keypad
	[3] Workflow of Writing the Circuits

	2.3.3.10. Comparison
	2.3.3.11. Debug Function
	[1] Online Monitor
	[2] Trace Monitor
	[3] Online Batch Processing

	2.3.3.12. Project Properties
	2.3.3.13. Lock Function
	[1] Locking the Project
	[2] Locking FBs (Common)
	[3] Locking an FB under [FB (Included with project)]

	2.3.3.14. Importing/exporting an FB under [FB (Common)]
	[1] Exporting an FB
	[2] Importing an FB

	2.3.3.15. Printing the Customizable Logic
	2.3.3.16. List of Input Terminal Signal Codes
	Numbers from 0000 to 12XX
	Numbers 4000 to 50XX
	Numbers 6000 to 70XX
	Numbers 80XX
	Numbers 90XX

	2.3.3.17. List of Output Terminal Signal Codes
	Numbers from 0000 to 12XX
	Numbers 80XX

	2.3.3.18. List of Logic Symbols
	2.3.3.18.1. [Digital] - Basic Logic
	10 to 15: Through
	20 to 25: AND
	30 to 35: OR
	40 to 45: XOR

	2.3.3.18.2. [Digital] - Flip-flop
	50 to 55: SR-FF
	60 to 65: RS-FF

	2.3.3.18.3. [Digital] - Edge Detection
	70, 72, 73: Rise Edge
	80, 82, 83: Fall Edge
	90, 92, 93: Both Edges

	2.3.3.18.4. [Digital] - Digital Other
	100 to 105: Hold
	110, 120, 130: Counter/Timer

	2.3.3.18.5. [Analog] - Basic Operator
	Calculator
	2001: Addition
	2002: Subtraction
	2003: Multiplication
	2004: Division
	2006: Absolute value
	2007: Inverse addition
	2103: Average

	Limiter
	2005: Limiter
	2008: Variable limiter

	Selector
	2101: Maximum selection
	2102: Minimum selection


	2.3.3.18.6. [Analog] - Comparator
	Comparator
	2051: Comparison 1
	2052: Comparison 2
	2053: Comparison 3
	2054: Comparison 4
	2055: Comparison 5
	2056: Comparison 6
	2071: Window comparison 1
	2072: Window comparison 2


	2.3.3.18.7. [Analog] - Converter
	Converter
	2009: Linear function
	2151: S13 function code input
	2201: Inverse scale transformation
	2202: Scale transformation
	3001: Conversion 1
	3002: Conversion 2


	2.3.3.18.8. [Digital + Analog] - Basic operator
	Basic operator
	4001: Hold
	4002: Inverse addition switchover
	4005: Low pass filter
	4006: Change rate limit
	6101: PID dancer output gain frequency


	2.3.3.18.9. [Digital + Analog] - Selector
	Selector
	4003: Selection 1
	4004: Selection 2
	5001 to 5014: Selection 3-1 to 3-14
	5101 to 5114: Selection 4-1 to 4-14
	5000: Selection 3
	5100: Selection 4


	2.3.3.18.10. [Digital + Analog] - Function Code
	Function Code
	6001: Function code read
	6002: Function code write
	6003: function code change




	2.3.4. Schedule
	2.3.4.1. Schedule Setting
	2.3.4.2.  Non-working Day Settings

	2.3.5. Trace
	Trace function
	Offline setting function
	2.3.5.1. Trace Function
	2.3.5.2. Realtime Trace
	2.3.5.3. Historical Trace
	2.3.5.4. Starting/stopping the Monitoring of the Trace
	2.3.5.5. Saving the Trace Data
	2.3.5.6. Copying the Trace Data Screen
	2.3.5.7. Printing the Trace Data
	2.3.5.8. Subwindow
	[1] Cursor
	[2] Adjust Graph Position
	[3] File Information

	2.3.5.9. Advanced Waveform Settings
	[1] Channel Configuration
	[2] A-Ch1 to A-Ch4 (analog settings)
	[3] D-Ch1 to D-Ch8 (digital settings)
	[4] Ch Setting Check (analog/digital)
	[5] Other Settings (including sampling time setting)

	2.3.5.10. Setting Export/Setting Import
	2.3.5.11. Combination with the Customizable Logic Function
	[1] How to Monitor a Customizable Logic Signal Using the Realtime Trace
	- Selecting the Trace Monitor
	- Save Trace Monitor File
	- External Signal Import
	- Advanced Waveform Settings
	- Graph Position Adjustment

	[2] Saving the Customizable Logic Signal Trace Data
	[3] Opening the Saved Customizable Logic Signal Trace Data

	2.3.5.12. Offline setting function

	2.3.6. Test Run
	2.3.6.1. Operating the Inverter from the Loader
	2.3.6.2. Monitoring the Inverter Operation Status from the Loader
	2.3.6.3. If You Cannot Use the [Drive operation] Menu
	[1] A communication Error Has Occurred
	[2] "LE" Enable Communications Link Is Assigned
	[3] The Inverter Has a Realtime Clock (RTC)



	2.4. Setup
	2.4.1. Communication Settings
	2.4.2. Browse
	2.4.3. Language
	2.4.4. Region Spec.
	2.4.5. Date Time

	2.5. Edit
	2.6. View
	2.6.1. Toolbar
	2.6.2. Status Bar
	2.6.3. Parameter Information and Character size
	2.6.4. Toolbox, Project Management Window, Output Window

	2.7. Function Code Edit
	2.7.1. Import and Export
	[1] CSV File Format
	[2] Editing a CSV File
	Setting input rules

	[3] Recommended Way of Use

	2.7.2. Export to CSV (Last error Info.)
	2.7.2.1. Commuication (read or write)
	2.7.2.2. Function code import
	2.7.2.3. Change the definition file

	2.7.3. Loader 3.2 compatible writing

	2.8. Window
	2.8.1. Cascade
	2.8.2. Tile
	2.8.3. Arrange Icons
	2.8.4. Tile Vertically

	2.9. Help
	2.9.1. Search the Topics
	2.9.2. About

	2.10. Global Model Country Setting

	Chapter 3  Reference Information
	3.1. Frequently Asked Questions
	3.1.1. Loader Specifications
	3.1.2. Communication-Related Information
	3.1.2.1. Connection Methods and Connection Devices
	3.1.2.2. USB Communication
	3.1.2.3. RS-485 Communication
	3.1.2.4. Common to Communication

	3.1.3. How to Use the Loader
	3.1.3.1. Function Code Settings
	3.1.3.2. Alarm History
	3.1.3.3. Customizable Logic
	3.1.3.4. Trace
	3.1.3.5. Test Run
	3.1.3.6. Date and Time

	3.1.4. Terminology

	3.2. FRENIC Loader Standard Specifications
	3.2.1. Functional Comparison with the FRENIC Loader 3.3
	3.2.2. Compatibility with the Existing FRENIC Loader
	3.2.3. Type of Files Used by the Loader 4
	3.2.4. Function Code Setting Specifications
	3.2.5. Tracing Specifications
	3.2.6. Customizable Logic Specifications
	3.2.7. Replacement of Inverter ROM Versions


	Edition
	Contact



